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1 INTRODUCTION 

1.1 PURPOSE OF THE DOCUMENT 

The document at hand details the evaluation and validation processes 
performed during the development of the HarmoSearch system as well 
as the results and findings during the validations. The overall goal of 
the evaluation process is first to incrementally improve the quality of 
the system and platform with regards to software components. The 
validation also aims at gathering explicit acceptance by the partners of 
the evaluated system.  

The evaluation was due starting after a year. In fact, it was decided to 
start it earlier and adopt agile development methods. This document 
explains the reasons of this decision. The early start as well as the 
approach, processes, and documents used are the outcome of the 
initial thinking and preparation of development. 

At the beginning of the project a basic evaluation procedure is defined 
with a set of dedicated activities that have been performed every time 
a new prototypical release candidate is released. Overall 5 release 
candidates are developed. The evaluation procedure covers technical 
and functional evaluations. The technical evaluation performed by 
developers prior focuses on evaluating the developed software 
artifacts, whereas the functional evaluation performed by the partners 
addresses the usability of the main components that provide a 
graphical user interface (UI) (supporting the user during its use of the 
platform).  

After each release, an acceptance note is validated by each partner so 
as to confirm that they accept the release and consider that it fits the 
requirements. The present document gathers all those acceptance 
notes. 

All in all the evaluation results shows that the developed components 
are of good quality. The expert users judge the usability and 
functionality of the HarmoSearch system platform and mapping tool 
mostly fulfilled. Especially the early releases showed usability deficits 
in the different systems, addressed by extended user documentation 
and extensive work on the graphical interfaces.  

1.2 DEFINITION OF TERMS AND ABBREVIATIONS 

The following terms and definitions are used throughout this 
document:  

• HarmoSearch system: The system gathers all the 
components, tools and features developed during the 
HarmoSearch project. For instance, the mapping tool and the 
platform defined below are part of the HarmoSearch system. 
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• Release candidate: The development of the HarmoSearch 
system, platform and mapping tool follows an iterative 
approach. Accordingly, several versions of the whole system are 
developed. A release candidate denotes to the most recent 
version of the prototypical implementation of the HarmoSearch 
platform and mapping tool ready to be evaluated. 

• Mapping tool: The HarmoSearch mapping tool is a stand-alone 
tool dedicated to support domain-experts (expert uses of a 
specific domain) in creating proper mappings between elements 
of a source schema and elements of a target schema. 

• Platform: The HarmoSearch platform is the graphical interface 
allowing non-technical users to benefit from the HarmoSearch 
system’s features. It uses profiles, roles, mapping files, and 
service subscription to let user import, publish or search data 
using the system. 

• Technical evaluation [Internal evaluation]: Defined in 
details in this document, this evaluation consists of technical unit 
tests performed by developers in order to ensure the robustness 
of the developed software artifacts. 

• Functional evaluation [External evaluation]: Defined in 
details in this document, this evaluation consists of using the 
components of the HarmoSearch system in order to ensure that 
they meet requirements and can be used by non-technical users. 
 
 

1.3 RELATIONSHIP WITH OTHER DOCUMENTS 

Initial inputs for this document are deliverable D2.1 Use Case 
Specification, D2.2 Architectural Design. D2.1 defines the main 
functionalities and requirements whereas D2.2 is used to describe the 
basic architecture of the HarmoSearch as well as the Harmonise 
systems. Those resources provide additional information but may be 
less easy to understand as regard the evolution of the HarmoSearch 
system and its evaluation. 

A detailed evaluation report specific to the standalone mapping tool 
can be found in D6.3 Evaluation Report on Validation of Results of 
Mapping Tool, as well as its documentation in D6.4 Manual for the 
HarmoSearch Mapping Tool. A detailed evaluation report specific to 
the registry can then be found in D5.3 Registry Evaluation Report: 

Finally, the documentation of the HarmoSearch platform is available in 
D7.2 Running Prototype. 
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1.4 STRUCTURE OF THE DOCUMENT 

The document is structured as follows:  

• Section 2 describes the overall development and evaluation 
approaches and provides an overview about the main goals as 
well as planned and performed activities. It aims at explaining 
the reasons for the chosen approach, and reason for the early 
start of the evaluation processes. It finally presents the iterative 
approach (agile development) adopted for the HarmoSearch 
project as well as the main evaluation principles.  

• Section 3 describes the planned evaluation process and its 
distinct steps, as well as the corresponding activities performed 
during each step.  

• Section 4 presents in details the documents used for those 
evaluations.  

• Section 5 summarizes the evaluation results of the various 
release candidates, and the review meetings together with all 
partners concluded by the validation (acceptance) of the release.  

• Appendix A presents the document gathering requirements, 
document, updated at the end of each evaluation session. 

• Appendix B provides the list of test cases documents, provided 
as results of the evaluation processes. 

• Appendix C provides the list of formal acceptation notes, 
prepared and validated by the partners for each release. 
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2 PRINCIPLES 

2.1 INITIAL APPROACH 

 

Evaluation of work was due on start in Month 12. However, the initial 
work on the different work packages (WP2 for the definition of the use 
cases and the initial requirement gathering for the different 
components) shows that the target system is complex and would 
therefore be difficult to evaluate. Furthermore, the produced 
documents are quite voluminous and hard to use both for the 
developers and the functional testers. 

As a consequence, the decision was taken by the partners to use an 
Agile development methods, detailed in the next chapter.  

The purpose of the evaluation report is to define the evaluation 
procedure for the HarmoSearch system. Since HarmoSearch is an 
information and communication technology (ICT) research project, the 
main deliverables are software artifacts.  

Specific evaluation activities are used to determine if the HarmoSearch 
tools met the expectations in regard of project execution, usability, 
and user satisfaction. The activities performed during the entire 
project are used to determine if the evaluation is effective and how the 
actual users feel about the final release.  

The following activities are performed during the project:  

• During the development phase unit tests are used to evaluate 
dedicated parts of the developed source code 

• Evaluation testing by expert users to evaluate the software 
quality perceived by the expert and end user 

2.2 AGILE DEVELOPMENT METHODS 

The HarmoSearch project is conducted using agile development 
methods, following iterative processes. Thus, although main 
expectations and requirements are defined for the general project, the 
partners have decided to divide the project in several steps. An initial 
step is to plan a series of releases candidate to ensure punctual 
evaluations of the work in progress, and precise monitoring and 
adaptation. 

For each release, precise requirements are defined, and planned for 
development, based on the outcome of the previous evaluation, the 
use cases defined at the beginning of the project (in doc...) and the 
continuous requirement gathering available in Appendix A. The 
division of the expectations in smaller precise requirements allows a 
flexible development. It can then be decided to postpone or cancel a 
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specific requirement in order to ensure the quality and time of delivery 
of a release candidate. For instance, it was decided to focus on an 
effective integration of Facebook and Twitter to the platform instead of 
adding other social network (as this would have required much more 
development for a minimal added value). 

This process allows using a maximum of resources for evaluation and 
feedbacks, at several stages of the project. 

At the end of evaluation of a release, the partners can then validate it, 
and decide which requirements to prioritize for the next release 
candidate. This is also the opportunity to add new requirements 
according to the results of the evaluation (for instance, improving 
usability of the mapping project in the firsts releases) 

2.3 EVALUATION PRINCIPLES 

The HarmoSearch system is evaluated from two distinct perspectives:  

• Technical evaluation 
• Functional evaluation  

2.3.1 Technical Evaluation 

The technical evaluation focuses on determining if the robustness of 
the developed software artifacts is satisfying. The developed artifacts 
are permanently evaluated during the development phase (mainly 
covered by unit tests).  

In order to keep the code quality high during the entire development 
phase a systematic approach to developer testing is performed:  

• In order to make sure that the requirements are implemented as 
defined, test cases must be developed for each relevant 
requirement. Moreover, the test cases should be defined at the 
requirements stage (requirements elicitation) or as early as 
possible (ideally before implementing the unit tests).  

• Relevant design concepts has to be tested using proper test 
cases ideally in the very early stage of the development phase 
or sometimes during the requirements elicitation.  

• Detailed test cases are built along with the current release 
candidate. Using a basic approach for defining these test cases 
can help avoiding errors in the requirements as well as in the 
design of the system and tools. Typically errors in the 
requirements or the design require more effort and thus, are 
more expensive than code errors.  

The technical evaluation is the responsibility of the developers. Some 
specific points (challenging requirement, technical issues, and choice 
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between a series of alternatives…) may be discussed with other 
partners, but the technical unit tests are not part of the delivery. 

2.3.2 Functional Evaluation 

The functional evaluation consists of expert and real user evaluations 
where both groups are asked to perform functional tests on the 
corresponding release candidate of the HarmoSearch system. The 
main purpose of these evaluations is to verify that the developed 
artifacts meet the needs of the end user. 

Testing the latest release with end-users is highly important in order 
to guarantee that the final user is satisfied. For evaluating the user’s 
experience a scenario-based cognitive approach is used.  

The overall objectives of functional evaluations are as follows:  

• Evaluate if the underlying business cases are covered or not by 
the final product 

• Discover gaps during the development and requirements 
elicitation phase 

• Gathering a common understanding of user expectations and 
how they can be managed effectively 

The user evaluation is conducted using a formal scenario-based 
approach. Thereby, a formal template is used in order to measure how 
the user feels when using the services and tools. The main points of 
interest the template covers are as follows:  

• How does the user feel when using the mapping tool for creating 
and managing and proper mapping solutions? 

• How does the user feel when using the system and the platform 
to search, import or publish data? 

• Are the tools intuitive to use? 
• Does the user grasp the underlying concepts easily? 

The declared overall goal of external evaluations as described above is 
to determine if the actual end-user can handle and perform the 
activities that are necessary for accomplishing their tasks. The user 
evaluation applies to the main building blocks of the HarmoSearch 
platform and the mapping tool:  

• User interfaces 
• Features 
• Error messages 
• Wizards 
• Editors & control panels 
• User assistance 
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The evaluation template is designed to collect feedback from 
participating users. Thereby, the user have to fulfill certain tasks 
defined by the development partner beforehand. The user evaluations 
are held alongside with the release of a corresponding release 
candidate. All in all 5 evaluations have been performed. 

During the evaluation the following actions are performed:  

• The formal template containing all steps and activities is defined. 
The template addressed the main functional building blocks as 
well as menus, error messages, and other UI-related aspects.  

• The template contains a detailed description of the input as well 
as the expected output necessary to perform the step 
successfully. Furthermore, it also contains the concrete 
component, which is the actual object of the evaluation and the 
corresponding sub-component if any.  

• The template also provides information on the test sequences. 
Giving each specific test an ID allows to precise in which order 
tests are to be played, and which are the dependencies. This is 
particularly useful when performing a more targeted test session 
after a bug was solved. 

• The test data must be clearly specified and some space for 
comments was present.  

• Moreover, the document contains additional space where the 
user can provide an overall feedback on the success of the 
current test case. Valid values are:  

o O - Test case is successful and met the requirements as 
expected 

o X – The test case is not accomplished due to an error or 
missing requirements.  

o W – The test case is accomplished as described but lacked 
either minor user expectations or requirements. This value 
can be used to provide additional feedback (for instance, 
lack of clarity on the interface). 

The document used as template for functional tests is described in 
details in the “Functional Evaluation Document” section 
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3 EVALUATION PROCESS  

The main goal of the evaluation process is to evaluate if the results of 
the developed software meet the expectations. Expectations are 
classified into the following groups:   

• Business expectations: In this group the main goal is to 
determine if the business expectations defined at the beginning 
of the project are met. This mainly includes the value of the 
release, its quality, as well as its delivery.  

• Workpackage execution: The main aim of this group is to 
evaluate if the workpackages dedicated to the development of 
the components of the HarmoSearch system is executed as 
planned (on time and quality) to fit the requirements. 

• User satisfaction: The final group that aims to determine if the 
system is a success from an end users point of view.  

The whole development and evaluation process is built upon several 
levels: planning, development and preparation, technical evaluation, 
functional evaluation, and review meetings.  illustrates the process 
graphically.  

 

  

 

 

 

 

 

 

 

 

 

 

The described evaluation process follows five main principles:   

• Collaboration 
• Integration 
• Formative 
• Summative 
• Supportive 
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Figure 1: Evolution process overview 
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Collaboration: Evaluating the developed software artifacts is 
accomplished in an organized and agreed way in conjunction with all 
participants involved in the development and test phase of the 
artifacts under consideration. This is also why each releases has to be 
formally accepted by the partners once evaluated. 

Integration: The described evaluation process is integrated into each 
of the release cycles of the HarmoSearch system.  

Formative: HarmoSearch is an international research project and 
involves partners from all around Europe. Generating feedback 
throughout the whole process ensures that all participants remain 
focused on the objectives of the HarmoSearch project (despite 
working different countries and organizations).  

Summative: The outcome of the evaluation is used to judge whether 
the HarmoSearch system (the final outcome) meets its objectives. At 
the end of the project a proper report on the evaluation and validation 
performed is published, which is the actual context and content of the 
document at hand.  

Supportive: The process foresees that all project partners (even 
those who are not actively involved) stay informed and are supported 
throughout the whole project.  
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3.1 ROLES AND RESPONSIBILITIES 

The evaluation procedure is done collaboratively, which means that 
the partners are actively involved in the evaluation process.  Thereby, 
each participant has one or more of the following roles:  

• Participant: The external evaluation is conducted in close 
collaboration with all partners. Especially SPK id strongly 
involved in the functional evaluation of the current HarmoSearch 
mapping tool, and Afidium in the functional evaluation of the 
HarmoSearch platform release candidates. All partners are 
involved and participate in the review and validation meetings, 
which are organized in order to share experiences, evaluate if 
the presented release candidates fulfill the requirements as 
expected, and gather a formal acceptation from the partners. In 
connection with the review meetings results and future steps are 
discussed.  

• Evaluation Leader (Afidium): Working in close collaboration 
with all participating partners, Afidium is responsible for 
gathering each release and its evaluation forms, supervising the 
evaluation and gather evaluation and validation from the 
partners 

• Release provider: In addition to providing the release, 
accesses and documentation, the release provider is responsible 
for creating the evaluation form, performing technical 
evaluation, and supporting all participants in case of questions 
or errors.  

• Business User (Domain-expert): An experienced professional 
having a deep understanding about a certain problem domain. 
Usually domain-experts have only little or no technical expertise 
in creating and using a proper mapping, and need a user-
friendly interface to benefits from this mapping and retrieve or 
publish data. Domain-experts are the focus group the 
HarmoSearch tools was developed for, and may be part of the 
consortium members (participants).  
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3.2 PROCESS TASKS 

Evaluation and testing is a five step process 

• Preparing the test cases 
• Planning     
• Technical Evaluation 
• Functional Evaluation 
• Review and acceptance 

3.2.1 Preparing the test cases 

The test cases for each module part of a release must ideally be 
prepared at the same time as the requirements. In general, the test 
cases are prepared after the requirements, in parallel with the 
developments. They are prepared by the release provider and 
submitted to the evaluation leader and the testers. A number of 
iterations may happen before final validation of the test grids. 

The test cases must be prepared jointly by the users and the 
developers so as to ensure that all aspects are covered and that the 
developers know what the users concretely expect and how they 
express it. It also allows ensuring that the test data are present and 
relevant for the expected test. 

To limit the size of the test grids, it was decided that the test grids for 
each release only contains new features to be tested. It is therefore 
recommended that the testers test a number of cases from the 
previous grids to ensure backward compatibility. Tests showing issues 
are especially important to be retested. 

However, if relevant, certain test cases from a previous release are 
copied to the next release usually to be expanded, so as to be able to 
replay previous test cases and validate the new features at the same 
time. 

Test cases are covering all the components of the HarmoSearch 
system (Query language, semantic registry, metasearch, mapping 
tool, portal, crawler…) which are modified in the latest release. 

The different test grids are merged to create the evaluation grids 
provided in the appendix. 

The evaluation grids are stored in a repository (SVN) shared with all 
partners. There is one directory per release, and in each release 
directory, the prepared test cases is positioned. An additional directory 
contains the necessary resources (such as inputs to be used or output 
examples to be used for comparison). 
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3.2.2 Planning 

The objective of this task is to set everything ready for the evaluation 
session:  

• Selection of participants 
• Scheduling of evaluation activities 

To ensure maximum validation and knowledge transfer to the 
partners, the evaluation sessions involve most of the partners. The 
participants are selected at least a month before the evaluation occur. 

The evaluation activities are limited in time during around a week (a 
maximum of two) to limit time dispersion: all feedbacks are available 
to the solution provider within a limited timeframe. During that time, 
the evaluation platform is kept stable (except in case of blocking 
issues). The evaluation time frame is scheduled so as to be compliant 
with all partners. It starts with the evaluation of the provider, usually 
followed by the evaluation of the evaluation leader (Afidium). Then 
comes the evaluation by the partners, one day for each. 

A follow up meeting is then planned by the evaluation leader, to define 
whether the release is accepted or not and under which conditions. 

Afidium as responsible partner ensures that the release candidate is 
delivered in time for evaluation and that all requirements are met. 
Furthermore, the evaluation leader Afidium has the overall 
responsibility of ensuring that the evaluation activities are done 
properly and in time. The participants that conduct the evaluation 
have the responsibility of identifying defects in the release candidate 
(usually the developer team is also part of the evaluation team).  

3.2.3 Technical Evaluation 

The purpose of the technical evaluation step is to test the robustness 
of the developed software artifacts and components. This evaluation is 
conducted by the release provider using proper tools for testing and 
for code quality improvement. Furthermore, relevant UI components, 
such as wizards, are tested manually.  

Each development team is responsible for unit testing. The unit testing 
traces are not part of the releases nor of the deliverables. Thus, the 
testing process described later only concerns the testing of releases 
after developments have been performed. 

The release provider also needs to perform the 1st test session of the 
functional evaluation, as described in the next section. 

3.2.4 Functional Evaluation 

The overall goal of the functional evaluation step is to allow user-
oriented evaluations in order to gain feedback from expert users.  
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Once the test cases and release candidate are prepared, the candidate 
has to be distributed for the evaluation. This includes the software 
(the evaluated mapping tool, HarmoSearch platform…) as well as the 
updated template of the evaluation.  

The release provider has to ensure that the prepared test cases can be 
performed. As a consequence, he plays them before delivering the 
release. At least one "technical" tester has to be active for each test 
case to be played. It could be a member of the team having developed 
the module or a member of another technical team. Those tests are 
meant to ensure the compliance with the cases prepared in advance. 

The results of the first tests are performed by the technical testers and 
are visible in the test cases files in the directory of the corresponding 
release. 

Internal project partners (expert users) as well as domain-experts that 
are not actively participating in the HarmoSearch project perform the 
functional evaluation. The evaluation has to be performed by internal 
as well as external partners in order to identify gaps from a user's 
(respectively expert-user’s) perspective. In the end, the collected 
feedback allows to reason about the success and usability of the 
HarmoSearch services and tools.  

This has to be performed by the users (partners or external users) 
identified in the planning step, before accepting a release after the 
delivery by the technical teams. The tester has to use the prepared 
test cases to ensure the coherence of the tests in relation with the 
requirements. 

The test cases are contained in one or several Excel files. They list 
functional tests based on a concrete business scenario as identified by 
the participants and the selected domain-experts beforehand. The 
document not only contains the scenario, but also the different steps 
to perform the evaluation. The file is filled by the users during the 
scheduled evaluation session with a global indicator, comments and 
possibly links to external documentation when required. When 
required, an “output” screenshot or file is placed in the same “test 
data” repository as the input resources, so as they are accessible to 
the release provider as well as the other partners.  

The provider partner uses then the evaluation outcome to populate the 
bug tracking system so as to ensure that the different issues are 
corrected for the next release (or sooner if they are preventing the 
release acceptance). 

The results of the functional evaluation is also presented to the other 
project partners during the review meeting in order to have a shared 
and general view on the user perceived usability of the HarmoSearch 
services and tools.  
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Once the evaluation is performed and release candidate corrected if 
necessary, the candidate has to be distributed for the final review. 
This includes the software (the evaluated mapping tool, HarmoSearch 
platform…) as well as the results of the evaluation.  

3.2.5 Review and Acceptation Meeting 

A follow up meeting (a Skype call or during a consortium meeting) is 
then organized. This review meeting is the final step in the evaluation 
cycle. Its main purpose is to present, to share, and to discuss the 
evaluation results within the project consortium. The object of 
discussion is the list of identified defects and issues that came up 
during the evaluation, and the objective is to define whether the 
release is accepted or not and under which conditions. 

Before the meeting the release provider prepares the actual release 
candidate so it can be presented properly. Furthermore, the release 
provider has prepared the main test cases that are then presented 
during the review meeting. The Evaluation leader ensured that test 
cases are ran, and taken into account by the release provider. The 
evaluation leader also prepares the formal acceptance note to be 
validated by the partners. 

Another point of discussion is the functional reviews, which is created 
during the evaluation. Thereby, the participating partners describe 
their experience and feeling using the release candidate under 
consideration. The results of these discussions is taken under 
consideration for further steps and requirements elicitations for the 
next release candidate.  

At the end of the review meeting the review results are collected for 
further analysis. Identified issues that are relevant for the next release 
candidate are added to the requirements list. This allows the 
evaluation leader to integrate the new proposals and 
recommendations in the requirement documents. Those are then 
submitted to the partners to define whether those requirements will be 
implemented or dropped and in which release. 

Once a release is tested, all results are gathered and the consortium 
can express whether release is accepted or not, possibly with a 
number of issues being registered. This corresponds to the formal 
acceptance note that must be generated for each release. This 
document is validated by all the partners and contains description of 
the delivery content, so each partner can check and accept the 
release. This ends the validation process of a release. 
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4 FUNCTIONAL EVALUATION DOCUMENT 

The form for the functional evaluation is used to collect the evaluation 
data from the participating users. Data collection during evaluation 
sessions is crucial. As described before the evaluation data is collected 
using a form-based approach. The reason why forms are used for 
capturing the evaluation results is simple: The reviewers are largely 
human processes. If data is not collected in a guided and formal way 
the information can easily be lost. The data collected by the evaluation 
process consists of defect data (bugs and issues that harm the basic 
functionality of the system, the platform or the mapping tool) and the 
user’s feeling using the HarmoSearch services and tools. 

As mentioned, selected users who perform the functional evaluation 
have to use the external evaluation form. The evaluation form is 
available to the participants before the starting of the evaluation 
session. Its main purpose is to record the following information:  

• Look and feel from the user’s perspective 
• Usability of the components of the HarmoSearch release 

candidate under evaluation 
• Functional defects or other issues that occurred during the test 
• Documentation (online and offline) 

The release provider is responsible for providing the evaluation form 
(detailed test cases) and the evaluation leader for collecting the 
results.  

As Evaluation leader, Afidium is also responsible for providing the 
initial template of test cases document and documentation on its use. 

4.1.1 Documentation of the test case form 

The test case template is an excel document that already contains the 
description of each column and how to use them (located in the “Help” 
sheet). This main documentation is also present in the evaluation 
forms created for each release. 

This main documentation is reported in the table below. 

In addition to this main documentation, more information is available 
in a private wiki opened to all partners. This additional documentation 
aims at providing assistance in the creation and use of the test cases 
documents. 

This additional documentation is reported below the table. 
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Field Description Cardinality Example 
Definition 
section 

Items defining the test case     

Id Unique identifier to refernce test case , 
in Bug tracker, other test case, 
documents … 

1 T1, 
AU1...  

Parent To reference an Id in case of child test 
cases. Child test cases happen when the 
same test case is played with different 
values 

0..1  

Sequence To reference an Id in case of linked test 
cases. Linked test cases happen when 
several cases must be played in a raw 

0..1 1,2, 3, … 

Action Action described in the documents that 
will be tested  

1 Crawling 

Name Name of the test case 1 Refresh 
Cache 

Description Explains what is the purpose of the test 
case 

1  

Comment 
(and 
alternatives) 

Any additional comment that would help 
explain the test case, if required 
Alternatives can be detailed here. They 
should then (if accepted) become 
additional test cases associated to a 
parent test case 

0..1  

Complements  Any additional information that should be 
used to test the Semantic Registry 

0..1  

Doc Ref A reference that would be present in 
requirements, use cases… 

0..1  

External Link Links to documents detailing the 
requirement or use case in relation with 
the test case 

  

Test section One section per test date. All tests 
may not be performed each time. 
Copy for a new test 

1..*   

Date Date of test. 1  
Actual Result Describes the actual response, especially 

if not per expectation 
X: Not OK 
W: OK but there is a warning: something 
that may be improved or better 
documented 
O: OK 
?: Cannot conclude 

1  

Output  
(XML, 
Screen...) 

Link to the output (screen copy, xml 
response …). Useful when response is 
not per expectation. 

0..1  

Table 2: Test cases main documentation 
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The status 
• O - OK: Test case succeeds without any problem. It is still 

possible to provide a screen shot or a file to show result or a 
comment, but no modification is expected, 

• W- Warning: Test case is considered valid. A comment should 
however be added to explain the warning. It may end up 
proposing a new or update requirement. It may be a suggestion 
to enrich or modify the test data or to produce additional test 
cases to validate more in detail the test case 

• X - Test case fails: An explanation must be provided with a 
screen shot or a file to show or illustrate results. It may end up 
with new requirements or the need to have new data or 
parameters before test is replayed. 

The screen shots are to be saved in the repository directory 
corresponding to the release (this is starting with release 3, previous 
screen shots being saved in the document itself). 

Splitting a test case in steps 

A test case must be split by steps, in case several steps are involved. 
For instance, a test case to check how to create a new user is likely to 
be split into several steps, like :  

1. Go to the create new account page, 
2. Enter the minimal information, 
3. Validate the input, 
4. Check that a confirmation mail is received, 
5. Check that admin gets an activation request, 
6. After activation, sign in . 

Detailing the different steps ensures proper testing and feedback to be 
used in the next release. 

Providing variations to a test case 

It is also important to provide variations around the same test case to 
go over the different possibilities. To illustrate with the previous 
example, different variations could be: 

• New account with a new company 
• New account with an existing company 
• Account already exists 
• Account uses an incorrect email  
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Not all cases are likely to be covered but expanding this list will allow 
improving the quality of the portal, step by step. 

It is also possible not to detail all the steps for the different variations, 
since a number of the steps of the different variations are likely to be 
common. It is therefore better to describe variables on specific steps 
instead of multiplying complete test cases. 

Providing a link to a file or screen shot 

Starting with release 3, in case there is a need to add a screen shot or 
additional information to a test case to illustrate an issue or a new 
requirement, a file must be saved to the repository directory 
corresponding to the release. 

The file name must contain:  

• the test case ID, 
• the date of the test session, 
• the user initials, 
• a self-explanatory free text. 

The server link must be copied to the test case line. 

If the complement corresponds to a possible new requirement, this 
information must be added to the requirement file once requirement 
are validated. 

Preparing a new test session 

• To prepare for a new test session using the same test case, 
simply replicate the colored test columns that contain the status, 
initials and comments for a test. 

• To create new test cases in an existing test file, simply copy an 
empty line to ensure coherence of colors and formula. 

4.1.2 Using the test cases form 

Tests cases documents are created and filled for each releases 
(possibly several documents per release). All those documents are 
gathered in the appendix.  
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5 EVALUATION SESSIONS AND ACCEPTANCE 

The participating partners, external users and the evaluation leader 
have performed the evaluations. All in all 5 evaluations are conducted. 
Each with the ongoing release candidate version of the HarmoSearch 
system. Afidium, as evaluation leader, is also responsible for collecting 
and distributing the results of the evaluations within the HarmoSearch 
consortium. The evaluations has taken place throughout the whole 
project. Overall 5 evaluations have been performed in M09, M10, M14, 
M23, and M26. 

At the end of the evaluation process, a review and validation meeting 
occurs. During those meetings, each release is validated by all 
partners with a formal acceptance note. All Acceptance notes are 
gathered in the appendix. 

As the subsections below will show more precisely, the evaluation has 
started early in order to follow a recursive evolution. At the very 
beginning, the main requirement of the release is to define the key 
components such as ontology, crawler prototype…(Release 1), and to 
integrate them in the first running prototypes (Release 2, metasearch 
and mapping tool). This is followed by the realization of the complete 
system while the improvement of the initial prototypes can continue 
(release 3). The two lasts releases are dedicated to the improvement 
of the previously implemented tools (addition of features, 
improvement of usability, and final tuning) for releases 4 and 5.  

5.1 EVALUATION OF RELEASE 1 

Main requirement: Definition of the key components for the 
HarmoSearch platform. 

The key components are well created and tested by the partners. The 
registry passes all tests very well, but some issues are noticed during 
the tests (on the query for instance, which aren’t correctly specified) 
and are added to the requirements of the second releases. Those few 
issues aren’t considered as problematic as no operation has been 
initially planned between the two releases. It is also confirmed to 
provide the first mapping tool (“Flocke”) in the release 2. 

Additional resources to be found in appendix:  

• Tests results of this release can be found in Test cases for 
release 1, 

• Content and Acceptance note for this release can be found in 
Acceptance note for release 1. 
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5.2 EVALUATION OF RELEASE 2 

Main requirement: Integration of the different components in order to 
have a running metasearch and a first release of the mapping tool. 

Evaluation has been performed without blocking issues, but many 
comments are provided, especially on the usability of the mapping tool 
(which use is very complicated in its early stage). Some improvements 
are made and tested before validation of the release, remaining 
improvements are postponed to the next releases. The first mapping 
tool meets the functional requirements, but is not stable enough and 
too complicated. Corresponding improvements are planned. 

With the fist mapping tool tested, and a functional meta search 
running (with integration of the first data sources and a graphical user 
interface for search and results), the second release points out the 
importance of ergonomics and usability (documentation, wizards, 
contextual help…) and allow partners to initiate the discussions of the 
demonstrations materials (scenarios, inputs and outputs…), as a first 
demonstration of the meta search and mapping tool was performed 
during the review meeting. 

Additional resources to be found in appendix:  

• Tests results of this release can be found in Test cases for 
release 2, 

• Content and Acceptance note for this release can be found in 
Acceptance note for release 2. 

5.3 EVALUATION OF RELEASE 3 

Main requirement: A complete system ready in a productive 
environment. 

This important release provides partners with a whole portal to be 
usable from end to end, an initial account management allowing to set 
up new users and organizations, as well as an API for external services 
to connect to HarmoSearch. In addition to the main functional 
requirements, this release is helpful to define in details the need for 
elements such as status reporting, parameters, notifications… to 
improve the overall usability of the platform. 

Release 3 also provides a much more user-friendly and intuitive 
mapping tool, even if more improvements are planned on this aspect 
(contextual wizards and messages). 

Additional resources to be found in appendix:  

• Tests results of this release can be found in Test cases for 
release 3, 

• Content and Acceptance note for this release can be found in 
Acceptance note for release 3. 
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5.4 EVALUATION OF RELEASE 4 

Main requirement: Apply the tools to enrich the system 

With only a few issues regarding some of the new features (publication 
on social media), which are quickly solved before validation, the 
HarmoSearch platform presented in the fourth release is a really good 
“exhaustive demonstration” of all the possibilities and features of the 
system (meta search, automatic and manual publication of data…). 
With improved navigation and usability, Afidium involves new users in 
the test processes to ensure the platform was easy to use and its 
feature easily understood by non-technical users. 

As the platform includes all the features for each users, the interface is  
too rich at this stage (too many features available) which can result in 
a lack of clarity. This confirms the need for user roles management in 
order to limit the feature to each user need (defined as several main 
scenarios). Those main roles are defined, and their integration to the 
platform is planned for the fifth release. 

Additional resources to be found in appendix:  

• Tests results of this release can be found in Test cases for 
release 4, 

• Content and Acceptance note for this release can be found in 
Acceptance note for release 4. 

5.5 EVALUATION OF RELEASE 5 

Main requirement: Fine tuning the system 

Along with the integration of new nice to have features, the 
improvement of social media integration, and the enrichment of data 
(scoring, keywords, qualification…), the main evolution in this release 
is the finalization of the user role management of the portal, with role-
specific interface. With this release, user now starts by creating the 
account that best fits its need (“I want to publish data,  to perform 
qualified meta search or to import qualified content), and will only see 
and access the features which are relevant to the role he picked. This 
fifth release confirms that the usability objective is met as well as the 
functional requirements. 

The structure and content of the help section is integrated to the 
platform, available to registered users. 

Additional resources to be found in appendix:  

• Tests results of this release can be found in Test cases for 
release 5, 

• Content and Acceptance note for this release can be found in 
Acceptance note for release 5. 
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APPENDIX A. LIST OF REQUIREMENTS 

This section contains the final list of requirements that are 
incrementally built and that is used to validate the actual features of 
the systems against the requirements per release. 
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Comment (Release)

U
1

R
Q

D
F

Account  

management

User Registration 

by himself

Create user with 

minimal information

User can create an account using minimal information in 

order to begin using the portal

Login : like email or other 

password : selected by user, with security notion+ 

retype for validation, real name, email

Associate user to entity (company, individual …) or 

create entity

Create user is not active until validation by HS admin 3

U
2

R
Q

D
F

Account  

management

User Registration 

by member of its 

entity

Create user from an 

existing account

Existing user can create validated users when logged in, if 

part of their own entity

Created user is directly active in that case and inherits 

from all roles from the entity. It is possible then to 

select services from the account 5+ Not key for the R5

U
3

R
Q

D
F

Account  

management

User Registration 

by HS user

Create Organisation 

and users from HS 

admin

HS admin can create validated users and associate them to 

any existing entity

An organisation can have different representatives 

(corresponding to different logins) having the same 

right, since the right are associated to the 

organisation. At present, only admin (harmonet 

personnel) can crezate users. People from an 

organisation cannot create users 1 Y

U
4

R
Q

D
F

Account 

management Notification

Define when to 

receive notifications

User or entity level definition of when users should receive 

mails in case of account update. N/A X

U
5

R
Q

D
F

Account 

management Notify User

Notify user in case of 

an update to its 

accounts

Any time an update is done on user account or to the 

entity for which the user is the main contact, user should 

be notified

It may be possible to specify in user profile for which 

events notification should apply 6 X

U
6

R
Q

D
F

Account 

management Entity Definition Create Entity

Entity is a legal entity or an individual that will provide 

services. It can be created by a new user or an HS admin

Users are associated to entities, as well as services. 

Entity is defined by Name, billing address, contacts, 

mail, main contact, Roles to be covered (provider, 

consumer). After activation, Services to be provided or 

used according to roles, contracted features, 

payments, ... can be accessed

In case of creation by HS user, it can be directly 

activated 4 3

U
7

R
Q

D
F

HS Account 

Management Activate account Account activation

After reviewing Entity or user account, HS admin can 

activate the profile. By default, account is inactive. 3

U
8

R
Q

D
F

HS Account 

Management Search account

List entities or 

accounts according to 

certain criteria

In order to activate or deactivate users, to send alerts, 

information, associate users to accounts …

Search by state (active, inactive, new user…), last login 

date, name, email, id, role, profile information … N/A X

U
9

R
Q

D
F

User 

registration Login

Login with UID and 

PWD to access HS services, user must first login.

A number of information must be accessible to non 

registered users, such as communication, news, login 

information… 1 Y

U
1

0

R
Q

D
F

User 

registration Login I forgot my password

In case user has forgotten some information to login, scree 

must be provided to get the information back

Like entering email + kaptcha + possibly additinal 

information 1 Y
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Comment (Release)

U
1

1

D
F

User 

registration Login

Lock in case of too 

many attemps

In order to ensure that robots do not use accounts, it 

should be possible to lock account in case too many invalid 

attemps are made N/A X

U
1

2

R
Q

D
F

User 

registration Logout Logout after usage To manually quit active session

Would also happen in case of inactivity if no notion of 

keep alive is present 1 Y

0 R
Q

D
F

Service 

Management Register service 

Add new data source 

(provide data) to an 

account or update 

existing information Define basic information

Mnemo code, Name, associate keywords, validity 

period

policy (public vs restricted, free vs fee)

In case of restriction, provide restriction criteria 1 Y

U
1

4

R
Q

D
F

Service 

Management Configure service 

Register data and 

services

Registers the different types of data that will be made 

available and the corresponding services.

Data mapping for the query language  between 

internal language and HS ontology can be uploaded

Mapping is performed outside the platform 3 Y

U
1

5

R
Q

D
F

Service 

Management Configure service 

Manage access 

information Define URLs, directories, user registration details

There can be information provided by default 

and the capacity to specialise per entity (if required in 

case of specific data being published) 3

U
1

6

R
Q

D
F

Service 

Management Configure service 

Manage registration 

of  actors

list actors matching criteria or using the service, include or 

exclude actors having requested the service

subscribers can request the service and the provider 

may want to manually accept or refuse it 4 Y

Extended for RL4 to have 

separate view for users .

U
1

7

R
Q

D
F

Service 

Management Analyse service

Search actors by 

usage

Search who is using the service, when how often for what 

… 6

U
1

8

R
Q

D
F

Service 

Management Analyse service

Analyse errors on 

service

displays number of errors upon mapping, on searches, 

reasons, frequency 6

U
1

9

R
Q

D
F

Service 

Management Notification

Manage notification 

reasons

Define the different errors that requires notification to a 

certain user

Several users could be notified. Could also be 

managed through the notion of importance associated 

to errors and users registering to certain importance 

levels. 3

U
2

0

R
Q

D
F Notification Notify User

Notify user in case of 

errors linked to a 

service

When an error for which user is registered, notification 

should occur 3

U
2

1

R
Q

D
F

Service 

subscription Search service

Search services 

according to different 

criteria Keywords, name, provider, content specific data, state

It can be used either for a new subscription (new 

providers, new requests from providers), or to 

manage existing subscriptions 5+ X

Only browsing the 

registry to see available 

data providers and  

external services 

U
2

2

R
Q

D
F

Service 

subscription

Subscribe to 

service

Manage subscriptions 

of services

Deactive certain services, accept or deny requests from 

providers, access to service details 

Certain services may not be free. Consumption should 

therefore be accessible as well, invoices … even if at a 

later stage 4 Y

Unsubscribe in RL4. 

Consumption, invoicing, 

licencing … is not 

present. (should be done 

offline)

Validity conditions 

should be added
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Comment (Release)

U
2

3

R
Q

D
F

Service 

subscription Configure service 

download data and 

service structures

Data and services need to be possibly mapped by 

subscriber. 3

U
2

5

R
Q

D
F Query Quick  search

Search by name or 

code, optional 

restriction with a date 

range 

Items searched often should be accessible directly by name 

or a key or code

Like using an exhibition code, a museum code or 

name, 

A date range can restrict results in relation with item 6

Q
B

S1

R
Q

D
F Query Basic search

Search using unique 

criteria or a 

combination or them

Geo data

*Zone, country, region, county, city, district,  point of 

interest: with codes (from list) or name (partial allowed), 

proximity notions

* geodesic coordinates :unique, with range, with circle Search criteria split by family for easier grouping 6 X

Q
B

S2

R
Q

D
F Query Basic search

Search using unique 

criteria or a 

combination or them

Property data

* Property name (possibly partial)

*Code

*Ranking (official, local, provided by travelers)

*Presence of infrastructure (swimming pool, golf )

*List of activities, exhibitions, events

*Presence of certain features (restaurant, spa ...) Search criteria split by family for easier grouping 6 X

Q
B

S3

R
Q

D
F Query Basic search

Search using unique 

criteria or a 

combination or them

Accommodation data

*Accommodation type, Accommodation code, 

Accommodation category, Accommodation view

*quantity of Accommodation

*Accommodation occupancy

*Begin date, end date (or duration) + possibly notion of 

flexibility on dates

*Accommodation features (Free wifi, Chimney, bubble 

bath, fridge, size, communicating, ...) Search criteria split by family for easier grouping 6 X

Q
B

S4

R
Q

D
F Query Basic search

Search using unique 

criteria or a 

combination or them

Traveler data

Type of travelers with quantity and possibly age

Traveler allocation per accommodation, per activity … Search criteria split by family for easier grouping 6 X

Q
B

S5

R
Q

D
F Query Basic search

Search using unique 

criteria or a 

combination or them

Distribution data

*Brand

*Vendor

*Promotion indicator or even promotion code

*Distribution channel

*Distribution media (B2B, B2C, committee ...)

*Time or request (no field, but information used for 

pricing)

*When should the query be executed (once, periodic) Search criteria split by family for easier grouping 6 X
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Comment (Release)

Q
B

S6

R
Q

M
H

Query Search Query output

* Which hotels are bookable in a city

* Hotel master data

* Hotel offer prices

* User ratings for this hotel or area (depending on the 

booking channel) Duplicate N/A X

Q
B

S7

R
Q

D
F Query Search Filtering results

Capacity to filter using the same criteria as the search 

options 6

It will be implemented 

the query context 

preferences (see REQ 

224)

Q
B

S8

R
Q

D
F Query Search Sorting results

by price, by location, by alphabetical order, by mark (in 

case of ranking provided), by matching value (close or far 

from search criteria) 6

It will be implemented 

the query context 

preferences (see REQ 

224)

Q
B

S9

R
Q

D
F Query Search Sorting results Capacity to aggregate several sort criteria 6

It will be implemented 

the query context 

preferences (see REQ 

224)

Q
B

S1
0

R
Q

A
V Query Search Sorting results

Specify ORDER BY conditions on the result set. More then 

one (for example price  ascending, rating descending) 6

It will be implemented 

the query context 

preferences (see REQ 

224)

Q
B

S1
1

R
Q

D
F Query Search Browsing Browsing (per page, first, last...) 6

Q
B

S1
2

R
Q

D
F Query Search Formatting response

What field should be returned in responses according to 

requester 6 X

Q
B

S1
3

R
Q

A
V Query Search ?

Given one Harmonise collection, be able to get all the 

possible values of a given element, considering a subset of 

content providers (category issues).

it is required to expand the web service to searcfh the 

registry 6

Q
B

S1
4

R
Q

A
V Query Search Use Suggesto

Being able to use the Suggesto's query language (see file 

SuggestoQueryLanguage.doc). This language is domain 

independent, and allows to set conditions among elements 

of a specific collections. 3 Y

Q
B

S1
5

R
Q

M
H

Query Search Fred

Query Input to receive data about

    * Which hotels are bookable in a city

    * Hotel master data

    * Hotel offer prices

    * User ratings for this hotel or area (depending on the 

booking channel) 
N/A X Dropped
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Q
B

S1
6

R
Q

M
H

Query Search Fred

Basic Query

    * Extraction Date: When should the data be retrieved

    * Arrival Date: When is the customer going to check-in

    * Departure Date and/or Length of Stay (how many 

nights)

    * Source: Where should the data be retrieved - which 

booking channel?

    * Hotel Category: qualitative market definition

    * Room Type

    * Number of Travelers

    * Geographic Information: country - region / province - 

city

    * Radius: catchment area - how far a hotel can be away 

from city center 
Radius will not be implemented N/A X Dropped

Q
B

S1
7

R
Q

M
H

Query Search Fred

Advanced Query

Basic Request + a list of hotels to be queried. The intention 

is to target the query to specific businesses.

    *     Hotel Name

    *     Address: Street and Number

    *     ZIP

    *     City

    *     Country 2 Y

Q
B

S1
8

R
Q

M
H

Query Search

Collection and 

Combinaiton mapping

I think the main challenge comes from mapping conditions 

and combinations

Examples:

give me all events from type "exhibition" from 

category "modern art" taking place in berlin on or 

after july 1st and on or before july 10th.

give me all exhibitions within 20 km from berlin that 

are open on mornings (9-12 am)

give me all exhibitions in europe which are for free 

(which might have worked with query by example) 2 Y

Q
B

S1
9

R
Q

M
H

Query Search

Data merging from 

different sources

Another problem is how to solve joins from data out from 

different sources

Examples:

give me all 4* hotels with available single rooms 

within 1 km from a certain exhibition in berlin about 

modern art (available during that exhibition) and rank 

by price depending on date of stay (should mean the 

cheapest hotel nearby during that exhibition) 6
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Q
B

S2
0

R
Q

T
M Query Search Example?

It should be possible to address single elements from this 

query [give me all 4* hotels with available single rooms 

within 1 km from a certain exhibition in berlin about 

modern art (available during that exhibition) and rank by 

price depending on date of stay (should mean the 

cheapest hotel nearby during that exhibition)] , e.g.

- only the addresses of these hotels.

- maybe a list of each exhibition and the hotel, which is the 

nearest to the relevant museum

- we could also think about offering approximation to the 

optimal results: In case a query does not offer a result, we 

could offer the closest approximation, like: No 4* hotels 

could be identified, but there are cheap 5* hotels and 3* 

hotels with high standards...

I think this is an example of the items detailed earlier. 

Notion of Nearer will not be covered, but rest 

available in release 5 6

Q
B

S2
1

R
Q

T
M Query Search

List of topics not in 

the ontology

From the euromuse.net point of view, there is still the 

problem how to identify the topical categories used by 

euromuse.net and not included in the Harmonise ontology. 

Questions: How can they be identified and used (without 

changing the mapping) Duplicate N/A X

R
Q

M
H

Administrate 

mappings activate and de-activate several mappings 4 Y

R
Q

M
H

Access right Limit the possibility to access only specific type of data 6

R
Q

M
H

Access right Ability to define a timeout period for access to the system 6 X

R
Q

M
H

Access right Limit access by number per period 6 X

R
Q

M
H

Access right Improvement of access control management: n:m, groups of recipients, etc. 6

R
Q

M
H

Query

Administrate 

mappings

Transfer of files in the 

harmonise format

Bypass the reconciliation if the file is already in the 

harmonise format. 4 Y Duplicate

R
Q

M
H

Handling of data 

transfer process

Improve error 

management Give error messages a user can understand and react to 3

R
Q

M
H

Handling of data 

transfer process Configureable number of attempts to send data (make several trials when having submission problems) 6

Only manual re-sending 

of files if anything goes 

wrong upon notification

R
Q

M
H

Handling of data 

transfer process Simple processes to  update or delete data 6

R
Q

M
H

Handling of data 

transfer process Messaging: Feedback on mandatory fields, success or error, confirmation IDs, etc 3

R
Q

M
H

Sending of files transfer of Binaries files Duplicate N/A X
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R
Q

M
H

Sending of files Multimedia files in zip-package Duplicate N/A X

R
Q

M
H

Data input

Handling of data 

transfer process Uploads of data to push as excel and text files 4 Y

But Claudio may be able 

to implement it, at least 

for events

R
Q

M
H

Data push Push data to multiple recipients or groups 3

R
Q

M
H

Ontology/Reconci

liation 

enhancements

Handling of data 

elements which need 

to be tranferred but 

are not covered by 

ontology

Data coming in target-format - bypass reconciliation to 

avoid loss by harmonise "filter": is transmission specific; 

add flag to upload interface and to webservice 

Dynamic mapping: idea to send data un-mapped, that is 

not covered by ontology or covered to serve another need. 

was already discussed as an option at the beginning of 

harmonise. those data could be passed through harmonise 

without mapping and added to the ontology later when 

the next update is coming. reconciliation engine should 

know that those data has to be transmitted and not delete 

it. 5+ X

But Claudio will code the 

bypassing of 

transformation

R
Q

M
H

Ontology/Reconci

liation 

enhancements Extension for inheritance relationships 6 X

R
Q

M
H

Ontology/Reconci

liation 

enhancements

Administration of 

reference lists and the 

mappings for value 

domain

** Ensure that mapping of reference lists of an 

organization can be managed in the mapping tool and used 

in the reconciliation engine (at least a procedure for expert 

users if it cannot be integrated) 5 Y

R
Q

M
H

Handling of data 

transfer process

Simple object 

identification To identify duplicates in data sets 6 X

R
Q

M
H

Content 

modification Make corrections of content (spell checking, special characters) 6 X

R
Q

M
H

Content 

modification Make content-checks (e.g. for mandatory fields) 6 X

R
Q

M
H

Content 

modification Change metrics or currencies

MH is not happy with the decision and will repeatedly 

push to bring it back into scope… 6 X

R
Q

M
H

General Collect usage statistics 6

R
Q

M
H

General Make logging of transfer, results and errors 1 Y

R
Q

M
H

Metasearch Sorting of query results and exchanged data 6

R
Q

M
H

Metasearch More search options (date on, before, after, / exhibition venue / combinations of fields / etc.) 1 Y

R
Q

M
H

Metasearch

Make better search 

for receiver because 

could be hundreds grouping, aut complete … 5+ Not key for the R5
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R
Q

M
H

Small 

improvements to 

the Web-GUI

ACL GUI to be 

checked (bugs in the 

visualisation bith of 

the administrator and 

of the other users)

Operation label + dropdown in same line with: “Allow push 

data to my system from”, “Allow query on my system by” + 

2nd dropdown on same line with sender id 

List acl service items table: change “Receiver id” label t 

“My system id:”

Put “Restriction” heading before dates & number of access 

The same for Modify acl service item (+ label to be 

changed) 1 Y

R
Q

M
H

Small 

improvements to 

the Web-GUI Modify mask: show webservice configuration fields only when “http service” is selected in directory service 4 Y

R
Q

M
H

Small 

improvements to 

the Web-GUI Make “Delete all” a button on top in logging 1 Y

R
Q

M
H

Small 

improvements to 

the Web-GUI Make “Delete all” a button on top of all boxes 3

R
Q

M
H

Small 

improvements to 

the Web-GUI

add new error 

messages:

“Data transformation failed. See log file for details” 

“No rights for this operation. See log file for details” 

“Data sending failed. See log file for details” 3

R
Q

M
H

Small 

improvements to 

the Web-GUI Load mappings as first page  of administration N/A X

Dropped because admin 

layout changed

R
Q

M
H

Data provision 

Allow new ways to 

access or submit data

Microformat 

HTML wrapper 

Semantic Cluster Names 

RSS import (&export?)and mapping first prototype 1 Y

R
Q

M
H

Query Search Get similar results, not exact results only (fuzzy search) 6 X

R
Q

M
H

Query Search

Access control for 

web-query GUI

only the users of a certain server connect to perform the 

web query (provided by Iframe. We need also to be able to 

provide access rights per web query

This can be performed using tokens (not vey simple) 

or server authentication N/A

Metasearch will be 

"free", i.e. it will not 

require authentication

R
Q

M
H

Mapping 

editor Mappings Mapping tool shall allow to import data schema from excel

This should be solved by providing an Excel template 

with a macro that will generate a schema. N/A X

R
Q

M
H

Mapping 

editor Mappings

Mapping tool shall 

support user in 

making of mappings 

by making suggestions

e.g. data fields from user's schema similar to a field from 

ontology are selected as candidates for mapping rules Will progress in subsequent releases 4 Y
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R
Q

M
H

Mapping 

editor Mappings

Mapping tool can be 

used without any 

technical 

understanding of 

making of mappings

but knowledge on concepts and some level of IQ must be 

given 1 Y

M
1

R
Q

T
S

Mapping 

editor Mapping

Dialogue driven 

mapping (editor)

user will be asked human-like questions, to define the 

mapping

Improve according to the comments made by the 

users 5 Y

xxxdf: add line to 

improve wording and 

dialogue for templates 

likes dates or language

M
2

R
Q

T
S

Mapping 

editor Mapping 

Easy implementation 

of mapping updates

The user should be able to update minor changes within 

the mapping according to the error log 3 Y

M
3

R
Q

T
S Ontology Update ontology Additional elements

Possibility of including elements to be mapped, which are 

not part of the Harmonise Ontology

Users want their data to be processed and not to be 

bound to a limited domain N/A D Duplicate of line 63

U
2

6

R
Q

T
S

Service 

Management Individual settings

Definition of 

individual settings

User defines settings how to receive the data (like UTF-8-

encoded, formated as text (instead of file), etc.

Wenn die Zeichenkombination & + q + u + o + t + ; 

(&quot; --> ") auftaucht, dann ersetze durch das UTF-8-

Zeichen " | Wenn die Zeichenkombination & + A+ u+ 

m+ l + ;  (&Auml; --> Ä), dann ersetze durch das UTF-8-

Zeichen Ä 

6 X

U
2

7

R
Q

T
S

Service 

Management Notification Abbrevation notifier

User will be informed by the system in case of 

abbrevations between the expected content and the 

content received

e.g. user expects a text of a maximum length of 400 

chars, user expects a specific field to contain content. 6 X

R
Q

T
S

Mapping 

editor Mapping

Automatic 

identification of 

standardardised 

elements like dates

the mapping editor can identify elements like dates, times 

and other repeated elements in a provided source (e.g. ids 

of special entities)

This is ongoing work so something will be possible in 

release 2 (split) 2 Y

R
Q

T
S

Mapping 

editor Mapping

Automatic 

identification of field 

contents

the mapping editor should be able to identify, whether a 

field's content refers to a file or not, whether a file 

contains text or images or both xxxAlbert: I do not understand. Please explain N/A X

R
Q

T
S

Service 

Management

Categories used by a 

certain user to 

structure content 

should not be 

dependent on a 

mapping, but growing 

with the users' offer

e.g.: euromuse.net uses a list of fixed topical categories to 

structure its content. This are categories like "modern art" 

(which are also part of the Harmonise Ontology), but also 

"European culture after 1800" which are not originally 

foreseen in the ontology. These categories are extended 

from time to time, due to new museums dealing with 

special topics not considered before. The list of categories 

should not be bound to a mapping and be offered to the 

users' of the data.

reference lists etc.

5+

Linked to REQ 63. 

Claudio and Marlis need 

to discuss. This might not 

be required at the 

beginning  if we do not 

have too many requests. 

In time it could become a 

big headacke
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R
Q

T
S Output File transfer

Files can be sent with 

the data

images and other multi media content is often part of the 

needs of data users. Harmonise must be able to transfer 

more than a link to a file, but the content itself 5+ Not key for the R5

R
Q

T
S

External 

service

Booking of extra 

services

extra services can be 

selected on the level 

of a single data 

transfer

Data modification services should be selectable on the 

level of single imports/exports. 6 X

R
Q

T
S Notification

Status 

notifications

user gets notified on 

updated content

when a data provider offers an updated (new records, 

changed records) the data user gets notified about a 

change and about the kind of change

checksum analysis. To be discussed with  Christoph 

who handle user profile interests data 6 X

R
Q

A
V

Metasearch 

Scenario Get metadata

access metadata 

information like 

categories,types of 

available contents…

Consumers or data owners shall be able to download 

dictionnary references in order to use reference data 

directly in their system. That would diminish the need to 

transcode and provide a vocabulary that is easy to use and 

understand (and it is hopefully documented). In addition 

metadata should be available programmatically (API) 5+ Linked to REQ 63

R
Q

A
V

Mapping 

process Data sending

analysis and check 

correctness of 

content

The uploaded data file should be analysed and checked for 

errors. It should be possible to analyse the internal 

structure of the document and to skip only single 

containers with invalid / corrupt content in the import, 

while the rest of the import stays successful (currently the 

entire upload fails with one corrupt sign in an uploaded 

file). External module BUT VERY IMPORTANT 6 X

R
Q

A
V

Semantic 

Registry

Explore the 

network

Find other partners in 

the network

A user should be able to identify who else has joined the 

network to be able to find potential partners for data 

exchange. 6

R
Q

A
V

Mapping 

process Mapping Mapping help service

A hotline should be available for questions (at least User 

FAQs or other support plattforms). 6 X

R
Q

A
V Administration Access control

Clear and individual 

access rules

It should be possible to define access rules on a individual 

basis.

Possible on the service level, but not on a data level. 

Release 5 will incorporate data 3
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M
S-

1

U
C

Metasearch 

Scenario

Harmonise 

Registration and 

Setup

The booking

providers and the

tourism portal

register on

Harmonise and

set up the data

flow.

The booking provider and the tourism portal register on 

the Harmonise platform, creating an account each and set 

it up (i.e. uploading the mappings for data translation and 

query translation). Furthermore, the booking providers 

also specify what kind of data they can supply (i.e. what 

kind of search queries they can answer).

After setting up the account, all partners with whom a data 

flow can be established are configured on the Harmonise 

platform. This means that for the portal the partners to 

whom a query is sent are specified and for the data 

providers those partners which are allowed to query are 

configured. 1 2 Y

Not booking engine but 

data providers

Providers: to be specified

Users: to be specified

Extend to be defined but 

whole use case expected

M
S-

2

U
C

Metasearch 

Scenario

Bookable Items 

Search

The goal is to 

allow a tourism 

portal to offer its 

users the ability 

to search for 

bookable data 

items offered by 

specific booking 

providers.

A user on the tourism portal enters specific search criteria. 

These include the type of bookable item to be found and 

specific criteria for the kind of item. For example in case of 

accommodation search this can include the number of 

persons and rooms, stay date and duration as well as 

specific criteria like number of stars or specific amenities 

(e.g. air conditioning).

From the tourism portal’s side this results in a search query 

for bookable data in the “query language” (i.e. the terms) 

of the tourism portal.

This query is sent to the Harmonise system and distributed 

to the configured booking providers with whom a contract 

(between the tourism portal and the accommodation 

provider) is established. Harmonise translates the query 

from the tourism portal’s terms to the terms of the 

booking providers.

Booking providers take the query and deliver the 

corresponding results (available bookable items, booking 

price and “deep link” for booking at the provider’s site) 

back to Harmonise. Harmonise translates the search 

results into the terms of the tourism portal and delivers 

the results to the portal in an asynchronous way.

The tourism portal displays the results to its users, where 

duplicates are handled on the portal. Therefore, each 

bookable item must have a unique ID for each booking 

provider.

1 2 Y

Actual search should be 

integrated in platform for 

at least 2 sources

Providers: to be specified

Users: to be specified

Extend to be defined but 

whole use case expected
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M
S-

2
a

U
C

Metasearch 

Scenario Modify Results

This use case extends the use case MS-2, 

where a search on Harmonise has been 

conducted by a tourism portal. Harmonise 

offers a possibility to paginate and sort the 

search results for the portal. 6 P

Partially, without 

pagination 

Since sorting is not 

implemetned

M
S-

2
b

U
C

Metasearch 

Scenario

Ranking items 

based on the user 

profile

As extension of the MS-2 use case, the tourist 

portal wants to show to the user items ranked 

in a personalised way exploiting a 

recommender system which could be provided 

by a service provider. Items retrieved from a 

query are then ranked exploiting a given 

recommendation algorithm provided by the 

Recommender System 6 X

M
S-

3

U
C

Metasearch 

Scenario

Items 

recommendation

s

The user of a Tourism Portal desires to get

recommendations about items related to a

specific topic of interest. The portal provides

contextual information (for example geo-

coordinates or specific theme of interest),

some constraints and receives backs items

best fitting the provided information. The user

could be interacting also through a mobile

device, thus on a mobile portal or with a

mobile application. 6 Could be moved away

IM
P

O
R

T
-1

U
C

Import 

Scenario

Harmonise 

Registration and 

Setup

The data

providers and the

tourism portal

register on

Harmonise and

setup the data

flow. This use

case is very

similar to the use

case MS-1,

though it does

differ in details.

The data providers and the tourism portal register on the 

Harmonise platform, creating an account each and setting 

it up (i.e. uploading the mappings for data translation and 

query translation). Furthermore, the data providers also 

specify what kind of data they can supply (i.e. what kind of 

search queries they can answer).

After setting up the account, all partners with whom a data 

flow can be established are configured on the Harmonise 

platform. In this specific case the setup incorporates the 

information about what data is to be retrieved (e.g. static 

accommodation data) and what the requirements are for 

the transfer (i.e. does not need to be delivered quickly). 3 Y
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IM
P

O
R

T
-2

U
C

Import 

Scenario

Batch transfer of 

static data

The goal of the use 

case is to transfer 

static information 

(e.g. in case of 

accommodation: 

accommodation 

name, description, 

location, pictures, 

amenities, etc.) from 

the data providers to 

the portal in regular 

intervals. 

The tourism portal sends a specific query to Harmonise in 

regular intervals asking for batch transfer of static data of a 

predefined kind. The time at which this batch import is 

triggered depends on the load of the tourism portal’s 

servers. The query can encompass specific constraints (e.g. 

“accommodations from Finland”). In addition the query 

can contain a time when the last update was done, 

therefore indicating that only changes since this time are 

of relevance (a so-called delta update). Each data item 

must have an ID which is unique within the scope of the 

data provider.

Harmonise translates the query to the local data format of 

the data providers and delivers it to the configured 

partners. The partners respond to the query with sending 

the corresponding data, taking the possibility of a delta 

update into account if possible. The responses are sent 

back to the tourism portal through Harmonise. Finally the 

tourism portal imports the data into its CMS and triggers 

further processing (e.g. local duplicate detection). 3 Y

P
S-

1

U
C

Publishing and 

Subscription 

Scenario

Data Hosting Use 

Case

This is to allow data 

providers to easily 

upload once or on a 

regular basis their 

data in the Harmonise 

portal.

A data provider wants to upload his data in the Harmonise 

network. Data may be uploaded once manually or 

regularly scheduled. A data provider wants to program 

regular batch uploads (for static data, for price and 

availability data, for booking synchronization …) or allow 

retrieval via web services, at certain times, on events... 

Each batch may contain one or several files. There may be 

several batches of different frequencies. User wants to be 

able to define batches, events. 1 3 Y

P
S-

1
a

U
C

Publishing and 

Subscription 

Scenario

Use of Cross 

Standard 

Interoperability

This use case extends the use case PS-1, where a data 

provider wants to upload his data in the Harmonise portal. 

When a data provider sends meta-data or categories (e.g. 

location), this data is often stored in different categories 

on the recipients side. The Harmonise service centre shall 

allow storing mappings between reference lists which 

other mappings, used by customers, can refer to. This shall 

allow e.g. to translate from region names or geo-codes to 

postal codes by referring to these reference lists - thus a 

user can have a region translated to a geo-code. 1 4 Y

We start with one pivot. 

Rest can be addressed as 

external service not in 

this project
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P
S-

1
b

U
C

Publishing and 

Subscription 

Scenario

Sending 

Multimedia 

Content

This use case extends the use case PS-1, where a data 

provider wants to upload his data in the Harmonise portal. 

When a data provider sends some data, he may want to 

add multimedia files to the content transferred (included 

as zipped package or encoded, not linked). 6

Partially, without 

multimedia files

P
S-

2

U
C

Publishing and 

Subscription 

Scenario

Data Publishing 

Use Case

This is to allow data 

providers to easily 

publish once or on a 

regular basis their 

data in the Harmonise 

network.

A data provider wants to publish data in the Harmonise 

network. This use case is similar to the Data Hosting (PS-1), 

but in this case what is uploaded and stored in the 

Harmonise portal are not the real data but some meta-

data which are useful to describe what kind of data the 

data provider has to offer. 2 Y

P
S-

3

U
C

Publishing and 

Subscription 

Scenario

Data Enrichment 

Use Case

To allow data 

providers to 

transform their data 

according to services 

they would have 

subscribed and to 

associate profiles to 

the data so as to allow 

alert to be generated 

by the portal to non 

subscribers

Data provider must be able to update data and to manually 

or automatically associate additional information to its 

data to create data profiles to be used to facilitate 

subscription, to link data together (for cross selling or up 

selling features, to create logical links...). Automatic 

enrichment can be performed via information already 

present in the data itself (like product name, location 

information, categories and codes…). 6 X External service

P
S-

4

U
C

Publishing and 

Subscription 

Scenario

Consumer 

Association Use 

Case

To allow data 

providers to define 

the consumers that 

will be allowed to 

download their data

Data provider wants to be able to define to whom its data 

will be distributed, either per batch or per data unit. 

Association may be performed by direct association of 

data consumers with data (with or without negotiation) or 

through data information or data profile mapping (like 

product name, location information, categories and 

codes…).

This corresponds to the user group requirement and 

access control list 6 P

It will stay as it is also in 

R5
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P
S-

5

U
C

Publishing and 

Subscription 

Scenario

Data Download 

Use Case

This is to allow 

consumers to 

download data 

pushed by data 

providers once or 

regularly.

A data consumer wants to schedule and define download 

content and methodology (batch, web service, at fixed 

time, on events…), selecting the content to import, 

possibly grouping data from different providers, using 

differential input or even possibly using web services 

instead of files. A consumer batch may correspond to one 

owner batch or aggregates several. Consumer shall be able 

to define data filters to limit the amount of data to be 

received from the different data sources he has subscribed 

to. Schedules are different from owner batch. In some 

cases, alert of data present can be sent to consumer. Alert 

on data changes could also be sent to data consumers for 

them to be able to refresh their data between batches. 6 P

Only the first part is 

implemented, it will stay 

as it is also in R5

P
S-

6

U
C

Publishing and 

Subscription 

Scenario

Data Subscription 

Use Case

This is to allow 

consumers to easily 

subscribe to row or 

enhanced data from 

different providers.

Data consumers need to be able to subscribe or 

unsubscribe to data. They can find relevant data because 

they are invited by data providers, because of alerts they 

receive or because of manual searches. Once data have 

been selected, subscription may occur directly or after 

negotiation has taken place. Data consumers need also 

alerts when subscribed data is updated or when new data 

corresponding to their profiles is published. 6

P
S-

7

U
C

Publishing and 

Subscription 

Scenario

Alert Definition 

Use Case

To allow consumers 

to define alerts and 

triggers in order to be 

notified if relevant 

events occur or if new 

services or data are 

available which may 

be of interest for him 

according to his 

profile.

Service Consumers should be able to define alerts using a 

set of keywords or data profiles so as to receive 

notifications in case those keywords or data are available. 

This may lead to a negotiation or a subscription. Moreover 

consumers can store search results or queries with trigger 

information. In case certain information in the result set 

change or in case new result batch queries, a notification 

may be sent to the user (by mail, SMS …). 6

P
S-

8

U
C

Publishing and 

Subscription 

Scenario

Portal Service 

Subscription Use 

Case

This is to allow users 

to easily subscribe to 

portal services.

All types of users must be able to subscribe or unsubscribe 

to the services provided by the portal for part or all of their 

data. Example of services will be booking, items 

recommendation, data hosting, data modification, 

statistical and market analyses, etc. Some services may be 

free of charge and others may require payments.

What will be implemented is additional description 

field for conditions + URL for external page to be 

provided by service provider. NO payment service will 

be implemented 5 Y

See if we add the 

payment part
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P
S-

9

U
C

Publishing and 

Subscription 

Scenario

Negotiation Use 

Case

This is to allow 

negotiating services 

and data subscription 

through the portal in 

order to facilitate 

subscriptions to new 

services/data or to 

new consumers.

Service and data consumers shall be able to search for 

specific services or data outside the ones they have 

subscribed to. If they are interested in certain 

services/data, they shall be able to initiate negotiation with 

the service or data provider in order to gain access to 

them. This may end up by being able to use the 

service/data after validation by the service/data provider 

or after a contract and financial agreement has been 

settled. 6 X

P
S-

1
0

U
C

Publishing and 

Subscription 

Scenario

Payment Use 

Case

This is to allow 

providing a way to 

charge and receive 

payment for the 

subscribed services.

The platform must be able to charge, invoice and take 

payment for platform services as well as for the 

reconciliation mechanism between service consumers and 

providers for the data requiring payment to be used. 6 X

P
S-

1
1

U
C

Publishing and 

Subscription 

Scenario

Profile 

Management Use 

Case

This is to allow 

providing and 

managing user 

profiles to store 

preferences, filters, 

access to subscribed 

services and data.

All types of users must be able to have and maintain a user 

profile containing identity information as well as data 

profiles, filters, subscriptions, invoice… 4 P

 Should be extended in 

every release

D
M

-1

U
C

Data 

Modification 

Scenario Provider Mapping

This is to allow data 

providers to define 

query and data 

mappings and to 

register these 

mappings.

Each Data provider expects requests to his services in a 

format suitable to his needs. A request either arrives at 

Harmonise system in the format of the data consumer or is 

already stored there as a request formulated in an 

intermediate standardised format (see WP4 Query 

Mapping). In the former case a transformation of the 

request is required using the Harmonise ontology and a 

transformation function (such as an XSLT artifact). In 

addition, responses are in the proprietary data format of 

the data provider and have to be transformed to the 

commonly agreed intermediate format. In order to do the 

transformation, the data provider has to offer appropriate 

transformation functions. 3 Y
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D
M

-2

U
C

Data 

Modification 

Scenario

Consumer 

Mapping

This is to allow data 

consumers to define 

query and data 

mappings and to 

register these 

mappings.

Each Data consumer expects data to be in a format 

suitable to his needs. The data arrives at Harmonise system 

in the format of the data provider and is transformed there 

to the intermediate standardised format. In order to 

perform a second transformation from intermediate 

format to the proprietary format of the consumer, the 

consumer has to provide a suitable transformation 

function. 3 Y

D
M

-3

Data 

Modification 

Scenario Data Cleansing

This is to allow data 

consumers to apply 

additional 

filter/cleanse services 

on raw data.

Data collected from several data providers may contain 

unwanted or redundant elements for a particular data 

consumer (unwanted characters, duplicates…). Harmonise 

system may provide additional services that can filter or 

cleanse data. 4 Y

As external services. 

Services will not be 

provided by 

Harmosearch

D
M

-4

Data 

Modification 

Scenario Decision support

To allow data 

consumers to apply 

additional decision 

support services on 

data such as ranking 

or recommender 

systems.

In general, search is performed either to become aware of 

all relevant elements for further processing (as for instance 

in market research, see Use Case 3, Market Intelligence) or 

for decision making (see Use Case 1, Accommodation Meta 

Search). In the latter case, decision support such as ranking 

of result elements according to some relevance criteria 

may be provided as additional service. 4 Y

As external services. 

Services will not be 

provided by 

Harmosearch

D
M

-5

Data 

Modification 

Scenario Data Enrichment

To allow data 

consumers to apply 

additional data 

enrichment services 

on data.

Data consumer may want that raw data is augmented with 

additional input. For instance, accommodation search data 

may be enriched with data provided from additional 

services such as rating agencies or user ratings, weather 

forecast services, or additional images. Data enrichment 

may change the structure of the data, for instance, by 

adding additional XML-elements to a result item. 4 Y

As external services. 

Services will not be 

provided by 

Harmosearch

D
M

-6

Data 

Modification 

Scenario Data Translation

To allow data 

consumers to apply 

additional translation 

services on data.

While the former data modification Use cases in general do 

not change the contents of data elements (purging a result 

set from unwanted characters changes the content not 

substantially), translation typically involves a drastic 

change of content. Examples are translation of textual 

descriptions to a different natural language, or conversion 

of price information from a particular currency to another 

currency. Additional services may provide such 

functionality. 4 Y

As external services. 

Services will not be 

provided by 

Harmosearch
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M
I-

1

Market 

Intelligence 

Scenario

Submit Ad Hoc 

Request

A Service 

Consumer/Service 

Provider is able to 

submit an ad-hoc 

search query 

collecting filtered data 

about 

accommodations and 

events used for 

analytical processing 

of market information 

conducted by a 

Market Analyser.

A Harmonise Participant (Service Consumer respectively 

Service Provider) should be able to formulate and send an 

ad-hoc search query collecting data about 

accommodations and events. The final result set serves as 

a basis for statistical analysis which will be conducted by 

external Market Analysers. In order to narrow the search 

focus additional filter criteria such as region or period of 

time may be specified by the Harmonise Participant. The 

Harmonise system executes the search query and returns a 

corresponding data set, accordingly. Thereby, the data set 

is constrained to the following information: price, object 

details, customer comments and customer ratings. In the 

following the data set can be forwarded by the Harmonise 

Participant to a Market Analyser who is capable of using 

the data set as a basis for statistical and analytical 

purposes. Compared to a regular search request  the 

described ad-hoc request is not time-critical. It is most 

likely that the time-consuming execution of the data 

acquisition will be executed during time periods outside 

the office hours (e.g. night time or weekends). 4 Y

As external services. 

Services will not be 

provided by 

Harmosearch

M
I-

2

Market 

Intelligence 

Scenario

Execute Interval 

Request

A Service 

Consumer/Service 

Provider is able to 

create a new or 

modify an existing 

search interval 

submitting a specific 

search query to the 

Harmonise system. 

A Harmonise Participant (Service Consumer respectively 

Service Provider) should be able to (i) create a new or (ii) 

modify an existing interval. Creating a new interval allows 

the user to specify a certain time period wherein the 

system executes a specific search request. Thereby, 

Execute Interval Request inherits the behaviour of Submit 

Ad Hoc Request (see Figure 25: Interval request use case 

diagram). Thus, it is out of the scope here to go into more 

detail regarding the execution of the search request (see 

Figure 24: Ad-hoc use request use case diagram). Once 

created, the interval may be saved for the sake of reuse. 

Consequently, the Harmonise Participant is free to load or 

modify an existing interval. Regarding the former the 

Harmonise Participant may change the interval’s 

configuration – e.g. period of time, search query.   4 Y

As external services. 

Services will not be 

provided by 

Harmosearch
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M
I-

3

Market 

Intelligence 

Scenario Analyse Data

The Harmonise 

system enables a 

Harmonise Statistician 

to gather and analyse 

log data statistically. 

A Harmonise Statistician shall be able to perform statistical 

analysis among log data documenting how Harmonise 

Participants use the system. The statistical analyses are 

managed and configured via a status cockpit which is part 

of the Harmonise system. The status cockpit helps the 

Harmonise Statistician to interact with the system 

supporting the following major functionalities: (i) Enable 

the execution and visualization of statistical analysis and 

(ii) manage notifications. The former allows the Harmonise 

Statistician to conduct specific methods on the log data, 

which serves as a basis for retrieving ranked statistics on 

system usage as well as user group specific usage. The 

latter will be addressed in use case Manage Notifications 

and will not be further detailed. Regarding the former, the 

Harmonise Statistician may narrow the scope of the 

consumed data by defining certain search criteria (e.g. 

product, category, geography). In the following the status 

cockpit shall be able to render the final statistics in a 

human readable format, which could be either graphically 

(e.g. pie chart or bar chart) or in tabular form. 4 Y

As external services. 

Services will not be 

provided by 

Harmosearch

M
I-

4

Market 

Intelligence 

Scenario

Manage 

Notifications

The Harmonise 

Statistician/Harmonis

e Administrator 

should be able to 

monitor certain 

events and activities 

within the Harmonise 

system. 

A Harmonise Statistician or Harmonise Administrator shall 

be able to perform statistical analysis among log data 

documenting how customers use the system. The 

statistical analyses are managed and configured via a 

status cockpit which is part of the Harmonise system. The 

status cockpit helps the Harmonise Statistician to interact 

with the system. Its purpose is twofold: (i) to enable the 

execution of statistical analysis and (ii) to manage 

notifications. The former has already been described in use 

case Analyse Data. The latter triggers when the system 

should inform the Harmonise Statistician or the Harmonise 

Administrator about certain circumstances. The 

notification mechanism would allow a seamless monitoring 

specific to the needs of Harmonise. For example it is crucial 

to react as soon as possible in case of reoccurring 

transaction failures or services. 4 Y

As external services. 

Services will not be 

provided by 

Harmosearch
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M
I-

5

Market 

Intelligence 

Scenario

Log System 

Activity

The Harmonise 

system shall be able 

to log certain 

activities conducted 

by Harmonise 

Participants. The 

collected data serves 

thereby as a basis for 

system-specific 

analyses. 

The Harmonise system shall be able to recognise specific 

activities which are executed by a Harmonise Participant. A 

specific activity in the context of this use case is seen from 

a general point of view addressing all activities which may 

be of interest for statistical as well as system analysis – e.g. 

recognition of transactions between Data Providers and 

Data Consumers. However, the logging mechanism should 

not be restricted to user triggered activities. In addition it is 

also considered to log the system’s behaviour regarding 

critical events such exceptions or environmental related 

data (e.g. number of online Harmonise Participants, etc.). 

In addition, the log-data will also be used as input for other 

use cases (e.g. Analyse Data or Manage Notifications). 

Consequently, the logging mechanism has to be very 

flexible regarding the recognition of system activities as 

well as the extraction of meta-information for a particular 

activity. Thus, the Harmonise system has to be able (i) to 

evaluate the relevance of an occurring activity, (ii) to 

extract the activity’s meta-data and (iii) to write the log-

data to a log data source (e.g. database or log-file). 6 P

Already implemented the 

logging of activities 

performed by the 

participants. No time to 

implement a GUI to 

query the logs in R5.

R
Q

H
S HS Front End

Public 

information Provide information on HS + How to register to become a new member Start with release 4 and update in release 5 2 5 Y

R
Q

H
S

Service 

Management Register service 

Add ability to link data 

sources and mapping 

files

Multiple data source and each can have multiple 

mappings. Admin must be integrated in the harmosearch 

admin 4 Y

Need to specify which 

one is the default one

H
S

Service 

Management Register service Add external services Duplicate N/A X

R
Q

M
H

Administration General

Improve logging to 

include errors

Initial logging does not implement exception handling. This 

needs to be added 2 3

R
L1

R
L

H
S RELEASE

Definition of the 

release

Definition of the key 

components for the 

Harmosearch 

platform

Definition of the Harmosearch Query Language ontology

Semantic registry component (implementation of query 

language for the registry)

Metasearch core Engine implementation (login, user and 

accounts management, file upload and dowload)

Crawler prototype based on microformat semantic 

annotations 1 1 Y

Appendix A - Detailed Requirements List  - Page 20 on 32



ID T
y

p
e

A
u

th
o

r
Group Action Requirement Description Comment

P
ri

o
.

R
e

le
a

se

Im
p

le
-

m
e

n
te

d

Comment (Release)

R
L2

R
L

H
S RELEASE

Definition of the 

release

Integration of the 

different components 

in order to have a 

metasearch running 

and have a first 

release of the 

mapping tool

Providers: Euromuse (Events), Museollitto (Events), Biella 

(Events, Attraction), Facebook (Events, Attraction)

Consumers: Harmosearch, Labtrip, Euromuse, Teleatlas

Subdomains: Attraction, Events

Minimal search criteria: Subdomain (0..2), Location (City, 

Country)(0..1), Date (Range)(0..2), Category(0..*). If no 

response, remove criteria C<D<L<S.

Expected output: HTML result list no paging, Name, 

summary, date if present, location, media if present ... 

Whatever is present in response

Mapping Tool: first version to be demonstrated: Events 

only, KHM used for demo, Biella, Museollitto

Biella: XSD provided by Adriano

Museollitto: XSD provided by Claudio (already svn: 

\Code_Repository\server\data\mapping\SML)

Museollitto ==> No because not ready

Facebook ==> No because no answer

feedback from Laptrip:  until you get us an easier way 

to get location data, we will not use

Teleatlas: not interested in event information

Euromuse: no answer yet 2 Y

R
L3

R
L

H
S RELEASE

Definition of the 

release

Have a complete 

system ready for 

commercial launch

Subdomain: Events

Providers:Biella, Euromuse, Crawler, 

Consumers: Euromuse,  Adriamuse?

Content:

*  Integration of the mapping tool into the system: 

download install from portal/ Assisted mapping upload and 

mapping validation

* Enhance mapping tool to map the queries as well

* integration of user interface for registry 

* have complete functional metasearch interface and API 

(web service) 

on one domain: events

* Implement scheduling capacity including user interface 

to parameter the scheduler

* have reference list mapping methodology with one base 

reference list for mapping

* Define how to manage parameters on mapping 

(language, currency...)

* Integration of Crawler. Setup of semi automatic 

procedure to periodically update indexes according to the 

providers configured in the semantic registry. 

* Register a new provider from the portal (crawler and API)

* Scenario and prototype to register and setup a new 

organisation (providers and consumers)

* Scenario and prototype to Improve usability of portal Feb 2012 3 P
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R
L4

R
L

H
S RELEASE

Definition of the 

release

Apply the tools to 

enrich the system

Subdomain: Events, Accomodation

Providers:Biella, Euromuse, Ec3Networks, Afidium

* Consumers: Harmosearch Facebook, Twitter, Foursquare 

(move to release 5, Google Plus (not because proved 

impossible) only for events from Biella and Euromuse

* Extend HS portal to query and display results for hotels 

(display  category according to domain)

* push the information to social networks

Have a complete commercial portal with 1 operational 

subdomain (event, )+ user friendly mapping tool 

* Add plugging capacity for external services (impact on 

user rights, interface and payment and implement the 

process with validation of subscription and validation of 

licences). Filtering external services will be added)

* Improve graphical interface of portal

* Improve labels as well and add helpers

* Allow multiple mappings (event mapping, hotel mapping)

Mapping Tool:mapping of reference list and editor 

improvements

* Simplification to data import by using an excel template 

for events and one for hotel. Allow import of ics calendars.  

Upload the file.

* Provide simple minimal input format for events and 

hotels for data publication. June 2012 4
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R
L5

R
L

H
S RELEASE

Definition of the 

release

Fine tuning the 

system

Also see content of word file

Subdomain: Events

Providers: Euromuse, Web provider (using the online 

form), Biella, Crawler using microformats or ics, Museum 

Portal Berlin

Consumers: 

* Scenario 1: publish: Facebook (HS and personna) for 

events and status update, Twitter (HS and personal) , for 

events from Biella and Euromuse and web provider

* Scenario 2: metasearch: B2C user on the event site 

* Scenario 3: import qualified content: Dummy consumer 

and later partners such as Pixmeaway, ETC

Portal: finalise the basic requirements (like user 

management) and Expand the event scenario: input from 

at least 2 sources, have capacity to qualify and enrich, 

publish in 2 or three distribution channels. Have a  cache to 

distribution ready and minimal scoring notions in place. 

* Complete Harmosearch Platform including the features 

and latest graphical layout

** data enhancement (addition of keywords, qualification, 

rating)

** Scoring could be counting the number of times data is 

retrieved. Notions must be defined

** Improve registry management interface to easily store 

and browse data

** Have interface per user role

** Integration of Crawler. Setup of semi automatic 

procedure to periodically update indexes according to the 

providers configured in the semantic registry. 

** Expand Crawler for easy configuration

** Allow sorting and filtering capacity to  the meta search 

before providing the result (only on cached data)

** Process to build unique identifier reference

* Additional Community site HarmoEvent (from input, 

import to distribution and search) in complement to Feb 2013 5 Y

R
Q

H
S

Metasearch 

Scenario Search page

Extend user interface 

to specify the search 

criterias and encode 

the user query into 

the HTO query 

language Try to create the user interface that is flexible However must meet minimal requirements on time 2 Y
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R
Q

H
S

Metasearch 

Scenario Search page

Allow a HTO query to 

be pasted in a form 

with a unique 

textarea

Also allow direct use of a query string in a web service 

interface 2 Y

R
Q

H
S

Metasearch 

Scenario Query processor Transform the query for each provider 2 Y

R
Q

H
S

Metasearch 

Scenario

Integrate the 

metasearch 

service Integrate the search engine (standard connector). Each output is HTO 2 Y

R
Q

H
S

Metasearch 

Scenario

Accept different 

output format Allow raw or specific output format to be specific 6 X

R
Q

H
S

Metasearch 

Scenario

Integrate 

Reconcilation Transforms from one format to the other (either request or response) based on specific mapping 2 Y

R
Q

H
S

Metasearch 

Scenario

Transform HTO 

into output HTML

to display the result 

list to present results nicely Can be removed if no time 29 2 Y

R
C

R
1

R
Q

H
S Crawler

Populate SOLR 

database

Select a limited 

number of relevant 

Google queries or 

URLs to crawl from 

facebook

This is in order to populate the demo database. Limitation 

to microformats for events (hcalendar) §DO: complement the requirement for later stage N/A X

because facebook does 

not accept. Will try 

Facebook API

R
C

R
2

R
Q

H
S Crawler

Integrate in 

metasearch

SO as to get results in 

the result list Description will come later after session with Claudio

Configuration, launch, indexing does not have to be 

within the user interface at this stage 1 2 Y

R
C

R
3

R
Q

H
S Crawler

 define an initial 

business scenario 

for the crawler, 

define providers 

or lists of urls

Define the target 

content to be 

expected and get the 

corresponding 

providers §DO+DF describe expectation N/A X

R
C

R
4

R
Q

H
S Crawler

Read different 

annotation 

formats

Enhance version so as 

to allow easy 

definition of 

additional annotation 

formats without 

creating new 

connectors At least microdata 5 Y ICS calendar?

R
C

R
5

R
Q

H
S Crawler

List of 

recommended 

annotation define sublist of microformat codes + example on how to use it, relevant for use in HS 3

R
Q

H
S

Metasearch 

Scenario Enable metasearch to be invoked through a web service 3 Y
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R
Q Crawler

Populate SOLR 

database differentiate real and wrong events and how to process big amounts of data 3

R
Q Crawler Use google as a starting point to crawl 6 X

R
Q Upload Select receivers Multiple receivers

Extend feature to allow multiple receivers to be selected 

before upload is invoked At present only one receiver is present 3

R
Q

Semantic 

Registry

Integrate in 

metasearch

Technical interface to integrate

Integrate missing information in the response (and config) 

(mapping id, connector id) §Todo: complement if required

Implement access control 2 Y

R
Q

Semantic 

Registry

User interface to 

configure the 

registry

Editing and entering data (subdomain, data description, 

provider properties) 3

R
Q

Semantic 

Registry

Use mapping as 

an aid to 

configure registry This is linked to the learning out of mapping or queries 6

R
Q

Semantic 

Registry Service registry Duplicate with next one N/A X

R
Q

Semantic 

Registry

Add features for 

the subscription 

scenario Subscribe to external services 4 Y

R
C

R
8

R
Q Crawler

Populate SOLR 

database

Create field 

containing keyword 

limited to the events

This will allow to retrieve only events targetting the search 

instad of searching the whoile page content inrelation with Test case CR4 2 Y

R
C

R
9

R
Q Crawler

Populate SOLR 

database Refresh database to update obsolete content in relation with test case CR5 3 Y But not automatic

R
Q Crawler Configure service 

Configure in the 

semantic registry 

which content to use 

from the crawler

We need to address the fact that a crawler can have 

different content and the content should be addressed in 

the semantic registry and not the crawler itself

can be solved by 1 crawler = 1 content but might be 

complex to implement 3

R
Q

Portal - 

Homepage

User is not logged 

in

User cannot see 

menus nor access 

services, except to 

create a new account 

or login

When user is not signed in he should see the welcome 

page only and have the capacity to sign in: no functionnal 

menu should appear

At present, menus are visible with error message if 

accessed, except metasearch, always accessible (in 

relation with tests case CM1) 3 Y

R
Q

Portal - 

Homepage Create new user

Self registration of 

user

User can create an account using minimal information in 

order to begin using the portal, at least in a minimal way 

until validation 

Must probably define the process or remove this 

feature. (in relation with CM19) 3 Y
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R
Q

Portal - 

Admin.Access

COntrol

Configure access 

to all Accept all as a way to configure users 3

R
Q Query Output format

Have the capacity to 

express that a 

response should/may 

containn certain fields preference for some fields, template for output formats 6 X

R
Q Query

Notion of 

flexibility Provide more precise infomration in order to order removal of non mandatory criteria 6 X

R
Q Query Precision

Allow expressing 

notion of how to use 

the input criteria

Either use exactly the information, or there is some leeway 

(like +/- 2 DAYS

Try to Integrate notions like narrower, broader, 

exact… 6

R
Q Query

Crossdomain 

queries Allow query over several domains in the same query 6

R
Q Query Location searches

Locaiton with a 

generic code (IATA, 

ONU ISO … could be 

searched using the 

codes Cities because already OK for countries

This will be possible only for the items within the 

reference lists. Analysis will be perforemd for release 

4 6

R
Q Query

Combine And and 

Or recursively

Allow queries that 

combine and and ors 

on several levels RQ corresponds to test case 5.4 3

R
Q Query

Search with geo 

point

Allo wsearching with 

point + Radius RQ corresponds to ttest case 6 This is not a priority 6 X

R
Q

Portal - 

Homepage Menu bars

Correctly handle 

redirections and 

layout and content of 

menu bars RQ corresponds to CM 18 3

R
Q Portal - Signon first time user handle capacity for first time user to decline agreement then logout out automatically 3 P

R
Q Portal - Admin

Imporve 

ergonomy and 

coherence of 

forms RQ corresponds to CM22 and CM25, CM 24 3 Y

R
Q

M
H

Mapping 

editor Mapping trial run

Make trial run with 

new mappings

After making a mapping, the user shall be able to run a 

mapping with a sample file to test the mapping 2 Y

But need to have the 

capacity to see the result 

in HTO
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R
Q

M
H

Mapping 

editor Mapping

The mapping tool 

shall integrate 

knowledge on making 

of mappings

It shall provide a guide to the process, best practises for 

mappings, etc.

This is ongoing work so something will be possible in 

release 2 (split) 2 Y

Partly. This is ongoing 

work

R
Q

H
S

Mapping 

editor Mapping

Add ability to easily 

add parameters to a 

link without having to 

write complex path

like adding currency to a price, language to a text, country 

code to a text… using an information within the file to map

Possibly there is a need to have intermediate mapping 

if codes are not standards 6 P

Parameters can be set, 

but not using infomration 

within  the file

Not OK in release 4. 

Moved to release 5

R
Q

H
S

Mapping 

editor Mapping

Support the user in 

finding the right field

in the HTO ontology. This supposes that we can first use 

the annotation information but also that  it is likely to be 

extended to have a nice name, additional structured 

information… 4 Y

R
Q

H
S

Mapping 

editor Mapping

Allow many to one 

and one to many 

mapping

Like Description.Title goes to Title and Like 

Description.Body goes to long description 3 Y

R
Q

H
S

Mapping 

editor Mapping Improve usability Start with release 4 and update in release 5 N/A X

R
Q

H
S

Mapping 

editor Mapping Improve flexibility in the capacity to map different situations Unclear what it covers? N/A X

R
Q

H
S

Mapping 

editor Mapping

Improve capacity to 

integrate new 

mapping based on real life schemas in different subdomains 4 Y

R
Q

H
S

Mapping 

editor Mapping Integrate output mapping into the metasearch engine 5 Y

Moved to release 5, 

Because Claudio did not 

provide the web services 

(One to import the 

mapping tool, one to 

upload and one to 

retreive instances from 

the metasearch engine)

R
Q

H
S Portal User Registration Any time user registers he should receive the link where he can login in the email 3

R
Q

H
S Portal Search criteria

Allow to select groups 

of providers based on the groups in the semantic registry 5+ Duplicate

R
Q

H
S

Semantic 

Registry

User interface to 

configure the 

registry

for the user to enter 

the location, data, 

category… 

corresponding to its 

data

Improve a little, for instance to specialise per users (limit 

access). 5 y
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R
Q

H
S

Semantic 

Registry

Automatic 

learning of the 

content of the 

data through the 

searches

We need to provide liited effort to match the descrition of 

work. 

This knowledge comes from: data explicitly inserted 

by tourism organizations when registering the service; 

information acquired from the mapping that each 

organization defines; annotations enriching the 

contents exchanged among partners 6

R
Q

X
X

Mapping 

editor

Transform HTO 

into output HTML In order to display results in HTML 3 Y

R
Q

Technical 

requirements

Ensure that it is 

possible to map 

and search data 

in several 

languages

It must be possible de 

define one or several 

language for search or 

mapping

First identify the extend of the problem and point out 

possible solutions if no language is defined? 6

M
2

R
Q

Mapping 

Interface Reference list

Be able to synchronise 

reference list  and 

mapping between 

portal and mapping 

tool

 a mechanism between the tool and the portal to 

syncrhonize files

Minimal implementation will be covered by line 186 

(Integrate output mapping into the metasearch 

engine). It is already possible to refresh reference list 

from the portal. 5+

To be discussed with 

Albert for clarification

R
Q Portal get mapping tool From portal, it must be possible to install the mapping tool 3 Y

R
Q

H
S

Mapping 

Interface Reference list

Be able to map list of 

references to generic 

lists supported by the 

portal

Mapping between general lists will be performed by 

Harmosearch 4 Y

R
Q

H
S

Mapping 

Interface

Mapping 

validation Allow mapping tool to use the meta search query to retrieve instance data to be used for validating mapping 6 X

validation is in portal and 

not mapping tool at 

present

Not in release 3

Because Claudio did not 

provide the web services 

(One to import the 

mapping tool, one to 

upload and one to 

retreive instances from 

the metasearch engine)
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R
Q

E
E

Metasearch 

Scenario Result list

Differentiate between 

results from crawler 

and from native 

connections

Differentiate in the data and in the interface and ensure 

that the provider behind the crawler is seen as the 

provider 3 Y

R
Q

E
E

Metasearch 

Scenario Search criteria Free text input Allow limited free text input

Define what free text content should be parsed. 

Probably very limited… 5+ Added after review

R
Q

C
P

Metasearch 

Scenario Search Search with Parallel queries 3 Y

R
Q

C
P

Metasearch 

Scenario Portal Service

Clear interface for the complete portal, like the registration 

process Duplaicate fro GUI helpers and labels N/A X

R
Q

H
S Ontology Prices Define how to handle offers 6

Need to discuss it on 

Thuesday

R
Q

H
S

Publish and 

Subscribe Use groups Allow groups of consumers or providers to be defined and used in metasearch and import, export 5+ Duplicate

5 R
Q

IM

Mapping 

editor Mapping

flexibility of the 

mapping process

structure a mapping process in a way that the editor does 

not feel like he or she is in a never ending questionnaire, a 

tool that resembles an entry form of an exhibition, would 

allow him or her to start wherever they like and save and 

continue when they decide.

The present tool, though not delivering that feature, is 

considered OK

N/

A X

6 R
Q

IM

Mapping 

editor settings 1

system elements 

(schema, filters, 

patterns…) should 

load automatically

Before the actual beginning of the mapping there are 

always some SETTINGS to decide, but if the user only parts 

from the own xsd, other necessary elements (filters, HTO 

schemata, patterns) should be default settings. 3 Y

7 R
Q

IM

Mapping 

editor settings 2

multilinguality 

support

a language is chosen, this decission should be set as default 

by next time the user opens the tool. Multilinguality only 

affects certain fields (<title><description> and <short 

description>)

currently euromuse does not define languages on the 

tags, the <description> contains information in the 

local language (23!), otherwise <description_en> is 

always in english. Possibility to define by default a 

language in the mapping tool 6 X

Not implemented. AR 

says it is commented, but 

we could not see it.

8 R
Q

IM

Mapping 

editor settings 3

pre-configured type of 

mapping through 

dialogue

maybe a pre-configured dataset could be loaded 

introducing an initial question (i.e. type of event), the fields 

should be then re-named or fields could be added in case 

the default "exhibition" fields are insuficient this would apply certain filters to the hto xsd schema 4 Y

9 R
Q

IM

Mapping 

editor Mapping

guidance to the user 

while linking

if the links can be adjusted in the dialoge-popups, these 

should contain some information what the user is 

supposed to do.

the dialogs that shoud allow to define i.e. date format 

to the individual strings, were no different from those 

in the RC I tested. It is half covered with task lists. 4 Y
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R
Q

H
S

Metasearch 

Scenario Result list Quality of the results

Provide information that shows if data is missing or wrong 

when coming from different sources 3 Y

R
Q

C
P

Metasearch 

Scenario Result list Quality of the results

Show complete information (all what is retrieved from the 

data provider) and put "not available" when the 

information is not available without leaving empty fields 3 Y

R
Q

C
P

Metasearch 

Scenario Result list Quality of the results

Do not show results which don't match the search criteria 

(e.g. out of date results) 3 Y

R
Q

C
P

Metasearch 

Scenario Result list Results pagination Scroll-up results page when clicking on previous or next 4 Y

R
Q

C
P

Metasearch 

Scenario Result list Quality of the results Show "permanent" in case of permanent exibitions 3 Y

R
Q

IM

Mapping 

editor mapping

getting attractions 

data (like museums) get geo-location easily from museums into harmonise

 the use of reference lists increases the mapping 

effort. Geo locations must first be added to hto then 

mapping can be performed. Information is present in 

Euromuse

N/

A X

Because geo locations 

are not supported in HS 

R
Q

IM

Mapping 

editor mapping

integrate the existing 

museum data (now 

available through 

reference lists) into 

the new GUI

right now is possible to query euromuse to restrict the 

search to a city (which already works with reference lists), 

it should be possible to give out the museum name 

(Location) xxxIM please clarify 6

R
Q

H
S HS Front End GUI Improve graphical interface Start with release 4 and update in release 5 5 Y

End of July with first 

intermediaite version

R
Q

H
S HS Front End GUI

Improve labels and 

helpers Improve text, allow configurable text via config files? Start with release 4 and update in release 5 5 Y

Need to display hints + 

provide texts

R
Q

H
S

Technical 

requirements Web Service

Provide pagination of 

results For the metasearch web service 5+ Not key for the R5

R
Q

H
S HS Front End Management Have specific interface according to user role 5 Y

R
Q

H
S

Service 

Management Management

Implement the 

incluson of external 

services

New external service in the portal: define, configure, select 

consumers to show and licence agreement for service 

provider 4 Y

R
Q

H
S

Service 

Management Management

Implement the 

incluson of external 

services

Implement the subscription request from a service 

subscriber + licence agreement from consumer agreement 4 Y

R
Q

H
S

Service 

Management Management

Implement the 

incluson of external 

services

Implement the validation of subscription and the service 

becomes available 4 y

R
Q

H
S

Service 

Management Management

Implement the 

selected external 

services

Moderator service before publication, with minimal quality 

control check (automated) 4 Y
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R
Q

Semantic 

Registry Alert subscription Subscribe to data to be notified when they are changed 6 Duplicate

R
Q

H
S

Metasearch 

Scenario

Language 

selection and 

context 

interpretation Interpret the context

Capacity to take into account the language and more 

generally context selection (style of output, priorities, 

filters, order…) 6

Possibility to specify 

some "context" 

preferences when 

submitting the query.

R
Q

H
S

Import 

Scenario Alert Definition

Send alert when data 

has changed on the 

provider side so that 

consumer can refresh

Alert on data changes could also be sent to data 

consumers for them to be able to refresh their data 

between batches. 6 Duplicate

R
Q

H
S

Mapping 

editor Query mapping

Perform query 

mapping in the 

mapping editor This is not retainedtutorial X x

Since mapping tool is too 

much behind

R
Q

H
S

Mapping 

editor

Reference list 

mapping

Perform mapping of 

reference lists 

Could be within the editor or triggerred by the editor and 

performed in a web application 4 Y

R
Q

H
S

Portal 

interface Query mapping Provide a step by step 

Directly accessible in the portal in the same place as where 

to import the query mapping files 4 Y

R
Q

H
S Crawler

Semi automatic 

refresh

A new crawler will be used and this will be performed. 

What i snot included is the integration of the crawker 

configuration into the semantic registry. This will be 

performed through an xml file (only performed by an 

expert. 5 Y

R
Q

H
S Data import

Simple data 

import Upload Excel file

Upload file, display in a table. Allow manual update and 

save N/A X

Dropped because 

duplicate of 59

R
Q

H
S Data import Simple data entry

Manual input of data 

in HS

Events and hotels can be directly entered in Harmosearch 

input form (same as for Excel validation) Ok for events only 4 P

But Claudio may be able 

to implement it, at least 

for events

R
Q

H
S Management Configuration

Wizard to configure 

easily a connector or 

a push process

For instance to define pushing to a facebook page or to 

configure a push to one system 4 Y

R
Q

H
S Query Configuration

Wizard to save a 

query into a 

scheduled query to be 

launched 

automatically

With or without intermediate step to filter before 

publication 4 Y

U
2

R
Q

D
F

Account  

management

Allow roles for 

user

Users are associated 

to one or several roles Roles are used to specialise the services and access

For instance a role to publish or to publish events, to 

search events… 5 Y

Only by admin through 

liferay interface
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U
2

R
Q

D
F

Account  

management

User Registration 

by member of its 

entity

Create user from an 

existing account

Existing user can create validated users when logged in, if 

part of their own entity

Created user is directly active in that case and inherits 

from all roles from the entity. It is possible then to 

select services from the account 5+ Duplicate of REQ 3

R
Q

H
S

Service 

management

Define how we 

charge and follow 

the services Maybe through the analysis of the logs

It is possible to get the logs from a database to excel 

for instance to process the data. The analysis would 

be external to the application 5 Y

may be once we really 

need it…

U
2

2

R
Q

D
F

Service 

subscription

Subscribe to 

service

Manage subscriptions 

of services

Extend input to allow more description for the service and 

user when selecting a service should have the capacity to 

have a page detailing the service (info from direct input 

and registry ….)

Add URL to an external page will be done. In the user 

role, it could be added the right to see the registry of 

others 5 Y

R
Q

D
F

Account  

management

User 

Management User Profile Update Add a new item in the config menu to update the profile 5 Y

R
Q

H
S

Mapping 

editor

Wording and 

templating

Improve wording for 

the helps and the 

items in thee list + 

add capacity to reuse 

previous mapping

value-of to change into something more user freindly, like 

mapping of langauge dependent items or opening hours: 

do it once and they have something in a list + reuse 5 Y

Partial. Could still be 

cgreatly imporved

R
Q

H
S Data input

data 

enhancement 

addition of keywords, 

qualification, rating

This will be performed at the registry or provider level, not 

at the data level

This would for instance correspond to general keword 

or location aded to all items 5 Y

R
Q

H
S Data input Scoring of data

Scoring could be 

counting the number 

of times data is 

retrieved. This is not entered by users, but defined from usage

Nb of times it is in a search

Nb of times the items is present in different data 

sources

Completeness of the data (number of fields filled)

according to the source itself (reliability…) 5 Y

R
Q

H
S Crawler Configuration Expand Crawler for easy configuration 6

R
Q

H
S

Metasearch 

Scenario Sorting

Sorting before 

response is returned

Allow sorting and filtering capacity to  the meta search 

before providing the result. Filtering corresponds to 

additional search criteria. This will not be implemented in 

the current metasearch, but will be an additional features 

only in relation with the cached data 5 Y

R
Q

H
S Data input

Process to build 

unique identifier to  reference for the cache to identify unique items 5 Y

R
Q

H
S

Publish and 

Subscribe On social network

Improve format on 

the output

see result of the test cases

Add link of landing page for instance, capacity to filter 

published items according to date range (Ines will explain 

in Mail) 5+
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APPENDIX B. TEST CASE DOCUMENTS 

This section gathers all the test cases that were filled for each release 
(PDF files extracted from Excel documents). There may be several 

documents per release. 

The PDF exports only contains the tests results. The content of the 

Help section has not been exported in each PDF, as it was already 
reported in the section “Documentation of the test case form” of this 

document.
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Appendix B.1. Test cases for release 1 

Test cases for the 1st release were divided in 4 documents: 
1. Test Case Release 1 – Crawler

2. Test Case Release 1 – Portal
3. Test Case Release 1 – Query

4. Test Case Release 1 – Semantic Registry
The results of all those excel documents were exported and included in this section. 
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Comment

 (and alternatives)

Complements 

for the semantic 

registry 1
9

/0
8

/2
0

1
1

Actual Result

C
R

1

C
R

1

1

Initial Crawling: 

Crawl and parse 

events that are 

tagged as 

microformat 

vevents on web 

pages.

Add a website containing microformat event tags (e.g. 

http://sabineschneider.it/harmosearch/) to 

NUTCH_ROOT/urls/nutch and as regular expression to 

NUTCH_ROOT/conf/crawl-urlfilter.txt. Then start the crawling 

process using a Unix terminal (Cygwin for Windows users) starting from the 

NUTCH_ROOT directory by calling bin/nutch crawl urls -dir 

crawl -depth 2.

Expected result: The events marked as 

vevents on the specified pages and all 

pages which are linked to from the 

given root site up to the chosen depth 

are parsed and listed in the directory 

NUTCH_ROOT/crawl in a proper 

format.

Req: the list of 

urls should 

come from the 

semantic 

registry (not 

manual)

O

Initial search shows nothing in 

database. After comleting, new 

directory is visible. Nothing to 

search yet.

C
R

2

C
R

1

2

Indexing: Index 

parsed events and 

populate a SOLR 

database with the 

tagged event 

information.

Having crawled some events, start SOLR by calling java -jar 

start.jar from SOLR_ROOT/example. As soon as the database is 

running, call the indexer from NUTCH_ROOT by typing in a Unix terminal 

bin/nutch solrindex http://localhost:8983/solr/ 

crawl/crawldb crawl/linkdb crawl/segments/* where the 

port number 8983 of SOLR has to be checked.

Expected result: The indexed events and 

all the tagged and parsed information 

fields are contained in the SOLR 

database as distinct items, from which 

they can be read out using queries.

O

Validation only performed by step 

3

C
R

3

C
R

1

3

Querying SOLR 

database: Send a 

query to the 

populated SOLR 

database, to 

obtain 

information 

about the crawled 

and indexed 

events.

After having crawled and indexed some events, go to the SOLR admin panel, 

located e.g. at http://localhost:8983/solr/admin/. Type the 

query in the second text field (Query String): Use *:* to obtain all the 

entries of the SOLR database. As an alternative to the SOLR admin panel, the 

query can directly be sent as a url, e.g. using 

http://localhost:8983/solr/select/?q=*%3A* which again 

returns all database entries. To search for specific information, e.g. for 

meetings, type in the admin panel summary:meeting or alternatively use 

http:// 

localhost:8983/solr/select/?q=summary%3Ameeting 

directly to run solr: http://localhost:11983/solr/admin/ (after launching  

tunnel)

Expected result: An XML formatted 

document is returned, containing as 

response to the given query various 

result documents, one for each event. 

Each such document contains tags for 

all event fields that were tagged, parsed 

and indexed. In the first case, all events 

contained in the database will be listed, 

in the second sample case only the 

events whose summary contains 

„meeting“ will be given as results.

O

Same extract all query returns 

data provides info. Info from 

extracted pages has been found! 

12 found

C
R

4

C
R

1

Add a new web 

page to the 

crawler

Same as CR1, but not starting from first page. New URL added: 

http://www.commerce.net

Redo also indexing and querying to 

validate that new data is presen t in the 

response

O

The new information has been 

added

C
R

6

C
R

4

Search precise 

information

We search Melanoma only present in 1 article on the new site (possibly 

article indexed seveeral times though)

Expected result: list one event or same 

event several times

X We find many events in the 

response with keyword 

Melanoma and most article do 

not contain this term.

C
R

5

C
R

1

Refresh cache

Content of SOLR Database is considered obsolete. Relaunch complete or 

partial update

Redo also indexing and querying to 

validate that updated data is present in 

the response. Change content on one 

event to validate the new one and add 

an event to a multi event page.

x

Reindexing does not work. Once a 

page is indexed, it will not be 

indexed again so changes are not 

tracked, except after 30 days (but 

we could not test)

C
ra

w
li

n
g
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Id

P
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n

t

S
e

q
u

e
n

ce Action Name Description Comment

 (and alternatives)

2
3

/0
8

/2
0

1
1 Actual Result Output 

(XML, Screen ...)
C

M
1 Home 

Page

Access home page, 

without signin

When user is not signed in he 

should see the welcome page only 

and have the capacity to sign in: no 

functionnal menu should appear

This might be a new requirement though. 

Furthermore, on the home page, an 

additional formal which would be very 

visible should allow signin. Could be the 

form access in the Signin page 

repositionned in the home page with text 

around.

X Menus are visible (though not all accessible). 

Search is accessible: that seems a bug because, 

then it is not possible to restrict the access to 

the content

C
M

1
7 Home 

Page

Navigate the menus Content should have same layout 

for the different services

W Out menu has differnet layout with Navigation 

item present

NavigationItemPresent

C
M

1
8 Home 

Page

Navigate the menus Click on Liferay in the navigation 

part

X Get errror link ErrorOnLiferay

C
M

1
9 Home 

Page

Access user account Click on user name (after sign in) should access user page X Nothing happens for David Faveur, but works 

for harmonise user

C
M

2

 

User.Auth

entication

Valid user registration Using id and password of standard 

user

registered users are in readme.txt file in 

E:\Sync\svn.partagé.Harmosearch\Code_Re

pository\server\install

rimini-museum-usr1, EMAIL=rimini-

museum-usr1@harmonet.org, PWD=rimini-

museum-usr1, ID=10869, ORG=rimini-

museum, ROLE=User

O accesses the portal though intermediate 

licence page; Only the first time after the user 

has been created.

Redo signin after logout. OK direct without 

licence

C
M

3

C
M

2

C
M

2 User.Auth

entication

Valid user registration, but 

disagree on policy

Licence message is displayed: 

Disagreeing should probably logout 

after displaying a message

W Message displayed, but stays on licence page: 

therefore stuck until agreeing. Should we keep 

the behaviour or change to logout?

C
M

4

C
M

2

C
M

3 User.Auth

entication

Valid user registration, 

agrees on policy

Agree on licence agreement. 

Shoiuld access services

O Access services after reminder question. All 

menus are accessible (not test done on menus)

Available menus in admin is:

Admin Menu Standard 

User

C
M

5

C
M

2

C
M

4 User.Auth

entication

Logout Returns to home page O OK

C
M

6

C
M

2

 

User.Auth

entication

Valid user registration Using id and password of standard 

user, after initial sign in + Add 

remember me

No licence is expected. Sign in kept if 

browser closed

O accesses the portal direct without licence 

page.

Closed browser. Reopned browser. Access 

URL. Sign in kept.

C
M

7

C
M

2 User.Auth

entication

Valid user registration 

using Open ID

C
M

8

C
M

1

C
M

1 User.Auth

entication

Access sign in page O Access page OK

Home Page

User Management
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S
e

q
u

e
n

ce Action Name Description Comment

 (and alternatives)

2
3

/0
8

/2
0

1
1 Actual Result Output 

(XML, Screen ...)
C

M
9

C
M

1

C
M

8 User.Auth

entication

Return to home page W Return to Home Page OK. However, label is 

unclear. I would prefer Return to Home Page 

or just home page

C
M

1
0 User 

Managem

ent

Create Account Create Account without being 

signed in

Filled First and Last Name, Email and 

captcha.

W Could create account.

Mandatory fields are not marked (compared to 

optional

Notion of screen name I do not understand 

Content of received mail a bit limited and 

wierd (received twice)

Create Account

C
M

1
1

C
M

1
0 User.Auth

entication

Signin with new account Using email and password taht was 

provided

Apparently does not work (as said in doc.) O

SignIn as david Faveur ==> OK as new 

registration with licence

I am not sure of content of user settings and 

why do I not have the list of the other users 

(that work)

C
M

1
2

C
M

1
1 User.Auth

entication

Access services Login with new user information To access the different services X No service is accessible. Exactly as if not logged 

in

NoServiceAvailable

C
M

1
3

C
M

2 User.Auth

entication

Use Forgot password Provide valid information O process OK on portal. Finished after received 

the mail (took a few minutes 

ResetPasswordMail

C
M

1
4

C
M

2

C
M

1
3 User.Auth

entication

Use Forgot password Provide invalid information O requires valid data to be provided.

C
M

1
5

C
M

2 User.Auth

entication

Valid admin registration Using id and password of 

administrator

O OK 

C
M

1
6 User 

Managem

ent

list all users W Only the users that I created manually are 

present. Where are the others? ==> AV has 

solved the issue

C
M

2
0

C
M

2 User.Auth

entication

Invalid user registration O Error message is displayed. Pwd cleared, email 

kept

To allow the use of the new user to 

test the harmonise features

X The issue on the user comes from the fact that 

no organisation is associated to the user. Once 

manually assocaited, most features seem to 

work (see below)

C
M

2
1

C
M

1
1 User.Auth

entication

Signin with new account After association of user to an 

organisation

Organisation also created manually W SignIn OK, Access to all menus, except Inbox SignInNoInboxAccess

C
M

4
2 User.Auth

entication

Do an action after session 

expired

What information shows that 

action expired, what happens

W In case action expired, usually login page is 

required and goes back to home page. Xxxin 

some cases error?

MANUAL INTERVENTION FROM 

ADRIANO

Admin.AccessControl
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S
e

q
u

e
n

ce Action Name Description Comment

 (and alternatives)

2
3

/0
8

/2
0

1
1 Actual Result Output 

(XML, Screen ...)
C

M
2

2 Admin.Acc

essControl

Access admin page as a user O

C
M

2
2 Admin.Acc

essControl

Configure access control 

list

as a user create, remove access control. Will need to 

login as another user to validate feature (if 

possible)

W Feature works However, 

* there is a lack of explanaiton (no help or hint)

* what are the mandatory fields (at first did 

not work because I did not input -1)

* Use default values so that user can work fast 

(like -1)

* No assistant on dates. What format is 

correct?

* What does max access number mean?

* The use of all as a default (which replaces 

others) means that if we do not pay attention, 

prevous conf is removed if new one without 

organisation selection is created!

* no info on list about who did it and when ...

C
M

2
3 Admin.Acc

essControl

Delete access control item as a user O

C
M

2
4 Admin.Acc

essControl

Update access control Item as a user modify some informaiton and then save W However, why i sthe interface different 

between create and update?

Admin.Ma

ppingServi

ce

C
M

2
5 Admin.Ma

ppingServi

ce

Upload mapping 

information

as a user upload one or two files. Will need to login 

as another user to validate feature (if 

possible)

W Feature works However, 

* I have difficulties understanding the interface 

(with done, not done...=

* Why a list when there can be only 2?

* When we replace a file, there is no easy way 

to know that the file was replaced (name is 

lost)

* no info on list about who did it and when ...

* How would I allow several mapping files for 

my cmpany?
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n
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S
e

q
u

e
n

ce Action Name Description Comment

 (and alternatives)

2
3

/0
8

/2
0

1
1 Actual Result Output 

(XML, Screen ...)
C

M
2

6 Admin.Ma

ppingServi

ce

Download mapping 

information

as a user download files from the server, files that 

were previously uploaded

X Get an error ==> Problem with content UploadMappingFile

C
M

2
7 Admin.Ma

ppingServi

ce

Delete mapping as a user O

C
M

2
8 Admin.Ma

ppingServi

ce

View Mapping as a user How? Except if does correspond to see the 

informaiton from the list

X I do not know how to view the mapping from 

the interface directly

Admin.Wo

rkflowMa

nager

C
M

2
9 Admin.Wo

rkflowMan

ager

I do not really know what to test and no access as a user 

PushingDa

ta

C
M

3
0 PushingDa

ta

upload file in euromuse 

format and send it to 

rimini

generate the upload

new req: more than one receiver. Test files 

in 

E:\Sync\svn.partagé.Harmosearch\Code_Re

pository\server\data\mapping

O

C
M

3
1

C
M

3
0 PushingDa

ta

upload file in euromuse 

format and send it to 

rimini

File present in the outbox. Must look in the 

inbox for remini to validate. How do I know 

it is sent (it does not seem to move from 

outbox to sent

W Date present in the starting date is incorrect: 

2011-08-18 13:18:16.903   (done at 4 PM)
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P
a

re
n

t

S
e

q
u

e
n

ce Action Name Description Comment

 (and alternatives)

2
3

/0
8

/2
0

1
1 Actual Result Output 

(XML, Screen ...)
C

M
3

2

C
M

3
1 PushingDa

ta

Check that file is sent X File not sent. Error has been logged 13:43:34,177 ERROR 

[BasePersistenceImpl:188] 

Caught unexpected 

exception 

org.hibernate.HibernateEx

ception

com.liferay.portal.kernel.e

xception.SystemException: 

org.hibernate.HibernateEx

ception: No Hibernate 

Session bound to thread, 

and configuration does 

not allow creation of non-

transactional one here  at 

m.liferay.portal.service.pe

rsistence.impl.BasePersist

enceImpl.processExceptio

n(BasePersistenceImpl.jav

a:195)   at 

com.liferay.portal.service.

persistence.UserPersistenc

eImpl.findAll(UserPersiste

nceImpl.java:3440)    at 

com.liferay.portal.service.

persistence.UserPersistenc

eImpl.findAll(UserPersiste

nceImpl.java:3360)  at 

org.harmonise.services.fra

mework.util.Util.getOrgani

zationMails(Util.java:116)

        at 

org.harmonise.services.fra

mework.util.Util.getOrgani

zationFirstMail(Util.java:10

4)

C
M

3
3

C
M

3
2 PushingDa

ta

Login as remini and check 

inbox

Validate that file is there and that 

the format is remini

check before that remini is corectly 

configured

Outbox

C
M 3
4 Outbox show outbox lists the files that must be sent O

C
M 3
5 Outbox Dowload a file downlaod the file and validate that it is in the format expected by the receiver O

C
M 3
6 Outbox Delete a file O
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P
a

re
n

t

S
e

q
u

e
n

ce Action Name Description Comment

 (and alternatives)

2
3

/0
8

/2
0

1
1 Actual Result Output 

(XML, Screen ...)
C

M 3
7 Outbox Delete all files

Sentbox

C
M 3
4 Sentbox show sentbox lists the files that have been sent O

C
M 3
5 Sentbox Dowload a file downlaod the file and validate that it is in the format expected by the receiver X Cannot test due to error CM32

C
M 3
6 Sentbox Delete a file X Cannot test due to error CM32

C
M 3
7 Sentbox Delete all files X Cannot test due to error CM32

Inbox

C
M

3
8 Inbox show inbox lists the files that have been 

received

Validate that all users of the organisation 

share same content

X Cannot test due to error CM32

C
M 3
9 Inbox Dowload a file New req: download all files? X Cannot test due to error CM32

C
M 4
0 Inbox Delete a file X Cannot test due to error CM32

C
M 4
1 Inbox Delete all files X Cannot test due to error CM32
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Id P

a
re

n
t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives)

Complements 

for the 

semantic 

registry 2
3

/0
8

/2
0

1
1

Actual Result

S
Q

1

Search all 

Return all possible 

information for all 

domains.

Output should 

contain Name, City, 

event location, 

event category, 

domain and date 

range. Optional 

content would be 

url, telephone, 

vignette, user rating

Comment from AV: For the test cases maybe should be better to be more precise on the input parameters, for 

example for categories if we mean the code of the category or the label (ID_ART or art…). Technically I think 

should be used the code; and probably we will see it when Claudio will define the query in the language…

DF:Any other feedback? according to comments, we could add a column for the precise parameters (it was 

there initially but removed because judged to precise)

CH: I'm not sure if "get all data from all domains" is really a useful test since it returns more or less arbitrary 

information.

CP: We can model a search request asking for data from all domains but this implies that the query itself is 

empty (i.e. search for all data without constraints) and that the output format is not specified (i.e. data are 

returned in the default format: otherwise what does it mean output should contain event name if the result 

item is e.g. an accommodation?). Maybe a useful test case here could be to import all data from one or more 

specified data providers (e.g Euromuse). I will provide a query which models this particular case.

Alterna-

tive SR1: limit 

list of 

providers in 

request to 

Euromuse 

and Facebook

O

We could have a test with all 

data from one domain as 

suggested and as well all data 

for 2  domains with differnt 

output list.

I am not sure it is very usefull 

though since we already mix 

subdomains in other tests

S
Q

2

Search All 

events

Retun all possible 

events

Output should be result list: Same output as SQ1

Alternative 1: Output should be Detailed EN: contain Name, City, Date range, summary, detailed description, 

url, precise address and vignette, price range. All text should be English

W

What about the optional 

fields? ==> Added in RQ

S
Q

2
.1

S
Q

2

Search All 

events, 

Alternative 1

Retun all possible 

events

Output should be result list: Same output as SQ1

Alternative 1: Output should be Detailed EN: contain Name, City, Date range, summary, detailed description, 

url, precise address and vignette, price range. All text should be English

O

S
Q

3

Search All 

events within 

time frame

Retun all possible 

events within [Date 

1, Date 2 ]

Output should be result list: Same output as SQ1

Alternative 1: give only Date 1

Alternative 2: give only date 2

Alternative 3: All events  during that period and all attractions at that date in the same query

Comment from CP - alternative 3: in this first version the query language is not able to handle queries joining 

different domains (e.g. events and attractions)

W I think there is a missmatch 

betwwen from, to and start, 

end. If it is the case, true for 

all tests with dates

In case of flexibility, how 

would we express the 

flexibility? ==> Added in RQ

S
Q

3
.1

S
Q

3

Search All 

events within 

time frame, 

alternative 1

Retun all possible 

events within [Date 

1, Date 2 ]

Output should be result list: Same output as SQ1

Alternative 1: give only Date 1

Alternative 2: give only date 2

Alternative 3: All events  during that period and all attractions at that date in the same query

Comment from CP - alternative 3: in this first version the query language is not able to handle queries joining 

different domains 

O

Why do we keep the AND 

since there is only one criteria

S
Q

3
.2

S
Q

3

Search All 

events within 

time frame, 

alternative 2

Retun all possible 

events within [Date 

1, Date 2 ]

Output should be result list: Same output as SQ1

Alternative 1: give only Date 1

Alternative 2: give only date 2

Alternative 3: All events  during that period and all attractions at that date in the same query

Comment from CP - alternative 3: in this first version the query language is not able to handle queries joining 

different domains 

O

S
e

a
rc

h
 Q

u
e

ry
 L

a
n

g
u

a
g

e
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Id P

a
re

n
t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives)

Complements 

for the 

semantic 

registry 2
3

/0
8

/2
0

1
1

Actual Result

S
Q

3
.3

S
Q

3

Search All 

events within 

time frame, 

Alternative 3

Retun all possible 

events within [Date 

1, Date 2 ]

Output should be result list: Same output as SQ1

Alternative 1: give only Date 1

Alternative 2: give only date 2

Alternative 3: All events  during that period and all attractions at that date in the same query

Comment from CP - alternative 3: in this first version the query language is not able to handle queries joining 

different domains

X

Query language does not 

handle joining subdomains as 

explained by CP ==> Should 

we expand?.

S
Q

4

Search All 

events within 

locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country 

codes and the full city name (not the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining 

different domains

O

S
Q

4
.1

S
Q

4

Search All 

events within 

locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country 

codes and the full city name (not the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining 

different domains 

O
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Id P

a
re

n
t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives)

Complements 

for the 

semantic 

registry 2
3

/0
8

/2
0

1
1

Actual Result

S
Q

4
.2

S
Q

4

Search All 

events within 

locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country 

codes and the full city name (not the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining 

different domains 

X

I think that using codes as a 

reference would greatly 

simplify language issues and 

allow better searches. ==> 

Should we extend? We need 

then extended city reference 

or allow only for ISO / ONU 

codes

S
Q

4
.3

S
Q

4

Search All 

events within 

locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country 

codes and the full city name (not the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining 

different domains 

O

Same as 1 since countries use 

codes. Remove from 

subsequent tests

S
Q

4
.4

S
Q

4

Search All 

events within 

locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country 

codes and the full city name (not the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining 

different domains 

W

Why he logical condition OR  

where inset probably implies 

or? Otherwise why use OR 

here and AND in the next one 

==> Test case will be 

corrected
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Id P

a
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n
t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives)

Complements 

for the 

semantic 

registry 2
3

/0
8

/2
0

1
1

Actual Result

S
Q

4
.5

S
Q

4

Search All 

events within 

locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country 

codes and the full city name (not the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining 

different domains 

O

S
Q

4
.6

S
Q

4

Search All 

events within 

locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country 

codes and the full city name (not the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining 

different domains 

O

S
Q

4
.7

S
Q

4

Search All 

events within 

locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country 

codes and the full city name (not the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining 

different domains 

X

Query language does not 

handle joining subdomains as 

explained by CP ==> Should 

we expand?.
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a
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e
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u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives)

Complements 

for the 

semantic 

registry 2
3

/0
8

/2
0

1
1

Actual Result

S
Q

5

Search All 

events for 

certain 

categories

Retun all possible 

events in Bertlin 

corresponding to 

modern art 

exhibitions

Output should be result list: Same output as SQ1

Alternative 1: in Berlin corresponding to modern art exhibitions or classical concerts

Alternative 2:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts

Alternative 3:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts during that 

period

Alternative 4:  in Berlin during that period or Wien  at that date, corresponding to modern art exhibitions or 

classical concerts 

Alternative 5:  in Berlin during that period corresponding to modern art exhibitions or in Wien  at that date 

concerning classical concerts 

O

Should we not use a 

thesaurus or something like 

that for categories. 

Otherwise, how do we match 

terms?

S
Q

5
.1

S
Q

5

Search All 

events for 

certain 

categories

Retun all possible 

events in Bertlin 

corresponding to 

modern art 

exhibitions

Output should be result list: Same output as SQ1

Alternative 1: in Berlin corresponding to modern art exhibitions or classical concerts

Alternative 2:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts

Alternative 3:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts during that 

period

Alternative 4:  in Berlin during that period or Wien  at that date, corresponding to modern art exhibitions or 

classical concerts 

Alternative 5:  in Berlin during that period corresponding to modern art exhibitions or in Wien  at that date 

concerning classical concerts 

O

S
Q

5
.2

S
Q

5

Search All 

events for 

certain 

categories

Retun all possible 

events in Bertlin 

corresponding to 

modern art 

exhibitions

Output should be result list: Same output as SQ1

Alternative 1: in Berlin corresponding to modern art exhibitions or classical concerts

Alternative 2:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts

Alternative 3:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts during that 

period

Alternative 4:  in Berlin during that period or Wien  at that date, corresponding to modern art exhibitions or 

classical concerts 

Alternative 5:  in Berlin during that period corresponding to modern art exhibitions or in Wien  at that date 

concerning classical concerts 

O

S
Q

5
.3

S
Q

5

Search All 

events for 

certain 

categories

Retun all possible 

events in Bertlin 

corresponding to 

modern art 

exhibitions

Output should be result list: Same output as SQ1

Alternative 1: in Berlin corresponding to modern art exhibitions or classical concerts

Alternative 2:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts

Alternative 3:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts during that 

period

Alternative 4:  in Berlin during that period or Wien  at that date, corresponding to modern art exhibitions or 

classical concerts 

Alternative 5:  in Berlin during that period corresponding to modern art exhibitions or in Wien  at that date 

concerning classical concerts 

O

Appendix B.1 - Document 3 - Test Case Release 1 - Query  - Page 5 on 6



Page 6 de 6
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a
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n
t
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e
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n

Name Description

Comment

 (and alternatives)

Complements 

for the 

semantic 

registry 2
3

/0
8

/2
0

1
1

Actual Result

S
Q

5
.4

S
Q

5

Search All 

events for 

certain 

categories

Retun all possible 

events in Bertlin 

corresponding to 

modern art 

exhibitions

Output should be result list: Same output as SQ1

Alternative 1: in Berlin corresponding to modern art exhibitions or classical concerts

Alternative 2:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts

Alternative 3:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts during that 

period

Alternative 4:  in Berlin during that period or Wien  at that date, corresponding to modern art exhibitions or 

classical concerts 

Alternative 5:  in Berlin during that period corresponding to modern art exhibitions or in Wien  at that date 

concerning classical concerts 

W

Could we not express 

category only once?

S
Q

5
.5

S
Q

5

Search All 

events for 

certain 

categories

Retun all possible 

events in Bertlin 

corresponding to 

modern art 

exhibitions

Output should be result list: Same output as SQ1

Alternative 1: in Berlin corresponding to modern art exhibitions or classical concerts

Alternative 2:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts

Alternative 3:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts during that 

period

Alternative 4:  in Berlin during that period or Wien  at that date, corresponding to modern art exhibitions or 

classical concerts 

Alternative 5:  in Berlin during that period corresponding to modern art exhibitions or in Wien  at that date 

concerning classical concerts 

O

S
Q

6

Search All 

events using 

geo 

coordinates

Search All events 

around a certain gps 

pont and a radius 

Output: Should be result List.

Alternative 1: Provide geo point of upper left corner and lower right corner

X I do not understand the 

query. I was expecting a point 

+ a length or something like 

that

S
Q

6
.1

S
Q

6

Search All 

events using 

geo 

coordinates

Search All events 

around a certain gps 

pont and a radius 

Output: Should be result List.

Alternative 1: Provide geo point of upper left corner and lower right corner

O
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Name Description

Comment

 (and alternatives) 0
5

/0
9

/2
0

1
1

Actual 

Result

S
Q

1

Search all 

Return all possible 

information for all 

domains.

Output should 

contain Name, City, 

event location, event 

category, domain 

and date range. 

Optional content 

would be url, 

telephone, vignette, 

user rating

Comment from AV: For the test cases maybe should be better to be more precise on the input parameters, for example for categories if we 

mean the code of the category or the label (ID_ART or art…). Technically I think should be used the code; and probably we will see it when 

Claudio will define the query in the language…

DF:Any other feedback? according to comments, we could add a column for the precise parameters (it was there initially but removed because 

judged to precise)

CH: I'm not sure if "get all data from all domains" is really a useful test since it returns more or less arbitrary information.

CP: We can model a search request asking for data from all domains but this implies that the query itself is empty (i.e. search for all data without 

constraints) and that the output format is not specified (i.e. data are returned in the default format: otherwise what does it mean output should 

contain event name if the result item is e.g. an accommodation?). Maybe a useful test case here could be to import all data from one or more 

specified data providers (e.g Euromuse). I will provide a query which models this particular case.

Alternative Semantic Registry 1: limit list of providers in request to Euromuse and Facebook

O

S
Q

2

Search All events

Retun all possible 

events

Output should be result list: Same output as SQ1

Alternative 1: Output should be Detailed EN: contain Name, City, Date range, summary, detailed description, url, precise address and vignette, 

price range. All text should be English

O

S
Q

2
.1

S
Q

2

Search All 

events, 

Alternative 1

Retun all possible 

events

Output should be result list: Same output as SQ1

Alternative 1: Output should be Detailed EN: contain Name, City, Date range, summary, detailed description, url, precise address and vignette, 

price range. All text should be English

O

S
Q

3

Search All events 

within time 

frame

Retun all possible 

events within [Date 

1, Date 2 ]

Output should be result list: Same output as SQ1

Alternative 1: give only Date 1

Alternative 2: give only date 2

Alternative 3: All events  during that period and all attractions at that date in the same query

Comment from CP - alternative 3: in this first version the query language is not able to handle queries joining different domains (e.g. events and 

attractions)

O

S
Q

3
.1

S
Q

3

Search All events 

within time 

frame, 

alternative 1

Retun all possible 

events within [Date 

1, Date 2 ]

Output should be result list: Same output as SQ1

Alternative 1: give only Date 1

Alternative 2: give only date 2

Alternative 3: All events  during that period and all attractions at that date in the same query

Comment from CP - alternative 3: in this first version the query language is not able to handle queries joining different domains (e.g. events and 

attractions)

O

S
Q

3
.2

S
Q

3

Search All events 

within time 

frame, 

alternative 2

Retun all possible 

events within [Date 

1, Date 2 ]

Output should be result list: Same output as SQ1

Alternative 1: give only Date 1

Alternative 2: give only date 2

Alternative 3: All events  during that period and all attractions at that date in the same query

Comment from CP - alternative 3: in this first version the query language is not able to handle queries joining different domains (e.g. events and 

attractions)

O

S
e

a
rc

h
 Q

u
e

ry
 L

a
n

g
u

a
g

e
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e
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n

Name Description

Comment

 (and alternatives) 0
5

/0
9

/2
0

1
1

Actual 

Result

S
Q

3
.3

S
Q

3

Search All events 

within time 

frame, 

Alternative 3

Retun all possible 

events within [Date 

1, Date 2 ]

Output should be result list: Same output as SQ1

Alternative 1: give only Date 1

Alternative 2: give only date 2

Alternative 3: All events  during that period and all attractions at that date in the same query

Comment from CP - alternative 3: in this first version the query language is not able to handle queries joining different domains (e.g. events and 

attractions)

X

Not 

supported 

in the query 

language

S
Q

4

Search All events 

within locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country codes and the full city name (not 

the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining different domains (e.g. events and 

attractions)

O

S
Q

4
.1

S
Q

4

Search All events 

within locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country codes and the full city name (not 

the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining different domains (e.g. events and 

attractions)

O
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a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) 0
5

/0
9

/2
0

1
1

Actual 

Result

S
Q

4
.2

S
Q

4

Search All events 

within locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country codes and the full city name (not 

the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining different domains (e.g. events and 

attractions)

X

Not 

supported 

in the query 

language

S
Q

4
.3

S
Q

4

Search All events 

within locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country codes and the full city name (not 

the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining different domains (e.g. events and 

attractions)

O

S
Q

4
.4

S
Q

4

Search All events 

within locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country codes and the full city name (not 

the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining different domains (e.g. events and 

attractions)

O
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t

S
e

q
u

e
n
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A
ct
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Name Description

Comment

 (and alternatives) 0
5

/0
9

/2
0

1
1

Actual 

Result

S
Q

4
.5

S
Q

4

Search All events 

within locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country codes and the full city name (not 

the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining different domains (e.g. events and 

attractions)

O

S
Q

4
.6

S
Q

4

Search All events 

within locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country codes and the full city name (not 

the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining different domains (e.g. events and 

attractions)

O

S
Q

4
.7

S
Q

4

Search All events 

within locations

Retun all possible 

events in Bertlin

Output should be result list: Same output as SQ1

Alternative 1: In France (Country instead of given city)

Alternative 2: in FRA (IATA code for Frankfurt)

Alternative 3: in IT (ISO code for Italy)

Alternative 4: in Berlin or Wien

Alternative 5: in Berlin or Wien with a certain period

Alternative 6: in Berlin at that date or Wien during that period

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 2: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country codes and the full city name (not 

the IATA code)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries joining different domains (e.g. events and 

attractions)

X

Not 

supported 

in the query 

language
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n

t

S
e

q
u

e
n

ce

A
ct
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Name Description

Comment

 (and alternatives) 0
5

/0
9

/2
0

1
1

Actual 

Result

S
Q

5

Search All events 

for certain 

categories

Retun all possible 

events in Bertlin 

corresponding to 

modern art 

exhibitions

Output should be result list: Same output as SQ1

Alternative 1: in Berlin corresponding to modern art exhibitions or classical concerts

Alternative 2:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts

Alternative 3:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts during that period

Alternative 4:  in Berlin during that period or Wien  at that date, corresponding to modern art exhibitions or classical concerts 

Alternative 5:  in Berlin during that period corresponding to modern art exhibitions or in Wien  at that date concerning classical concerts 

O

S
Q

5
.1

S
Q

5

Search All events 

for certain 

categories

Retun all possible 

events in Bertlin 

corresponding to 

modern art 

exhibitions

Output should be result list: Same output as SQ1

Alternative 1: in Berlin corresponding to modern art exhibitions or classical concerts

Alternative 2:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts

Alternative 3:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts during that period

Alternative 4:  in Berlin during that period or Wien  at that date, corresponding to modern art exhibitions or classical concerts 

Alternative 5:  in Berlin during that period corresponding to modern art exhibitions or in Wien  at that date concerning classical concerts 

O

S
Q

5
.2

S
Q

5

Search All events 

for certain 

categories

Retun all possible 

events in Bertlin 

corresponding to 

modern art 

exhibitions

Output should be result list: Same output as SQ1

Alternative 1: in Berlin corresponding to modern art exhibitions or classical concerts

Alternative 2:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts

Alternative 3:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts during that period

Alternative 4:  in Berlin during that period or Wien  at that date, corresponding to modern art exhibitions or classical concerts 

Alternative 5:  in Berlin during that period corresponding to modern art exhibitions or in Wien  at that date concerning classical concerts 

O

S
Q

5
.3

S
Q

5

Search All events 

for certain 

categories

Retun all possible 

events in Bertlin 

corresponding to 

modern art 

exhibitions

Output should be result list: Same output as SQ1

Alternative 1: in Berlin corresponding to modern art exhibitions or classical concerts

Alternative 2:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts

Alternative 3:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts during that period

Alternative 4:  in Berlin during that period or Wien  at that date, corresponding to modern art exhibitions or classical concerts 

Alternative 5:  in Berlin during that period corresponding to modern art exhibitions or in Wien  at that date concerning classical concerts 

O

S
Q

5
.4

S
Q

5

Search All events 

for certain 

categories

Retun all possible 

events in Bertlin 

corresponding to 

modern art 

exhibitions

Output should be result list: Same output as SQ1

Alternative 1: in Berlin corresponding to modern art exhibitions or classical concerts

Alternative 2:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts

Alternative 3:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts during that period

Alternative 4:  in Berlin during that period or Wien  at that date, corresponding to modern art exhibitions or classical concerts 

Alternative 5:  in Berlin during that period corresponding to modern art exhibitions or in Wien  at that date concerning classical concerts 

O
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Name Description

Comment

 (and alternatives) 0
5

/0
9

/2
0

1
1

Actual 

Result

S
Q

5
.5

S
Q

5

Search All events 

for certain 

categories

Retun all possible 

events in Bertlin 

corresponding to 

modern art 

exhibitions

Output should be result list: Same output as SQ1

Alternative 1: in Berlin corresponding to modern art exhibitions or classical concerts

Alternative 2:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts

Alternative 3:  in Berlin or Wien  corresponding to modern art exhibitions or classical concerts during that period

Alternative 4:  in Berlin during that period or Wien  at that date, corresponding to modern art exhibitions or classical concerts 

Alternative 5:  in Berlin during that period corresponding to modern art exhibitions or in Wien  at that date concerning classical concerts 

O

S
Q

6

Search All events 

using geo 

coordinates

Search All events 

around a certain gps 

pont and a radius 

Output: Should be result List.

Alternative 1: Provide geo point of upper left corner and lower right corner

O

S
Q

6
.1

S
Q

6

Search All events 

using geo 

coordinates

Search All events 

around a certain gps 

pont and a radius 

Output: Should be result List.

Alternative 1: Provide geo point of upper left corner and lower right corner

O
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Appendix B.2. Test cases for release 2 

Test cases for the 2nd release were divided in 2 documents:  
1. Test Case Release 2 – Mappint Tool 

2. Test Case Release 2 – Meta search 
The results of all those excel documents were exported and included in this section. 



Id

P
a

re
n

t

Action Name Description Comment

 (and alternatives)

2
0

/9
/1

1

W
h

o Actual Result
M

T
1 Mapping 

Tool RCP

Start 

mapping 

application

Used to test if the mapping 

tool  starts as expected 

from a Windows-based 

application.

Output: The application should come up as expected from a 

common Windows application (start). By clicking the X or the 

menu item "Exit" (File menu) the application windows should 

dissapeare accordingly (exit). 

W I

M

In the location 

D:\HARMOSEARCH\06_Mapping 

Tool\Flocke_rc1_.win32.win32.x86 the 

application did not react. Changed to 

C/temp/flocke and works 

Additional comment: After finishing the 

test cases I was not able to close the 

mapping tool accordingly. 

M
T

2

M
T

1 Mapping 

Tool RCP

Customize 

mapping 

tool 

application 

window

The user is allowed to make 

changes to the mapping 

tool interface. This regards 

to appearance related 

issues such as for example 

window size, open views, 

position of a view within 

the tool, etc. For testing 

purposes the user is 

required to change the 

window size and the 

location of a view by simply 

drag-and-drop.

Output: The tool reacts according to the changes and displays the 

view within ist new position and the application window is resized 

accordingly.

O I

M

Worked as expected

M
T

3

M
T

2 Mapping 

Tool RCP

Exit 

mapping 

application

Used to test if the mapping 

tool can be exited as 

expected from a Windows-

based application.

Output: The application is terminated as expected from a 

common Windows-based application.

O I

M

Worked as expected

M
T

4

M
T

2 Mapping 

Tool RCP

Auto-apply 

customiziat

ions

Evaluates if the changes 

done in Task MT2 are 

committed and executed to 

the mapping tool.

Output: The excepted behaviour (see MT2) is still valid after the 

mapping tool application has been restarted (see MT1 and MT3).

O I

M

Worked as expected
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Id

P
a

re
n

t

Action Name Description Comment

 (and alternatives)

2
0

/9
/1

1

W
h

o Actual Result
M

T
5

M
T

1 Mapping 

Project 

Handling

Create a 

clean 

mapping 

project

Clean mapping projects are 

used to denote mappings 

that are not realted to any 

kind of business case (e.g. 

Euromuse business case). 

Accordingly, no default 

resources, such as Schema, 

Filter, or Patterns are 

associated and therefore 

not included in the project 

from scratch. 

Output: The new mapping project is created reflecting the initial 

project structure. The project structure is visible in the project 

explorer window in the mapping tool as well as locally in the file 

system. Thereby, the project root is a folder, which name must be 

equal to the project name as specified by the user. The root 

folder has to include the following folders: Filter, Mappings, 

Output, Pattern, Schema, as well as a configuration file named 

config.xml.

O I

M

Worked as expected

M
T

6

M
T

1 Mapping 

Project 

Handling

Create a 

profile-

based 

mapping 

project

Profile-based mapping 

projects are business case 

specific (e.g. Euromuse) and 

therefore include distinct 

resources (Schema, Filter, 

Patterns, etc.). A profile 

summarized the included 

resources.

Output: The new mapping project is created accordingly (see 

MT5). In contrast to MT5 the folders are now filled with 

corresponding resources. Again, this can be observed directly in 

the mapping tool (project explorer) as well as locally in the file 

system. Since the project has been created using the Euromuse 

profile the following resources have been added to the 

corresponding folders: eurmouse_filter.filter, hto_filter.filter 

(both to the Filter folder); hto.xsl, HTO_Euromuse.xsl (to the 

Pattern folder); hto.xsd (Schema folder).

O I

M

Worked as expected

M
T

7 Mapping 

Project 

Handling

Open/Close 

schema file

Schema files are formalized 

using an XML notation. 

Thus, it makes sense to 

open a schema file for 

editing purposes within the 

mapping tool. 

Output: By double-clicking on a schema file (visible in the project 

explorer) an XML editor opens and displays the content of the 

file. In case the schema file is corrupt or not valid (e.g. not well 

formed) a corresopnding error message is presented to the user. 

The editor-window is closed by clicking on the "X" button in the 

upper right corner. 

O I

M

Worked as expected
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Id

P
a

re
n

t

Action Name Description Comment

 (and alternatives)

2
0

/9
/1

1

W
h

o Actual Result
M

T
8 Mapping 

Project 

Handling

Open/Close 

pattern file

Patterns are XSL templates 

that transform a given input 

to a given output. In 

addition patterns need to 

be adapted from case to 

case. Accordingly, the 

mapping tool needs to 

allow a technical user to 

open and change a pattern.

Output: By double-clicking on a pattern file (visible in the project 

explorer) an XSL editor opens and displays the content of the file. 

In case the pattern file is corrupt or not valid (e.g. not well 

formed) a corresopnding error message is presented to the user. 

The editor-window is closed by clicking on the "X" button in the 

upper right corner. 

O I

M

Worked as expected

M
T

9 Mapping 

Project 

Handling

Open/Close 

filter file

Filters are simple 

expressions that put a 

schema into a strict corset. 

In order to edit a filter it is 

necessary to open the filter 

within a text editor.

Output: By double-clicking on a filter file (visible in the project 

explorer) a text editor opens and displays the content of the file. 

In case the pattern file is corrupt a corresopnding error message 

is presented to the user. The editor-window is closed by clicking 

on the "X" button in the upper right corner. 

O I

M

Worked as expected

M
T

1
0 Mapping 

Project 

Handling

Create new 

mapping 

model file

In some situations a single 

mapping file may not be 

suitable. Therefore, the 

mapping tool has to be 

capable of handling an 

arbitrary number of 

mapping files. Accordingly, 

it has to provide an 

adequate mechanism that 

allows the user to create 

new mappings from 

scratch.

Output: The newly created mapping file is created locally and 

added to the Mappings folder (visible in the project wizard). 

O I

M

Worked as expected
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Id

P
a

re
n

t

Action Name Description Comment

 (and alternatives)

2
0

/9
/1

1

W
h

o Actual Result
M

T
1

1 Mapping 

Project 

Handling

Import 

local 

schema file

In most cases the user 

wants to make a mapping 

from his private data 

schema to the Harmonise 

data schema. Thus, he 

needs to add and open his 

proprietary schema in the 

mapping tool.

IM: Select Import Schema. The pop up menu had the option 

“import…” and I clicked that, another window appeared 

Output: The newly imported schema file is added to the project 

and added to the Schema folder in the project structure (both, 

locally on the file system as well as in the project explorer of the 

mapping tool). In case the schema file is corrupt or another 

exception occurs the tool reacts in two ways: First the user will be 

notified that an error occurred and second a new log message is 

added to the log file.

W I

M

I was able to accomplish the task, but 

only at the second try. Calling the wizard 

was confusing due to missleading 

wording (see comment).

M
T

1
2 Mapping 

Project 

Handling

Export 

mapping 

project

Exporting a mapping 

project allows users to 

share solutions and 

collaborative work on 

mappings. 

Output: Results in a ZIP file that can be saved locally. The ZIP 

contains all necessary meta-information and resources. 

Accordingly, the resulting ZIP contains the project structure and 

all associated resource-files (e.g. pattern, filter, mappings, 

schema)

O I

M

Worked as expected

M
T

1
3 Mapping 

Project 

Handling

Delete 

mapping 

project

The mapping tool needs to 

be capable of deleting a 

mapping project, which is 

currently not used but 

should be kept for further 

tasks.

Output: The mapping prjoect is deleted from the project explorer. 

However, not entirely from the local disc. Consequently, the 

project folder and ist subfolders (including resources) is still 

available.

O I

M

Worked as expected

M
T

1
4 Mapping 

Project 

Handling

Permanentl

y delete a 

mapping 

project

Some mapping projects are 

of no use any more. 

Accordingly, the mapping 

tool has to provide a delete 

option that allows the user 

to permanently remove a 

project (both locally and 

from the workspace).

Output: The mapping project is deleted from the project explorer 

and locally from the file system. As a result the project is not 

visible in the file system.

O I

M

Worked as expected
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Id

P
a

re
n

t

Action Name Description Comment

 (and alternatives)

2
0

/9
/1

1

W
h

o Actual Result
M

T
1

5 Mapping 

Project 

Handling

Import 

mapping 

project

To collaborate/extend 

existing mapping solutions.

Output: Uses the exported project (ZIP file) from MT12. A wizard 

guides the user trough the import process where he has to 

provide the location of the target project ZIP file. After all 

information has been provided the project is visible in the project 

explorer and the local file system. In case of an error a user 

notification by means of a dialog is shown and a new log message 

is added to the log file. 

O I

M

Worked as expected

M
T

1
6 Mapping 

Project 

Configurat

ion

Open/(Clod

e 

configurati

on file 

editor

Allows users to edit the 

current profile.

Output: After double-clicking the configuration file (visible in the 

project explorer) a configuration editor opens. In case of an error 

(e.g. not well formed) the editor wont open. Instead a 

corresponding error message is prestented and displayed to the 

user. 

O I

M

Worked as expected

M
T

1
7 Mapping 

Project 

Configurat

ion

Add/Remo

ve schema 

file

Adds or removes a schema 

from the profile and the 

project.

Output: By checking a schema (and savind the changes) the 

corresponding file is added to the project explorer. The new file is 

present in the Schema folder. Removing a file is similar: Uncheck 

the box and save your choice. The schema file will be removed 

from the project structure (schema folder). 

O I

M

Worked as expected

M
T

1
8 Mapping 

Project 

Configurat

ion

Add/Remo

ve pattern 

file

Adds or removes a pattern 

from the profile and the 

project.

Output: By checking a pattern (and savind the changes) the 

corresponding file is added to the project explorer. The new file is 

present in the Pattern folder. Removing a pattern is similar: 

Uncheck the box and save your choice. The pattern file will be 

removed from the project structure (pattern folder). 

O I

M

Worked as expected

M
T

1
9 Mapping 

Project 

Configurat

ion

Add/Remo

ve filter file

Adds or removes a filter 

from the profile and the 

project.

Output: By checking a filter (and savind the changes) the 

corresponding file is added to the project explorer. The new file is 

present in the Filter folder. Removing a filter is similar: Uncheck 

the box and save your choice. The filter file will be removed from 

the project structure (Filter folder). 

O I

M

Worked as expected

M
T

2
0 Graphical 

Modeling

Open/Close 

editor

To conduct mappings a 

graphical editor is 

necessary. This editor is 

called only on mapping 

files. 

Output: The mapping editor is opened by double-clicking a 

mapping file (Mapping folder). As a result the grahpical editor 

opens and presents an empty canvas (in case the mapping file has 

been empty) or an already existing mapping. In case the file is 

corrupt or damaged the editor wont open corretlcy. Instead a 

corresponding error message is displayed. 

O I

M

Worked as expected
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Id

P
a

re
n

t

Action Name Description Comment

 (and alternatives)

2
0

/9
/1

1

W
h

o Actual Result
M

T
2

1 Graphical 

Modeling

Load 

schema to 

editor

Schemata are the actual 

subject of mapping and 

need to be present in a 

mapping file.

Output: A schema file is deliaged to open within the graphical 

editor by drag-and-drop the schema file from the project explorer 

to the already opened editor (see MT20). As a result the schema 

is opened and displayes accordingly in the editor. In case the user 

wants to drag-and-drop files others than schema files (*.xsd 

extension) the drag operation will not work. In such a case the 

drag coursor provides visual feedback (crossed cicle) to the user.

O I

M

Worked as expected

M
T

2
2 Graphical 

Modeling

Move 

schema 

figure

Already loaded schemata 

need to be moveable in 

order to keep the editor 

window usable.

Output: The user is able to move a loaded schema by simple drag-

and-drop operations within the editor. As a result the schema can 

be moved smoothly within the editor window and changes its 

position according to the user's mous position.

W I

M

Was able to meet expectations. However, 

some issues are left. The window in the 

editor’s area of the schema seems to be 

resizable (and it works vertically) but 

horizontally it won’t expand / shorten 

(okv.xsd has some long tag names

M
T

2
3 Graphical 

Modeling

Tree 

interaction 

(collapse/e

xpand)

Output: By clicking the + respectively - buttons near a node the 

tree can be collapsed or expaned.

O I

M

Worked as expected

M
T

2
4 Graphical 

Modeling

Load 

second 

schema

Output: A second schema file is loaded to the editor and 

visualized as a tree structure (see MT21).

O I

M

Worked as expected

M
T

2
5 Graphical 

Modeling

Perform 

simple 

mapping 

(connect 

elements)

In general a user can 

perform two types of 

mappings: Simple and 

complex types. The former 

correspond to mappings 

that connect two atomic 

elements (with no further 

children nodes), whereas 

the latter corresponds to 

mappings that describe the 

linking between elements 

that have further children.

Output: A connection between two simple elements is visualized. 

Therby, the connection is drawn as a line leading from one 

schema-element to its opposite. The opposite is thereby, located 

in a another schema tree.

O I

M

Additional comments: 

What if I connect two elements that 

make no sense? It makes the connection, 

I can correct with the select tool the end 

of the link and place it in the correct 

place, this action was not in the task list.

When mouse over the link a pop up info 

window (yellow) appears, but this 

appears very far from the mouse, this 

should appear where the mouse is.
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Id

P
a

re
n

t

Action Name Description Comment

 (and alternatives)

2
0

/9
/1

1

W
h

o Actual Result
M

T
2

6 Graphical 

Modeling

Delete 

mapping 

links

Output: Pressing the delte button on the keyboard or via a left-

click on the connection the line bewteen the two elements is 

erased. As a consequence the line is not visible anymore.

O I

M

Additional comments: 

The option “Delete proposal” in the 

upper frame of the editor area is not 

irreversible!! I clicked it thinking it would 

be deleting only 1 link but it deleted all 

my links at once without telling me that 

all my links would be irreversibly deleted.

M
T

2
7 Graphical 

Modeling

Perform 

complex 

mapping Output: Draws a connection (see MT26) between two complex 

elements (parent elements) of two distinct schemata.

O I

M

Additional comments:

IM: Suggestion for the list: Couldn’t it by 

clicking on the elements to be linked 

themselves also activate the link pop-up 

(the lines are hard to click sometimes, 

specially when 2 lines run together 

M
T

2
8 Filters Call filter 

dialog 

(select 

all/deslect 

all/select 

single 

filter)

Allow the user to apply or 

delete certain filters.

Output: By clicking the + respectively - buttons near a node the 

tree can be collapsed or expaned.

O I

M

Worked as expected

M
T

2
9 Filters Apply 

specific 

filter to 

schema

Output: The target schema is constrained to the elements that 

are defined in the filter. Accordingly, the hto schema is 

constrained to event related information items.

O I

M

Worked as expected

Additional comments:

Once applied the filter I cannot undo it. If 

I click undo, the last action performed in 

the editing area (a link was set) undoes. 

M
T

3
0 Filters Add 

another 

filter to 

schema

Allow multiple filters at a 

time.

Output: Within the filter dialog another filter has to be clicked 

and committed (by clicking OK). The behaviour follows the same 

as described in MT29.

O I

M

Worked as expected

M
T

3
1 Filters Clear all 

filters

Delete all filters from the 

mapping.

Output: Removes all checked filters in the filter dialog. After 

clicking the OK button the changes are reflected by a "reset" in 

the mapping editor.

O I

M

Worked as expected
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Id

P
a

re
n

t

A
ct

io
n

Name Description
Comment

 (and alternatives)

2
3

/0
8

/1
1

W
h

o

Actual Result

S
Q

1 Search all from 

Euromuse

Return all possible information 

for all domains coming from 

Eurmuse.

Output should contain Name, City, event location, event category, domain and date range. 

Optional content would be url, telephone, vignette, user rating

Comment from CP - so far the metasearch engine does handle "context" information 

(optional result fields, language preferences, etc.) so even if they are present in the query 

language then they are ignored

O D

F

We could have a test with all data from one domain as 

suggested and as well all data for 2  domains with 

differnt output list.

I am not sure it is very usefull though since we already 

mix subdomains in other tests

S
Q

2 Search All events Retun all possible events Output should be result list: Same output as SQ1 W M

H

What about the optional fields? ==> Added in RQ

S
Q

2
.1

S
Q

2 Search All events, 

Alternative 1

Retun all possible events Alternative 1: Output should be Detailed EN: contain Name, City, Date range, summary, 

detailed description, url, precise address and vignette, price range. All text should be English

Comment from CP - so far the metasearch engine does handle "context" information 

(optional result fields, language preferences, etc.) so even if they are present in the query 

language then they are ignored

O

S
Q

3 Search All events 

within time frame

Retun all possible events 

within [1.9.2011, 31.12.2011 ]

Output should be result list: Same output as SQ1

Comment from CP - if you specify both start and end date you will get events whose time 

interval overlaps with the specified dates

W I think there is a missmatch betwwen from, to and 

start, end. If it is the case, true for all tests with dates

In case of flexibility, how would we express the 

flexibility? ==> Added in RQ

S
Q

3
.1

S
Q

3 Search All events 

within time 

frame, alternative 

1

Retun all possible events 

starting from 1.9.2011

Output should be result list: Same output as SQ1

Alternative 1: give only Date 1

Comment from CP - if you specify only the start date you will get all events which ends after 

the specified date (independently from when they start)

O Why do we keep the AND since there is only one 

criteria

S
Q

3
.2

S
Q

3 Search All events 

within time 

frame, alternative 

2

Retun all possible events until 

31.12.2011

Output should be result list: Same output as SQ1

Alternative 2: give only date 2

Comment from CP - if you specify only the end date you will get all events which starts before 

the specified date (independently from when they end)

O

S
e

a
rc

h
 Q

u
e

ry
 L

a
n

g
u

a
g

e
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Id

P
a

re
n

t

A
ct

io
n

Name Description
Comment

 (and alternatives)

2
3

/0
8

/1
1

W
h

o

Actual Result

S
Q

3
.3

S
Q

3 Search All events 

within time 

frame, Alternative 

3

Retun all possible events and 

attractions within [1.9.2011, 

31.12.2011 ]

Output should be result list: Same output as SQ1

Alternative 3: All events  during that period and all attractions at that date in the same query

Comment from CP: in this first version the query language is not able to handle queries 

joining different domains (e.g. events and attractions)

X Query language does not handle joining subdomains as 

explained by CP ==> Should we expand?.

S
Q

4 Search All events 

within locations

Retun all possible events in 

Vienna/Austria

Output should be result list: Same output as SQ1 O

S
Q

4
.1

S
Q

4 Search All events 

within locations

Retun all possible events in 

Austria

Output should be result list: Same output as SQ1

Alternative 1: In Austria (Country instead of given city)

O

S
Q

4
.2

S
Q

4 Search All events 

within locations

Retun all possible events in 

Frankfurt

Output should be result list: Same output as SQ1

Alternative 2: in FRA (IATA code for Frankfurt)

Comment from CP: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) 

country codes and the full city name (not the IATA code)

X I think that using codes as a reference would greatly 

simplify language issues and allow better searches. ==> 

Should we extend? We need then extended city 

reference or allow only for ISO / ONU codes

S
Q

4
.3

S
Q

4 Search All events 

within locations

Retun all possible events in 

Italy

Output should be result list: Same output as SQ1

Alternative 3: in IT (ISO code for Italy)

O Same as 1 since countries use codes. Remove from 

subsequent tests

S
Q

4
.4

S
Q

4 Search All events 

within locations

Retun all possible events in 

Biella or Wien

Output should be result list: Same output as SQ1

Alternative 4: in Biella or Wien

W Why he logical condition OR  where inset probably 

implies or? Otherwise why use OR here and AND in the 

next one ==> Test case will be corrected
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Id

P
a

re
n

t

A
ct

io
n

Name Description
Comment

 (and alternatives)

2
3

/0
8

/1
1

W
h

o

Actual Result

S
Q

4
.5

S
Q

4 Search All events 

within locations

Retun all possible events in 

Biella or Wien within 

[1.9.2011,31.12.2011]

Output should be result list: Same output as SQ1

Alternative 5: in Biella or Wien or within a certain period

O

S
Q

4
.6

S
Q

4 Search All events 

within locations

Retun all possible events in 

Biella within 

[1.9.2011,31.12.2011] or Wien 

within [1.1.2012,31.03.2012]

Output should be result list: Same output as SQ1

Alternative 6: in Biella within a certain period or Wien within another period

O

S
Q

4
.7

S
Q

4 Search All events 

within locations

Retun all possible events in 

Bertlin if no attractions

Output should be result list: Same output as SQ1

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 7: in this first version the query language is not able to handle 

queries joining different domains (e.g. events and attractions)

X Query language does not handle joining subdomains as 

explained by CP ==> Should we expand?.

S
Q

5 Search All events 

for certain 

categories

Retun all possible events in 

Biella corresponding to cultural

Output should be result list: Same output as SQ1 O Should we not use a thesaurus or something like that 

for categories. Otherwise, how do we match terms?

S
Q

5
.1

S
Q

5 Search All events 

for certain 

categories

Retun all possible events in 

Wien  corresponding to 

modern art exhibitions or 

sculpture exhibitions

Output should be result list: Same output as SQ1

Alternative 1: in Wien  corresponding to modern art exhibitions or sculpture exhibitions

O
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Id

P
a

re
n

t

A
ct

io
n

Name Description
Comment

 (and alternatives)

2
3

/0
8

/1
1

W
h

o

Actual Result

S
Q

5
.2

S
Q

5 Search All events 

for certain 

categories

Retun all possible events in 

Wien or Biella or 

corresponding to modern art 

exhibitions or culture

Output should be result list: Same output as SQ1

Alternative 2:  in Wien or Biella or corresponding to modern art exhibitions or culture

O

S
Q

5
.3

S
Q

5 Search All events 

for certain 

categories

Retun all possible events in 

Wien or Biella corresponding 

to modern art exhibitions or 

cultural during that period

Output should be result list: Same output as SQ1

Alternative 3:  in Wien or Biella corresponding to modern art exhibitions or cultural during 

that period

O

S
Q

5
.4

S
Q

5 Search All events 

for certain 

categories

Retun all possible events in 

Biella corresponding to sport 

or cultural in that period and 

the events in Vienna 

corresponding to modern art 

exhibition or sculpture 

exhibition in the same period

Output should be result list: Same output as SQ1

Alternative 4:  in Biella corresponding to sport or cultural in that period and in Vienna 

corresponding to modern art exhibition or sculpture exhibition in the same period

W Could we not express category only once?

S
Q

5
.5

S
Q

5 Search All events 

for certain 

categories

Retun all possible events in 

Biella corresponding to cultural 

in that period and the events in 

Vienna corresponding to 

modern art exhibition in the 

same period

Output should be result list: Same output as SQ1

Alternative 5:  in Biella corresponding to cultural in that period and in Vienna corresponding 

to modern art exhibition in the same period

O

S
Q

6 Search All events 

using geo 

coordinates

Search All events around a 

certain gps pont and a radius 

Output: Should be result List.

Comment from CP: not yet handled geo coordinates

X I do not understand the query. I was expecting a point 

+ a length or something like that

S
Q

6
.1

S
Q

6 Search All events 

using geo 

coordinates

Search All events between a 

certain gps upper left corner 

and lower right corner

Output: Should be result List.

Alternative 1: Provide geo point of upper left corner and lower right corner

Comment from CP: not yet handled geo coordinates

O
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Id
S

Q
1

S
Q

2
S

Q
2

.1
S

Q
3

S
Q

3
.1

S
Q

3
.2

0
4

/1
2

/1
1

W
h

o

Actual Result
Output 

(XML, Screen ...)

1
2

/1
2

/1
1

W
h

o

Actual Result

O C

P

R

Registry: O (returns Euromuse)

Query Processor (selecting 'euromuse' from list): O (1 XML file)

Metasearch: W (10 results - missing city/location and event domain due to 

incomplete mapping)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

O IM advance search (sq1.xml) returned 10 results with title, short description in local 

language and english, date range, categories sometimes link but  missing Organiser 

and location

simple search sent returns the same

Observations:

1.- If the query includes Paris, Berlin, Vienna, Biella and Rome, why is there a finnish 

exhibition in the output?

2.- Weblink, why is it not the link to the euromuse.net exhibition link? 

O C

P

R

Registry: O (returns Euromuse, Biella and euromuse/crawler)

Query Processor (selecting all three data providers): O (1 XML file each)

Metasearch: W (274 results - missing city/location and event domain due to 

incomplete mapping)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

O C

P

R

Registry: O (returns Euromuse and euromuse/crawler)

Query Processor (selecting both data providers): O (1 XML file each)

Metasearch: W (269 results - missing city/location and event domain due to 

incomplete mapping)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

O C

P

R

Registry: O (returns Euromuse, Biella and euromuse/crawler)

Query Processor (selecting all three data providers): O (1 XML file each)

Metasearch: W (274 results - missing city/location and event domain due to 

incomplete mapping)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

x IM it returned 274 euromuse exhibitions. Also dating in a range outside the query 

O C

P

R

Registry: O (returns Euromuse, Biella and euromuse/crawler)

Query Processor (selecting all three data providers): O (1 XML file each)

Metasearch: W (274 results - missing city/location and event domain due to 

incomplete mapping)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

x IM selected 1.9.2011 results 0 selected from 1.9.2011 to 1.9.2011 (the only way) results: 

11. Dates are not in the search range (i.e. exh in the range 19/11/2011  - 23/06/2013 

in the output).

selected today: 12.12.2011 results 77 (also bugs in the output i.e.  exh from 

01/12/2012  to 24/02/2013  )

O C

P

R

Registry: O (returns Euromuse, Biella and euromuse/crawler)

Query Processor (selecting all three data providers): O (1 XML file each)

Metasearch: W (274 results - missing city/location and event domain due to 

incomplete mapping)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

x IM results 0
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S
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S
Q
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S
Q
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.4

0
4

/1
2

/1
1

W
h

o

Actual Result
Output 

(XML, Screen ...)

1
2

/1
2

/1
1

W
h

o

Actual Result

X C

P

R

Not available in this release

O C

P

R

Registry: O (returns Euromuse and euromuse/crawler)

Query Processor (selecting both data providers): O (1 XML file each)

Metasearch: W (14 results - missing city/location and event domain due to 

incomplete mapping)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

O IM same as SQ3

O C

P

R

Registry: O (returns Euromuse and euromuse/crawler)

Query Processor (selecting both data providers): O (1 XML file each)

Metasearch: W (14 results - missing city/location and event domain due to 

incomplete mapping; same number of results as above because for testing purpose 

we limit to 10 the max number of results coming from Euromuse)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

w IM Outputs info only if choosing category "exhibition" 10 events in Austria und Vienna 

from euromuse, but 0 from euromuse-mf. 

Entries also outside the wished date-range (from 12.12.2011 on, but past exhibitions 

in output)

X C

P

R

Not available in this release

O C

P

R

Registry: O (returns Biella)

Query Processor (selecting Biella data provider): O (1 XML file)

Metasearch: W (5 results -missing city/location and event domain due to 

incomplete mapping)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

IM From biella I get no output (selecting event/all categories/italy/biella/daterange: 

today-empty/provider:Biella)

W C

P

R

Registry: O (returns euromuse, biella and euromuse/crawler)

Query Processor (selecting all three data providers): X (1 XML file each but 

Euromuse cannot understand multiple cities in the same query, need to be splitted 

using the OR construct instead of the InSet condition - see following test case)

Metasearch: W (6 results - missing city/location and event domain due to 

incomplete mapping; less than all events in Vienna because of incorrect query 

translation - see above)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

IM cannot choose 2 criteria in the simple search mask
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4

.5
S
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.6
S

Q
4

.7
S

Q
5

S
Q

5
.1

0
4

/1
2

/1
1

W
h

o

Actual Result
Output 

(XML, Screen ...)

1
2

/1
2

/1
1

W
h

o

Actual Result

O C

P

R

Registry: O (returns euromuse, biella and euromuse/crawler)

Query Processor (selecting all three data providers): O (1 XML file each)

Metasearch: W (6 results - missing city/location and event domain due to 

incomplete mapping; wrong dates in the results coming from Euromuse but this 

seems to be a Euromuse problem)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

X IM cannot choose 2 criteria in the simple search mask, therefore tried two different but 

related test cases:

- Test1: event / exhibition / - / Vienna / 16.02.2012 / euromuse

- Test2: event / exhibition / - / Berlin / 16.02.2012  / euromuse and all  

Date Range:

- Start date = end date (16.02.2012), in that time there are no temporary exhibitions 

in euromuse for Vienna. The two exhibitions output have no dates “//-//”, to be 

expected, as in our system for permanent exhibitions are start and end dates not 

compulsory. Could the output be tricked into give out “permanent exhibition” or 

“ongoing”?

- Directly related to this: I tried the same for Berlin, but permanent exhibitions are not 

included in the output. The 13 exhibitions are temporary exhibitions, but in that date 

(16.02.2012), there are all in all 85 exhibitions.     

Usability:

- When clicking through result pages (i.e. exhibitions in Berlin on 16.02.2012 = 13 

entries = 3 result pages), the next page automatically sets at the bottom of the list, 

could it not be the top?

W C

P

R

Registry: O (returns euromuse, biella and euromuse/crawler)

Query Processor (selecting all three data providers): O (2 XML file each)

Metasearch: X (10 results  - not all the results of an OR query are displayed - this bug 

has already been fixed for the third release)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

IM cannot choose 2 criteria in the simple search mask

X C

P

R

Not available in this release

O C

P

R

Registry: O (returns biella)

Query Processor (selecting biella as data provider): O (1 XML file)

Metasearch: W (4 results - missing city/location and domain due to incomplete 

mapping)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

IM no output when I ask for Biella

O C

P

R

Registry: O (returns euromuse and euromuse/crawler)

Query Processor (selecting both data providers): O (1 XML file each)

Metasearch: W (5 results - missing city/location and domain)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen
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5
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S
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S
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S
Q

6
.1

0
4

/1
2

/1
1

W
h

o

Actual Result
Output 

(XML, Screen ...)

1
2

/1
2

/1
1

W
h

o

Actual Result

W C

P

R

Registry: O (returns biella,  euromuse and euromuse/crawler)

Query Processor (selecting all three data providers): O (2 XML file each)

Metasearch: X (11 result -not all the results of an OR query are displayed - this bug 

has already been fixed for the third release)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

W C

P

R

Registry: O (returns biella,  euromuse and euromuse/crawler)

Query Processor (selecting all three data providers): O (2 XML file each)

Metasearch: X (11 result - not all the results of an OR query are displayed - this bug 

has already been fixed for the third release)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

W C

P

R

Registry: O (returns biella,  euromuse and euromuse/crawler)

Query Processor (selecting all three data providers): O (2 XML file each)

Metasearch: X (5 result  - not all the results of an OR query are displayed - this bug 

has already been fixed for the third release)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

W C

P

R

Registry: O (returns biella,  euromuse and euromuse/crawler)

Query Processor (selecting all three data providers): O (2 XML file each)

Metasearch: X (10 result  - not all the results of an OR query are displayed - this bug 

has already been fixed for the third release)

Registry: screen

Query Processor: XML file(s)

Metasearch: screen

X C

P

R

Not available in this release

X C

P

R

Not available in this release
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Q
2
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S

Q
3

S
Q

3
.1

S
Q

3
.2

1
6

/1
2

/1
1

W
h

o

Actual Result

1
8

/1
2

/1
1

W
h

o

Actual Result

W M

N

Metasearch 10 Results:

Should city be part of location or separate, because it wasnt 

explicitly mentioned in the result?

O E

C

T

R

L

Registry returns Euromuse. Query Processor returns the query all euromuse query.  Metasearch returns 10 results. 

x M

N

Metasearch 274 Results: this is not the same as SQ1 as 

mentioned in the comment

W E

C

T

R

L

Registry returns all the providers. Query processor converts the three queries. Metasearch returns 274 results from thr three providers. 

But: search is slow. I tried to remove starting date and ending date from output fields but as output i got dates as well. Output format 

looks not used, right ?

x M

N

Metasearch 269 Results:

Missing  summary, precise address, price range according to 

the information given in the comment

W E

C

T

R

L

Registry returns Euromuse and euromuse/crawler. 

Query Processor   OK

Metasearch: W (269 results - missing city/location and event domain due to incomplete mapping).                                                But 

Language Preference has some influence ? What is the subdomain testComplianceEvent ?

W M

N

Metasearch 274 Results:

Unclear from the description if the result should  show 

exhibitions which are also only partly in the time frame of the 

search (as it is the case) or if only those should be shown which 

are open during the whole time of the search

x E

C

T

R

L

Does not look the time criteria are working: searching to= 2011-09-28 and from= 2011-09-28 I get: Pergamon. Panorama of the Ancient 

City . 

Pergamon.  Which happens in the 30-09-2011 (out of the period). The semantics of the date search should be: events which are 

available in the given timeframe

Comment CP: Pergamon. Panorama of the Ancient City ends on 30/09/2012...

x Metasearch 274 Results:

Showing results which have "Opening" not at the 1.9.2011

x E

C

T

R

L

 Searching endDate  from=2013-12-01 I got the  event Aboa Vetus permanent exhibition, closing at  31-12-2012

x M

N

Metasearch 274 Results:

Showing results which have "Opening" not at the 31.12.2011

x E

C

T

R

L

Searching startDate to 2008-12-31 i got the event Aboa Vetus permanent exhibition starting at 01/01/2011
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.4

1
6

/1
2

/1
1

W
h

o

Actual Result

1
8

/1
2

/1
1

W
h

o

Actual Result

M

N

Metasearch Not tested not tested

W M

N

Metasearch 14 Results:

Field location empty -> validation difficult

Exhibitions are in german,  so probably fine

x Semantic Registry OK, changed to IT and to Biella worked as well returning biella. But how is configured ?. Querying for AT and 

Innsbruck I got 10 results not in Innsbruck, but for vienna i got correctly 14 results

W M

N

Metasearch 14 Results:

Field location empty -> validation difficult

Exhibitions are in german,  so probably fine

w E

C

T

R

L

but if searching for DE 0 results

M

N

Metasearch Not tested

W M

N

Metasearch 5 Results:

Field location empty -> validation difficult

Exhibitions are in italian,  so probably fine

E

C

T

R

L

Semantic Registry OK, query Processor ok. But metasearch 0 results.  We are also working in Biella, so maybe there is some unexpected 

change.

Comment CP: the server was down: can you please retry?

W M

N

Metasearch 6 Results:

Field location empty -> validation difficult

Exhibitions are in italian or german,  so probably fine

E

C

T

R

L

0 results

Comment CP: the server was down: can you please retry?
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Actual Result

M

N

Metasearch 0 Results:

Comment CP: the server was down: can you please retry?

E

C

T

R

L

0 results

Comment CP: the server was down: can you please retry?

M

N

Metasearch 0 Results:

Comment CP: the server was down: can you please retry?

E

C

T

R

L

0 results

Comment CP: the server was down: can you please retry?

M

N

Metasearch Not tested

M

N

Metasearch 0 Results:

Comment CP: the server was down: can you please retry?

E

C

T

R

L

0 results

Comment CP: the server was down: can you please retry?

M

N

Metasearch 0 Results:

Comment CP: the server was down: can you please retry?
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Actual Result

M

N

Metasearch 0 Results:

Comment CP: the server was down: can you please retry?

M

N

Metasearch 0 Results:

Comment CP: the server was down: can you please retry?

M

N

Metasearch 0 Results:

Comment CP: the server was down: can you please retry?

M

N

Metasearch 0 Results:

Comment CP: the server was down: can you please retry?
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Appendix B.3. Test cases for release 3 

Test cases for the 3rd release were divided in 3 documents:  
1. Test Case Release 3 – Harmosearch Portal 

2. Test Case Release 3 – Portal 
3. Test Case Release 3 – Mapping Tools 

The results of all those excel documents were exported and included in this section. 



Id

P
a

re
n

t

S
e

q
u

e
n

ce
Action Name Description

Comment

 (and alternatives)

2
3

/0
8

/1
1

Actual Result

Output 

(XML, 

Screen ...)

C
M

1 Home 

Page

Access home page, 

without signin

When user is not signed in he 

should see the welcome page only 

and have the capacity to sign in: no 

functionnal menu should appear

This might be a new requirement though. 

Furthermore, on the home page, an additional formal 

which would be very visible should allow signin. Could 

be the form access in the Signin page repositionned in 

the home page with text around.

X Menus are visible (though not all accessible). 

Search is accessible: that seems a bug because, then it is not 

possible to restrict the access to the content

C
M

1
7 Home 

Page

Navigate the 

menus

Content should have same layout for the different services W Out menu has differnet layout with Navigation item present Navigatio

nItemPres

ent

C
M

1
8 Home 

Page

Navigate the 

menus

Click on Liferay in the navigation part X Get errror link ErrorOnLif

eray

C
M

1
9 Home 

Page

Access user 

account

Click on user name (after sign in) should access user page X Nothing happens for David Faveur, but works for harmonise 

user

C
M

2

 

User.Auth

entication

Valid user 

registration

Using id and password of standard 

user

registered users are in readme.txt file in 

E:\Sync\svn.partagé.Harmosearch\Code_Repository\s

erver\install

rimini-museum-usr1, EMAIL=rimini-museum-

usr1@harmonet.org, PWD=rimini-museum-usr1, 

ID=10869, ORG=rimini-museum, ROLE=User

O accesses the portal though intermediate licence page; Only the 

first time after the user has been created.

Redo signin after logout. OK direct without licence

C
M

3

C
M

2

C
M

2 User.Auth

entication

Valid user 

registration, but 

disagree on policy

Licence message is displayed: Disagreeing should probably logout after displaying a messageW Message displayed, but stays on licence page: therefore stuck 

until agreeing. Should we keep the behaviour or change to 

logout?

C
M

4

C
M

2

C
M

3 User.Auth

entication

Valid user 

registration, agrees 

on policy

Agree on licence agreement. Shoiuld access services O Access services after reminder question. All menus are 

accessible (not test done on menus)

Available menus in admin is:

Admin 

Menu 

Standard 

User

C
M

5

C
M

2

C
M

4 User.Auth

entication

Logout Returns to home page O OK

C
M

6

C
M

2

 

User.Auth

entication

Valid user 

registration

Using id and password of standard 

user, after initial sign in + Add 

remember me

No licence is expected. Sign in kept if browser closed O accesses the portal direct without licence page.

Closed browser. Reopned browser. Access URL. Sign in kept.

C
M

7

C
M

2 User.Auth

entication

Valid user registration using Open ID

C
M

8

C
M

1

C
M

1 User.Auth

entication

Access sign in page O Access page OK

Home Page

User Management
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ce
Action Name Description

Comment

 (and alternatives)

2
3

/0
8

/1
1

Actual Result

Output 

(XML, 

Screen ...)

C
M

9

C
M

1

C
M

8 User.Auth

entication

Return to home page W Return to Home Page OK. However, label is unclear. I would 

prefer Return to Home Page or just home page

C
M

1
0 User 

Managem

ent

Create Account Create Account without being 

signed in

Filled First and Last Name, Email and captcha. W Could create account.

Mandatory fields are not marked (compared to optional

Notion of screen name I do not understand 

Content of received mail a bit limited and wierd (received 

twice)

Create 

Account

C
M

1
1

C
M

1
0 User.Auth

entication

Signin with new 

account

Using email and password taht was 

provided

Apparently does not work (as said in doc.) O

SignIn as david Faveur ==> OK as new registration with licence

I am not sure of content of user settings and why do I not have 

the list of the other users (that work)

C
M

1
2

C
M

1
1 User.Auth

entication

Access services Login with new user information To access the different services X No service is accessible. Exactly as if not logged in NoService

Available

C
M

1
3

C
M

2 User.Auth

entication

Use Forgot 

password

Provide valid information O process OK on portal. Finished after received the mail (took a 

few minutes 

ResetPass

wordMail

C
M

1
4

C
M

2

C
M

1
3 User.Auth

entication

Use Forgot 

password

Provide invalid information O requires valid data to be provided.

C
M

1
5

C
M

2 User.Auth

entication

Valid admin 

registration

Using id and password of administrator O OK 

C
M

1
6 User 

Managem

ent

list all users W Only the users that I created manually are present. Where are 

the others? ==> AV has solved the issue

C
M

2
0

C
M

2 User.Auth

entication

Invalid user registration O Error message is displayed. Pwd cleared, email kept

To allow the use of the new user to test the harmonise features X The issue on the user comes from the fact that no organisation 

is associated to the user. Once manually assocaited, most 

features seem to work (see below)

C
M

2
1

C
M

1
1 User.Auth

entication

Signin with new 

account

After association of user to an 

organisation

Organisation also created manually W SignIn OK, Access to all menus, except Inbox SignInNoI

nboxAcces

s

C
M

4
2 User.Auth

entication

Do an action after 

session expired

What information shows that action expired, what happens W In case action expired, usually login page is required and goes 

back to home page. Xxxin some cases error?

MANUAL INTERVENTION 

FROM ADRIANO
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ce
Action Name Description

Comment

 (and alternatives)

2
3

/0
8

/1
1

Actual Result

Output 

(XML, 

Screen ...)

C
M

2
2 Admin.Acc

essControl

Access admin page as a user O

C
M

2
2 Admin.Acc

essControl

Configure access 

control list

as a user create, remove access control. Will need to login as 

another user to validate feature (if possible)

W Feature works However, 

* there is a lack of explanaiton (no help or hint)

* what are the mandatory fields (at first did not work because I 

did not input -1)

* Use default values so that user can work fast (like -1)

* No assistant on dates. What format is correct?

* What does max access number mean?

* The use of all as a default (which replaces others) means that 

if we do not pay attention, prevous conf is removed if new one 

without organisation selection is created!

* no info on list about who did it and when ...

C
M

2
3 Admin.Acc

essControl

Delete access 

control item

as a user O

C
M

2
4 Admin.Acc

essControl

Update access 

control Item

as a user modify some informaiton and then save W However, why i sthe interface different between create and 

update?

C
M

2
5 Admin.Ma

ppingServi

ce

Upload mapping 

information

as a user upload one or two files. Will need to login as another 

user to validate feature (if possible)

W Feature works However, 

* I have difficulties understanding the interface (with done, not 

done...=

* Why a list when there can be only 2?

* When we replace a file, there is no easy way to know that the 

file was replaced (name is lost)

* no info on list about who did it and when ...

* How would I allow several mapping files for my cmpany?

C
M

2
6 Admin.Ma

ppingServi

ce

Download mapping 

information

as a user download files from the server, files that were 

previously uploaded

X Get an error ==> Problem with content UploadMa

ppingFile

C
M

2
7 Admin.Ma

ppingServi

ce

Delete mapping as a user O

C
M

2
8 Admin.Ma

ppingServi

ce

View Mapping as a user How? Except if does correspond to see the informaiton 

from the list

X I do not know how to view the mapping from the interface 

directly

Admin.Service

Admin.AccessControl

Appendix B.3 - Document 1 - Test Case Release 3 - Harmosearch Portal  - Page 3 on 4



Id

P
a

re
n

t

S
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e
n

ce
Action Name Description

Comment

 (and alternatives)

2
3

/0
8

/1
1

Actual Result

Output 

(XML, 

Screen ...)

C
M

2
9 Admin.Wo

rkflowMa

nager

I do not really know what to test 

and no access as a user 

TODO

C
M

3
0 PushingDa

ta

upload file in euromuse format and send it to rimini generate the upload

new req: more than one receiver. Test files in 

E:\Sync\svn.partagé.Harmosearch\Code_Repository\s

erver\data\mapping

O

C
M

3
1

C
M

3
0 PushingDa

ta

upload file in euromuse format and send it to rimini File present in the outbox. Must look in the inbox for 

remini to validate. How do I know it is sent (it does not 

seem to move from outbox to sent

W Date present in the starting date is incorrect: 2011-08-18 

13:18:16.903   (done at 4 PM)

C
M

3
2

C
M

3
1 PushingDa

ta

Check that file is sent X

C
M

3
3

C
M

3
2 PushingDa

ta

Login as remini and 

check inbox

Validate that file is there and that 

the format is remini

check before that remini is corectly configured

CM34 Outbox show outbox lists the files that must be sent O

CM35 Outbox Dowload a file downlaod the file and validate that it is in the format expected by the receiver O

CM36 Outbox Delete a file O

CM37 Outbox Delete all files

CM34 Sentbox show sentbox lists the files that have been sent O

CM35 Sentbox Dowload a file downlaod the file and validate that it is in the format expected by the receiver X Cannot test due to error CM32

CM36 Sentbox Delete a file X Cannot test due to error CM32

CM37 Sentbox Delete all files X Cannot test due to error CM32

CM38 Inbox show inbox lists the files that have been Validate that all users of the organisation share same X Cannot test due to error CM32

CM39 Inbox Dowload a file New req: download all files? X Cannot test due to error CM32

CM40 Inbox Delete a file X Cannot test due to error CM32

CM41 Inbox Delete all files X Cannot test due to error CM32

Inbox

File not sent. Error has been logged : 

13:43:34,177 ERROR [BasePersistenceImpl:188] Caught unexpected 

PushingData

Outbox

Sentbox
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Id P
a

re
n

t

S
e

q
u

e
n

A
ct

io
n

Name Description

Comment

 (and alternatives)

P
0 Home page cotnent and 

menus

User access the home page, before any action is performed

P
0

.1 P
0 Content of the home page 

without login

Home page has text, a sign in access on the right a a home menu 

when no login is performed

Describe in the test partition improvements if necessary

P
0

.2 P
0 Content of the home page 

after login

Home page has text, profile access, logout,menus… Describe in the test partition improvements if necessary

P
0

.3 P
0 Documentation of the 

home page

Link to the documentation Describe in the test partition improvements if necessary

P User Registration A new user  creates an account by compiling  the form.  He can choose an existing organization to be assigned to or create a new one.

P
1

.1 P
1 User registrates with 

missing user fields

P
1

.2 P
1 User registrates with 

invalid email

P
1

.3 P
1 User registrates without 

captcha

P
1

.4 P
1 User registrates with valid 

data to a new 

organization / user side

insert your own data (names and email address). insert also the 

organization you belong to (must not be already listed among the 

registered organizations)

Email address will be used to send notifications, and should therefore be real and owned by the user .

In order to log into the system the new user and organisation need to be activated by an administrator. 

After the activation, which is notified via email to the user, he can log into the portal and he is ranked as 

an adiminstrator of the new organization.

If the user writes a new org in the text box and also selects an existing organization from the combo 

box, the combo box is not read.

P
1

.5 P
1 User registrates with valid 

data to a new 

organization / 

administrator side

Prerequisite: the previous test case (user registration with correct 

data) has been performed with success

This test case can only be tested by the system administrator.

P
1

.6 P
1 User registrates twice 

with the same data

H
o

m
e

.P
a

g
e

U
se

r.
R

e
g

is
tr

a
ti

o
n

 click on 'Sign in';  click on 'Create Account';  insert a valid email and the correct captcha (text verification field) .  do not insert one of the required fields (first name, last 

name and screen name)

 insert first name, last name, screen name and the correct captcha (text verification field) .  insert an invalid email address (or just don't inserti it)

 insert first name, last name, screen name and a valid email address. Insert an wrong captcha (text verification field)  or just don't insert it

Prerequisite: the registration of the previous test case must have been completed with success (the user side part is enough)

insert the same data like in the above registration test case (user side test case); at least screen name or email address must be the same
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 (and alternatives)

P
1

.7 P
1 User registrates with valid 

data to an existing 

organization

insert your own data (screen name and email address must not be 

already registered)

choose 'okv' as organization to belong to

Email address might be used to send notifications, and should therefore be owned by the user.

In order to log into the system the new user needs to be activated by an administrator.

After the activation, which is notified via email to the user, he can log into the portal, belonging  to the 

chosen organization.

P
1

.8 P
1 Administrator activates 

the account a user has 

created.

the administrator activates the account created by a user. if a new 

organization has been contextually registered, then he also 

configures it assigning it to the 'HarmoSearch' community.

This test case can only be tested by the administrator. 

When an account is created by a user, the administrator receives a notification to activate the account 

and a second notification asking to configure the organization if a new one has been created.

P
1

.9 P
1 Content of the user 

registration page

User registration page allows creation of a new user. It contains 

fileds, menus, buttons.

Describe in the test partition improvements if necessary

P
1

.1
0

P
1 Documentation of the 

user registration page

Link to the documentation Describe in the test partition improvements if necessary

P
1

.1
1

P
1 Emails exchange There are 2 emails being sent: one for creation and one 

formnotification

Describe in the test partition improvements if necessary

P
 

User Login A user logs in into the HarmoSearch portal

P
2

.1 P
2 User logs in with right 

credentials the first time

P
2

.1 P
2 after a successfull login, 

user wnats to change its 

password using his profile

P
2

.2 P
2 User logs in with wrong 

credentials

P
2

.3 P
2 User logs in with correct 

credentials

P
2

.4 P
2 User takes an overview of 

the availability of the 

services

take a look on the Services Board portlet in the home page You can further check by uploading the mapping  file 'HTO_Euromuse.xslt' (available in the test data 

folder) from within 'Configurations'->'Mapping Store' in the row 

'Upload mapping from Harmonise ontology to local system (for importing/receiving data) ' and check 

again on the services board that the Import Data is now Active

U
se

r.
Lo

g
in

 click on 'Sign in'log in with new credenCals

click on   user name (upper right) and change password

click on 'Sign in'

log in with missing or worng email address or password.

log in with the right email address and the password received by email.
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Comment

 (and alternatives)

P
2

.5 P
2 User has forgotten its 

identifiers and requires 

them to be sent again

P
2

.6 P
2 Content of the signin 

block

Sing in block has user and password filed + Button Describe in the test partition improvements if necessary

P
2

.7 P
2 Documentation of the 

user login page

Link to the documentation Describe in the test partition improvements if necessary

P
 3 Metasearch A user performs metasearch by using the search fields of the  interface or by posting directly HarmoSearch queries in the text area

P
.3

.0 P
3

P
3

.1
2

, 
P

3
.1

3
, 

Metasearch query

go in the 'Metasearch' tab

execute a simple search 

No mapping has been added at this stage

P
.3

.1 P
3 Insert invalid query

P
.3

.2 P
3 Registry is unavailable in 

metasearch

Prerequisite: the registry has been shut down

select any kind of simple or advanced metasearch

Post: start the registry again

This test case can only be tested by the administrator. 

P
.3

.3 P
3

P
3

.3
, 

Query mapping is missing 

in metasearch

Delete euromuse query mapping then go to next cell

P
.3

.4 P
3

P
3

.3
, 

P
3

.4
, 

Query mapping is missing 

in metasearch

P
.3

.5 P
3

P
3

.3
, 

Query mapping is missing 

in metasearch

Add euromuse query mapping

M
e

ta
se

a
rc

h
click on 'Forgot Password'

enter the answer of the question

go in the metasearch tab

click on 'Advanced Search' and insert an invalid HarmoSearch query (as an example you can use the test query 'SQ0_invalid_metasearch_query.xml')

go on 'Metasearch' and execute any simple search selecting 'euromuse' as data provider
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P
.3

.6 P
3

P
3

.6
, 

Data provider is not 

available in metasearch

Misconfigure euromuse query service access parameters

P
.3

.7 P
3

P
3

.6
, 

Data provider is not 

available in metasearch

P
.3

.8 P
3

P
3

.6
, 

Data provider is not 

available in metasearch

P
.3

.9 P
3

P
3

.9
, 

Data mapping is missing in 

metasearch

P
.3

.1
0

P
3

P
3

.9
, 

Data mapping is missing in 

metasearch

P
.3

.1
1

P
3

P
3

.9
, 

Data mapping is missing in 

metasearch

P
.3

.1
2

P
3

P
3

.1
2

, 

Metasearch on 

unregistered category

P
.3

.1
3

P
3

P
3

.1
2

, 

Metasearch on 

unregistered category

P
.3

.1
4

P
3

P
3

.1
2

, 

Metasearch on 

unregistered category

P
.3

.1
5

P
3

P
3

.1
2

, 
P

3
.1

3
, 

Metasearch on 

unregistered category

  go in the 'Metasearch' tabexecute a simple search on euromuse selecCng 'exhibiCon music' as category

Delete euromuse data mapping from local system to HTO

go on 'Metasearch' and execute any simple search selecting 'euromuse' as data provider

Add euromuse data mapping from local system to HTO

Change euromuse data configuration in the semantic registry

go in the 'Metasearch' tab

execute a simple search on euromuse selecting 'exhibition music' as category

Restore euromuse data configuration in the semantic registry

Perform any simple search selecting euromuse as data provider, all as category

Restore euromuse query service access parameters
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 (and alternatives)

S
Q

1 Search all from Euromuse Return all possible information for all domains coming from 

Eurmuse. Use the Advanced Search area (same for all items marked 

SQxxx)

Output should contain title, shoth description, event location, event category, date range, url, vignette.

S
Q

2 Search All events Retun all possible events Output should be result list: see SQ1

S
Q

2
.1

S
Q

2 Search All events, 

Alternative 1

Retun all possible events Alternative 1: Output should be Detailed EN: contain title, short description, event location, event 

category, date range,  url, vignette, detailed description, price range. All text should be English

Comment from CP - so far the metasearch engine does handle "context" information (optional result 

fields, language preferences, etc.) so even if they are present in the query language then they are 

ignored

S
Q

3 Search All events within 

time frame

Retun all possible events within [1.4.2012, 30.04.2012 ] Output should be result list: see SQ1

Comment from CP - if you specify both start and end date you will get events whose time interval 

overlaps with the specified dates

S
Q

3
.1

S
Q

3 Search All events within 

time frame, alternative 1

Retun all possible events starting from 1.4.2012 Output should be result list: see SQ1

Alternative 1: give only Date 1

Comment from CP - if you specify only the start date you will get all events which ends after the 

specified date (independently from when they start)

S
Q

3
.2

S
Q

3 Search All events within 

time frame, alternative 2

Retun all possible events until 30.04.2012 Output should be result list: see SQ1

Alternative 2: give only date 2

Comment from CP - if you specify only the end date you will get all events which starts before the 

specified date (independently from when they end) - THEREFORE ALSO PAST EVENTS ARE RETRIEVED

S
Q

3
.3

S
Q

3 Search All events within 

time frame, Alternative 3

Retun all possible events and attractions within [1.4.2012, 

30.04.2012 ]

Output should be result list: see SQ1

Alternative 3: All events  during that period and all attractions at that date in the same query

Comment from CP: in this first version the query language is not able to handle queries joining different 

domains (e.g. events and attractions), colud be implemented in the metasearch engine but this is not 

jet available

S
Q

4 Search All events within 

locations

Retun all possible events in Berlin/Germany Output should be result list: see SQ1

S
Q

4
.1

S
Q

4 Search All events within 

locations

Retun all possible events in Germany Output should be result list: see SQ1

Alternative 1: In Germany (Country instead of given city)

S
e

a
rc

h
 Q

u
e

ry
 L

a
n

g
u

a
g

e
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S
Q

4
.2

S
Q

4 Search All events within 

locations

Retun all possible events in Frankfurt Output should be result list: see SQ1

Alternative 2: in FRA (IATA code for Frankfurt)

Comment from CP: HarmoNET tourism ontology uses the ISO 3166 two-letter (or ‘A2’) country codes 

and the full city name (not the IATA code)

S
Q

4
.3

S
Q

4 Search All events within 

locations

Retun all possible events in Italy Output should be result list: see SQ1

Alternative 3: in IT (ISO code for Italy)

S
Q

4
.4

S
Q

4 Search All events within 

locations

Retun all possible events in Biella or Berlin Output should be result list: see SQ1

Alternative 4: in Biella or Berlin

S
Q

4
.5

S
Q

4 Search All events within 

locations

Retun all possible events in Biella or Berlin within 

[1.4.2012,30.04.2012]

Output should be result list: see SQ1

Alternative 5: in Biella or Berlin within a certain period

S
Q

4
.6

S
Q

4 Search All events within 

locations

Retun all possible events in Biella within [1.4.2012,30.04.2012] or 

Berlin within [1.5.2012,31.05.2012]

Output should be result list: see SQ1

Alternative 6: in Biella within a certain period or Wien within another period

S
Q

4
.7

S
Q

4 Search All events within 

locations

Retun all possible events in Bertlin if no attractions Output should be result list: see SQ1

Alternative 7: in Berlin at that date if there is no attraction (in Berlin at that date)

Comment from CP - alternative 7: in this first version the query language is not able to handle queries 

joining different domains (e.g. events and attractions)

S
Q

5 Search All events for 

certain categories

Retun all possible events in Biella corresponding to cultural Output should be result list: see SQ1

S
Q

5
.1

S
Q

5 Search All events for 

certain categories

Retun all possible events in Berlin  corresponding to modern art 

exhibitions or sculpture exhibitions

Output should be result list: see SQ1

Alternative 1: in Berlin  corresponding to modern art exhibitions or sculpture exhibitions

S
Q

5
.2

S
Q

5 Search All events for 

certain categories

Retun all possible events in Berlin or Biella corresponding to 

modern art exhibitions

Output should be result list: see SQ1

Alternative 2:  in Berlin or Biella or corresponding to modern art exhibitions

S
Q

5
.3

S
Q

5 Search All events for 

certain categories

Retun all possible events in Berlin or Biella corresponding to 

modern art exhibitions during that period

Output should be result list: see SQ1

Alternative 3:  in Berlin or Biella corresponding to modern art exhibitions during that period

S
Q

5
.4

S
Q

5 Search All events for 

certain categories

Retun all possible events in Biella corresponding to sport or cultural 

in that period and the events in Berlin corresponding to modern art 

exhibition or sculpture exhibition in the same period

Output should be result list: see SQ1

Alternative 4:  in Biella corresponding to sport or cultural in that period and in Berlin corresponding to 

modern art exhibition or sculpture exhibition in the same period
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 (and alternatives)

S
Q

5
.5

S
Q

5 Search All events for 

certain categories

Retun all possible events in Biella corresponding to cultural in that 

period and the events in Berlin corresponding to modern art 

exhibition in the same period

Output should be result list: see SQ1

Alternative 5:  in Biella corresponding to cultural in that period and in Berlin corresponding to modern 

art exhibition in the same period

S
Q

6 Search All events using 

geo coordinates

Search All events around a certain gps pont and a radius Output: Should be result list: see SQ1

Comment from CP: not yet handled geo coordinates

S
Q

6
.1

S
Q

6 Search All events using 

geo coordinates

Search All events between a certain gps upper left corner and lower 

right corner

Output: Should be result list: see SQ1

Alternative 1: Provide geo point of upper left corner and lower right corner

Comment from CP: not yet handled geo coordinates

P
3

.1
6

P
3 Content of the 

Metasearch page

Overall structure of meta search page. Simple, advanced and 

response block will be detailed in different area

Describe in the test partition improvements if necessary

P
3

.1
7

P
3 Content of the Simple 

Search

Simple search area Describe in the test partition improvements if necessary

P
3

.1
8

P
3 Content of the Advanced 

Search

Advanced search area Describe in the test partition improvements if necessary

P
3

.1
9

P
3 Content of the Result area Result list area Describe in the test partition improvements if necessary

P
3

.2
0

P
3 Documentation of the 

Metasearch Page

Link to the documentation Describe in the test partition improvements if necessary

P Push Data A user pushes a data file to some other HarmoSearch organization

P
.4

.1 P
4

P
4

.1
, 

P
4

.2
, 

Push without permission

M
e

ta
se

a
rc

h
E

x
ch

a
n

g
e

:P
u

sh
.D

a
ta

delete the permission 'PUSH to euromuse'
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 (and alternatives)

P
.4

.2 P
4

P
4

.1
, 

P
4

.2
, 

Push without permission

P
.4

.3 P
4

P
4

.1
, 

P
4

.2
, 

Push without permission

P
.4

.4 P
4

P
4

.1
, 

P
4

.2
, 

Push without permission

P
.4

.5 P
4

P
4

.1
, 

P
4

.2
, 

Push without permission

P
.4

.6 P
4 Push with missing data file 

or receiver

log in with your user

go on 'Exchange Data' ->'Push Data'

click on 'Send' without selecting a file to send (or without selecting 

any receiver)

You can use any file in this test case

P
.4

.7 P
4 Push with missing data 

mapping file

P
.4

.8 P
4

P
4

.8
, 

Push data file not 

compliant with your 

mapping file

P
.4

.9 P
4

P
4

.8
, 

P
4

.9 Push data file not 

compliant with your 

mapping file

E
x

ch
a

n
g

e
:P

u
sh

.D
a

ta

Add  data mapping from local system to HTO

log in with your user

go on 'Exchange Data' ->'Push Data'

select 'CPR' as receiver and 'harmonise_to_push.xml' (available in the test folder) as data file 

click on 'Send'

log in with your user

go on 'Exchange Data' ->'Push Data'

add the permission 'PUSH to euromuse' with  past dates

log in with your user

go on 'Exchange Data' ->'Push Data'

modify the permission 'PUSH to euromuse'

Prerequisite: mapping file from local system to Harmonise ontology must not be available for your organization (check in 'Configurations' -> 'Mapping Store', and if necessary 

delete it)

log in with your user

go on 'Exchange Data' ->'Push Data'

select 'CPR' as receiver and 'euromuse_to_push.xml' (available in the test folder) as data file 
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 (and alternatives)

P
.4

.1
0

P
4 Push data file to receiver 

which has not provided 

data mapping towards its 

local system: euromusemf

P
.4

.1 P
4

P
4

.1
1 Upload data mapping file

P
.4

.1
2

P
4

P
4

.1
1

, 
P

4
.1

2 Push data file to multiple 

receivers

P
.4

.1
3

P
4

P
4

.1
3

, 

Push to provider that has 

personalized the location 

where to send the data

P
.4

.1
4

P
4

P
4

.1
3

, 
P

4
.1

4
, 

Push to provider that has 

personalized the location 

where to send the data

log in with your user

go on 'Push Data' and use 'euromuse_to_push' as data file and 

select euromuse as receiver

This test case can only be tested partially by the user. The confirmation of the remote euromuse 

service administrator is required.

P
.4

.1
5

P
4

P
4

.1
3

, 

Push to provider that has 

personalized the location 

where to send the data

P
.4

.1
6

P
4 Content of the Push data 

page

Overall structure of page + Blocks included in the page. Describe in the test partition improvements if necessary

P
.4

.1
7

P
4 Documentation of the 

Push Data Page

Link to the documentation Describe in the test partition improvements if necessary

P Import Data  A user imports data from some  providers by using the search fields of the  interface or by posting directly HarmoSearch queries in the text area

P
.5

.1 P
5

P
5

.1
, 

P
5

.2
, 

Import without 

permissions to query

E
x

ch
a

n
g

e
:I

m
p

o
rt

.D
a

ta

Add  data mapping from local system to HTO

log in with your user

go on 'Exchange Data' ->'Push Data'

select 'euromuse' and 'CPR' as receivers and 'euromuse_to_push.xml' (available in the test folder) as data file 

click on 'Send'

configure euromuse service to receive data as HTTP service

configure euromuse service to receive data as Web Portal GUI

delete the permission 'QUERY to euromuse' 

log in with your user

go on 'Exchange Data' ->'Push Data'

select 'euromusemf' as receiver and 'euromuse_to_push.xml' (available in the test folder) as data file 

click on 'Send'
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P
.5

.2 P
5

P
5

.1
, 

P
5

.2
, 

Import without 

permissions to query

P
.5

.3 P
5

P
5

.1
, 

P
5

.2
, 

Import without 

permissions to query

P
.5

.4 P
5

P
5

.1
, 

P
5

.2
, 

Import without 

permissions to query

P
.5

.5 P
5

P
5

.1
, 

P
5

.2
, 

Import without 

permissions to query

Import wfrom simple 

query without query 

mapping

log in with your user

go on 'Exchange Data' ->'Import Data'

use a simple query

P
.5

.6 P
5 Import with invalid query

P
.5

.7 P
5 Import with unavailable 

registry

Prerequisite: the registry has been shut down

perform any kind of simple or advanced import

Post: start the registry again

This test case can only be tested by the system administrator.

P
.5

.8 P
5

P
5

.8
, 

Query mapping is missing 

in import

Delete euromuse query mapping then go to next cell

P
.5

.9 P
5

P
5

.8
, 

P
5

.9
, 

Query mapping is missing 

in import

E
x

ch
a

n
g

e
:I

m
p

o
rt

.D
a

ta

log with your user, go in 'Import Data' and execute a simple search selecting just 'euromuse' as data provider

log in with your user

go on 'Exchange Data' ->'Import Data'

add the permission 'QUERY to euromuse'  with wrong dates

log in with your user

go on 'Exchange Data' ->'Import Data'

modify the permission 'QUERY to euromuse' 

log in with your user

go on 'Exchange Data' ->'Import Data'

perform an advanced search with an incorrect HarmoSearch query (you can use for instance the test quer y 'SQ0_invalid_import_query.xml')
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P
.5

.1
0

P
5

P
5

.8
, 

Query mapping is missing 

in import

P
.5

.1
1

P
5

P
5

.1
1

, 

Data mapping of remote 

provider is missing in 

import

P
.5

.1
2

P
5

P
5

.1
1

, 
P

5
.1

2
, 

Data mapping of remote 

provider is missing in 

import

P
.5

.1
3

P
5

P
5

.1
1

, 

Data mapping of remote 

provider is missing in 

import

P
.5

.1
4

P
5 Own data mapping is 

missing in import

P
.5

.1
5

P
5

P
5

.1
5

, 
P

5
.1

6
, 

Data provider is 

unavailable in import

P
.5

.1
6

P
5

P
5

.1
5

, 
P

5
.1

6
, 

Data provider is 

unavailable in import

P
.5

.1
7

P
5

P
5

.1
5

, 

Data provider is 

unavailable in import

P
.5

.1
8

P
5 Import on unregistered 

category

P
.5

.1
9

P
5

P
5

.1
9

, 

Import all from euromuse 

with Advanced Search

Add euromuse query mapping

Delete euromuse data mapping from local system to HTO

log with your user, go in 'Import Data' and execute a simple search selecting just 'euromuse' as data provider

Add euromuse data mapping from local system to HTO

Prerequisite: mapping file from Harmonise ontology to local system must not be available for your organization (check in 'Configurations' -> 'Mapping Store', and if necessary 

delete it)

log with your user

go on 'Exchange Data'->'Import Data' and perform an import from 'euromuse' selecting 'exhibition ancient world'
Misconfigure euromuse query service access parameters

perform an import through Simple Search setting euromuse as data provider, all as category

Restore euromuse query service access parameters

perform an import through Simple Search setting euromuse as data provider, 'activity' as category

Add  data mapping from HTO to  local system
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Name Description

Comment

 (and alternatives)

P
.5

.2
0

P
5

P
5

.1
9

, 
P

5
.2

0 Import all from euromuse 

with Advanced Search

P
.5

.2
1

P
5

P
5

.2
1

, 
P

5
.2

2 Import using Simple 

Search

P
.5

.2
2

P
5

P
5

.2
1

, 
P

5
.2

2 Import using Simple 

Search

P
.5

.2
3

P
5

P
5

.2
3

, 

Import as provider that 

has personalized the 

location where to send 

the import result data

P
.5

.2
4

P
5

P
5

.2
3

, 
P

5
.2

4
, 

Import as provider that 

has personalized the 

location where to send 

the import result data

go on 'Import Data' and execute an import selecting 'biella' as data 

provider (imports everything)

This test case can only be tested partially by the user. The confirmation of the remote euromuse 

service administrator is required.

The results file will be available also in the 'Querybox', although it is configured to be sent to the HTTP 

service.

P
.5

.2
5

P
5

P
5

.2
3

, 

Import as provider that 

has personalized the 

location where to send 

the import result data

P
.5

.2 P
5 Content of the import 

data page

Overall structure of page + Blocks included in the page. Describe in the test partition improvements if necessary

P
.5

.2
7

P
5 Documentation of the 

Import Data Page

Link to the documentation Describe in the test partition improvements if necessary

P Scheduler A user schedules an import or a push operation to be executed on a regular base (daily, weekly or monthly)

P
.6

.1 P
6

P
6

.1
, 

Schedule a data import 

correctly

E
x

ch
a

n
g

e
:S

ch
e

d
u

le
r

Add  data mapping from HTO to  local system

perform an import through Simple Search setting all as data provider, all as category, 1-31 March as period

configure your service to receive import data as HTTP service

configure your service to receive import data as Web Portal GUI

Add  data mapping from HTO to  local system

perform an import through Advanced Search using 'SQ1_for_import.xml'
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n

A
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n

Name Description

Comment

 (and alternatives)

P
.6

.2 P
6

P
6

.1
, 

P
6

.2 Schedule a data import 

correctly

log in with your user

go on 'Exchange Data'->'Scheduler' and select

   IMPORT Data as Operation

   euromuse as recipient

   exhibition art history as category

   each day at hh mm in scheduled options (see comment!)

   click 'Schedule task'

The HarmoSearch portal server has GMT time. You must therefore subtract 1 hour to the time you want 

the operation to be scheduled (that is true if your time is GMT+1).

P
.6

.3 P
6 Schedule with unavailble 

registry

Prerequisite: the registry has been shut down

perform any kind of scheduled import

Post: start the registry again

This test case can only be tested by the system administrator.

P
.6

.4 P
6 Schedule a push with no 

data provider attached

Prerequisite: your organization has no data provider attached 

(check in 'Configurations'->'Query Service' and select your 

organization in Registry Data Management: there should be no Data 

Provider Attached; otherwise delete it)

logged in with your user

go on 'Exchange Data'->'Scheduler' and select

   PUSH Data as Operation

   CPR as recipient

   exhibition ancient world as category

   each day at hh mm in scheduled options (see comment!)

   click 'Schedule task'

The HarmoSearch portal server has GMT time. You must therefore subtract 1 hour to the time you want 

the operation to be scheduled (that is true if your time is GMT+1).

P
.6

.5 P
6

P
6

.5
, 

P
6

.6
, 

Schedule a push correctly

P
.6

.6 P
6

P
6

.5
, 

P
6

.6
, 

Schedule a push correctly

P
.6

.7 P
6

P
6

.5
, 

P
6

.6
, 

Schedule a push correctly

E
x

ch
a

n
g

e
:S

ch
e

d
u

le
r

Attach a data provider to your organisation

Add query mappings for your organisation

Add  data mapping from local system to HTO
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Name Description

Comment

 (and alternatives)

P
.6

.8 P
6

P
6

.5
, 

P
6

.6
, 

P
6

.7
, 

Schedule a push correctly log in with your user

go on 'Exchange Data'->'Scheduler' and select

   PUSH Data as Operation

   CPR as recipient

   exhibition ancient world as category

   each day at hh mm in scheduled options (see comment!)

   click 'Schedule task'

The HarmoSearch portal server has GMT time. You must therefore subtract 1 hour to the time you want 

the operation to be scheduled (that is true if your time is GMT+1). In a scheduled push the user does 

not upload a file but he submits a query that allows the system to automatically export the data to be 

sent from his system, therefore the user needs to register a query service and to upload a query 

mapping to use this functionality.

P
.6

.9 P
6

P
6

.5
, 

P
6

.6
, 

Schedule a push correctly

P
.6

.1 P
6 Content of the scheduler 

page

Overall structure of page + Blocks included in the page. Describe in the test partition improvements if necessary

P
.6

.1
1

P
6 Documentation of the 

Scheduler Page

Link to the documentation Describe in the test partition improvements if necessary

P
P

.7
.1 P
7

P
7

.1
, 

Check status of push in 

'operation status'

P
.7

.2 P
7

P
7

.1
, 

P
7

.2 Check status of push in 

'operation status'

P
.7

.3 P
7

P
7

.3
, 

Check status of import in 

'operation status'

P
.7

.4 P
7

P
7

.3
, 

P
7

.4 Check status of import in 

'operation status'

P
.7

.5 P
7 Content of the page Overall structure of page + Blocks included in the page. Describe in the test partition improvements if necessary

P
.7

.6 P
7 Documentation of the 

page

Link to the documentation Describe in the test partition improvements if necessary

P
P

.8
.1 P
8

P
8

.1
, 

Check results of push in 

'Inbox'

E
x

ch
a

n
g

e
:O

p
e

ra
ti

o
n

.S
ta

tu
s

D
a

ta
:I

n
b

o
x

log in with your user

go on 'Exchange Data' ->'Operation Status'

Execute a push operation

Delete data provider attached to your organisation

Execute a push operation

log in with your user

go on 'Exchange Data' ->'Operation Status'

Execute an import operation
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Name Description

Comment

 (and alternatives)

P
.8

.2 P
8

P
8

.1
, 

Check results of push in 

'Inbox'

P
.8

.

P
8 Content of the page Overall structure of page + Blocks included in the page. Describe in the test partition improvements if necessary

P
.8

.4 P
8 Documentation of the 

page

Link to the documentation Describe in the test partition improvements if necessary

P
P

.9
.1 P
9

P
9

.1
, 

Check results of push in 

'Outbox'

P
.9

.2 P
9

P
9

.1
, 

Check results of push in 

'Outbox'

P
.9

.3 P
9 Content of the page Overall structure of page + Blocks included in the page. Describe in the test partition improvements if necessary

P
.9

.4 P
9 Documentation of the 

page

Link to the documentation Describe in the test partition improvements if necessary

P
P

.1
0

.

P
1

0

P
1

0
.1 Check results of push in 

'Sentbox'

P
.1

0
.2

P
1

0

P
1

0
.1

, 

Check results of push in 

'Sentbox'

P
.1

0
.

P
1

0 Content of the page Overall structure of page + Blocks included in the page. Describe in the test partition improvements if necessary

P
.1

0
.4

P
1

0 Documentation of the 

page

Link to the documentation Describe in the test partition improvements if necessary

P
P

.1
1

.

P
1

1

P
1

1
.1 Check results of push in 

'Querybox'

P
.1

1
.2

P
1

1

P
1

1
.1

, 

Check results of push in 

'Querybox'

P
.1

1

P
1

1 Content of the page Overall structure of page + Blocks included in the page. Describe in the test partition improvements if necessary

D
a

ta
:S

e
n

tb
o

x
D

a
ta

:Q
u

e
ry

b
o

x
D

a
ta

:O
u

tb
o

x
log in with euromuse (euromuse@harmonet.org, euromuse)

go on 'Data Repository' ->'Inbox'

Execute an unsuccessful push operation

log in with your user

go on 'Data Repository' ->'Outbox'

Execute a successful push operation

log in with your user

go on 'Data Repository' ->'Sentbox'

Execute a successful import operation

log in with your user

go on 'Data Repository' ->'Querybox'
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n
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S
e

q
u

e
n

A
ct
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n

Name Description

Comment

 (and alternatives)

P
.1

1
.4

P
1

1 Documentation of the 

page

Link to the documentation Describe in the test partition improvements if necessary

P
1

2
P

.1
2

.1

P
1

2 delete the permission 

'PUSH to euromuse'

P
.1

2
.2

P
1

2 add the permission 'PUSH 

to euromuse' with wrong 

dates

P
.1

2
.3

P
1

2 modify the permission 

'PUSH to euromuse'

P
.1

2
.4

P
1

2 delete the permission 

'QUERY to euromuse' 

P
.1

2
.5

P
1

2 add the permission 

'QUERY to euromuse' with 

wrong dates

P
.1

2
.6

P
1

2 modify the permission 

'QUERY to euromuse'

P
.1

2

P
1

2 Content of the page Overall structure of page + Blocks included in the page. Describe in the test partition improvements if necessary

P
.1

2
.8

P
1

2 Documentation of the 

page

Link to the documentation Describe in the test partition improvements if necessary

P
1

3
P

.1
3

.1

P
1

3 Upload data mapping file 

from local system to 

Harmonise ontology

P
.1

3
.2

P
1

3 Delete data mapping file 

from local system to 

Harmonise ontology

P
.1

3
.3

P
1

3 Upload data mapping 

from Harmonise ontology 

to local system

C
o

n
fi

g
u

ra
ti

o
n

s:
A

cc
e

ss
.P

o
li

ci
e

s
C

o
n

fi
g

u
ra

ti
o

n
s:

M
a

p
p

in
g

.S
to

re

log in as euromuse (euromuse@harmonet.org, euromuse)

go on 'Configurations'->'Access Policies'

delete the permission 'All can QUERY to euromuse' if it exists

log in as euromuse (euromuse@harmonet.org, euromuse)

go on 'Configurations'->'Access Policies'

add the permission 'All can QUERY to euromuse' setting start date to 1/2/2012 and end date to 29/2/2012

log in as euromuse (euromuse@harmonet.org, euromuse)

go on 'Configurations'->'Access Policies'

modify the permission 'All can QUERY to euromuse' removing all the constraints

log in with your user. go on 'Configurations'->'Mapping Store'. choose 'Upload mapping from local system to Harmonise ontology (for sending data)'. Select the mapping 

from local system to Harmonise ontology (you can choose the file available in the test folder as 'Euromuse_HTO.xslt'). click on 'Send' and check for the success message on 

top of the page
log with your user. go on 'Configurations'->'Mapping Store'. delete the data mapping file from local system to Harmonise Ontology if it exists

log in with your user. go on 'Configurations'->'Mapping Store'. choose 'Upload mapping from Harmonise ontology to local system (for importing/receiving data)'. select the 

mapping from Harmonise ontology to local system (you can choose the file available in the test folder as 'HTO_Euromuse.xslt'). click on 'Send' and check for the success 

message on top of the page

log in as euromuse (euromuse@harmonet.org, euromuse)

go on 'Configurations'->'Access Policies'

delete the permission 'All can PUSH to euromuse' if it exists
log in as euromuse (euromuse@harmonet.org, euromuse)

go on 'Configurations'->'Access Policies'

add the permission 'All can PUSH to euromuse' setting start date to 1/2/2012 and end date to 29/2/2012
log in as euromuse (euromuse@harmonet.org, euromuse)

go on 'Configurations'->'Access Policies'

modify the permission 'All can PUSH to euromuse' removing all the constraints
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S
e
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u

e
n

A
ct
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n

Name Description

Comment

 (and alternatives)

P
.1

3
.4

P
1

3 Delete data mapping from 

Harmonise ontology to 

local system

P
.1

3
.5

P
1

3 Delete euromuse data 

mapping file

P
.1

3
.6

P
1

3 Upload euromuse data 

mapping file

P
.1

3
.7

P
1

3 Upload query mapping 

files

P
.1

3
.8

P
1

3 Delete query mapping 

files

P
.1

3
.9

P
1

3 Delete euromuse query 

mapping file

P
.1

3
.1

0

P
1

3 Upload euromuse query 

mapping file

P
.1

3
.1

1

P
1

3 Download Mapping Tool

P
.1

3
.1

2

P
1

3 Upload private support 

library for the mapping

go on 'Configurations'->'Mapping Store' 

upload any file in the 'Upload support library' portlet

This test case verifies only that the support library is uploaded. If it works correctly, linked with the 

actual mapping files, is tested in the Query and/or Data Mapping Validation.

P
.1

3
.1

3

P
1

3 Delete private support 

library for the mapping

P
.1

3

P
1

3 Content of the page Overall structure of page + Blocks included in the page. Describe in the test partition improvements if necessary

P
.1

3
.1

5

P
1

3 Documentation of the 

page

Link to the documentation Describe in the test partition improvements if necessary

P
P

.1
4

.1

P
1

4 Register a new data 

provider in the semantic 

registry

P
.1

4
.2

P
1

4 Delete a data provider 

from the semantic registry

C
o

n
fi

g
u

ra
ti

o
n

s:
Q

u
e

ry
.S

e
rv

ic
e

go on 'Configurations'->'Mapping Store' 

delete the private support library file from the box if it exists

login with your user

go in 'Configurations'->'Query Service' and select your organization in Registry Data Management

Create and attach a new Data Provider assigning as id <Your-organization_name>_dataprovider (no whitesapces!)
login with your user

go in 'Configurations'->'Query Service' and select your organization in Registry Data Management

select the Data Provider attached to your organisation if it exists

log with your user

go on 'Configurations'->'Mapping Store'

delete the data mapping file from Harmonise Ontology to local system if it exists
log in as 'euromuse' (euromuse@harmonet.org, euromuse)

go on 'Configurations'->'Mapping Store'

delete the data mapping file (10835_so.xslt) if it exists
log in as 'euromuse' (euromuse@harmonet.org, euromuse)

go on 'Configurations'->'Mapping Store'

choose 'Upload mapping from local system to Harmonise ontology (for sending data)'
log with your user

go on 'Configurations'->'Mapping Store'

choose 'Upload query mapping to translate HarmoSearch fields and enumerations'
log with your user

go on 'Configurations'->'Mapping Store'

delete the two query mapping files if they exist
log in as 'euromuse' (euromuse@harmonet.org, euromuse)

go on 'Configurations'->'Mapping Store'

delete the query structure mapping file (10835_query_os.xslt) if it exists
log in as 'euromuse' (euromuse@harmonet.org, euromuse)

go on 'Configurations'->'Mapping Store'

choose 'Upload query mapping to translate HarmoSearch query structure'
go on 'Configurations'->'Mapping Store' 

download the file within 'Download Mapping Tool', if it exists
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Comment
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P
.1

4
.3

P
1

4 Modify euromuse 

configuration in the 

semantic registry: change 

the Service Access 

Endpoint

P
.1

4
.4

P
1

4 Modify euromuse 

configuration in the 

semantic registry: restore 

the Service Access 

Endpoint

P
.1

4
.5

P
1

4 Modify euromuse 

configuration in the 

semantic registry: change 

a category

P
.1

4
.6

P
1

4 Modify euromuse 

configuration in the 

semantic registry: restore 

the category

P
.1

4

P
1

4 Content of the page Overall structure of page + Blocks included in the page. Describe in the test partition improvements if necessary

P
.1

4
.8

P
1

4 Documentation of the 

page

Link to the documentation Describe in the test partition improvements if necessary

P
1

5
P

.1
5

.1

P
1

5 Select to receive the data 

which are sent by other 

organisations through an 

HTTP service (for 

euromuse)

log in with user euromuse (euromuse@harmonet.org, euromuse)

go on 'Configurations' ->'Receive data'

select the 'receive data' row and click on 'Modify'

select 'HTTP service', insert as url, user and password: 

 http://www.euromuse.net/harmonise/sendfile/send.php

   karin, karin

Click on 'InitialiseDefault services' if there are no rows

P
.1

5
.2

P
1

5 Select to access the data 

which are sent by other 

organisations through the 

Web Portal GUI (for 

euromuse)

log in with user euromuse (euromuse@harmonet.org, euromuse)

go on 'Configurations' ->'Receive data'

select the 'receive data' row and click on 'Modify'

select 'Web Portal GUI'

Click on 'InitialiseDefault services' if there are no rows

C
o

n
fi

g
u

ra
ti

o
n

s:
Q

u
e

ry
.S

e
rv

ic
e

C
o

n
fi

g
u

ra
ti

o
n

s:
R

e
ce

iv
e

.D
a

ta
login with user euromuse (euromuse@harmonet.org, euromuse)

go in 'Configurations'->'Query Service' and select Euromuse in Registry Data Management

select the 'Euromuse Exhibitions' data provider

edit the service access endpoint inserting 'http://www.euromuse.net/harmonise' as service access endpoint (no whitespaces!)

'Save changes'
login with user euromuse (euromuse@harmonet.org, euromuse). go in 'Configurations'->'Query Service' and select Euromuse in Registry Data Management. select the 

'Euromuse Exhibitions' data provider. edit the service access endpoint inserting 'http://www.euromuse.net/harmonise/query/query.php' as service access endpoint (no 

whitesapces!). 'Save changes'

login with user euromuse (euromuse@harmonet.org, euromuse). go in 'Configurations'->'Query Service' and select Euromuse in Registry Data Management. select the 

'Euromuse Exhibitions' data provider. click on 'EDIT Data Description'. edit the text displayed in the text area changing 'exhibition music' with 'exhibition pop music'

login with user euromuse (euromuse@harmonet.org, euromuse).go in 'Configurations'->'Query Service' and select Euromuse in Registry Data Management. select the 

'Euromuse Exhibitions' data provider. click on 'EDIT Data Description'. edit the text displayed in the text area changing 'exhibition pop music' with 'exhibition music'
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P
.1

5
.3

P
1

5 Select to receive the data 

imported by other 

organisations through an 

HTTP service

log in with your user

go on 'Configurations'->'Receive Data'

select the 'receive query results' row and click on 'Modify'

select 'HTTP service', insert as url, user and password: 

   http://www.euromuse.net/harmonise/sendfile/send.php (no 

whitespaces!)

   karin, karin

Click on 'InitialiseDefault services' if there are no rows

P
.1

5
.4

P
1

5 Select to access the data 

imported by other 

organisations through the 

Web Portal GUI

log in with your user

go on 'Configurations'->'Receive Data'

select the 'receive query results' row and click on 'Modify'

select 'Web Portal GUI'

Click on 'InitialiseDefault services' if there are no rows

P
.1

5

P
1

5 Content of the page Overall structure of page + Blocks included in the page. Describe in the test partition improvements if necessary

P
.1

5
.6

P
1

5 Documentation of the 

page

Link to the documentation Describe in the test partition improvements if necessary

P
1 Data Mapping Validation The user checks his data mappings by uploading an instance file and checking the results of the transformation

P
.1

6
.1

P
1

6 Check mapping with 

missing instances file

P
.1

6
.2

P
1

6 Check forward mapping 

with missing mapping file

P
.1

6
.3

P
1

6 Check backward mapping 

with missing mapping file

P
.1

6
.4

P
1

6

P
1

6
.4

, 

Check forward mapping 

with instance data not 

compliant to mapping

P
.1

6
.5

P
1

6

P
1

6
.4

, 

Check forward mapping 

with instance data not 

compliant to mapping

P
.1

6
.6

P
1

6

P
1

6
.6

, 

Check backward mapping 

with instance data not 

compliant to mapping

P
.1

6
.7

P
1

6

P
1

6
.6

, 

Check backward mapping 

with instance data not 

compliant to mapping

P
.1

6
.

P
1

6

P
1

6
.8 Check forward mapping 

successfully

M
a

p
p

in
g

:D
a

ta
.M

a
p

p
in

g
.V

a
li

d
a

ti
o

n

Add  data mapping from local system to HTO

go on 'Data Mapping Validation' and in the Forward Mapping Validation portlet select HarmoNET as output format using 'harmonise_to_push.xml' (in test folder) as instance 

data file

Add  data mapping from HTO to  local system

go on 'Data Mapping Validation' and in the Backward Mapping Validation portlet select HarmoNET as input format using 'euromuse_to_push.xml' (in test folder) as instance 

data file

Add  data mapping from local system to HTO

log in with your user

go on 'Mapping Validation'->'Data Mapping Validation'

do a Forward mapping without selecting any file
Prerequisite: mapping file from local system to Harmonise ontology must not be available for your organization (check in 'Configurations' -> 'Mapping Store', and if necessary 

delete it). go on 'Data Mapping Validation' and in the Forward Mapping Validation portlet select HarmoNET as output format using 'euromuse_to_push.xml' (in test folder) 

as instance data file
Prerequisite: mapping file from Harmonise ontology to local system must not be available for your organization (check in 'Configurations' -> 'Mapping Store', and if necessary 

delete it). go on 'Data Mapping Validation' and in the Backward Mapping Validation portlet  select HarmoNET as input format using 'harmonise_to_push.xml' (in test folder) 

as instance data file
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n

A
ct

io
n

Name Description

Comment

 (and alternatives)

P
.1

6
.9

P
1

6

P
1

6
.8

, 
Check forward mapping 

successfully

P
.1

6
.1

P
1

6

P
1

6
.1

0 Check backward mapping 

successfully

P
.1

6
.1

1

P
1

6

P
1

6
.1

0
, 

Check backward mapping 

successfully

P
.1

6

P
1

6 Content of the page Overall structure of page + Blocks included in the page. Describe in the test partition improvements if necessary

P
.1

6
.1

3

P
1

6 Documentation of the 

page

Link to the documentation Describe in the test partition improvements if necessary

P
1

7 Query Mapping Validation The user checks his query mappings by uploading a test query and checking the results of the transformation

P
.1

7
.1

P
1

7 Check query mapping with 

missing or wrong query

P
.1

7
.2

P
1

7 Check query mapping with 

missing query mapping 

file

P
.1

7
.

P
1

7

P
1

7
.3 Check query mapping with 

success

P
.1

7
.4

P
1

7

P
1

7
.3

, 

Check query mapping with 

success

P
.1

7

P
1

7 Content of the page Overall structure of page + Blocks included in the page. Describe in the test partition improvements if necessary

P
.1

7
.6

P
1

7 Documentation of the 

page

Link to the documentation Describe in the test partition improvements if necessary

P Web Services A user of an external system (or the system itself) invokes an operation on the  platform through a Web Service instead of the GUI

P
.1

8
.1

P
1

8 SimpleSearch import 

through Web Service with 

wrong or missing 

parameters

perform an import with 'simpleSearch' method with one or more of 

the following wrong or missing (null) parameters:

   a null sender or wrong name

   wrong name of some receiver

   a date format in search_criteria different from 'dd.mm.yyyy'

   a country code that is not two-letter code from ISO 3166-1

To be tested using Oxygen or XMLSpy or similar. 

WSDL: http://harmosearchdev.harmonet.org/WebAccessPortal-portlet/DataExchangeManager?wsdl

P
.1

8
.2

P
1

8

P
1

8
.2

, 

SimpleSearch import 

correctly through Web 

Service

M
a

p
p

in
g

:Q
u

e
ry

.M
a

p
p

in
g

.V
a

li
d

a
ti

o
n

W
e

b
.S

e
rv

ic
e

s

Add  data mapping from HTO to  local system

Add  data mapping from HTO to  local system

go on 'Data Mapping Validation' and in the Backward Mapping Validation portlet  select HarmoNET as input format using 'harmonise_to_push.xml' (in test folder) as instance 

data file

go on 'Mapping Validation'->'Query Mapping Validation' and do not insert any query, or the invalid query of 'SQ0_invalid_metasearch_query.xml' in the test folder

Prerequisite: query mapping file for your organisation must not be available (check in 'Configurations' -> 'Mapping Store', and if necessary delete them)

log in with your user
Add query mappings for your organisation

log in with your user

go on 'Query Mapping Validation' 

insert the test query 'SQ1.xml' available in the test folder

go on 'Data Mapping Validation' and in the Forward Mapping Validation portlet select HarmoNET as output format using 'euromuse_to_push.xml' (in test folder) as instance 

data file
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Id P
a

re
n

t

S
e

q
u

e
n

A
ct

io
n

Name Description

Comment

 (and alternatives)

P
.1

8
.3

P
1

8

P
1

8
.2

, 
P

1
8

.3 SimpleSearch import 

correctly through Web 

Service

perform an import with 'simpleSearch' method using your 

organization's name as sender, 'euromuse' as receiver and void (not 

null!) search_criteria

Same as P18.1

P
.1

8
.4

P
1

8 AdvancedSearch import 

through Web Service with 

wrong or missing 

parameters

perform an import with 'advancedSearch' method with one or more 

of the following wrong or missing (null) parameters:

   a null sender or wrong name

   a null xml_query parameter

   'SQ0_invalid_import_query' (from test folder) as  xml_query 

Same as P18.1

P
.1

8
.5

P
1

8

P
1

8
.5

, 

AdvancedSearch import 

correctly through Web 

Service

P
.1

8
.6

P
1

8

P
1

8
.5

, 
P

1
8

.6 AdvancedSearch import 

correctly through Web 

Service

perform an import with 'advancedSearch' method using your 

organization's name as sender, and 'SQ1_for_import.xml' (from test 

folder) as xml_query

Same as P18.1

P
.1

8
.7

P
1

8 Push data file through 

Web Service with wrong 

or missing parameters

perform an import through 'pushData' method with one or more of 

the following parameters wrong or missing:

   sender null or with wrong name

   receivers null or with some wrong name

   xml_file null, is not available on the file system, or is not 

compliant with the expected format (you can use 

'harmonise_to_push.xml', available in the test folder) 

Same as P18.1

P
.1

8
.8

P
1

8

P
1

8
.8

, 

Push data file through 

Web Service correctly to 

multiple receivers

P
.1

8
.9

P
1

8

P
1

8
.8

, 
P

1
8

.9 Push data file through 

Web Service correctly to 

multiple receivers

perform an import through 'pushData' method, setting your 

organization's name as sernder, 'euromuse' and 'CPR' as receivers, 

and using 'euromuse_to_push.xml' (available in the test folder) as 

xml_file

Same as P18.1

P
.1

8
.1

0

P
1

8 Content of the 

documentation

See 'Annex_D_4_3_Web Service APIs Specifications_v0.2.docx' file 

available in SVN at /04_Query_Mapping/metasearch engine

Describe in the test partition improvements if necessary

Add  data mapping from HTO to  local system

Add  data mapping from  local system to HTO
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Id
P

0
P

0
.1

P
0

.2
P

0
.3

P
P

1
.1

P
1

.2
P

1
.3

P
1

.4
P

1
.5

P
1

.6

Expected Output 7
/3

/1
2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result

W D

F

I would expect a more direct home page to sign in 

with capacity to login directly or to access new 

account. I would also expect to see some text 

detailing either what I get if I register or that 

redirects me to an information page (not present 

now)

O AV ok, to be improved communication but 

next release

W D

F

Displays panel Ok ! I think we should have 

additional feature, like a panel to know what new 

partner is present otherwise why would I want to 

register and I therefore may not the inforation if I 

do not go to the list. We may want also to have a 

list of data that was exchanged since last login (like 

what batches happened.

O AV ok, to be improved communication but 

next release

- C

P

R

Not available in this release - D

F

- AV

Error message is shown: "You have entered invalid data. Please 

try again."  and "Please enter a valid [ first name | last name | 

screenname ]"

O C

P

R

Error message as expected O D

F

Error message as expected O AV

Error message is shown: "You have entered invalid data. Please 

try again."  and "Please enter a valid email address."

O C

P

R

Error message as expected O D

F

Error message as expected O AV

Error message is shown: "You have entered invalid data. Please 

try again."  and "Text verification failed."

O C

P

R

Error message as expected O D

F

Error message as expected O AV

Success message on the screen. An e-mail is sent to  the user to 

notify the registration and communicate the password.

O C

P

R

Success message

Confirmation email has arrived

O D

F

Success message

Confirmation email has arrived, but went to spams

O AV

An e-mail is sent to the administrator to notify the new account 

and new organisation creation.

O C

P

R

Two emails have arrived: one 

asking to activate the user and 

another one asking to configure 

the new organization

O D

F

Two emails have arrived: one asking to activate the 

user and another one asking to configure the new 

organization

O AV

Error message is shown: "You have entered invalid data. Please 

try again."  and "The [ email address | screen name ] you 

requested is already taken."

O C

P

R

Error message as expected O D

F

Error message as expected O AV
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Id
P

1
.7

P
1

.8
P

1
.9

P
1

.1
0

P
1

.1
1

P
 

P
2

.1
P

2
.1

P
2

.2
P

2
.3

P
2

.4

Expected Output 7
/3

/1
2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result

Success message on the screen

An e-mail is sent to  the user to notify the registration and 

communicate the password.

O C

P

R

Success message

Confirmation email has arrived

O D

F

Success message

Confirmation email has arrived

O AV

An e-mail is sent to  the user to notify the activation of the 

account.

O C

P

R

Activation notification email 

has arrived

O D

F

Activation notification email has arrived O AV

AV

- C

P

R

Not available in this release - D

F

- AV

C

P

R

Not available in this release W D

F

Emails were received. However, 

first emails comes from: HarmoNET Administrator 

[support@harmonet.org]

second email comes from: support@harmonet.org

message is therefore not so clear.

First email contains link to signin, second email 

does not contain the link.

O AV

reminder sentence must be created W D

F

I could enter the reminder, but was not prompted 

to change my password at the same time as the 

reminder phrase

W AV ok as david says (but minor issue for me)

X D

F

Error 404 on profile O AV worked to me

Error message is shown: "You have entered invalid data. Please 

try again."  and "Authentication failed. Please try again."

O C

P

R

Error message as expected O D

F

Error message as expected O AV

The users gets logged in into the home page of the portal. The 

user's first and last name are displayed in the top right corner. In 

this first page a table is shown summarizing the availability of 

the services for the logged in user.

O C

P

R

Got logged in into the 

personalized home page

O D

F

Got logged in into the personalized home page O AV

Status is 'Not Active' for all services, apart from Metasearch, for 

which no permissions nor mappings need to be set

O C

P

R

Content of services board as 

expected

W D

F

Content of services board as expected. I would 

have like the capacity to use a link to get more 

infomration on the different features porposed in 

the table, like, what is data mapping configuration 

because dscription provided minimal infomration 

on the row, but nothing on the column. It could 

just be text for instance.

W AV definetly here explanation is needed
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Id
P

2
.5

P
2

.6
P

2
.7

P
 3

P
.3

.0
P

.3
.1

P
.3

.2
P

.3
.3

P
.3

.4
P

.3
.5

Expected Output 7
/3

/1
2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result

Email is sent with new password O C

P

R

Email with new password 

received

W D

F

Email with link to enter a new password received. I 

like this feature, but it is not what is described in 

the expected behaviour

O AV for me is ok

O D

F

O AV

- C

P

R

Not available in this release - D

F

Not available in this release - AV

AV

I get results only in case some providers have all as allowed 

organisation.

W D

F

I get results though no query mapping has been 

setup. Logivccal as some accept all. We should 

have a test with nothing returned possibly

O AV for me is fine, i get results even if i do 

not define mapping

Error message is shown: "User query not valid against 

HarmoSearch query language XSD".

O C

P

R

Error message as expected W D

F

Error message as expected. But we could probably 

improve the error sentence

O AV maybe you could show also the error 

the validator produce

Error message is shown: "Impossible to connect to the data 

registry. Please contact the administrator".

O C

P

R

Error message as expected - D

F

- AV

AV

Error message: "Missing mapping for the query structure from 

Harmonise Ontology to euromuse".

O C

P

R

Error message as expected O D

F

Error message as expected O AV

AV
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Id
P

.3
.6

P
.3

.7
P

.3
.8

P
.3

.9
P

.3
.1

0
P

.3
.1

1
P

.3
.1

2
P

.3
.1

3
P

.3
.1

4
P

.3
.1

5

Expected Output 7
/3

/1
2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result

AV

Example error message: "Failed on euromusemf: Impossible to 

connect to provider".

O C

P

R

Error message as expected O D

F

Error message as expected O AV

AV

AV

Error message: "Missing data mapping from euromuse to 

Harmonise Ontology".

O C

P

R

Error message as expected O D

F

Error message as expected O AV

Error message: "There is no provider to query that matches your 

search criteria.".

O C

P

R

Error message as expected O D

F

Error message as expected W AV ok but tried  on a different provider 

(euromuse was working)

O C

P

R

1 data providers contacted: 

euromuse

43 results

W D

F

I get results (as expected. I think the expected info 

is wrong

CP: you are right, I corrected the expected output

W AV ok but tried  on a different provider 

(euromuse was working)

CP: you are right, I corrected the 

expected output

Appendix B.3 - Document 2 - Test Case Release 3 - Portal  - Page 25 on 63



Id
S

Q
1

S
Q

2
S

Q
2

.1
S

Q
3

S
Q

3
.1

S
Q

3
.2

S
Q

3
.3

S
Q

4
S

Q
4

.1

Expected Output 7
/3

/1
2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result

The metasearch process is asynchronous and the results can be 

visualised as soon as they become available.

In the result list it is possible to understand if the data comes 

from an external data source or from the local index.

O C

P

R

1 data provider contacted: 

euromuse

100 results

Note: for testing purpose we 

limited to 100 the maximum 

number of results which are 

retrieved from euromuse

O D

F

1 data provider contacted: euromuse

100 results

Note: for testing purpose we limited to 100 the 

maximum number of results which are retrieved 

from euromuse

O AV ok

Same as SQ1 O C

P

R

3 data providers contacted: 

euromuse, euromusemf, biella

364 results

O D

F

4 data providers contacted: 

364 results

O AV ok. Just as a comment, is important 

search by language

Same as SQ1 - C

P

R

Not available in this release - Not available in this release - AV

Same as SQ1 O C

P

R

3 data providers contacted: 

euromuse, euromusemf, biella

112 results

O D

F

4 data providers contacted:

212 results

O AV ok

Same as SQ1 O C

P

R

3 data providers contacted: 

euromuse, euromusemf, biella

113 results

O D

F

4 data providers contacted:

213 results

O AV ok

Same as SQ1 O C

P

R

3 data providers contacted: 

euromuse, euromusemf, biella

363 results

O D

F

4 data providers contacted: 

362 results + 1 error: Failed on CPR: Impossible to 

connect to provider

O AV ok

Same as SQ1 - C

P

R

Not available in this release - D

F

Not available in this release -

Same as SQ1 O C

P

R

2 data providers contacted: 

euromuse, euromusemf

192 results

O D

F

2 data providers contacted:

92 results. This one was quick

O AV ok tried also with IT rome and succeed

Same as SQ1 O C

P

R

2 data providers contacted: 

euromuse, euromusemf

230 results

O D

F

2 data providers contacted:

230 results

O AV ok
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Id
S

Q
4

.2
S

Q
4

.3
S

Q
4

.4
S

Q
4

.5
S

Q
4

.6
S

Q
4

.7
S

Q
5

S
Q

5
.1

S
Q

5
.2

S
Q

5
.3

S
Q

5
.4

Expected Output 7
/3

/1
2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result

Same as SQ1 - C

P

R

Not available in this release - D

F

Not available in this release -

Same as SQ1 O C

P

R

3 data providers contacted: 

euromuse, euromusemf, biella

118 results

O D

F

3 data providers contacted:

117 results

O AV ok

Same as SQ1 O C

P

R

3 data providers contacted: 

euromuse, euromusemf, biella

197 results

O D

F

3 data providers contacted: 194 results + 1 Error: 

Failed on biella: Error in translating the query for 

the provider

O AV ok, tried also to change Berlin in BAAAA 

(so to search only for biella), i got biella 

but also some wrong from euromuse. 

Probably an error in euromuse

Same as SQ1 O C

P

R

3 data providers contacted: 

euromuse, euromusemf, biella

82 results

O D

F

3 data providers contacted: 84 results. Twice. Tried 

again with 82 results + 1 error: Failed on 

euromusemf: Error in translating the query for the 

provide

O AV working, also dates looks ok

Same as SQ1 O C

P

R

3 data providers contacted: 

euromuse, euromusemf, biella

76 results

O D

F

3 data providers contacted: 78 results O AV OK

Same as SQ1 - C

P

R

Not available in this release - Not available in this release -

Same as SQ1 O C

P

R

1 data providers contacted: 

biella

1 result

O D

F

1 data providers contacted: biella. 1 result O AV ok, 1 results. The category is not shown, 

mapping problem?

Same as SQ1 O C

P

R

2 data providers contacted: 

euromuse, euromusemf

149 results

O D

F

2 data providers contacted: 149 results O AV

Same as SQ1 O C

P

R

2 data providers contacted: 

euromuse, euromusemf

50 results

O D

F

2 data providers contacted: 50 results O AV

Same as SQ1 O C

P

R

2 data providers contacted: 

euromuse, euromusemf, biella

3 results

O D

F

2 data providers contacted: 3 results O AV

Same as SQ1 O C

P

R

3 data providers contacted: 

euromuse, euromusemf, biella

25 results

O D

F

3 data providers contacted: 25 results O AV
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Id
S

Q
5

.5
S

Q
6

S
Q

6
.1

P
3

.1
6

P
3

.1
7

P
3

.1
8

P
3

.1
9

P
3

.2
0

P
P

.4
.1

Expected Output 7
/3

/1
2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result

Same as SQ1 O C

P

R

3 data providers contacted: 

euromuse, euromusemf, biella

3 results

O D

F

3 data providers contacted: 

3 results

O AV

Same as SQ1 - C

P

R

Not available in this release - D

F

Not available in this release -

Same as SQ1 - C

P

R

Not available in this release - D

F

Not available in this release -

W D

F

I would introduce a toggle between simple and 

complex search,

W AV

W D

F

provider names instead of codes, Begin instead of 

from and End insted of to, align cells and have 

hints. We should align better cells

W AV

W D

F

Some text would possibly help + a link to the query 

language documentation and examples (like access 

to our query examples + description of what they 

do.

W AV

W D

F

Could be interesting to have a small overview of 

results like which provider responded, how many 

results by provider (possibly for direct access or 

filtering…)

W AV

- C

P

R

Not available in this release - D

F

Not available in this release -
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Id
P

.4
.2

P
.4

.3
P

.4
.4

P
.4

.5
P

.4
.6

P
.4

.7
P

.4
.8

P
.4

.9

Expected Output 7
/3

/1
2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result

Either an error message is shown: "No participants available to 

receive data" if no providers have given permission to push, 

otherwise 'euromuse' just isn't listed in the drop-down menu of 

the providers

O C

P

R

Error message as expected  + 

drop-down menu without 

euromuse

O D

F

No error message but Euromuse not listed O AV

Either an error message is shown: "No participants available to 

receive data" if no providers have given permission to push, 

otherwise 'euromuse' just isn't listed in the drop-down menu of 

the providers

O C

P

R

Error message as expected  + 

drop-down menu without 

euromuse

O D

F

No error message but Euromuse not listed O AV

Error message is shown: "Please select a data file' or 'Please 

select at least one receiver'

O C

P

R

Error message as expected  O D

F

Error message as expected  O AV

Message is shown: "Operation stated. You will receive an email 

notification. To view the status and results go here.' After some 

minutes you will receive an email summarizing the outcome of 

the operation.

O C

P

R

Confirmation message as 

expected  + email notification 

received

W D

F

Error message displayed (as expected). Missing 

data mapping from Afidium to Harmonise 

Ontology

But I do not understand why I should receive a 

mail

O AV

Error message is shown: "Error in data mapping from Harmonise 

Ontology to HarmoNET: org.xml.sax.SAXParseException: Content 

is not allowed in prolog. Line: xxx Column: yyy".

O C

P

R

Error message as expected W D

F

Error message as expected. However, message 

difficult to interpret as erroneous format…

O AV
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Id
P

.4
.1

0
P

.4
.1

P
.4

.1
2

P
.4

.1
3

P
.4

.1
4

P
.4

.1
5

P
.4

.1
6

P
.4

.1
7

P
P

.5
.1

Expected Output 7
/3

/1
2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result 1
2

/3
/1

2

W
h

o

Actual Result

Screen message is shown: "Operation stated. You will receive an 

email notification. To view the status and results go here.' After 

some minutes you will receive an email saying 'Failed on 

euromusemf: Missing data mapping from Harmonise Ontology to 

euromusemf.'

O C

P

R

Message on the screen as 

espected 

Email received with content as 

expected

X D

F

Apparently, it worked:

Dear HarmoSearch User

The push operation you have started has been 

completed.

Operation completed successfully on: CPR.

Kind regards,

Harmosearch.

I suppose that the setup was ok for CPR. It seems 

logical since it corresponds to the next test

O AV

AV

Screen message is shown: "Operation stated. You will receive an 

email notification. To view the status and results go here.' After 

some minutes you will receive an email saying '   Operation 

completed successfully on: euromuse, CPR'.

O C

P

R

Message on the screen as 

espected 

Email received with content as 

expected

O D

F

Message on the screen as espected 

Email received with content as expected. Beware 

of time information. Server seems to have wrong 

time though

O AV

In 'Operation Status' the push operation is reported as 

completed successfully

O C

P

R

Operation status' page has 

content as expected

Availability of data file on 

HTTP service endpoint could 

not be checked

Operation status' page has content as expected

Availability of data file on HTTP service endpoint 

could not be checked

W D

F

I would explain some explanation and possibly a 

list with names and not just codes. I would also 

expect that we can get some additional 

information on the providers (for instance via a 

page that the providers could complete in the 

system or a link to a web site...

W AV

- C

P

R

Not available in this release - D

F

Not available in this release - AV
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Either an error message is shown: "No participants available to 

be queried" if no providers have given permission to query, 

otherwise euromuse does not appear in the list of data providers 

that can be queried.

O C

P

R

O D

F

No error message but Euromuse not listed O AV

Either an error message is shown: "No participants available to 

be queried" if no providers have given permission to query, 

otherwise euromuse does not appear in the list of data providers 

that can be queried.

O C

P

R

O D

F

No error message but Euromuse not listed O AV

O D

F

Import started OK but got an error in operation 

status

O AV

Error message is shown: "User query not valid against 

HarmoSearch query language XSD".

O C

P

R

Error message as expected O D

F

Error message as expected O AV

Error message is shown: "Impossible to connect to the data 

registry. Please contact the administrator".

O C

P

R

Error message as expected Error message as expected AV

AV

Screen message is shown: "Operation stated. You will receive an 

email notification. To view the status and results go here.'

After some minutes you will receive an email saying 'Failed on 

euromuse: Missing mapping for the query structure from 

Harmonise Ontology to euromuse".

O C

P

R

Screen message as expected

Email received with content as 

expected

O D

F

Screen message as expected

Email received with content as expected

O AV
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Actual Result 1
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Actual Result 1
2
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W
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Actual Result

Screen message is shown: "Operation stated. You will receive an 

email notification. To view the status and results go here.' In 

'Operation Status' tab the entry of the previous import reports: 

'Error on euromuse: Missing data mapping from euromuse to 

Harmonise Ontology".

O C

P

R

Screen message as expected

'Operation status' page has 

content as expected

Screen message as expected

'Operation status' page has content as expected

O AV

Screen message is shown: "Operation stated. You will receive an 

email notification. To view the status and results go here.' In 

'Operation Status' tab the entry of the previous import reports, 

for instance: 'Failed on euromuse: Missing data mapping from 

Harmonise Ontology to CPR'.

O C

P

R

Screen message as expected

'Operation status' page has 

content as expected

Screen message as expected

'Operation status' page has content as expected

O AV

Screen message is shown: "Operation stated. You will receive an 

email notification. To view the status and results go here.' In 

'Operation Status' tab the entry of the previous import reports, 

for instance: 'Failed on euromusemf: Impossible to connect to 

provider".

O C

P

R

Screen message as expected

'Operation status' page has 

content as expected

Screen message as expected

'Operation status' page has content as expected

O AV

Error message: "There is no provider to query that matches your 

search criteria.".

O C

P

R

Error message as expected Error message as expected o AV

AV
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W
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Actual Result

Screen message is shown: "Operation stated. You will receive an 

email notification. To view the status and results go here.'

In 'Operation Status' tab the entry of the previous import 

reports: ' Operation completed successfully on: euromuse".

In 'Data Repository'->'Querybox' the result file is available (check 

the timestamp), and it contains some results (check with the 

example file 'import_results_Advanced_Search.xml' in the test 

folder)

O C

P

R

Screen message as expected

'Operation status' page has 

content as expected

Result file is correct

Screen message as expected

'Operation status' page has content as expected

Result file is correct

o AV

Screen message is shown: "Operation stated. You will receive an 

email notification. To view the status and results go here.'

In 'Operation Status' tab the entry of the previous import 

reports: ' Operation completed successfully on: euromuse".

In 'Data Repository'->'Querybox' the result files are available 

(check the timestamp), and they contain some results (check 

with the example files 'import_results_Simple_Search_[data-

provider].xml' in the test folder)

O C

P

R

Screen message as expected

'Operation status' page has 

content as expected

Result files are correct

Screen message as expected

'Operation status' page has content as expected

Result file is correct

o AV

Screen message is shown: "Operation stated. You will receive an 

email notification. To view the status and results go here.'

In 'Operation Status' tab the entry of the previous import 

reports: ' Operation completed successfully on: biella".

O C

P

R

Screen message as expected

'Operation status' page has 

content as expected

Availability of data file on 

HTTP service endpoint could 

not be checked

Screen message as expected

'Operation status' page has content as expected

Availability of data file on HTTP service endpoint 

could not be checked

o AV

- C

P

R

Not available in this release Not available in this release
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After the time set in the scheduled options, the result file is 

available in 'Querybox' and contains some results. In 'Operation 

Status' the import operation is reported to be completed 

successfully on euromuse. After some minutes you receive also a 

notification email.

O C

P

R

Operation status' page has 

content as expected

Result file is present in 

'Querybox' and contains results

Email has arrived

Operation status' page has content as expected

Result file is present in 'Querybox' and contains 

results

Email has arrived

o AV

Operation Status' reports the unavailability of the regsitry O C

P

R

Operation status' page has 

content as expected

Email has arrived with message 

as expected

Operation status' page has content as expected

Email has arrived with message as expected

o AV

In 'Operation Status' the push operation is reported to be failed, 

with error message: 'Missing query service configuration for 

<your-organization>' After some minutes you receive also a 

notification email.

O C

P

R

Operation status' page has 

content as expected

Email has arrived

Operation status' page has content as expected

Email has arrived

o AV
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In 'Operation Status' the push operation is reported to be 

completed successfully on CPR. After some minutes you receive 

also a notification email.

O C

P

R

Operation Status reports as 

expected

Email received

Operation Status reports as expected

Email received

- C

P

R

Not available in this release Not available in this release

A row describes the just performed push, listing your 

organization as sender, the receiver, the timestamp, the status 

(FAILED, COMPLETED or ONGOING), the detail of the success or 

errors, and a link to the sentbox.

O C

P

R

Content of 'Operation Status' as 

expected

O D

F

Content of 'Operation Status' as expected O AV

A row describes the just performed import, listing your 

organization as sender, the receiver, the timestamp, the status 

(FAILED, COMPLETED or ONGOING), the detail of the success or 

errors, and a link to the querybox.

O C

P

R

Content of 'Operation Status' as 

expected

Content of 'Operation Status' as expected o AV

W D

F

I could expect capacity to select certain lines then 

delete them.. I would expect Deete all on the right

W AV

- C

P

R

Not available in this release - D

F

Not available in this release - AV
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The file sent from the user with a push operation is present (see 

also the timestamp) and can be downloaded or deleted

O C

P

R

File present as expected File present as expected o AV

- C

P

R

Not available in this release Not available in this release

The file sent from the user with a push operation is present (see 

also the timestamp) and can be downloaded or deleted

O C

P

R

File present as expected O D

F

File present as expected O AV

W D

F

Outbox is differnt from rest with a navigation 

panel: all must be coherent. Layout is also 

different from status (delete all is written in a 

different way. Same remarks as for operation 

status

W AV

- C

P

R

Not available in this release - D

F

Not available in this release - AV

The file sent from the user with a push operation is present (see 

also the timestamp) and can be downloaded or deleted

O C

P

R

File present as expected O D

F

File present as expected O AV

O D

F

Same remark as previous one O AV

- C

P

R

Not available in this release - D

F

Not available in this release - AV

The file received from the user with an import operation is 

present (see also the timestamp) and can be downloaded or 

deleted

O C

P

R

File present as expected File present as expected o AV
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- C

P

R

Not available in this release Not available in this release

Policy is removed from the box at the end of the page. O C

P

R

O D

F

O AV

Policy is listed in the box at the end of the page. O C

P

R

O D

F

O AV

Policy is listed in the box at the end of the page. O C

P

R

W D

F

Message: 

Access policy successfully modified does not 

appear in the same position as when created for 

instance

o AV

Policy is removed from the box at the end of the page. O C

P

R

O D

F

O AV

Policy is listed in the box at the end of the page. O C

P

R

O D

F

Same as before about message position O AV

Policy is listed in the box at the end of the page. O C

P

R

O D

F

O AV

- C

P

R

Not available in this release - D

F

Not available in this release - AV

File is listed in the box at the end of the page. O C

P

R

O D

F

O AV

File is removed from the box at the end of the page. O C

P

R

O D

F

O AV

File is listed in the box at the end of the page. O C

P

R

O D

F

O AV
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File is removed from the box at the end of the page. O C

P

R

O D

F

O AV

File is removed from the box at the end of the page. O C

P

R

O D

F

O AV

File is listed in the box at the end of the page. O C

P

R

O D

F

O AV

Files are listed in the box at the end of the page. O C

P

R

o AV

Files are removed from the box at the end of the page. O C

P

R

o AV

File is removed from the box at the end of the page. O C

P

R

O D

F

File is removed O AV

File is listed in the box at the end of the page. O C

P

R

O D

F

File is added to list O AV

File can be downloaded on the local file system O C

P

R
File is listed in the box at the end of the page. O C

P

R
File is removed from the box at the end of the page. O C

P

R

- C

P

R

Not available in this release - D

F

Not available in this release -

Data provider configuration saved O C

P

R
Data provider removed O C

P

R
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Data provider configuration saved O C
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Data provider configuration saved O C
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Data provider configuration saved O C
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Data provider configuration saved O C
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Not available in this release Not available in this release

Configuration saved. O C
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Configuration saved. O C
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o
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Configuration saved. O C
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Configuration saved. O C
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Not available in this release - D

F

Not available in this release -

Error message is shown: 'Please select an instance file'. O C

P

R

Error message as expected o Error message as expected o

Error message is shown: 'Reconciliation problems: Missing data 

mapping from <your-organization> to Harmonise Ontology'.

O C

P

R

Error message as expected o Error message as expected o

Error message is shown: 'Reconciliation problems: Missing data 

mapping from Harmonise Ontology to <your-organization> '.

O C

P

R

Error message as expected o Error message as expected o

Error message is shown: 'Reconciliation problems: Error in data 

mapping from CPR to Harmonise Ontology: 

org.xml.sax.SAXParseException: Invalid byte 2 of 4-byte UTF-8 

sequence. Line: 33 Column: 150'.

O C

P

R

Error message as expected o Error message as expected o

Error message is shown: 'Reconciliation problems: Error in data 

mapping from CPR to Harmonise Ontology: 

org.xml.sax.SAXParseException: Invalid byte 2 of 4-byte UTF-8 

sequence. Line: 33 Column: 150'.

O C

P

R

Error message as expected

Error message as expected

o
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Screen message: 'File successfully transformed'

File is available in the list nearby, and contains some results 

(same as in 'forward_data_mapping_results.xml' in the test 

folder).

O C

P

R

Screen message as expected

File as expected

Screen message as expected

File as expected

o

Screen message: 'File successfully transformed'

File is available in the list nearby, and contains some results 

(same as in 'backward_data_mapping_results.xml' in the test 

folder).

O C
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R

Screen message as expected

File as expected

Screen message as expected

File as expected

o
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P

R

Not available in this release - D

F

Not available in this release -

Error message: "HarmoSearch query not valid" O C

P

R

Error message as expected Error message as expected o

Error message: "Query translation problems: Missing mapping 

for the query structure from Harmonise Ontology to okv"

O C

P

R

Error message as expected Error message as expected o

Screen message: "Query transformed successfully" O C

P

R

Error message as expected Error message as expected o
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R

Not available in this release - D

F

Not available in this release -

Exception is thrown ( MissingParameterException or 

ValidationException)

O C

P

R

Error messages received Error messages received
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The method returns a successful completion message: ' 

Operation completed successfully on: euromuse".. In 'Operation 

Status' tab the entry of the previous import reports also 

successful completion and links to the 'Querybox', where the 

result file is available (check the timestamp), and it contains 

some results.

O C

P

R

Email received

Operation logged and 

accessible through the 

Operation Status Panel

Email received

Operation logged and accessible through the 

Operation Status Panel

Exception is thrown ( MissingParameterException or 

ValidationException)

O C

P

R

Error messages received Error messages received

The method returns a successful completion message: ' 

Operation completed successfully on: euromuse".. In 'Operation 

Status' tab the entry of the previous import reports also 

successful completion and links to the 'Querybox', where the 

result file is available (check the timestamp), and it contains 

some results (check with the example file 

'import_results_Advanced_Search.xml' in the test folder).

O C

P

R

Email received

Operation logged and 

accessible through the 

Operation Status Panel

X D

F

Dit not work because I put an XML string and not a 

file. Claudio has been advised

Exception is thrown ( MissingParameterException or 

ReconciliationException)

O C

P

R

Error messages received Error messages received

The method returns a successful completion message: ' 

Operation completed successfully on: euromuse, CPR".. In 

'Operation Status' tab the entry of the previous push reports also 

successful completion and links to the 'Sentbox', where the data 

file you sent is available (check the timestamp).. Logged in as 

euromuse (or CPR), in 'Data Repository'->'Inbox' the file that has 

been sent is available.

O C

P

R

Email received

Operation logged and 

accessible through the 

Operation Status Panel

Email received

Operation logged and accessible through the 

Operation Status Panel

O C

P

R
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IM   hWp://harmosearchdev.harmonet.org/home(revise url)?

O T

M

It took a while to find the "Sign In" link (which is not a big deal 

at the moment), a direct login which directly "jumps" to the 

users attention would be nice.I agree with David, that it would 

be nice to see what you get in case of a registration. However, 

from a "functional" point of view I would consider this issue as 

minor and agree with Adriano to tackle it in the next release.

O IM O P

W

 Important: "You have to sign in!" Otherwise there is nothing 

to do.

O T

M

Since I had to register I was not able to see the content due to 

a missing activation. 

O O P

W

some hints would be useful: what can you do here, what is 

harmosearch.

- T

M

_

O IM

o T

M

Worked as expected. The error messages have been displayed 

correctly. 

W IM exct phrase:

You have entered invalid data. Please try again. 

Please enter a valid screen name.

O P

W

You have entered invalid data. Please try again.

Please enter a valid screen name.  

"Create new account" could be more prominent.
o T

M

Worked as expected. Error message (I did not enter any mail 

adress) came up correctly.

W IM phrasing correct

field highlighted "Name", it should be the email address, if the 

email address is missing :P

O P

W

You have entered invalid data. Please try again.

Please enter a valid email address. 

o T

M

Worked as expected. Error message came up correctly. W IM correct phrasing

again field highlighted: "name" instead of captcha

O P

W

You have entered invalid data. Please try again.

Text verification failed. 

o T

M

Worked as expceted. Mail arrived quickly after the registration 

(sender: HarmoNET Administrator <support@harmonet.org>)

organization: TU Vienna

Minor comment: it would be nice to provide my own password

O IM as expected

activation after notifying Claudio

O P

W

tested last week - after claudio sent us the credentials, we 

could login.

W T

M

Received only one email informing me that my account has 

been activated (sender: support@harmonet.org)

W P

W

tried to create a new account with an already exiistitng 

account: werder@museumsmedien after login we get: an-

unexpected-system-error-occurred

com.liferay.portal.LayoutFriendlyURLException 

O T

M

Worked as expected. The error messages have been displayed 

correctly. 

O IM
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O T

M

Worked as expceted. Notification mail arrived immediately. O IM password received instantly

W T

M

Activation mail finally arrived with a 2 hours delay. O IM activation after notifying claudio

- T

M

_

O T

M

Minor: I agree with David that both links should contain a link 

to the portal. However, it may be more convenient to directly 

lead the user to the login-page (sign in area). Furthermore a 

link to more information (e.g. FAQ, First steps, etc.) may be 

nice to have for a new user. However, these are realy minor 

issues.

O P

W

O T

M

worked as expected O P

W

X T

M

got an 404 error X P

W

http: 404

http://www.internic.at/bin/notfound?ERR=404

But Control Panel works fine!!!
O T

M

Error messages came up as expected O IM as expected O P

W

You have entered invalid data. Please try again.

Authentication failed. Please try again. 

O T

M

Log-in lead me to the home screen 

(http://harmosearchdev.harmonet.org/home) displaying the 

organizational services panel

O IM as expected O P

W

W T

M

I agree with David and Adriano O IM uploaded original file "museoliitto2hto-mapping.xslt" in the 

Mapping store: Upload mapping for "Museolitto"

Upload mapping from local system to Harmonise ontology (for 

sending data) 

success: Mapping Files :16508_so.xslt 

Participant: museolitto

type: mapping from local system to HTO

O P

W
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O T

M

I agree with David (does not match the described expected 

behavior), however, the functionality is given and works as 

expected. Remark: I was able to perform this action several 

times (3 times in a row - pause between each try approx. 2 

minutes). The link should have an expire time (or at least 

should be invalid in case the user has changed his password 

successfully). However, this is just a minor issue.and did not 

affect the overall functionality - in contrary, it proofed it works 

well :-)

O im The system asks first for email address, then to answer the 

question

why do I have to forget my password in order to enter my 

own? 

Suggestion: If the first password routine was to receive a 

random password, the second should also be so (the email 

should contain the new password). 

W P

W

in the control panel, i could not test this, the way it is 

described ?

O T

M

_ P

W

not clear to me, what to test

- T

M

_ P

W

O T

M

I executed two different queries: (i) with no changes 

respectively the default values for the query (just a click on 

"search") and (ii) a "self-defined" query (country: austria, 

category: activity; data provider: euromuse). The results for 

the former was a list of available events, the latter returned 

the expected message as described in expected output.

O P

W

O T

M

Error message came up as expected. I agree with David that 

the error message could be more "user friendly". Furthermore, 

I suggest to differentiate error messages additonally - for 

example by color (e.g. red). However, this is a minor issue and 

does not affect the outcome of this test case.

O IM expected response O P

W

User query not valid against HarmoSearch query language XSD

- T

M

? _

O T

M

Error message came up as expected O IM Layouted out of the provided surface:

Failed on euromuse: Missing mapping for the query structure 

from Harmonise Ontology to euromuse

O P

W

Failed on euromuse: Missing data mapping from euromuse to 

Harmonise Ontology
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O T

M

O IM O P

W

Failed on euromuse: Missing data mapping from euromuse to 

Harmonise Ontology

O T

M

Error message as expected O IM O P

W

Failed on euromuse: Impossible to connect to provider

O T

M

Error message appeared - tried it also with other providers 

(euromuse, biella, all) 

o IM O P

W

O T

M

Received 43 results (selected provider: all)

Second search (provider: biella) not results --> message 'There 

is no provider to query that matches your search criteria.'

Third search (provider: euromuse) 43 results

O IM 99 results from euromuse (external service)

246 results from euromusemf  (local index) 

O P

W

Results found: 43
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Actual Result

O T

M

Found 99 results data provider euromuse. O IM SQ1 - 99 results 1 provider euromuse (external service)

SQ2 - 362 results 3 providers contacted (euromuse, 

euromusemf, biella) unsorted

SQ3 - 112 results 2 providers (euromuse + euromusemf) 

unsorted

SQ4 - 192 results from 2 providers (euromuse + euromusemf) 

unsorted

SQ5 - 1 resutl from Biella

SQ6 - User query not valid against HarmoSearch query 

language XSD

O P

W

Results found: 99

O T

M

3 data providers contacted; results were available as soon as 

the first provider delivered data; 

Found results: 364  

W IM Results found: 345 from 3 data providers O P

W

 Is SQL2.xml the right file? Was not clear to me …

      Waiting for results. Completed 2 of 3 contacted providers. 

Failed : (see Errors) 

Load available results 

Results found: 363
- T

M

W IM alternative 1 (english results) ? 

Failed 1: (see Errors)

 Failed on euromuse: Error in translating the query for the 

provider

retreived 259 non in english language (only local lang)

_

O T

M

3 data proviers contacted (used SQ3 query); 112 results 

received

O IM Date range topic aleady discussed in RELEASE 2, I think past 

exhibitions (in the praxis) should be automatically discarded, 

and not shown (i thought it was a good solution, to set 'today' 

as default starting date)

O P

W

O T

M

3 data providers contacted (used SQ3 alternative 1 query); 112 

results received

o IM O P

W

W T

M

3 providers contacted (used SQ3 alternative 2 query); 102 

results; received error message "Failed on euromusemf: Error 

in translating the query for the provider"

o IM O P

W

- T

M

O T

M

contacted proviers: 2; received results: 192 O im used SQ5 alternative 3 (Provider: all / Location: Berlin / 

Dates:April 1-30 / category: modern art) 

Results 3 from euromuse (external service)

O P

W

also listing archived (old) exhibitions (EUROMUSE should not 

deliver them!!!)

O T

M

contacted proviers: 2; received results: 230 O P

W

o.k. for Harmosearch  - but same as above.
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- T

M

X P

W

changed SQL4.xml using "Frankfurt" and got wrong results

O T

M

contacted providers: 3; received results: 117 O IM Used SQ4 alternative 3

117 results contacting 3 data providers 

O P

W

O T

M

contacted providers: 3; received results: 197 O IM Used SQ4 alt.4

197 results from euromuse, euromusemf, biella 

x P

W

used SQL-Alternative4.xml, from EUROMUSE there are 

exhibitions listed, sure not from Berlin!!!

O T

M

contacted providers: 3; received results: 85 O IM O P

W

O T

M

contacted providers: 3; received results: 79 O IM O P

W

Results found: 84

- T

M

_

O T

M

contacted providers: 1; received results: 1 O IM 1 data provider contacted, 0 results O P

W

O T

M

contacted providers: 2; received results: 149 O IM 2 providers

99 results

O P

W

Results found: 149

O T

M

contacted providers: 2; received results: 50 O P

W

Results found: 50

W T

M

contacted providers: 3; received results: 3; received error 

message: 'Failed on euromusemf: Error in translating the query 

for the provider'

O P

W

Results found: 3

O T

M

contacted providers: 3; received results: 25 O P

W

Results found: 31
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O T

M

contacted providers: 3; received results: 3 O P

W

Results found: 5

- T

M

_

- T

M

_

W T

M

From a users perspective I would separate simple search and 

advanced search. Remark: Entered queries are not deleted and 

still present when clicking on the main menu link 

"Metasearch" - as a user I would expect that I am forwarded to 

a "blank" search page.  I noticed that the search query is 

processes, too. Of course a minor issue, but should be noted. 

(after a relog - sign out sign in - the interface is reseted and 

works as expected)

W P

W

technically well done. For users the simple search could be 

more easier and it could be beautified ;-)

O T

M

Several design remarks (similar to the ones David already 

proposed), however, at the current stage this is (I think) minor. 

W P

W

see above

W T

M

Users who do not have a technical background (and are 

familiar with the query language syntax of course) will not be 

able to use the advanced search. Additional help and 

documentation will improve the usability. Again this is from 

my point of view not crucial yet

W P

W

some hints could be given for the advanced search. Help page 

with examples, e.g. in the wiki

O T

M

The provided information is straight forward and provides the 

most important information. Of course the design could be 

better, but again this is something for the final release. From a 

content perspective I do not have any obligations. From a 

users perspective an overview similar to the one David 

described may be helpful.

W P

W

o.k., but it would be nicer to have all results shown on one 

page and to sort it some kind

- T

M

_
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O IM no error message, receivers: CPR euromusemf biella O P

W

O T

M

worked as expected - euromuse is not listed; no error message

Listed receivers: CPR, euromusemf, biella

O IM no error message, receivers: CPR euromusemf biella O P

W

only eurmusemf… is showing, no euromuse

O T

M

Worked as expected, I received the error message "Please 

select a data file" and "Please select at least one receiver" 

after choosing a data file (in my case a random xslt file)

O IM Please select a data file (when neither choosing nor uploadin)

Please select at least one receiver (upoading dummy txt)

O P

W

Please select a data file 

X T

M

Error message "Missing data mapping from TU Vienna to 

Harmonise Ontology"

Mail has not been sent or at least received

Sending an information mail makes sense to me, since I want 

to push the data and should be informed in case of an error.

X im in config > mapping store > no mapping files available but 

push euromuse_to_push.xml to CPR

result: Missing data mapping from museolitto to Harmonise 

Ontology 

X P

W

Missing data mapping from museumsmedien to Harmonise 

Ontology 

W T

M

Error message shown. I agree with David regarding the 

erroreous format. 

O IM Error in data mapping from Harmonise Ontology to HarmoNET: 

org.xml.sax.SAXParseException: Content is not allowed in 

prolog. Line: 6 Column: 16 

O P

W

Error in data mapping from Harmonise Ontology to HarmoNET: 

org.xml.sax.SAXParseException: Content is not allowed in 

prolog. Line: 6 Column: 16 
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W T

M

Success message shown, Received the notification mail with 

more details.

Provided link also worked displays the same message as 

received per mail: "Failed on euromusemf: Missing data 

mapping from Harmonise Ontology to euromusemf." 

O IM server time is one hour too early?

test performed at 16:11 email received 15:12 (?)

X P

W

Error in data mapping from Harmonise Ontology to HarmoNET: 

org.xml.sax.SAXParseException: Content is not allowed in 

prolog. Line: 6 Column: 16 

O T

M

Message displayed. Provided link worked and showed that the 

operation was completed successfully - Result: "Operation 

completed successfully on: CPR." 

Email received (same message as on the portal link). Remark: 

Experienced the same timing-issue as David

O IM W P

W

dont get any screen messages …

O T

M

Message displayed. Provided link worked and showed that the 

operation was completed successfully - Email received. 

Remark: Again timing 

O IM W P

W

dont get any screen messages …

email o.k.

W T

M

Fully agree with David. Additional explanation is defenitelly 

needed.

W P

W

push data seems very time consuming - it maybe helpful, if 

there is shown something like" data processing … please be 

patient"

- T

M

_
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O T

M

No error message; euromuse isn'tlisted (available: all, 

euromusemf, biella)

O IM rather the second, euromuse does not appear in the list of DP O P

W

O T

M

No error message; euromuse is not listed (available: all, 

euromusemf, biella)

O IM rather the second, euromuse does not appear in the list of DP O P

W

O T

M

Received message &email.

Failed on euromusemf, biella & euromuse: Missing data 

mapping from Harmonise Ontology to TU Vienna.

Remark: as a user I would expect to know the result, the 

message should provide the information accordingly - e.g. 

operation stated and failed/was successfull ...

IM Failed on euromuse: Missing data mapping from Harmonise 

Ontology to museolitto.

O P

W

O T

M

Received error message: User query not valid against 

HarmoSearch query language XSD Remark: For the final release 

the error message could be more expressive (most users are 

not familiar with XSD schemata, etc.) or should have some 

information what or where the error is (of course this is 

currently out of scope)

o IM O P

W

X T

M

was not able to test _

O T

M

Message shown, Mail received, Link ok

O IM O P

W

Failed on euromuse: Missing mapping for the query structure 

from Harmonise Ontology to euromuse.
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O T

M

Message shown, Mail received, link ok

O IM O P

W

Failed on euromuse: Missing data mapping from euromuse to 

Harmonise Ontology.   

O T

M

Message shown, Mail received, linktested - same message as 

mail: "Failed on euromuse: Missing data mapping from 

Harmonise Ontology to TU Vienna."

O IM Failed on euromuse: Missing data mapping from Harmonise 

Ontology to museolitto.    

O P

W

Failed on euromuse: Missing data mapping from Harmonise 

Ontology to museumsmedien.    

O T

M

Message shown as expected

Mail received

Link tested - "Failed on euromuse: Impossible to connect to 

provider."

IM JUMPED TO SCHEDULER (task 120)

O T

M

Error message shown as expected

O P

W

There is no provider to query that matches your search 

criteria. 

O T

M

Met expected output results; message shown, results 

downloadable, file matches the test data file (compared on a 

control sample basis)
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O P

W

Operation completed successfully on: euromuse. 

W T

M

worked as expected

Remark: in addition to harmonise the status result message 

also states that the operation has been successfull on biella, 

too (not in line with the output description). In addition I also 

got a failure message saying that the operation failed on 

euromusemf.
_ P

W

which file to use?

O T

M

worked as expected; messsage shown; mail received

W T

M

Similar to the meta-search additional information (e.g. 

descriptions) and design issues are present. However, this is a 

minor issue and does not affect RC3.

- T

M

TOBECONTINUED
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X IM This answers my comment before!

Configured at 16:00 for 16:10 (server time)…

at 16:10 operation succeded all euromuse exhibitions (english) 

in querybox

from 33 current (end date posterior 'today') art history 

exhibitions, the query outputed around 100 (current and past 

exhbitions). This should be hindered.

performed a scheduled query with same category, but with 

date restriction (next 30 days), same number of exhibitions 

were outputed in the query... 
w no register of last scheduled task in the operation status log

w no register of last scheduled task in the operation status log
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P
.8

.
P

.8
.4

P
P

.9
.1

P
.9

.2
P

.9
.3

P
.9

.4
P

P
.1

0
.

P
.1

0
.2

P
.1

0
.

P
.1

0
.4

P
P

.1
1

.
P

.1
1

.2
P

.1
1

1
4

/3
/1

2

W
h

o
Actual Result 1

5
/3

/1
2

W
h

o

Actual Result 1
6

/3
/1

2

W
h

o

Actual Result

O IM

O IM

O IM

w IM from task 121

last scheduled query

starting date: 2012-03-15 15:10:05.716

commited date: empty
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.1
1

.4
P

1
2

P
.1

2
.1

P
.1

2
.2

P
.1

2
.3

P
.1

2
.4

P
.1

2
.5

P
.1

2
.6

P
.1

2
P

.1
2

.8
P

1
3

P
.1

3
.1

P
.1

3
.2

P
.1

3
.3

1
4

/3
/1

2

W
h

o
Actual Result 1

5
/3

/1
2

W
h

o

Actual Result 1
6

/3
/1

2

W
h

o

Actual Result

O T

M

Successfully deleted; PUSH no longer listed in the table; 

Success message shown (above table)

O T

M

PUSH is listed; Details (date) is accordingly shown in the table o IM O P

W

O T

M

Worked as expected - restrictions (date) were no longer listed 

in the access control policies table. Success message shown 

above the table. 

o IM O P

W

O T

M

Success message displayed and policy vanished from the table O IM O P

W

O T

M

Success message shown; Policy including dates appears in the 

table

Remark: In general the UI may be improved in order to permit 

such situations - e.g. provide warning message in case of 

irrational data selection

O IM O P

W

O T

M

Success message shown; Policy modified and restrictions 

disapeared

Remark: Potential improvement --> clear button removing all 

restrictions 

O IM O P

W

O IM O P

W

O T

M

Worked as expected; Message has been shown accordingly 

"Mapping file successfully uploaded"

O IM O P

W

O T

M

Worked as expected; message shown: "Mapping file 

successfully uploaded"

O P

W

O IM O P

W
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P
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3

.5
P

.1
3

.6
P

.1
3

.7
P

.1
3

.8
P

.1
3

.9
P

.1
3

.1
0

P
.1

3
.1

1
P

.1
3

.1
2

P
.1

3
.1

3
P

.1
3

P
.1

3
.1

5
P

P
.1

4
.1

P
.1

4
.2

1
4

/3
/1

2

W
h

o
Actual Result 1

5
/3

/1
2

W
h

o

Actual Result 1
6

/3
/1

2

W
h

o

Actual Result

O T

M

File is no longer listed and the success message came up upon 

the mapping file table.

O P

W

O T

M

File appeared in the table and success message was displayed 

accordingly

O IM O P

W

O IM O P

W

O P

W

O T

M

File removed and success message has been displayed above 

the table. 

O P

W

O T

M

File was added but renamed to 10835_query_os.xslt - should 

be added to the expected output cell

O IM O P

W

O IM O P

W

O P

W

O P

W

O P

W

_

O T

M

o IM O P

W
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.1
4

.3
P

.1
4

.4
P

.1
4

.5
P

.1
4

.6
P

.1
4

P
.1

4
.8

P
1

5
P

.1
5

.1
P

.1
5

.2

1
4

/3
/1

2

W
h

o
Actual Result 1

5
/3

/1
2

W
h

o

Actual Result 1
6

/3
/1

2

W
h

o

Actual Result

O T

M

o IM o P

W

O T

M

o IM O P

W

O T

M

o IM O P

W

o IM O P

W

O T

M

Successs message displayed as expected; details are shown in 

the table; 

Remark: username and password are shown in plain text
O T

M

Worked as expected: "Service configuration successfully 

modified" message displayed above the table; type changed to 

"Web Portal GUI"; Service URL, username, password --> empty

O IM O P

W

O T

M

Worked as expected: "Service configuration successfully 

modified" message displayed above the table; type changed to 

HTTP service

O IM O P

W
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.1
5

.3
P

.1
5

.4
P

.1
5

P
.1

5
.6

P
1

P
.1

6
.1

P
.1

6
.2

P
.1

6
.3

P
.1

6
.4

P
.1

6
.5

P
.1

6
.6

P
.1

6
.7

P
.1

6
.

1
4

/3
/1

2

W
h

o
Actual Result 1

5
/3

/1
2

W
h

o

Actual Result 1
6

/3
/1

2

W
h

o

Actual Result

O T

M

Worked as expected; changes have been persisted; success 

message displayed

O P

W

O P

W

_
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P
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1
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P
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P

.1
7
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P

.1
7

.
P

.1
7

.4
P

.1
7

P
.1

7
.6

P
P

.1
8

.1
P

.1
8

.2

1
4

/3
/1

2

W
h

o
Actual Result 1

5
/3

/1
2

W
h

o

Actual Result 1
6

/3
/1

2
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h

o

Actual Result
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P
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P
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4
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/1

2
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h

o
Actual Result 1

5
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/1
2

W
h
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Actual Result 1
6
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h

o

Actual Result
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Id P
a
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n

t
Action Name Description

Comment

 (and alternatives)

Import Import A user imports an existing mapping project solution pakced within a ZIP file. 

M
T

1
.1

M
T

1 Call import 

project 

wizard

Import 

project 

The user calls the import project 

wizard that allows him to select an 

existing ZIP file from the local file 

system. 

The chosen mapping project is imported from the source location (local file system) to the current workspace. The mapping project and ist 

contents (e.g. patterns, filters, schemata) are (after the import) available in the workspace. Furthermore, the data is also copied "physicall", 

meaning that all files and folders are also available in the workspace folder on the local file system. 

Mapping Mapping A user is able to perform simple or complex mappings using the HarmoSearch mapping editor.

M
T

2
.1

M
T

2 Import 

schema to 

editor

Import 

schema to 

editor

In order to create a mapping it is 

necessary that the user is able to 

import a corresopnding schema to 

the mapping editor.

The schema resource is a schema (xsd) file located in the current mapping project. Schema resources are located in the project's "Schema" 

folder. To import the file to the mapping editor the user has to click on the schema file, holding the click and dragging the file onto the mapping 

editor. As a result the schema (and its elements) are displayed as a tree structure in the mapping editor.

M
T

2
.2

M
T

2 Apply filter Apply filter Filters are used to constrain the 

visibility of schema elements that are 

not relevant for an individual 

mapping case. 

Filters are resources that are captured in the "Filter" folder of the mapping project under consideration. A filter can be applied to a mapping by 

opening the mapping file in the mapping editor and clicking the "applyFilter" button on the main toolbar. A dialog pops up and provides the user 

the possibility to select the filers of choice. In case the user has chosen filters before the corresponding ones are already marked as active (check 

beside the filter). As a result the visible elements of the target schema (ech filter is used to have at least one target schema) is reduced to all 

those elements that are not filtered.

M
T

2
.3

M
T

2 Create 

initial 

mapping

Create initial 

mapping

The user is able to conduct a 

graphical mapping by connecting 

source and target elements of the 

source respectifely target schema.

The user is able to create a mapping by specifying the elements that should map. Therefore he opens the mapping editor by doule-clicking on the 

mapping file (located in the "Mapping" folder) and importing the source and target schemata. To associate two mapping candidates the user has 

to select the "link" component placed on the toolbar (left hand side of the editor). The connection is drawn by drag and click on, first the source 

element, and second the target element. As a result a black link between those elements is drawn.

M
T

2
.4

M
T

2
.3 Refine 

mapping 

and apply 

pattern

Refine 

mapping and 

apply pattern

The user performs a mapping by 

applying a pattern.

Click on the “select” element of the palette to enter the “select modus”, then click on the newly created link.  A dialogue will open. It shows a list 

where one can select suitable pre-built methods from the support libraries. As a result the link between source and target element changes its 

color to green. 

Transforma

tion

Transformatio

n

Transforms a mapping to XSLT.

M
T

3
.1

M
T

3 Create XSLT 

transformat

ion file and 

gain visual 

feedback

Create XSLT 

transfor-

mation file 

and gain 

visual feed-

back

After solving a specific mapping 

scenario the user is able to transform 

the mapping to an adequate 

transformation format (e.g. XSLT). 

Press the “createTX” (TX is for transformation) in the action bar. This triggers the transformation process provided 

by a transformation engine instance file. Transformation process files are stored in the "Input" folder and can 

contain an arbitrary number of transformation steps (e.g.transform the mapping to harmonise, harmonise to 

euromuse, and euromuse to a HTML representation). At the end of the transformation process the HTML output 

(currently set as default) is shown in the internal feedback view. The feedback view pops up automatically.

User 

assistance

User 

assistance

Refers to relevant enhancments helping the user handling the mapping tool

M
T

4
.1

M
T

4 Automated 

update

Automated 

update

Tool updates and realeases should be 

installed minimal invasive from a 

user's perspective.

The automatic update is executed after starting the mapping tool. In the background the update component of the mapping tool checks the 

available repositories if new plugin versions are available or not. In case they are the mapping tool displays a dialog guiding the user through the 

update process. Otherise a dialog appears that informs the user that no updates were found. The latter case has no effect and the user is able to 

proceed using the mapping tool. In the former case he be asked to restart the mapping tool in order to apply the changes and make the new 

updates available in the mapping tool (e.g. add help, menu, alternative editor, etc.) 

MT1

MT2

MT3

MT4
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n

t
Action Name Description

Comment

 (and alternatives)

M
T

4
.2

M
T

4 Add third 

party 

extensions

Add third 

party 

extensions

The user should be able to extend the 

mapping tool by third party plugins 

(e.g. editors, transformation routines, 

etc.)

M
T

4
.3

M
T

4
.1 Integrated 

help

Integrated 

help

Help supporting the user handling the 

main functionalities of the mapping 

tool. 

In case the user is stuck or wants to know more about specific functionality he is able to call the integrated help-documentation. To do so he has 

to select "Help->Help Contents" from the main menu. After clicking Help Contents a separate window appears showing the documentation 

separatly.

M
T

4
.4

M
T

4
.2 Cheatsheet 

support

Cheatsheet 

support

Neat process descriptions in a tutorial-

like way.

In order to use cheatsheets the user has to go to "Help->Cheat Sheets…". A dialog appears listing all available cheatsheets. After selecting the 

desired cheatsheet a separate view opens and displays the cheatsheet's content providing a step-by-step description of how to reach a specific 

goal (e.g. create a new mapping project). In addition the cheatsheets are supported by help and wizard support.

M
T

4
.5

M
T

4
.1 Context-

sensitive 

help

Context-

sensitive help

Provides the ability to show context-

sensitive help as a hook to the 

integrated help (documentation). 

Context-senstive help can be retreived in two ways: (i) by pressing the F1 button or by clicking the question mark button within a dialog (e.g. 

wizards, cheatsheets). In both cases a short summary message is displayed in the help view (which might come up). The contextual help points 

the user to additional resources (often pinpointed under "see also:").
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M
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1

.1
M

T
2

.1
M

T
2

.2
M

T
2

.3
M

T
2

.4
M

T
3

.1
M

T
4

.1

MT1

MT2

MT3

MT4

2
3

/1
/1

2

W
h

o
Actual Result 3

1
/1

/1
2

W
h

o

Actual Result

o T

M

used the museolito project 

as provided 

o I

M

o T

M

o I

M

o o I

M

o o I

M

o o I

M

the pattern windows are still very uninformative

w I had to manually change the 

support library references; 

may be to complex for a 

"simple" domain expert. 

Beside that it worked as 

expected

w I

M

 I had to manually correct and edit the XSLT : very complicated and not so clear.if I import the other reference lists available, shouldn't the html view read the new xslt 

files? Or do they have to be linked? Images:This element has no match in the hto ontology (filtered), had to be added manually by Albert

Prices & Categories: Museolitto does not provide this kind of information. Permanent: It is not so important, if an exhibition has an end data, it is temporary. For now 

we only receive from museolitto temporary exhibitions, so all entries have this field empty. The outcome, as i very well asked in my presentation and before, the output 

mapping file did not work on the server, is it not necessary that i can output a file that works in order to validate? If I recall correctly from my output file to the mapping 

file uploaded in the server (which works) there are two differences: the image pattern was manually added, so was a path at the beginning of the file.

o x I

M

After starting the tool it was stuck for nearly 10 minutes. then a dialog reporting: 'Contacting Software Sites' has encountered a problem. Unable to conecto to 

repository … . After reporting this issue to Thomas he disabled the auto-update and I was able to start the editor. A manual update resulted in the same behavior and 

afterwards the tool took longer to start.
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M

T
4

.2
M

T
4

.3
M

T
4

.4
M

T
4

.5

2
3

/1
/1

2

W
h

o
Actual Result 3

1
/1

/1
2

W
h

o

Actual Result

o x I

M

??

o x I

M

No help content (used Cheat Sheets)

o o I

M

I consider these cheatsheet approach as very helpfull

o x I

M
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N
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e

Description
Comment
 (and alternatives) Expected Outputs 18

/7
/1

2
W

ho

Actual 
Result 24

/8
/1

2
w

ho Actual Result O
ut

pu
t 

M
T0

.1

M
T0 - Setup file on your local hard disk o T

M
o IM

M
T0

.2

M
T0

M
T0

.1 - new directory corresponding to 
the provided installation location 
during installation
- new icon on the desktop 

o T
M

o IM

M
T0

.3

M
T0

M
T0

.2 Prerquisite: You have installed the mapping tool 
accordingly
Start the mapping tool
- double-click the 'MappingTool' shortcut on your 
Desktop

Alternative: Open the tools installation 
location; Start the mapping tool by double-
clicking the MappingTool.exe

- mapping tool window appears o T
M

o IM

M
T0

.4

M
T0

M
T0

.1 AT THE END OF YOUR TESTING: Uninstall the 
mapping tool
- open the tools installation location 
- double-clicking "uninstall.exe"
- follow the instructions of the uninstaller 

NOTE: The uninstaller in its current version 
is kept very simple and stupid. Thus, the 
uninstallation procedure will delete ALL 
data in the respective installation location!

- mapping tool has been 
uninstalled from the local hard disk
- desktop icon "MappingTool" has 
been deleted

w T
M

The 
installer 
needs 
to be 
refined 

x IM

M
T0

.5

M
T0

M
T0

.2 Prerequisite: You need to have access to the 
Internet and the mapping tool needs to have 
firewall permission to download content; 
Mapping tool started and running
update : go to Help > Check for Updates
Follow the instructions and restart the tool.

In case no updates can be found a respective 
information is shown to the user: "No 
updates were found"

- Update is beeing processed and 
installed
- at the end of the installation 
process a dialog appears asking 
wheather to restart the application 
or not

o T
M

w IM

M
T0

.6

M
T4 Prerequisite: same as MT0.5

Alternative: Install plugins from a ZIP resource 
(see Alternatives)
Add a third party extension
- go to Help > Install New Software
- select 
http://www.ec.tuwien.ac.at/projects/harmosearc
h/mappingtool/repository" from the drop-box 
- expand "HarmoSearch - Third Party Features 
- check "HarmoSearch Mapping Tool Cheatsheets" 
- press "Next" and follow the instructions
- restart the mapping tool

Alternative:
Install updates from ZIP resource
- Click Help > Install New Software
- Click "Add…", Click "Archive"
- Navigate to the test data folder (data_tool) 
and select 
"Flocke_Additions_Cheatsheet_Support.zip"
- Click "OK", Enter "Cheatsheet Support" in 
the "Name" field
- Click "OK", Uncheck "Group Items by 
Category" 
- Check "HarmoSearch Mapping Tool 
Cheatsheets", Click "Next" and follow the 
instructions
- Restart the mapping tool

- Third party plugin is updated and 
processed
- At the end of the installation 
procedure a dialog appears asking 
you to restart the mapping tool
- After restarting the mapping tool 
an additional menu entry should 
appear under the Help main menu 
entry
- Click "Help > Cheatsheets …" 
- A dialog appears and displays 
HarmoSearch related contents
- Expand  "HarmoSearch" and 
make sure it contains two entries 
(i) "Create a new "Hello World" 
mapping project" and (ii) "Reuse 
existing mapping solution" 

o T
M

w IM

Installed correctly
direct access in desktop was created 
:D

Like in the previous version of the 
mapping tool, the complete status 
bar is after a click full, and it does not 
unistall anything.

is there a way around the firewall (i 
cannot change my firewall settings, 
and these do not allow the mapping 
tool to connect). Alternatively you 
could ask Adriano or David (or Peter) 
to do these test lines?

MT0

MT1

Update the 
mapping 
tool

Download 

Install the 
mapping 
tool

Start the 
mapping 
tool

Remove 
the 
mapping 
tool

Preparation : Installing the Mapping Tool from scratch

is there a way around the firewall (i 
cannot change my firewall settings, 
and these do not allow the mapping 
tool to connect). Alternatively you 
could ask Adriano or David (or Peter) 
to do these test lines?

Add third 
party 
extensions

Prerequisite: You have access to the Internet and are allowed to download files
Download the mapping tool
   // /Installation of the mapping tool to your local hard drive

- start the setup and follow the wizard instructions
- accept the license agreement (currently not specified)
- specify the install location on your local hard drive (e.g., C:\Harmosearch)

Typical functionality for a solution developer
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N
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Comment
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/7
/1

2
W

ho

Actual 
Result 24

/8
/1

2
w

ho Actual Result O
ut

pu
t 

M
T1

.1

M
T1 Create a new mapping project

- go to File > New > Mapping Project
- provide a project name and a mapping file name 
(set per default)
- press "Finish"

Input validation project name
- provide no project name
- an error message is displayed at the top of 
the wizard dialog: "Provide a correct project 
name."
Input validation mapping file name
- provide a project name
- delete the default name of the mapping file
- error message appears: "Provide a correct 
mapping file name."
- enter a file name, without file ending 
".harmonize"
- error message appears: " The mapping file 
has to have the extentension harmonize"

- a new project appears in the 
mapping navigator view
- the project contains 6 folders, i.e., 
Filter, Input, Mappings, Output, 
Pattern, Schema
- the project contains a 
configuration file, i.e., 
basic.mappingconfig

o T
M

o IM

M
T1

.2

M
T1

w
ar

ni
ng

.p
ng

M
T1

.3

M
T1 Prerequisit: An already existing mapping project

Import a schema resource
- go to File > Import
- expand "HarmoSearch Wizards", select "Import 
Schema File", check "Choose an existing file from 
local source"
- click "Browse" and navigate to the data folder 
(data_tool) and select "hto.xsd", select the target 
project and click "Finish"

Import a schema resource from a bundle
- go to File > Import
- expand "HarmoSearch Wizards"
- select "Import Schema", check "Choose a 
bundle of files packed in a ZIP file"
- click "Browse" and navigate to the data 
folder (data_tool) and select 
"schemaBundle.zip", uncheck "KHM.xsd" 
(optional), select the target project and click 
"Finish"

single import : the "Schema" folder 
of the target project contains the 
"hto.xsd" schema file
bundle import : the "Schema" 
folder of the target project 
contains "museolito.xsd" and 
"KHM.xsd"

o T
M

o IM

as expected

both as expected

Typical questions under consideration may be
- is the information provided by the dialog sufficient
- is the  information easy to understand and self-explaining
- is the feedback in case of an error sufficient

Feedback from IM on 24/8/12 (placed in several columns for readability purpose):  
- If you have chosen New>Mapping project there is not much dialogue 
 - having the red cross, when the user has not yet entered a name to the mapping project, leads to think that something is already wrong, maybe only a warning sing (pic warning.png)?
 - Of course, if the user modifies the file that has to end .harmonise, the red icon should appear. For "harmonise" is not a common extension, maybe write ".harmonise" ?

Create new 
project

Feedback 
about the 
content 
and the 
project 
wizard. 

Import 
schema 
wizard
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M
T1

.4

M
T1 Prerequisit: same as MT1.3

Import a pattern resource
- go to File > Import
- expand "HarmoSearch Wizards"
- select "Import Pattern File" 
- check "Choose an existing file from local source"
- click "Browse" and navigate to the data folder 
(data_tool) and select "date-time.xsl"
- select the target project
- click "Finish"

Import a pattern resource from a bundle
- go to File > Import
- expand "HarmoSearch Wizards"
- select "Import Pattern" 
- check "Choose a bundle of files packed in a 
ZIP file"
- click "Browse" and navigate to the data 
folder (data_tool) and select 
"patternBundle.zip"
- select the target project and click "Finish"

single import : the "Pattern" folder 
of the target project contains the 
"data-time.xsl" pattern file
Bundle import : the "Pattern" 
folder of the target project 
contains multiple pattern files, i.e., 
data-time.xsl, Euromuse-RL-
languages.xslt, euromuse2html.xsl, 
HTO_Euromuse.xslt, 
HTO_Euromuse_new.xslt, 
hto2html.xsl, thov2.xsl

o T
M

o IM

M
T1

.5

M
T1 Prerequisit: same as MT1.3

Import a filter resource
- go to File > Import, expand "HarmoSearch 
Wizards", select "Import Filter File" , click 
"Browse" and navigate to the data folder 
(data_tool) and select "filter.xml", 
- select the target project and click "Finish"

- the "Filter" folder of the target 
project contains "filter.xml"

o T
M

o IM

M
T1

.6

M
T1 Prerequisit: same as MT1.3

Import a input resource, e.g., instance data
- go to File > Import, expand "HarmoSearch 
Wizards"
- select "Import Input File", click "Browse" and 
navigate to the data folder (data_tool) and select 
"biellaEvents.xml"
- select the target project and click "Finish"

Import an infput file resource from a bundle
- go to File > Import
- expand "HarmoSearch Wizards"
- select "Import Input File", check "Choose a 
bundle of files packed in a ZIP file"
- click "Browse" and navigate to the data 
folder (data_tool) and select 
"inputBundle.zip", select the target project 
and click "Finish"

single file : the "Input" folder of the 
target project contains a new file 
called "biellaEvents.xml"
bundle : the "Input" folder of the 
target project contains 3 new files 
called "biellaEvents.xml", 
"biella2hto.xml", and "process.xml"

o T
M

o IM

M
T1

.7

M
T1

M
T1

.8

M
T1 IM

M
T1

.9

M
T1 a new ZIP file has been created in 

the specified location on your local 
hard-drive

o T
M

o IM

MT2

both as expected

See above

as expected

Feedback regarding the file import wizards, which are in puarticular pattern, schema, input file wizard
Feedback from IM on 24/8/12 (placed in several columns for readability purpose
The import wizard has 2 selections (from single file and from zip) this is clear, but it has a compulsory second step, that is not that clear, namely to select the target folder / project in which the elements are to 
be imported. Maybe if a warning sign where shown in the upper part of the wizzard (as when something is wrong) with the message "Don't forget to select the target project" would be more clear

both as expected

as expected

Import 
pattern 
wizard

Import 
filter 
wizard

Domain experts Functionalities; Describes typical scenarios a domain expert faces during the mapping cycle using the HarmoSearch mapping tool 

Import 
input file 
wizard

Export

Feedback regarding the filter file import wizard

Prerequisit: An already existing mapping project
Exporting a project
- go to File > Export, select "Archive File" and press "Next"
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M
T2

.1

M
T2 Import a pre-defined mapping project 

- go to File > Import, expand "General" 
- select "Existing Projects into Workspace" and 
click "Next"
- select "Select archive file" (default), click 
"Browse" and navigate to data folder (data_tool) 
and select "BiellaDemoProject.zip"
- check "BiellaDemoProject",  check "Copy project 
into workspace" and press "Next"

Project already exists in the workspace 
(BiellaDemoProject)
- left-click "BiellaDemoProject" in the 
Mapping Navigator view
- click "Delete"
- check "Delete project contents on disk 
(cannot be undone)
- click "OK"
- repeat "Import a pre-defined mapping 
project"

- a new project appears in the 
Mapping Navigator view called 
"BiellaDemoProject"
- expand the project
- make sure the project has a 
"basic.mappingconfig" file
- those folders have to be present: 
"Filter", "Input", "Mapping", 
"Output", "Pattern", "Schema", the 
folders contain several files, e.g., 
filter.xml (Filter folder), hto.xsd 
(Schema folder)

o T
M

o IM A) "select archive file" is not set 
as default, "select root directory" 
is.
B) check copy project into 
workspace is not an option (it is 
defaulty checked and greyed, 
check pic "import_dialogue.png") im

po
rt

_d
ia

lo
gu

e.
pn

g

M
T2

.2

M
T2 - the mapping file will be opened 

by the maping editor (the editor 
window appears in the middle of 
the screen)
- the Graph View editor tab is 
active (highlighted)
- the modeling canvas is empty 
(white area)

o T
M

o IM

M
T2

.3

M
T2 - two schema figures are shown on 

the modeling canvas
- the schema items are shown as 
tree-view 
- the shapes can be moved by 
simple drag and drop actions

o T
M

o IM

M
T2

.4

M
T2

M
T2

.5

M
T2 - as soon as the mapping link is 

created a black line appears 
connecting both elements
- when selecting a link a dialog 
window appears
- confirming the mapping settings 
changes the color from black to 
green

o T
M

o IMSingle 
source 
target 
mappings

Opening 
the 
mapping 
file

Import a 
schema to 
editor

Import test 
project into 
workspace

I LIKE THIS! Here is what I missed in 
Mint in this step, maybe possible to 
mend in flocke: define root element: 
"your schema root element contains 
one or more datasets with identical 
structure"

some kind of information in pop up

Open the mapping file
- in the Mapping Navigator view expand "BiellaDemoProject"
- expand the "Mapping" folder
- double-click "biella.harmonize"

Import a schema to the editor
- expand the "Schema" folder, click and drag "hto.xsd" onto the modeling canvas (white area), 
drop "hto.xsd" onto the modeling canvas,select "event" from the drop-box and press "OK"
- click and drag "biella.xsd" onto the modeling canvas, drop "biella.xsd" onto the modeling 
canvas, select "eventList" from the drop-box and press "OK"

Feedback about the import functionality
Feedback from IM on 24/8/12 (placed in several columns for readability purpose)
: Provided this approach will be given once the user has already perfomed an initial mapping, or continues the work of a colleage, it is very simple and user-friendly .
All other possibilities of import (Browse root element…) are not covered by testcase, what are they for?

Prerequisite: Imported demo project and imported schema files (biella.xsd, hto.xsd)
Map a single source element to single target element and accept its value
- select the "link" component from the component list next to the modeling canvas (left hand 
side)
- click on "title" in the "biella" schema, click on "mainTitle" in the "hto" schema
- select the "Select" component from the component list next to the modeling canvas (left hand 
side), click on the newly created link
- select "hto:value-of" in the dialog, enter "." (without ") for the value parameter and click 
"Confirm"
- save changes by clicking the save-button in the main toolbar or  by pressing STRG+S
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M
T2

.6

M
T2 Prerequisite: same as MT2.5

Perform transformation 
- click "createTX" in the main toolbar 
- check the result in the Feedback View

Make sure potential changes on the 
mapping have been saved! 
- changes are indicated by means of a * 
symbol at the top of the editor pane

- the Feedback View appears on 
the right hand side of the modeling 
canvas
- the Feedback View shows 4 
events in the HTO format, which is 
the output of the transformation 
(XSLT)
- each event (starting with 
<event>) has a <mainTitle> tag
- the elements "mainTitle" has a 
value: Mostra for the first three 
events, Mostre for the last event
NOTE: The values differ due to the 
provided instance data!

o T
M

o IM

M
T2

.7

M
T2 - as soon as the mapping link is 

created a black line appears 
connecting both elements
- when selecting a link a dialog 
window appears
- confirming the mapping settings 
changes the color from black to 
green

o T
M

o IM

M
T2

.8

M
T2 - each event (<event>) has an 

additonal <subTitle> entry
- the value for each sub title has to 
equal the main title's value, i.e., 
Mostra for the first three, Mostre 
for the last event
NOTE: The values differ due to the 
provided instance data!

o T
M

o IM

M
T2

.9

M
T2 - two configured (green) mapping 

links interlinking the elements 
"articleName" and "contactWeb" 
in the biella schema to 
"shortDescription" in the hto 
schema

o T
M

o IM

Perform 
transforma
tion

Single 
source to 
multiple 
target 
element 
mappings

Perform 
transforma
tion

Concatinati
on multiple 
source to 
single 
target 
mapping

expected

as expected

expected

expectedPrerequisite: Imported demo project and imported schema files (biella.xsd, hto.xsd)
Map a single source element to multiple target elements and accept its value
- select the "link" component from the component list next to the modeling canvas (left hand 
side), click on "title" in the biella schema and click on "subTitle" in the hto schema
- select the "Select" component from the component list next to the modeling canvas (left hand 
side), select the newly created link, select "hto:value-of" in the dialog, enter "." (without ") for 
the value parameter and  click "Confirm"
- save changes by clicking the save-button in the main toolbar
Prerequisite: Imported demo project and imported schema files (biella.xsd, hto.xsd); existing 
mapping
Perform transformation 
- click "createTX" in the main toolbar 
- check the result in the Feedback View

Prerequisite: same as MT2.5
Concatinate values from multiple source to single target element
- select the "link" component from the component list next to the modeling canvas (left hand 
side)
- click on "articleName" in the "biella" schema, click on "shortDescription" in the "hto" schema
- select the "Select" component from the component list next to the modeling canvas (left hand 
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M
T2

.1
0

M
T2 - a new <shortDescription> 

element appears 
- its value contains the article title 
and a web link, e.g., 
Mostrahttp://www.biellesitessitori
diunita.it
NOTE: The values depend on the 
provided instance data! Thus, they 
can vary!

o T
M

o IM

M
T2

.1
1

M
T2 Prerequisite: Imported demo project and 

imported schema files (biella.xsd, hto.xsd)
Map an xsd formated date
- select the "link" component from the component 
list next to the modeling canvas (left hand side), 
click on "dateMin" in the biella schema and click 
on "startDate" in the hto schema
- select the "Select" component from the 
component list next to the modeling canvas (left 
hand side), select the newly created link and select 
"hto:xsd-date-to-hto-date" in the dialog 
- enter "." (without ") for the "date" parameter 
and click "Confirm"
- save changes by clicking the save-button in the 
main toolbar

The provided date format in the instance 
data corresponds to the xsd-date format
Evaluation of the input format
- Expand "Input" and open 
"biellaEvents.xml" 
- check the date format for <dateMin>, it 
should be 2011-10-15T12:00:00

- as soon as the mapping link is 
created  a black line appears 
connecting both elements
- when selecting a link a dialog 
window appears
- setting the mapping specifications 
the link's color is changed to green

o T
M

w IM

M
T2

.1
2

M
T2 - the output has another new 

element: <startDate>
- the start date has three sub-
elements: <year>, <month>, <day>
- check the value for each sub-
element, e.g., 2011 (year), 10 
(month), 15 (day)
NOTE: The values depend on the 
provided instance data! Thus, they 
can vary!

o T
M

o IM

Date 
mapping

Perform 
transforma
tion

Perform 
transformai
ton 

why not with comma space 
inbetween, it makes sense to want to 
have 2 data in one field (I would 
imagine, e.g., I would like to send 
data that is not in the hto ontology to 
a third party (e.g. euromuse), like the 
webcontact, and I want to add it to 
the long description, but comma 
separated, or even in a new line 
<br/>
The result is as expected, but it is not 
easy to guess, which is the right 
choice... maybe the wording could be 
different (see comments line 42)
dateMin in source biella is start date 
in hto, the format has to be chosen 
"hto:xsd-date-to-hto-date", why then 
for the dateMax (which is the end 
date in hto) does not work the same 
"hto:xsd-date-to-hto-date", and has 
to be chosen "yyyymmdd-date-to-hto-
date"? In the xml of the biella event 
both have the same fortmat (namely: 
20112011T12:00:00 / 
yyyymmddThh:mm:ss)

Prerequisite: Imported demo project and imported schema files (biella.xsd, hto.xsd); existing 
mapping
Perform transformation : click "createTX" in the main toolbar 
and check the result in the Feedback View

Prerequisite: same as MT2.5
Perform transformation 
- click "createTX" in the main toolbar 
- check the result in the Feedback View
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M
T2

.1
3

M
T2 Prerequisite: same as MT2.5

Map a date formated in ddmmyyyy
- select the "link" component from the component 
list next to the modeling canvas (left hand side)
- click on "dateMax" in the "biella" schema, click 
on "endDate" in the "hto" schema and select the 
"Select" component from the component list next 
to the modeling canvas (left hand side)
- select the newly created link, select 
"hto:ddmmyyyy-to-hto-date" in the dialog,  enter 
"." (without "") for the "date" parameter and click 
"Confirm"
- save changes by clicking the save-button in the 
main toolbar

The provided date format in the instance 
data corresponds to a format like: 
20112011T12:00:00
Evaluate the date format of the instance 
data
- Expand "Input" and open 
"biellaEvents.xml"
- check the date format for <dateMax>, it 
should be something like 
20112011T12:00:00

- as soon as the mapping link is 
created a black line appears 
connecting both elements
- when selecting a link a dialog 
window appears
- setting the mapping specifications 
the link's color is changed to green

o T
M

o IM

M
T2

.1
4

M
T2 - the output has another new 

element: <startDate>
- the start date has three sub-
elements: year, month, day
- check the value for each sub-
element, e.g., 2011 (year), 10 
(month), 15 (day)
NOTE: The values depend on the 
provided instance data! Thus, they 
can vary!

o T
M

o IM

M
T2

.1
5

M
T2 Transforma

tion

Perform 
transformai
ton 

Date 
mapping 

See comments in line 42.

as expected

Transforms a mapping to XSLT.

Prerequisite: same as MT2.5
Perform transformation 
- click "createTX" in the main toolbar 
- check the result in the Feedback View



Appendix B.4 - Document 1 - Test Case Release 4 - Mapping Tool  - Page 8 on 15

Id Pa
re

nt

Se
qu

en
ce

Ac
tio

n

N
am

e

Description
Comment
 (and alternatives) Expected Outputs 18

/7
/1

2
W

ho

Actual 
Result 24

/8
/1

2
w

ho Actual Result O
ut

pu
t 

M
T2

.1
6

M
T2 Prerequisite: same as MT2.5

Map hto:languageText elements (e.g., long 
description)
- select the "link" component from the component 
list next to the modeling canvas (left hand side), 
click on "longDesc" in the "biella" schema and click 
on "longDescription" in the "hto" schema
- select the "Select" component from the 
component list next to the modeling canvas (left 
hand side), select the newly created link, select 
"hto:languageText" in the dialog and enter "." 
(without "") for the "text" parameter
- enter 'de' (including the ') for the "language" 
parameter and click "Confirm"
- save changes by clicking the save-button in the 
main toolbar

Note: Once a language text has been 
mapped, the language parameter is saved 
automatically and available via the drop-
down list. 

- as soon as the mapping link is 
created a black line appears 
connecting both elements
- when selecting a link a dialog 
window appears
- setting the mapping specifications 
the link's color is changed to green

o T
M

o IM

M
T2

.1
7

M
T2 - the output has another new 

element: <longDescription>
- <longDescription> has two sub-
elements: <text> and <language>
- make sure the language-value is 
set to "de"
- check if the text-value is set (may 
vary depending on the instance 
data)
NOTE: The values depend on the 
provided instance data! Thus, they 
can vary!

o T
M

o IM

- the links between "articleName", 
"contactWeb" and 
"shortDescription" are deleted and 
not present anymore

o T
M

o IM

M
T2

.1
7

M
T2 - the generated output has no 

<shortDescription> element 
anymore

o T
M

o IMPerform 
transformai
ton 

Delete a 
mapping 
link

Perform 
transformai
ton 

Set hto 
language

mac user… everywhere you write left-
clicks should be right-clicks!!

as expected

Prerequisite: same as MT2.5
Perform transformation  : click "createTX" in the main toolbar  and  check the result in the 
Feedback View

Prerequisite: same as MT2.5
Delete a mapping link as follows
- select "Select" from the components list 
- left-click the link between "articleName" and "shortDescription" and select "delete"
- left-click the link between "contactWeb" and "shortDescription" and select "delete"
- save your changes

Prerequisite: same as MT2.5
Perform transformation : click "createTX" in the main toolbar  and check the result in the 
Feedback View

typed 'it' instead

as expected
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M
T2

.1
8

M
T2 Prerequisite: same as MT2.5

Reuse language settings
- select the "link" component from the component 
list next to the modeling canvas (left hand side)
- click on "longDesc" in the "biella" schema, click 
on "shortDescription" in the "hto" schema and 
select the "Select" component from the 
component list next to the modeling canvas (left 
hand side)
- select the newly created link, select 
"hto:languageText" in the dialog, enter "." 
(without "") for the "text" parameter and click the 
drop-down boxk and select 'de' for the "language" 
parameter and click "Confirm"
- save changes by clicking the save-button in the 
main toolbar

Note: The Biella schema does not have a 
short description. However, for 
demonstration purposes we will map the 
long description 

- mapping dialog: the previously set 
language ('de') is available via the 
drop-down box for the langauge 
parameter
- confirming the mapping 
specifications changes the link's 
color to green

o T
M

o IM

M
T2

.1
9

M
T2 - the <shortDescription> element 

appears again with two sub-
elements: <text> and <language>
- make sure the language-value is 
set to 'de'
- check if the text-value is set (may 
vary depending on the instance 
data)
NOTE: The values depend on the 
provided instance data! Thus, they 
can vary!

o T
M

o IMPerform 
transformai
ton 

Reuse 
already set 
language

as expected

as expected

Provide feedback about the graphical feedback (green, black links)

Feedback from IM on 24/8/12 (placed in several columns for readability purpose)
a) The link 'sticky' function… still think there should have an integrated solution to 'guide' the user to the select functionality (maybe the first link could activate a dialoge informing to change into the select 
function to confirm or edit the link).
b) the value mapping condition dialogue disapears if you click on another application on your computer even if you have not set a parameter for value; it could remain there and disapear once the link is 
confirmed, it is clicked in the white area of the viewer or esc is hit. Or it could have a 'close window' button.

Prerequisite: same as MT2.5
Perform transformation 
- click "createTX" in the main toolbar 
- check the result in the Feedback View
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A user follows a defined mapping process that 
suggests the elements that a domain expert has to 
map

M
T2

.2
1

M
T2 Delete the previously created mapping links

- select each link by a right-click and select 
"delete"
- save your changes
- close the mapping file "biella.harmonize"
- double-click "biella.harmonize" again in order to 
re-open the mapping editor

Note: To refresh the settings it is required 
to close and re-open the mapping file

- all links are deleted and do not 
appear anymore on the modeling 
canvas

o T
M

o IM as expected

Prerequisite: Prerequisite: same as MT2.5

Delete all 
mapping 
links

Following a 
strict 
mapping 

Provide feedback about the interlinking method
Feedback from IM on 24/8/12 (placed in several columns for readability purpose)
Interlinking dates: so ok, it is obvious that you are linking from xsd (source) to hto (target), so why repeat it? Why not offer the user to define their format? E.g.
 YYYYMMDD
 DD-MM-YYYY
 DD.MM.YYYY
 DDMMYYYY
or even better, with a sample-date:
1.1.2000
2000-01-01 ...[more can be found in excel]
interlinking text: If I where not to have the cheat sheets, how would I know that the language has to be defined by de, it, en... and cannot write deutsch, italiano,... this would be easier if in the window, an 
example could be provided, also i find weird that I have to set semi-colon 'en'...It is just not intuitive enough.

Provide feedback about the Graph View editor
Feedback from IM on 24/8/12 (placed in several columns for readability purpose)
n information about the links appears when mousover a link (from/to). This information should not hang around too much (PIC mouseover_limit.png)
Another day this did not happen (maybe the computer was running slower, and this is not the mapping tool, but the computer.)

Provide general feedback 
Feedback from IM on 24/8/12 (placed in several columns for readability purpose)
At the moment nothing more… see general functionality improvement (languagues and dates). The trouble is, this is not an example that I can then test results, that is still what I am looking for in the test 
cases, to output a file and actually use it
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M
T2

.2
2

M
T2 - a form view editor appears in the 

editor pane
- the "Form View" tab is active 
(highlighted) 
- the "biella" schema is listed as a 
tree view on the left hand side of 
the editor
- the right hand side of the editor 
shows the mapping steps: (i) a 
table and (ii) 4 bullets (Step 1, 
Step2, Step3, Step all)
- "Step all" is checked

o T
M

o IM

M
T2

.2
3

M
T2 Mapping the title element

- select "Step 1" 
- select "title" from the table on the right hand 
side
- expand the biella schema shown on the left hand 
side
- drag&drop the "title" element onto the second 
table (right below the first one)
- select "hto:languageText"
- type 'en' (including ') as parameter into the drop-
box for the "language" parameter
- press "Confirm"
- save your changes

Explanation: The form editor is separated 
into two parts: the left hand side shows the 
source schema (biella), whereas the right 
hand side shows the target schema (hto). 
The mappers task is to provide an adequate 
mapping for required target elements. These 
elements are defined by a fixed mapping 
process. The mapping process in the context 
of the HarmoSearch mapping tool is called 
"Filter". The corresponding filter file 
(filter.xml) is located in the "Filter" folder. 
Note: We leave the subtitle element 
unmapped since no corresponding opposite 
element exists in the biella schema!

- the "title" tag changes ist color 
from white to green (showing that 
the mapping has been completed)
- "subtitle" remains in white (not 
mapped) status

o T
M

o IMMapping 
the basic 
description 

as expected

ohhh!

Switch to the Form View mapping editor
- click the "Form View" tab at the bottom of the mapping editor

Change the 
mapping 
editor
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M
T2

.2
4

M
T2 - the Feedback View appears on 

the right hand side of the modeling 
canvas
- the Feedback View shows 4 
events in the HTO format, which is 
the output of the transformation 
(XSLT)
- each event (starting with 
<event>) has a <mainTitle> tag
- the elements "mainTitle" should 
have a value: Mostra for the first 
three events, Mostre for the last 
event
- make sure no <subTitle> element 
exists
NOTE: The values differ due to the 
provided instance data!

o T
M

o IM

M
T2

.2
5

M
T2 Switch to step 2

- select "Step2"
Mapping the long description element
- select "longDescription", drag and drop 
"longDesc" from the biella schema to the table 
below
- select "hto:languageText", select the already 
defined language 'en' from the drop-down list and 
press "Confirm" and save your changes
Mapping the Begin Date
- select "beginDate", drag and drop "dateMin" 
from the biella schema to the table below
- select "hto:xsd-date-to-hto-date" and press 
"Confirm"and save your changes
Mapping the End Date
- select "endDate", drag and drop "dateMax" from 
the biella schema to the table below
- select "hto:ddmmyyyy-data-to-hto-date" and 
press "Confirm" and - save your changes

Note: Short description and day times will 
not me mapped since we are not able to find 
a corresponding opposite in the biella 
schema

- Step 2 is active and the 
corresponding elements are shown 
in the table
- their default status is not-mapped 
so far (white box)
- after confirming the mappings for 
"longDescription", "startDate" and 
"endDate" their status changes to 
done, wich is illustrated by a green 
box

o T
M

o IMMapping 
the 
additional 
informatio
n 

Perform 
transformai
ton 

as expected, ant might I say done in 
less than 1 minute!
PS Still thinking we should rephrase 
the options "hto:xsd-date-to-hto-
date" and"hto:ddmmyyy-data to-hto-
date"

as expectedPerform transformation 
- click "createTX" in the main toolbar 
- check the result in the Feedback View
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/7
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Actual 
Result 24

/8
/1

2
w

ho Actual Result O
ut

pu
t 

M
T2

.2
6

M
T2 - the output shows 2 new 

elements: <description>, 
<timeline>
- <timeline> is composed, among 
others, of <startDate> and 
<endDate> elements
- check that <startDate> as well as 
<endDate> have assigned values 
for <year>, <month> and <day>
- <description> contains among 
others <longDescription>
- make sure the sub-elements 
<text> and <language> contain a 
value (en in case of <language>)
NOTE: The values depend on the 
provided instance data! Thus, they 
can vary

o T
M

o IM

M
T2

.2
7

M
T2 Switch to step 3

- select "Step 3"
Mapping the category
- select "category",  drag and drop "kwID" from 
the biella schema (sub-element of "eventType")
- select "hto:Category", select "." from the drop-
down list and press Confirm
- save your changes

Note: the remaining elements "organiser 
id" and "location id" will be mapped in the 
next step for demonstration purposes of 
the graphical domain-expert feedback

- Step 3 is active and the 
corresponding elements are shown 
in the table
- their default status is not-mapped 
(white box)
- after applying the mapping 
"category" switches to done (green 
box)
- organiser id and location id 
remain white (not mapped at all)

o T
M

o IM

M
T2

.2
8

M
T2 - the output shows a new element: 

<category>
- check if  the sub-element 
<domainValue> is set (e.g., 
exhibition european art before 
1800)
NOTE: The values depend on the 
provided instance data! Thus, they 
can vary!

o T
M

o IMPerform 
transformai
ton 

Mapping 
step 3

Perform 
transformai
ton 

as expected

as expected

as expected

Perform transformation 
- click "createTX" in the main toolbar 
- check the result in the Feedback View

Perform transformation 
- click "createTX" in the main toolbar 
- check the result in the Feedback View
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Result 24

/8
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ho Actual Result O
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M
T2

.2
9

M
T2 Indicate organiser id as unsolved mapping

- select "organiser id" 
- drag and drop "pid" onto the table below
- save your changes

In case the domain-expert does not feel 
confortable with a solution or is not able to 
do a mapping at all but is sure that a 
corresponding opposite exists in the source 
schema he is able to provide graphical 
feedback.

- the "organiser id" changes ist 
color to black
- this indicates that the domain 
expert is not sure about the 
correctness of the proposed 
mapping, the feedback indicates 
"additional support needed"

o T
M

o IM

M
T2

.3
0

M
T2 Mark location id as "TODO"

- select "location id"
- drag and drop "id" onto the table below, click on 
"id" , select "TODO" from the drop-box and press 
"Confirm"
- save your changes

Setting a mapping status to TODO signals 
the technical expert that the domain expert 
was not able to solve the mapping. 
Potential reasons may be missing pattern 
support. As a consequence the technical 
expert has an anchor and knows where to 
hook in in order to solve the problem and 
finalize the mapping, e.g., by implementing 
the missing pattern

- the "location id" changes ist color 
to red
- such a mapping indicates that the 
corresponding opposite has been 
found but cannot be mapped to 
hto due to technical reasons
- such mappings require additional 
technical support, e.g., 
implementing  missing pattern

o T
M

o IM

M
T2

.3
1

M
T2 Reset the mapping for location id

- select "location id", select "id", select "reset" 
from the drop-down box and press "Confirm"
- save your changes

In case the domain expert thinks an already 
set mapping has to be reset

- the "location id" changes ist color 
to white (no mapping at all)

o T
M

w IM it is black (pic 
reset_mapping.png)
What is the difference between 
reset and delete?
See: reset_mapping,png

sc
re

en

IM I made a pic with comments see : 
Form_ui.png sc

re
e

Reset an 
already 
defined 
mapping

Set the 
mapping 
status to 
TODO

Set a 
mapping to 
status 
unknown

MT4

as expected
comment 1: what if the domain 
expert, has no clue as what to 
choose? Could not be possible to 
mark location id in the hto element 
as TODO?
Comment 2: where to set to TODO, in 
the hto:Referencedvalue or hto:value-
of?

alternativelly, the user (as I did), can 
open in the viewer in the folder 
"input" , the "BiellaEvents.xml" 
where he/she can see the actual 
values being mapped. 

Feedback about the Form View UI

Feedback about the functionality of the Form View mapping editor
Feedback from IM on 24/8/12 (placed in several columns for readability purpose)
I am fan! It can be handled better than the Graphical view, where switching from Link function to Select function and the many windows, added complexity to the process. 
The form view is more intuitive, once you know you have to activate the element in the hto filter to be mapped, and know the area where the source schema element has to be dropped... is easy peasy!! still, 
the content of the mapping conditioning could be simplified

Feedback about the graphical domain expert feedback functionality
Feedback from IM on 24/8/12 (placed in several columns for readability purpose)
? You mean set a link as TODO? This is great if I knew of a case of a user having a technical expert behind to finish up their work, maybe Sabine, can give you some feedback ...

Transformation Process
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- the standard XML output has 
changed to HTML listing the 
corresponding events and 
mappings in table form

o T
M

o IM

M
T3

.1

M
T3 Open the integrated help

- Click "Help > Help Contents" in the main menu
- Expand the "HarmoSearch Mapping Tool User 
Guide" node
- Expand "Getting Started" 
- Expand "Basic Tutorial"
- Click "Create your first mapping project"

Note: The documentation is in a pre-
leminary state due to the prototypical 
status of the mapping tool. 

- The integrated help dialog pops 
up
- The help contents appear on the 
left hand side and contain two 
nodes (i) "HarmoSearch Mapping 
Tool User Guide" and (ii) "XSL Tools 
User Documentation"
- "HarmoSearch Mapping Tool User 
Guide" contains 4 sub-nodes
- "Getting Started" and "Concepts" 
are further refined by additional 
sub-nodes

o T
M

Docum
entatio
n 
expecte
d

w

M
T3

.2

M
T3 - The "Cheat Sheets" View opens 

and shows the content of the 
"Create a new "Hello World" 
mapping project
- The cheatsheet is separated into 
5 sections 
- Interacting with the cheatsheets 
result in for example calling a 
wizard or moving to the next 
explanatory section

o T
M

w

M
T3

.3

M
T3 o T

M

M
T3

.4

M
T3

MT3 User 

Use HTML 
as output 
format

Potential question : What functionality should be covered by means of a cheat sheet

is there a way around the firewall (i 
cannot change my firewall settings, 
and these do not allow the mapping 
tool to connect). Alternatively you 
could ask Adriano or David (or Peter) 
to do these test lines?

did this, once I had mapped all fields 
from the excercise above (including: 
title, dates, description, categories), 
and the categories were not 
outputed in the html output (while 
they where output in the xml 
feedback

is there a way around the firewall (i 
cannot change my firewall settings, 
and these do not allow the mapping 
tool to connect). Alternatively you 
could ask Adriano or David (or Peter) 
to do these test lines?

cheat 
sheets

help 
contents

Cheatsheet 
support

Integrated 
help

Prerequisits: An existing project and corresponding mappings
Requirements: Note, in order to generate HTML output a proper transformation template 
(XSLT) is required that is suitable to transform the resulting XML output to HTML
Change the process settings : 
- Expand the "Input" folder
- double-click "process.xml", uncomment "<Xsl>Pattern/hto2html.xsl</Xsl>" by removing "<!--" 
and "-->"
- change the value of "<Output>" to "html" (without ") and save your changes
Perform transformation : click "createTX" in the main toolbar and check the result in the 
Feedback View

Prerequisite: To accomplish this task the installation of the third party plugin 
"harmosearch.mappingtool.cheatsheets" (see task MT0.6)
Open the cheatsheets
- Click "Help > Cheatsheets…", Expand "HarmoSearch"
- Select "Create a new "Hello World" mapping project", Click "OK" 
- Start the cheat sheet by clicking "Click on Begin" in the Introduction section
- Follow the instructions

Refers to relevant enhancments helping the user handling the mapping tool

Potential question :  What are must have criteria for the user documentation provided by the mapping tool
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/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
0 Basic 

configuration 

needed for 

the tests

User configures his account with mappings, permissions and query 

service

R
0

.0 R
0 Create an 

account if you 

don't have 

one yet

 click on 'Sign in'

 click on 'Create Account'

insert your own data (names and a valid email address)

select also the organization you belong to (if not present insert the 

organization's name)

wait for the account activation email (activation is done by an 

administrator)

Email which confirms that the 

account is active.

O

P
ro

m
o

te
r

Emails recevied, 

account active

X
m

u
se

u
m

sm
e

d
ie

n
no activation, 

Claudio did it 

manually.

password and 

sentence ends with 

dot, to me it is not 

clear, where the 

password ends

it seems not possible 

to copy & paste the 

password

R
0

.1 R
0 Upload data 

mapping file 

from local 

system to 

Harmonise 

ontology (for 

the events 

domain)

Log in with your user

- go on 'Configurations'->'Mapping Store'

- select any identifier as 'collectionId' (for instance 'events')

- choose 'Upload mapping from local system to Harmonise ontology'

- select the mapping from local system to Harmonise ontology 

(choose the file available in the test folder as 'Euromuse_HTO.xslt' )

- select 'default for sending events'

- click on 'Send' and check for the success message on top of the page

File is listed in the box at the 

end of the page.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok

R
0

.2 R
0 Upload data 

mapping file 

from 

Harmonise 

ontology to 

local system 

(for the 

events 

domain)

Log in with your user

- go on 'Configurations'->'Mapping Store'

- select any identifier as 'collectionId' (for instance 'events')

- choose 'Upload mapping from Harmonise ontology to local system'

- select the mapping from Harmonise ontology to local system 

(choose the file available in the test folder as 'HTO_Euromuse.xslt')

- select 'default for receiving events'

- click on 'Send' and check for the success message on top of the page

File is listed in the box at the 

end of the page.

O

P
ro

m
o

te
r

?

m
u

se
u

m
sm

e
d

ie
n

upload takes a long 

time, no hints from 

the system, what is 

going on…

tried again

tried 3 times

then stopped, and 

clicked on "mapping 

store" again, it 

showed the 

HTO_Euromuse at 

the bottom, but no 

success message

T
e

st
.S

e
t.

U
p
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/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
0

.3 R
0 Set up query 

service

Login with your user

go in 'Configurations'->'Query Service'

in panel 'Registry Data Management' click on the name of your 

organization (Participant Name)

Go on panel 'Create and attach a new Data Provider' and insert an id 

(e.g. <Your-organization_name>_dataprovider (no whitespaces!))

click on 'Create' and insert the following parameters:

      any name for your provider

      the name of the collectionId that you used when uploading the 

mapping (for instance 'events')

      'http://www.euromuse.net/harmonise/query/query.php' as 

service access endpoint 

       (no whitespaces!)

      'karin' as username and password (no whitespaces!)

      'HTTPAdapter' as Connector class (no whitespaces!)

      select 'METASEARCH' and 'IMPORT' as supported Query types

      'Event' as Subdomain

      click on 'Save Changes'

click 'Edit Data Description' and select 'Events with location and 

category' from the drop-down list on the top

click on 'Save Changes'

If you go back to the view 

'Harmonise Participant Details' 

(back to list, click on your 

organization's name), the new 

data provider is attached to 

the your organization

O

P
ro

m
o

te
r

X

m
u

se
u

m
sm

e
d

ie
n

this does not seem 

to work?:

click 'Edit Data 

Description' and 

select 'Events with 

location and 

category' from the 

drop-down list on 

the top

click on 'Save 

Changes'

I always get some 

XML in the window, 

but no success?

R
0

.4 R
0 Change email 

address 

(which is the 

username) of 

'testuser'

Log in with username 'testuser@test.user', with password 'testuser'

- go on 'Configurations' -> 'Edit Profile'

- insert your email address (must be different from the one you 

already set for your user account on HarmoSearch)

- click 'Save' and check the success message

After you log out you can 

again log in with the new 

email address as username, 

and 'testuser' as password

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

Your request 

processed 

successfully. O.k.

R
0

.5 R
0 Subscribe to 

external 

service

Log in with your account

- go on 'External Services' -> 'Subscribe to Service'

- click 'Subscribe' on the external service 'Event fields filter'

- do not insert any value in 'Terms of use' (asking to use the service 

without restrictions)

This service is open to all, and 

the subscription does not 

require the authorization by 

the owner of the service

Event fields filter' is in status 

'Auhtorized' and is 

immediately available in the 

dropdown list of the import, 

push and scheduler pages.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

o.k.
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/1

1
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2

W
h
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Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
0

.6 R
0 Upload query 

mappings (for 

the events 

domain)

log with your user

go on 'Configurations'->'Mapping Store'

insert the collection id you already used for the events domain when 

uploading the data mappings (for instance 'events')

choose 'Upload query mapping to translate HarmoSearch fields and 

enumerations'

select the query fields and enumerations mapping file (you can 

choose the file available in the test folder as 

'HTO_Euromuse_query_enum.xslt')

choose 'Upload query mapping to translate HarmoSearch query 

structure'

select the query structure mapping file (you can choose the file 

available in the test folder as 'HTO_Euromuse_query.xslt')

click on 'Send' and check for the success message on top of the page

Files are listed in the box at 

the end of the page.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

Mapping file 

successfully 

uploaded

But the test file is an 

.xsl not .xslt

R
0

.7 R
0

Restore 

testuser email 

address 

(which 

represents 

the 

username)

AT THE END OF YOUR TESTING:

Log in as testuser (username is the emai you set), with password 

'testuser'

-  go on 'Configurations' -> 'Edit Profile'

- insert as email address: testuser@test.user

- click 'Save' and check the success message

Required when you stop 

testing!

After you log out you can 

again log in with the 

'testuser@test.user' as 

username, and 'testuser' as 

password

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

R
0

.8 R
0

Remove 

scheduled 

tasks

AT THE END OF YOUR TESTING:

Log in with your account

- delete all scheduled operations within 'Exchange Data' -> 

'Scheduler'

Required when you stop 

testing!

Otherwise the mail 

notifications will be sent to 

the next testers

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n
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Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
0

.9 R
0

Content of 

user 

registration 

page

Create Account' page contains fields and buttons to register a new 

user

R
0

.1
0

R
0

Documentatio

n of user 

registration 

page

Link to the documentation

R
0

.1
1

R
0

Content of 

user profile 

editing form

Edit Profile' page has fields and buttons for updating user 

information and password
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Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
0

.1
2

R
0

Documentatio

n of user 

profile editing 

form

Link to the documentation

R
1 Publish 

events on 

social 

networks

User publishes selected events on Facebook and on Twitter

R
1

.1 R
1

R
0

.1
, 

R
0

.3
, 

R
0

.6
, 

R
1

.1
, 

R
1

.2
, 

R
1

.3 Give 

permission to 

publish on 

your behalf

Login with your account

go on Configurations -> Social Networks

click on 'give permissions' for one of the social networks where you 

have an account

For Facebook, it is enough if 

you give to HarmoSearch app 

the permissions: 'Post on your 

behalf' and 'Manage your 

events'.

The button for giving 

permission is replaced by the 

buttons for expanding the 

credentials token and for 

removing the just given 

permission.

On the Scheduler page, if you 

select 'Publish' as operation, 

your social network target is 

now available in the 

dropdown list (e.g. as 'Twitter-

my status')

O
P

ro
m

o
te

r
_

m
u

se
u

m
sm

e
d

ie
n

R
1

.2 R
1

R
0

.1
, 

R
0

.3
, 

R
0

.6
, 

R
1

.1
, 

R
1

.2
, 

R
1

.3 Schedule 

publish with 

manual filter

Prerequisite : you have uploaded and configured the mapping of 

events from your local system to HarmoSearch, the two mappings 

for the query, and you have configured a query service for your 

organization (see the 'Sequence' column - C18 - for the details)

go on 'Exchange Data' -> 'Scheduler'

select 

- 'Publish on social network' as operation

- your social network's target (one or more) as recipient (*)

- keep 'Filter manually' selected

- subdomain 'Event', country 'France', city 'Paris', category 'exhibition 

painting'

- schedule the operation within the next 10 minutes (**)

- wait until the operation is done

* don't select 'HarmoSearch 

event' or 'HarmoSearch 

status', but only 'Facebook my 

event', 'Facebook my status', 

'Twitter my status'

** you can refer to 

http://www.timeanddate.com

/worldclock/city.html?n=195

in order to know the server's 

system clock

In 'Operation Status' the 

publish operation is reported 

as suspended and awaiting 

confirmation.

An email is sent that invites 

the user to log in and confirm 

the publishing of the selected 

events.

Some events should be 

available for publishing on 

your social network (the same 

that are returned with a 

metasearch using the same 

search parameters).

O

P
ro

m
o

te
r

_

m
u

se
u

m
sm

e
d

ie
n

E
xc

h
a

n
g

e
:P

u
b

li
sh

.E
v
e

n
ts
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Actual Result

R
1

.3 R
1

R
0

.1
, 

R
0

.3
, 

R
0

.6
, 

Filter 

manually and 

confirm 

publishing

go on 'Exchange Data' -> 'Confirm publishing'

select one or more of the events in the list

click on 'Publish selected items'

The message 'Selected items 

have been published' is 

shown.

The selected events are 

published on the users social 

network target.

O

P
ro

m
o

te
r

_

m
u

se
u

m
sm

e
d

ie
n

R
1

.4 R
1

R
0

.1
, 

R
0

.3
, 

R
0

.6
, 

R
1

.1
, 

R
1

.4 Schedule full 

automatic 

publish

go on 'Exchange Data' -> 'Scheduler'

select 

- 'Publish on social network' as operation

- your social network's target (one or more) as recipient (*)

- unselect 'Filter manually' checkbox

- subdomain 'Event', country 'France', city 'Paris', category 'exhibition 

european cultural history'

* don't select 'HarmoSearch 

event' or 'HarmoSearch 

status', but only 'Facebook my 

event', 'Facebook my status', 

'Twitter my status'

In 'Operation Status' the 

publish operation is reported 

as completed.

An email is sent that informs 

on the success of the 

scheduled operation.

One event should be 

published on your social 

network (the same that is 

returned with a metasearch 

using the same search 

parameters).

O

P
ro

m
o

te
r

_

m
u

se
u

m
sm

e
d

ie
n

R
1

.5 R
1

R
0

.1
, 

R
1

.1
, 

R
1

.5 Publish from 

file

Prerequisite:  you have uploaded and configured the mapping of 

events from your local system to HarmoSearch

- Log in with your account

- go on 'Exchange Data' -> 'Share Data'

- select 'Publish on social network' as operation

- uncheck 'Filter manually' checkbox

- select the file 'euromuse_Architektur.xml' as data file (available in 

the test folder)

- your social network's target (one or more) as recipient

- 'Event' as domain

- click on 'Send'

As alternative files you can use 

'euromuse_Wir_essen_Reis.x

ml' or 

'euromuse_2_events.xml'

In 'Operation Status' the 

publish operation is reported 

as completed.

An email is sent that informs 

on the success of the 

operation.

O

P
ro

m
o

te
r

_

m
u

se
u

m
sm

e
d

ie
n

R
1

.6 R
1

R
0

.1
, 

R
1

.1
, 

R
1

.5 Publish from 

file with 

wrong file 

format

Prerequisite : you have uploaded and configured the mapping of 

events from your local system to HarmoSearch

- Log in with your account

- go on 'Exchange Data' -> 'Share Data'

- select 'Publish on social network' as operation

- uncheck 'Filter manually' checkbox

- select the file 'harmonise_to_push_reduced.xml' as data file 

(available in the test folder)

- your social network's target (one or more) as recipient (*)

- 'Event' as domain

- click on 'Send'

*

don't select 'HarmoSearch 

event' or 'HarmoSearch 

status', but only 'Facebook my 

event', 'Facebook my status', 

'Twitter my status'

The screen message and the 

'Operation Status' report the 

failure of the operation, with 

error message 'Error in data 

mapping: Input file is 

incompatible with the 

mapping file.'

O

P
ro

m
o

te
r

_

m
u

se
u

m
sm

e
d

ie
n
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
1

.7 R
1

R
0

.1
, 

R
0

.3
, 

R
1

.1
, 

R
1

.7
, 

Scheduled 

publish

Publish from file with manual filter (see **) ** use the file 

'euromuse_2_events.xml' as 

data file and keep the 'Filter 

manually' checkbox checked

There are some items listed in 

'Exchange Data' -> 'Confirm 

publishing'

O

P
ro

m
o

te
r

_

m
u

se
u

m
sm

e
d

ie
n

R
1

.8 R
1

R
0

.1
, 

R
0

.3
, 

R
1

.1
, 

R
1

.7
, 

R
1

.8
, 

R
1

.9 Remove 

permission 

for publishing

Prerequisite : you have given permission to publish on some social 

network, and there are items ready to publish within 'Exchange 

Data' -> 'Confirm publishing'

- go on Configurations -> Social Networks

click on 'remove permissions' for one of the social networks where 

you have given permission before

The button for giving 

permission is again available.

O

P
ro

m
o

te
r

_

m
u

se
u

m
sm

e
d

ie
n

R
1

.9 R
1

R
0

.1
, 

R
0

.3
, 

R
1

.1
, 

R
1

.7
, 

R
1

.8
, 

R
1

.9 Confirm 

publishing 

without 

permission

Prerequisite : you have removed permission to publish on social 

networks on your behalf, and there are items ready to publish within 

'Exchange Data' -> 'Confirm publishing'

go on 'Exchange Data' -> 'Confirm publishing'

select one or more of the events in the list

click on 'Publish selected items'

An error message is shown: 

'The items below could not be 

published. Please see the 

error details here.'

'Operation Status' reports an 

error of missing configuration 

to publish on social networks. 

An email notification is sent to 

the user that informs about 

the error.

The items that could not be 

published due to the error, are 

still available in the 'Confirm 

publishing' page for a later try.

O

P
ro

m
o

te
r

_

m
u

se
u

m
sm

e
d

ie
n
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a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
1

.1
0

R
1 Content of 

the social 

networks 

configuration 

page

Social networks configuration page allows to give permission to 

HarmoSearch to publish events on some social network on the user's 

behalf. 

Overall structure of page + Blocks included in the page.

Describe in the test partition 

improvements if necessary
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
1

.1
1

R
1 Content of 

the pages for 

defining the 

publishing 

(scheduler, 

share data)

Scheduler' and 'Share Data' pages allow to specify which events to 

publish, where and when to publish. 

Overall structure of page + Blocks included in the page.

Describe in the test partition 

improvements if necessary

R
1

.1
2

R
1 Content of 

the page for 

filtering and 

confirming 

the publishing

Confirm publishing' page allows to check and filter the events that 

are ready to be published. 

Overall structure of page + Blocks included in the page.

Describe in the test partition 

improvements if necessary

R
1

.1
3

R
1 Documentatio

n of the 

pages: 'Social 

Networks', 

'Scheduler', 

'Share data', 

'Confirm 

publishing'

Link to the documentation Describe in the test partition 

improvements if necessary

R
2 External 

Services

Harmonise users provide online services that can be included in the 

HarmoSearch processes

E
xc

h
a

n
g

e
:E

xt
e

rn
a

l.
S

e
rv

ic
e

s
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
2

.1 R
2

R
0

.4
, 

R
2

.1 User registers 

a new service 

that is open 

to all

Log in as testuser (username is the emai you set), with password 

'testuser'

- go on 'External Services' -> 'Manage Services'

- register a new service on the 'Add Workflow Service' panel, with 

fields:

- name: 'Test Filter'

- description: 'Filters out some services'

- keep 'Authorization required' unchecked

- access URL: http://harmosearchdev.harmonet.org/ExternalService-

portlet/testService

- click on 'Set'

The new service is in the 

workflow services list on the 

left

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

o.k.

R
2

.2 R
2

R
0

.4
, 

R
2

.1
, 

R
2

.2 Add users to 

service

Logged as testuser

- go on 'External Services' -> 'Service Policies'

- within the panel on the left (Add service policy)

- choose 'Test Filter'

- select your organization as 'Authorized users'

- do not insert any terms of use

- click on the button

Your organization is now listed 

among the authorized users.

O
P

ro
m

o
te

r
O

m
u

se
u

m
sm

e
d

ie
n

Workflow service 

now authorized

R
2

.3 R
2

R
0

.1
, 

R
2

.1
, 

R
2

.2
, 

R
2

.3 Use external 

service that is 

unavailable

Prerequisite : You have uploaded the mapping from your system to 

Harmonise ontology

logged in with your account,

go on 'Exchange Data' -> 'Share Data'

- select 'Push' as operation

- choose 'euromuse_2_events.xml' as data file (available from test 

folder)

- 'euromuse' as recipient

- 'Event' as domain

- Include 'Test Service' (click on Add button)

- click on 'Send'

Error message is shown on the 

screen ('Test Service is 

unavailable').

The error message is also 

reported in 'Operation Status' 

and in a mail notification.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

Error in external 

service. Service is 

not available: 

http://harmosearch

dev.harmonet.org/E

xternalService-

portlet/testService

R
2

.4 R
2

R
0

.4
, 

R
2

.1
, 

R
2

.2 Remove users 

from service

Logged as testuser

- go on 'External Services' -> 'Service Policies'

- click on 'Delete' on the row that has your organization as 

'Authorized users'

Your organization is no more 

listed among the authorized 

users.

When you log in with your 

account, the service is no 

more available in the 

dropdown list on the import, 

push and scheduler pages.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok

E
xc

h
a

n
g

e
:E

xt
e

rn
a

l.
S

e
rv

ic
e

s
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
2

.5 R
2

R
0

.4
, 

R
2

.1
, 

R
2

.2
, 

R
2

.5 Modify 

service

Log in as testuser (username is the emai you set), with password 

'testuser'

- go on 'External Services' -> 'Manage Services'

- clik 'Modify' on 'Test Filter'

- update the access URL with: 

http://harmosearchdev.harmonet.org/ExternalService-

portlet/permEvents

- check 'Authorization requested' checkbox

- click on 'Save'

The service is now updated in 

the workflow services list. 

(There are no more authorized 

users).

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok

R
2

.6 R
2

R
0

.4
, 

R
2

.1
, 

R
2

.5
, 

R
2

.6 Subscribe to 

service

log in with your account

go on 'External Services' -> 'Subscribe to Service'

click on 'subscribe' for the 'Test Filter' service

you are free to insert the terms of use that you want

Status of the service is 

'REQUESTED'.

An email is sent to the email 

address that you have set for 

'testuser', saying that a user 

requested the subscrition to 

the service.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
2

.7 R
2

R
0

.4
, 

R
2

.1
, 

R
2

.5
, 

R
2

.6
, 

R
2

.7 Deny 

subscription 

to service

Log in as testuser (username is the emai you set), with password 

'testuser'

- go on 'External Services' -> 'Manage Services'

- click on 'Deny' on the subscription request of your user (on the 

Workflow Requested Service Panel)

An email is sent to the email 

address that you have set for 

your account, saying that the 

request for  subscription was 

denied.

If you log in with your account, 

in 'Subscribe to Service' the 

service is in 'Denied' status, 

and the service remains not 

available in the dropdown list 

on the import, push and 

scheduler pages.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok

R
2

.8 R
2

R
0

.4
, 

R
2

.1
, 

R
2

.3
, 

R
2

.8 Subscribe to 

service with 

terms of use

log in with your account

go on 'External Services' -> 'Subscribe to Service'

click on 'subscribe' for the 'Test Filter' service

insert 20 as 'Max number of times'

Status of the service is 

'REQUESTED'.

An email is sent to the email 

address that you have set for 

'testuser', saying that a user 

requested the subscrition to 

the service.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
2

.9 R
2

R
0

.4
, 

R
2

.1
, 

R
2

.3
, 

R
2

.8
, 

R
2

.9
, 

R
2

.1
0

, 
R

2
.1

1

Accept 

subscription 

to service 

changing 

terms of use

Log in as testuser (username is the emai you set), with password 

'testuser'

- go on 'External Services' -> 'Manage Services'

- click on 'Modify' on the subscription request of your user (on the 

Workflow Requested Service Panel)

- assign permission to use the service only once ('max number of 

times'=1), within a date interval that includes the current date

An email is sent to the email 

address that you have set for 

your account, saying that the 

request for  subscrition was 

accepted.

If you log in with your account, 

in 'Subscribe to Service' the 

service is in 'Authorized' 

status, the terms of use are 

updated, and the service is 

now available in the 

dropdown list on the import, 

push and scheduler pages.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok

R
2

.1
0

R
2

R
0

.2
, 

R
2

.9
, 

R
.1

0
, 

R
.1

1 Include 

external 

service in 

scheduled 

import 

without 

permission

Prerequisite: You have uploaded the mapping from Harmonise 

ontology to your system

- log in with your account

- go on 'Exchange Data'-> 'Scheduler'

- select 'Import Data' as operation

- select 'euromuse' as recipient

- 'exhibition ancient world' as category

- include 'Test Filter' as external service (click on 'Add' button)

- choose a time schedule (*)

- click on 'Schedule task'

- Do an import using the external service (next test case, R2.11) 

before this task starts

*

choose a time schedule that 

gives you the time to do the 

next test case (R2.11) before 

this scheduled task is 

executed

Operation Status' and email 

notification report about the 

failure due to missing 

authorization to use the 

external service (only one use 

was allowed).

'Test Service' is no more 

available in the dropdown list 

of the import, push and 

scheduler pages.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok

R
2

.1
1

R
2

R
0

.2
, 

R
2

.9
, 

R
2

.1
0

, 
R

1
1 Use external 

service in 

import

Prerequisite:  You have uploaded the mappings from Harmonise 

ontology to your system

- log in with your account

- go on 'Exchange Data'->'Import Data' 

- select 'euromuse' as data provider

- 'exhibition ancient world' as category

- include 'Test Filter' as external service (click on 'Add' button)

- click on 'Search'

At the end of this test, wait 

until the scheduled task of 

R2.10 is executed and check 

the outcome.

Screen message and 

'Operation Status' report 

success of the import.

In 'Subscribe to Service' the 

'max number of times' is 

updated to 0.

In the Scheduler page, the 

'Test Service' is no more 

available among the External 

Services.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
2

.1
2

R
2

R
0

.4
, 

R
2

.1
0

, 
R

.1
1

, 
R

2
.1

2 Update access 

control policy 

for external 

service

Prerequisite: do not executed this operation before the scheduled 

task in R2.10 is done

Log in as testuser (username is the emai you set), with password 

'testuser'

- go on 'External Services'->'Service Policies' 

- click 'Modify' in the row that refers to 'Test Filter' and to your 

organization

- do not restrict the terms of use with any date nor number of times 

to use the service

- click on the button for updating the policy

Alternative:

- on the panel on the left (Add 

service policy) do:

- select 'Test Filter'

- select your organization as 

'Authorized users'

- do not restrict the terms of 

use with any date nor number 

of times to use the service

- click on the button for 

adding the policy

Your organization is listed 

among the authorized users.

When you log in with your 

account, the service is again 

available in the dropdown list 

on the import, push and 

scheduler pages.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok

R
2

.1
3

R
2

R
0

.1
, 

R
0

.4
, 

R
0

.5
, 

R
2

.9
, 

R
2

.1
2

, 
R

2
.1

3

Use external 

service in 

push

Prerequisite:  You have uploaded the mapping from local system to 

Harmonise ontology, and you have subscribed to the service 'Event 

fields filter'

- log in with your account

- go on 'Exchange Data'->'Share Data' 

- select 'Push Data' as operation

- select 'euromuse_Wir_essen_Reis.xml' as data file (available from 

test folder)

- select 'test' as recipient

- 'Event' as sudomain

- include 'Event fields filter' as external service (click on 'Add' button)

- click on 'Send'

Screen message and 

'Operation Status' report 

success of the push.

Logging in as 'testuser', the file 

in inbox looks like 

'push_Wir_essen_Reis_filtere

d.xml' in the results test folder 

(only id, title, date and 

location are taken). If you did 

the same operation without 

the external service, the result 

would be like 

'push_Wir_essen_Reis.xml'.

O
P

ro
m

o
te

r
O

m
u

se
u

m
sm

e
d

ie
n

ok

R
2

.1
4

R
2

R
0

.1
, 

R
1

.1
, 

R
2

.9
, 

R
2

.1
2

, 
R

2
.1

4 Use external 

service in 

publish

Prerequisite : You have uploaded the mapping from local system to 

Harmonise ontology, and you have authorization to use the 'Test 

filter' external service

- log in with your account

- go on 'Exchange Data'->'Share Data' 

- select 'Publish on social network' as operation

- keep 'Filter manually' checked

- select 'euromuse_2_events.xml' as data file (available from test 

folder)

- select your social network's target (one or more) as recipient

- 'Event' as sudomain

- include 'Test Filter' as external service (click on 'Add' button)

- click on 'Send'

Operation Status' reports that 

the operation is suspended 

awaiting confirmation.

Only one of the two events 

from the source file are listed 

in the page 'Exchange Data' -> 

'Confirm publishing' (the 

external service filtered out 

only the one that is a 

permanent exhibition) . 

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok

R
2

.1
5

R
2

R
0

.4
, 

R
2

.1
, 

Delete 

external 

service

Logged in as 'testuser'

- go on 'External Services' -> 'Manage Services'

- click 'Delete' on the 'Test Filter' service

The service is no more listed in 

the workflow services panel.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e

ok
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a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
2

.1
6

R
2 Content of 

the page for 

managing 

services

Manage Services' page allows to register external services, to modify 

them, and to accept or deny subscription requests. 

Overall structure of page + Blocks included in the page.

Describe in the test partition 

improvements if necessary

R
2

.1
7

R
2 Content of 

the page for 

subscribing to 

services

Subscribe to Service' page allows to view the subscription status of all 

services and to do new subscriptions. 

Overall structure of page + Blocks included in the page.

Describe in the test partition 

improvements if necessary

R
2

.1
8

R
2 Content of 

the page for 

managing 

service 

policies

Service Policies' page allows to manage the policies related to the 

services that the logged user is providing. 

Overall structure of page + Blocks included in the page.

Describe in the test partition 

improvements if necessary

R
2

.1
9

R
2 Content of 

the pages 

that use 

external 

services 

(share data, 

import, 

scheduler)

share data, import, scheduler pages allow to include the external 

services in the given operation. 

Overall structure of page + Blocks included in the page.

Describe in the test partition 

improvements if necessary

R
2

.2
0

R
2 Documentatio

n of the 

pages: 'Social 

Networks', 

'Scheduler', 

'Share data', 

'Confirm 

publishing'

Link to the documentation Describe in the test partition 

improvements if necessary

R
3 Push Data A user pushes a data file to some other HarmoSearch organization

R
3

.1 R
3

R
0

.1
, 

R
3

.1 Push data and 

bypass 

mapping

Prerequisite : You have uploaded the mapping from your system to 

Harmonise ontology

logged in with your account

- go on 'Exchange Data' -> 'Share Data'

- select 'Push Data' as operation

- choose 'harmonise_to_push_reduced.xml' as data file (from the test 

folder)

- 'test' as recipient

- 'Event' as subdomain

- check 'Exclude data mapping' checkbox

- click 'Send'

Operation Status' reports the 

success of the operation.

It you tried the same steps 

without bypassing the 

mapping an error would be 

raised, because the file sent is 

not in Euromuse format.

Furthermore, if you log in as 

'testuser', the file that is in the 

inbox is exactly the same as 

the one you sent. 

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

Operation IN 

PROGRESS. You will 

receive an email 

notification. To view 

the status and 

results go here

E
xc

h
a

n
g

e
: 

P
u

sh
.D

a
ta
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
3

.2 R
3 Push through 

form logged in with your account

- go on 'Exchange Data' -> 'Upload Data'

- select 'Push Data' as operation

- insert the event fields

- select 'test' as recipient

You can also select 'Publish on 

social network' as alternative 

operation

Screen message and 

'Operation Status' report the 

success of the operation.

Testuser receives an email and 

a file is sent to its inbox.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok

R
3

.3 R
3 Push through 

Excel file logged in with your account

- go on 'Exchange Data' -> 'Share Data'

- select 'Push Data' as operation

- choose 'push_Excel_2003.xsl' as data file (from the test folder)

- 'test' as recipient

- 'Event' as subdomain

- click 'Send'

You can also select 'Publish on 

social network' as alternative 

operation

Screen message and 

'Operation Status' report the 

success of the operation.

Testuser receives an email and 

a file is sent to its inbox.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok

R
3

.4 R
3 Push through 

Excel file with 

wrong 

template

logged in with your account

- go on 'Exchange Data' -> 'Share Data'

- select 'Push Data' as operation

- choose 'wrong_template_Excel_2003.xsl' as data file (from the test 

folder)

- 'test' as recipient

- 'Event' as subdomain

- click 'Send'

You can also select 'Publish on 

social network' as alternative 

operation

Error message: "Excel file may 

be corrupted. Please check if 

the right template was used."

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

Excel file may be 

corrupted. Please 

check if the right 

template was used.

R
3

.5 R
3 Content of 

the page for 

sending data 

through files 

(excel or xml)

Share Data' page allows to push data either through xml or excel files. 

It contains fileds, menus, buttons.

Describe in the test partition 

improvements if necessary
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
3

.6 R
3 Content of 

the page for 

sending data 

through a 

form

Upload Data' page allows to push data inserting it directly in the GUI. 

It contains fileds, menus, buttons.

Describe in the test partition 

improvements if necessary

R
3

.7 R
3 Documentatio

n of the 

pages: 'Share 

Data' and 

'Upload Data'

Link to the documentation Describe in the test partition 

improvements if necessary

R
4 Multiple 

Mapping

A user can upload multiple mappings and use the collection 

identifier to specify when to use which mapping

C
o

n
fi

g
u

ra
ti

o
n

:M
a

p
p

in
g

.S
to

re

Appendix B.4 - Document 2 - Test Case Release 4 - Portal  - Page 17 on 46



Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
4

.1 R
4

R
4

.1
, 

R
4

.2 Upload 

mapping from 

local system 

to Harmonise 

ontology 

without 

specifying 

when to use 

the mapping

logged in with your account,

go on 'Configurations' -> 'Mappings Store'

- insert 'events' (or any other name) as collection id

- choose 'Upload mapping from local system to Harmonise ontology'

- select the mapping from local system to Harmonise ontology 

(choose the file available in the test folder as 'Euromuse_HTO.xslt')

- click on 'Send' and check for the success message on top of the page

Uploaded file is available in 

the mappings list on the 

bottom.

In 'Configurations' -> 

'Exchange Data Service' there 

is no value for 'Collection Id' 

for sending data from the 

'Event' subdomain.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

Mapping file 

successfully 

uploaded

C
o

n
fi

g
u

ra
ti

o
n

:M
a

p
p

in
g

.S
to

re
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
4

.2 R
4

R
4

.1
, 

R
4

.2 Push Data 

with 

incomplete 

mapping 

configuration 

(mapping 

available but 

not specified 

when to use 

it)

log in with your account

- go on 'Exchange Data'->'Share Data' 

- select 'Push Data' as operation

- select 'euromuse_2_events.xml' (or 'euromuse_to_push.xml') as 

data file (available from test folder)

- select 'test' as recipient

- 'Events' as sudomain

- click on 'Send'

Operation status' report about 

the failure in sending the data, 

saying that the data mapping 

is missing or not configured.

O

P
ro

m
o

te
r

x

m
u

se
u

m
sm

e
d

ie
n

Operation IN 

PROGRESS. You will 

receive an email 

notification. To view 

the status and 

results go here

R
4

.3 R
4

R
4

.1
, 

R
4

.3
, 

R
4

.4 Specify the 

mapping to 

use when 

sending data 

through the 

collection 

identifier

go on 'Configurations' -> 'Exchange Data Service'

- click 'modify' on 'send data' for 'Event' subdomain

- select 'events' (or the name you have chosen when uploading the 

mapping file) as collection id

Collection Id' for sending data 

from the 'Event' subdomain is 

present in the table.

O
P

ro
m

o
te

r
O

m
u

se
u

m
sm

e
d

ie
n

ok

R
4

.4 R
4

R
4

.1
, 

R
4

.3
, 

R
4

.4 Push Data Push Data Operation Status' report on 

the success of the operation.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

Operation IN 

PROGRESS. You will 

receive an email 

notification. To view 

the status and 

results go here

R
4

.5 R
4

R
4

.5
, 

R
5

.5 Upload 

mapping from 

Harmonise 

ontology to 

local system 

for 

accommodati

ons

go on 'Configurations' -> 'Mappings Store'

- insert 'acco' (or any other name) as collection id

- choose 'Upload mapping from Harmonise ontology to local system'

- select the mapping from Harmonise ontology to local system 

(choose the file available in the test folder as 'identity.xslt ')

- check the box 'set default for receiving accommodations'

- click on 'Send' and check for the success message on top of the page

Uploaded file is available in 

the mappings list on the 

bottom.

In 'Configurations' -> 

'Exchange Data Service'  the 

'Collection Id' for receiving 

data from the 

'Accommodation' subdomain 

is set.

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

Mapping file 

successfully 

uploaded
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
4

.6 R
4

R
4

.5
, 

R
5

.5 Import 

accommodati

ons

go on 'Exchange Data'->'Import Data' 

- select 'Accommodation' as subdomain

- 'b&b' as type

- 'biella' as data provider

- click on 'Search'

Operation Status' reports 

about the success of the 

operation. 

In 'Data Repository' -> 

'Querybox' the file with the 

accommodations from biella is 

available with 10 

accommodation results (it 

looks like the file 

'accommodation_results.xml' 

in the test folder).

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

Operation IN 

PROGRESS. You will 

receive an email 

notification. To view 

the status and 

results go here

R
4

.7 R
4 Content of 

the pages for 

uploading and 

configuring 

the mappings

Mapping Store' and 'Exchange Data Service' pages allow to define 

which mapping to use and in association to which collection of data. 

Overall structure of page + Blocks included in the page.

Describe in the test partition 

improvements if necessary

R
4

.8 R
4 Documentatio

n of the 

pages: 

'Mapping 

Store' and 

'Exchange 

Data Service'

Link to the documentation Describe in the test partition 

improvements if necessary

R
5

R
5

.1 R
5 Metasearch 

of 

accommodati

ons

go on 'Metasearch'

- select 'Accommodation' as subdomain

- 'guesthouse' as type

- 'tv room' as facility

- click 'Search'

7 results are given O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

7 results

R
5

.2 R
5

R
5

.2
, 

R
5

.3 Upload 

mapping for 

receiving 

accommodati

ons

Upload mapping for receiving accommodations O

P
ro

m
o

te
r

?

m
u

se
u

m
sm

e
d

? Same test as 

above???

R
5

.3 R
5

R
5

.2
, 

R
5

.3 Import 

accommodati

ons

Import accommodations O

P
ro

m
o

te
r

?

m
u

se
u

m
sm

e

E
xc

h
a

n
g

e
:A

cc
o

m
m

o
d

a
ti

o
n

s
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
5

.4 R
5 lookup, 

through 

registry, of 

data 

providers that 

have 

accommodati

ons

go in 'Configurations' -> 'Query Service'

- insert the query 'SQ7_any_accommodation.xml' from the test folder 

in the form 'Query to Provider Test'

- click 'Check Provider'

Biella is returned as data 

provider for accommodations

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

Biella

R
5

.5 R
5

R
5

.2
, 

R
5

.5 Import of 

accommodati

ons through 

Web Service

Prerequistite : you have configured the mapping for receiving 

accommodations

perform an import with 'simpleSearch' method using your 

organization's name as sender, 'biella' as receiver, 'Accommodation' 

as subdomain, 'guesthouse' as type and 'restaurant' as facility

To be tested using Oxygen or 

XMLSpy or similar. 

WSDL: 

http://harmosearchdev.harmo

net.org/WebAccessPortal-

portlet/DataExchangeManager

?wsdl

Documentation: 

'Annex_D_4_3_Web Service 

APIs Specifications_v0.3.docx' 

file available in SVN at 

/04_Query_Mapping/metasear

ch engine 

Two strings are returned. The 

first says 'Operation 

completed successfully on: 

biella.' and the second is a link 

to the imported file available 

on the Data Repository.

'Operation Status' reports 

about the successful 

completion and links to the 

'Querybox', where the result 

file is available (check the 

timestamp).

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok

R
5

.6 R
5 Content of 

the pages for 

searching and 

importing 

accommodati

ons

Metasearch' and 'Import Data' (and 'Scheduler') pages allow to 

retrieve data on accommodations. They contain fileds, menus, 

buttons.

Describe in the test partition 

improvements if necessary
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
5

.7 R
5 Documentatio

n of the 

pages: 

'Metasearch' 

and 'Import 

Data' (and 

'Scheduler') 

(with respect 

to the 

accommodati

on domain)

Link to the documentation Describe in the test partition 

improvements if necessary

R
5

.8 R
5 Documentatio

n of the 

Webservices

See 'Annex_D_4_3_Web Service APIs Specifications_v0.3.docx' file 

available in SVN at /04_Query_Mapping/metasearch engine

Describe in the test partition 

improvements if necessary

R
6

R
6

.1 R
6 Take oveview 

of 

configuration

logged in with your account

go on 'Home'

check the status of the services

The expected outcome 

describes what should be 

present in the home at the 

end of all tests

* 'Share Data' is active, with 

'event mapping' configured, 

but 'accommodation mapping' 

not.

* 'Scheduled Share' is active, 

with 'event mapping' 

configured, but 

'accommodation mapping' 

not.

* 'Import Data' and 'Receive 

Data' is active, with 

'accommodation mapping' 

configured.

* 'Receive Queries' is active 

with 'Query mappings' 

available and 'Query Service' 

O

P
ro

m
o

te
r

O

m
u

se
u

m
sm

e
d

ie
n

ok

C
o

n
fi

g
u

ra
ti

o
n

:H
o

m
e
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output 9
/1

1
/1

2

W
h

o

Actual Result 1
2

/1
1

/1
2

W
h

o

Actual Result

R
6

.2 R
6 Content of 

home page 

(after login)

Home page has text, profile access, logout,menus…

Overall structure of page + Blocks included in the page.

Describe in the test partition 

improvements if necessary

R
6

.3 R
6 Documentatio

n of the home 

page

Link to the documentation Describe in the test partition 

improvements if necessary

R
6

.4 R
6 Content of 

home page 

(without 

login)

Home page has text, a sign in access on the right a a home menu 

when no login is performed

Describe in the test partition 

improvements if necessary
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Id
R

0
R

0
.0

R
0

.1
R

0
.2

1
3

/1
1

/1
2

W
h

o
Actual Result O

u
tp

u
t 

 

(S
cr

e
e

n
 

..
.)

1
6

/1
1

/1
2

W
h

o

Actual Result O
u

tp
u

t 

(S
cr

e
e

n
 

..
.)

1
7

/1
1

/1
2

W
h

o

Actual Result O
u

tp
u

t 

(S
cr

e
e

n
 

..
.)

1
9

/1
1

/1
2

W
h

o

Actual Result 1
9

/1
1

/1
2

W
h

o

Actual Result

X G

K

CAN BE BLOCKING :

1st connexion : clicking the "validate"  button doesn't 

work on Firefox 16 on the "security question" screen. I 

had to use "enter" key

w

In
é

s

_euromuse screen 

name already taken?!

_Activation requires 

email to claudio

o

A
d

ria
n

o

To be improved the menu 

bar on the top by 

removing private pages 

(Go to menu item). Add 

to portal-ext.properties 

the following: 

layout.user.private.layout

s.enabled=false

layout.user.public.layouts

.enabled=false

breadcrumb.show.guest.g

roup=false

W G

K

X T

M

_registration worked as 

expected

_registration mail received 

immediatelly after 

completing the 

registration

_activation mail received 

after contacting Marlis

_minor issue: received a 

(404) Page not found error 

when clicking on my 

profile (upper right corner)

w G

K

Not blocking : 

1) "collection id" is a required field, it would need some 

kind of hint, help (button, section, mouse over 

tooltip…) as user doesn"t understand what this id is 

about

2) File is present in the list, but only "collection id" lets 

us understand it is the same one. We could use an 

information like the submission date here to get an 

idea, or uploader maybe, as the file is renamed 

compared to the local file imported

3) The download button opens XML data in the same 

browser tab. This is disturbing and compels user to go 

back. We should have this opened in a new tab

o

In
é

s

_security question, 

when "write my own" 

the save button does 

not respond to mouse 

click, has to be activated 

with ctrl. n
o

n
re

sp
o

n
se

.p
n

g o

a
d

ria
n

o

ok O G

K

Before doing this, I 

deleted all the 

uploaded files 

except the one 

with collection id 

"Acco"

then done, named 

"events2

O T

M

_file listed as 

20001_#events_so.xslt

_success message received 

accordingly

o G

K

With same  comments as above (not blocking, remarks) o

In
é

s

w

a
d

ria
n

o

ok, but why "events" and 

"accommodations" are 

bold ?

O G

K

O T

M

_file listed as 

20001_#events_os.xslt

_success message received 

accordingly
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Id
R

0
.3

R
0

.4
R

0
.5

1
3

/1
1

/1
2

W
h

o
Actual Result O

u
tp

u
t 

 

(S
cr

e
e

n
 

..
.)

1
6

/1
1

/1
2

W
h

o

Actual Result O
u

tp
u

t 

(S
cr

e
e

n
 

..
.)

1
7

/1
1

/1
2

W
h

o

Actual Result O
u

tp
u

t 

(S
cr

e
e

n
 

..
.)

1
9

/1
1

/1
2

W
h

o

Actual Result 1
9

/1
1

/1
2

W
h

o

Actual Result

W G

K

0) Generally speaking, this section looks quite unclear, 

this needs user who really know what they're doing. 

Help would be nice

1) "No whitespaces!" => this is not indicated on the 

page. Is it blocking ? Plus it is possible to create a 

provider id with whitespace (if problematic, then 

whitespace presence should result in an error)

2) Mapping Collection Identifier => shouldn't this be a 

drop down list ? we don't have the names of collection 

ids on the screen, we may not remember them all

3) Can't check if this worked : "click 'Edit Data 

Description' and select 'Events with location and 

category' from the drop-down list on the top

click on 'Save Changes'" Only xml description (not 1st 

field) is still present, don't see it anywhere else. Would 

be nice to have it on the dataprovider page with other 

info (where there is the edit button)

2
0

1
2

1
1

1
3

_
G

K
_

S
p

a
ce

-i
n

-d
a

ta
-p

ro
v
id

e
r.

p
n

g o

In
é

s

_ add success message 

on top of the page, once 

the changes are saved

_ move the delete 

option to the bottom of 

menu list

w

a
d

ria
n

o

ok, but  hide password 

(with *). Make the page: 

http://harmosearchdev.h

armonet.org/configuratio

ns as a link to the first 

menu item for example. 

Also the other tolevel 

menu items

O G

K

O T

M

_worked fine for me

_remarks: may be 

overwhelming for novice 

users since the procedure 

is not very intuitive. 

Additional feedback, e.g., 

when saving data or a 

short text describing the 

tasks (?) may be helpful

O G

K

o

In
é

s

o

a
d

ria
n

o

ok G

K

O T

M

W G

K

1) User has to guess he must click on the button. An 

help sentence would help understanding action can be 

performed here

o

In
é

s

o
a

d
ria

n
o

- G

K

already subscribed, 

no restriction

O T

M
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Id
R

0
.6

R
0

.7
R

0
.8

1
3

/1
1

/1
2

W
h

o
Actual Result O

u
tp

u
t 
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o G

K

Same comment as before on files list o

In
é

s

o

a
d

ria
n

o

ok O G

K

O T

M

_received message

_files werelisted 

accordingly 

(20001_#events_query_en

um_os.xslt, 

20001_#events_query_os.

xslt)

_minor: in my first attemt i 

did not enter the 

collection id. I received an 

error message (GOOD!) 

but had to browse to the 

file again. It would be 

more convenient the data 

will not be lost when 

receiving an error.

O G

K

o

In
é

s

o

In
é

s

G

K

O T

M

O G

K

EITHER NOT APPLICABLE, OR A TEST CASE IS MISSING

Is this applicable ? I've been to this section to check 

presence of the service in the dropdown list, but i 

didn't scheduled anything.(list is empty)

Edit : my mistake, i did it before end of tests

o

In
é

s

o

In
é

s

W G

K

Some confirmation 

popup would be 

nice, we can delete 

by mistake

W T

M

_no confirmation is 

rquired --> delete by 

accident may occur

_ nice to have: a delete all 

button
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NOT BLOCKING, suggestions : 

1) followed  the reset paswword process. I was asked to 

provide a password (Old ? New ?) while writing the 

Capthcha, and asked again to give the new password 

twice (which is logical) from the link found in the mail. 

The 1st password field is a bit confusing

2) Account creation form : we miss the button to reload 

the captcha, as sometimes it becomes unreadable, we 

have to reload the page/ submit a wrong one.

3) When validating an incorrect / incomplete account 

creation form, the company field selected content is 

lost when the patge is reloaded

4) When on the confirmation page before account 

activation, a message displays "... not active yet, please 

contact the administrator for more help". In this 

message we miss a link to send a mail to the 

administrator, or a contact form. If we don't want to 

provide such a link, then the message should be 

changed for something as in the mail : "You will receive 

a notification as soon as the account will be activated." 

(not "please contact...")

In
é

s

o

a
d

ria
n

o

G

K

X Link is missing (not applicable test ?) 

Generally speaking, the service lacks contextual help 

(message, tooltips on mouse over…) 

User can't find any link to Doc, Wiki, Help or FAQ

w

In
é

s

_no documentation x

A
d

ria
n

o

I think a help page telling 

what to do for registering 

(all what we did till now, 

like upload mapping, 

query mapping, 

subscribe) is needed

X T

M

_i like the success and 

error messages very much. 

Good work on that! 

However, some 

procedures are quite 

complicated and 

additional information 

(short description) may be 

helpful
W 1) When changing the user mail, no mail was  received 

on the new email added. A confirmation mail would be 

nice

2) for security reasons, some changes such as a new 

mail could require confirmation of the user identity by 

asking the password again (nice to have)

In
é

s

o

A
d

ria
n

o

for me is fine O T

M

_intuitive and common 

procedure
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Actual Result

- Same comment as for R0.10

In
é

s

x

A
d

ria
n

o

W T

M

_did not found a help page 

or link but I do not think 

ist really necessary since 

changing data in the 

profile is straight forward 

and intuitive. However, a 

hover-text may be helpful 

for novice usersIn
é

s

X G

K

BLOCKING from user point of view : 

1) Facebook permission, using Firefox 16 : Once process 

is completed, I still see the "give permission button", 

not the "delete" one. Yet, the Harmosearch application 

is present in my account. deleted the app, tried again, 

same issue

2
0

1
2

1
1

1
3

_
G

K
_

fa
ce

b
o

o
k
-p

e
rm

is
si

o
n

s-
re

q
u

e
st

.p
n

g w

In
é

s

_i actually granted 

permission to post on 

the euromuse page… 

_but it connects only 

with the personal 

timeline not with the 

page

_When I login to my 

facebook (page or 

personal) i cannot see 

the harmosearch app

_email notifications as 

expected

o

A
d

ria
n

o

X G

K

StillBLOCKING from 

user point of view : 

1) Facebook 

permission, using 

Firefox 16 : Once 

process is 

completed, I still 

see the "give 

permission button", 

not the "delete" 

one. Yet, the 

Harmosearch 

application is 

present in my 

account. deleted 

the app, tried 

again, same issue

O T

M

_worked fine

X G

K

BLOCKING (pending confirmation I did it properly)

1) received the notification mail with failure message : " 

Failed on Afidium: Missing mapping for the query 

structure from Harmonise Ontology to Afidium."

2
0

1
2

1
1

1
3

_
G

K
_

R
1

-2
_

so
ci

a
l-

p
u

b
li

sh
-

fa
il

u
re

.p
d

f

o

In
é

s

o

A
d

ria
n

o

GREAT! O G

K

Ok, probably forgot 

to upload the 2nd 

file in 0.6 for 

previous tests

O T

M

_first received an error 

message that no query 

mapping has been 

uploaded 

_uploaded the missing 

mapping file now it works 

fine

_great feature! I also like 

the way the data is 

collected
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K

not applicable as previous failed o

In
é

s

_yep, it comes out, 

unfortunately in the 

wrong timeline

fa
ce

_
a

lt
.p

n
g o

A
d

ria
n

o

But events for approving 

are shown in one page or 

it is paginated ? What if 

the number is very large ?

O G

K

Ok, probably forgot 

to upload the 2nd 

file in 0.6 for 

previous tests

O T

M

O G

K

pending

NOT BLOCKING : 

It would be nice to be able to edit & duplicate 

scheduled operation instead of having to delete & start 

from scratch

o

In
é

s

o

A
d

ria
n

o

G

K

O T

M

O G

K

o

In
é

s

o

A
d

ria
n

o

G

K

O T

M

O G

K

o

In
é

s

o
A

d
ria

n
o

ok G

K

O T

M

_also received a 

corresponding email

Appendix B.4 - Document 2 - Test Case Release 4 - Portal  - Page 29 on 46



Id
R

1
.7

R
1

.8
R

1
.9

1
3

/1
1

/1
2

W
h

o
Actual Result O

u
tp

u
t 

 

(S
cr

e
e

n
 

..
.)

1
6

/1
1

/1
2

W
h

o

Actual Result O
u

tp
u

t 

(S
cr

e
e

n
 

..
.)

1
7

/1
1

/1
2

W
h

o

Actual Result O
u

tp
u

t 

(S
cr

e
e

n
 

..
.)

1
9

/1
1

/1
2

W
h

o

Actual Result 1
9

/1
1

/1
2

W
h

o

Actual Result

X G

K

I can't upload file in the "scheduler" page. Is this a 

mistake and should we use "Share" menu instead with 

the mentioned file ? 

If so then the task is OK. I did it, with checked "filter 

manualy", and it worked (sucess + present in 

confirmation list)

o

In
é

s

_ok, it is a bit confusing 

with all the submenus… 

we have to think of a 

solution abou t maybe 

fusioning the scheduled 

operations in the 

confim publishing or 

sth… 

o

A
d

ria
n

o

ok, under the share menu 

items. I also think is a 

little bit confusing the 

menu structure

W G

K

Should be share 

instead of 

scheduler (mistake 

in test description

O T

M

X G

K

BLOCKING using Firefox 16 

1) Facebook : As said before, permission was given but 

button "give" was never replaced by "remove". User 

has to go to Facebook and manually remove the app

NOT BLOCKING

o

In
é

s

o

A
d

ria
n

o

X G

K

Still BLOCKING 

using Firefox 16 

1) Facebook : As 

said before, 

permission was 

given but button 

"give" was never 

replaced by 

"remove". User has 

to go to Facebook 

and manually 

remove the app

O T

M

O G

K

error displayed after removing permission, even if the 

app is still on the twitter account

o

In
é

s

_why in the error log in 

operation status it the 

result listed twice?

d
o

u
b

le
_

e
rr

o
r.

p
n

g o

A
d

ria
n

o

G

K

O T

M
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NOT BLOCKING (apart from Facebook issue already 

mentioned)

1) On facebook, asking for so many permissions on the 

account can be frightening for the user. Maybe the 

need can be defined more precisely so we ask for fewer 

permissions

2)  On twitter : access is OK, present in my twitter 

account, but we only know there is permission on the 

harmosearch page. We should display info such as 

avatar & pseudo so user knows which account he linked

3) What about adding several accounts ? usefull for 

twitter as well as facebook

4) PERMISSION REMOVAL, tested on Twitter : seems 

OK on Harmosearch side, but the application wasn"t 

removed from my twitter account. Publication then 

fails in the next test so it's not blocking. Is the app 

expected to remain on the account ? this is not clear on 

the user point of view (seems like a bad marketing trick 

for those who looks in details)

w

In
é

s

_facebook has two 

types of pages, private 

personal profiles, and 

pages profiles. One user 

can be admin of a 

corporate page, and at 

the same time have a 

private page

_the harmosearch app 

should be able to give 

the user the possibility 

to separte this in the 

configuration menu. See 

twitterfeed.png

_once the permission 

have ben granted, there 

is no way to see details 

or statuses in this config 

page... I recommend 

you to make an account 

in tweeterfeed and take 

a look around at the 

possibilities (you can 

use this rss to test 

configurations: 

http://www.euromuse.

net/index.php?id=181&

rss=1)

tw
it

te
rf

e
e

d
.p

n
g w

A
d

ria
n

o

too many permission 

requests, I agree. 

Possibility to post on a 

corporate page.

G

K

W T

M

_in total fine with me

_agree with GK that 

multiple accounts may 

make sense

_same experience as Inés: 

HarmoSearch app has not 

been removed from my 

twitter account

Appendix B.4 - Document 2 - Test Case Release 4 - Portal  - Page 31 on 46



Id
R

1
.1

1
R

1
.1

2
R

1
.1

3
R

2

1
3

/1
1

/1
2

W
h

o
Actual Result O

u
tp

u
t 

 

(S
cr

e
e

n
 

..
.)

1
6

/1
1

/1
2

W
h

o

Actual Result O
u

tp
u

t 

(S
cr

e
e

n
 

..
.)

1
7

/1
1

/1
2

W
h

o

Actual Result O
u

tp
u

t 

(S
cr

e
e

n
 

..
.)

1
9

/1
1

/1
2

W
h

o

Actual Result 1
9

/1
1

/1
2

W
h

o

Actual Result

W G

K

For network selection, It could be easier and nicer to 

have pictures (network logo + avatar) as checkbox 

instead of the list. It also avoids the necessity to use 

mouse + keybord to select multiple profiles. See 

example from Tweetdeck, same is also on hootsuite 

and other profiles tools

it also feels like a more personal experience

2
0

1
2

1
1

1
3

_
G

K
_

S
o

ci
a

l-
a

cc
o

u
n

t-
se

le
ct

io
n

-p
ro

p
o

sa
l.

p
n

g w

In
é

s

_see comment on line 

23

_we had spoken of 

filtering out events, I 

figured this in the 

scheduler. I want 

actually to schedule 

facebook status updates 

with euormuse 

crawler… from the feed 

that the crawler gives 

back, there is too many 

items… The scheduler 

date range form is a 

dropdown with 1-31. 

This has not been 

tested. Dies it mean, it 

is every first day of the 

month? that i update 

my status? or that i 

search for new data? 

(see filter_social.png)

tw
e

e
t_

q
u

a
li

ty
.p

n
g w

A
d

ria
n

o

The published event 

should have a link to the 

detail page of the event

G

K

T

M

w G

K

Visual hint on which come from scheduling and which 

come from sharing could be nice

Also, pictures  instead of network names would make 

table clearer

In
é

s

A
d

ria
n

o

Pagination if there are 

too many ?

G

K

T

M

- G

K

no doc found -

In
é

s

still missing, or not well 

linked, for not found

-
A

d
ria

n
o

not found G

K

T

M

T

M
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_on the right, yes o

a
d

ria
n

o

W G

K

missing in test grid 

: this was required 

for 2.10,11,12,13

O T

M

_worked fine

_typo in the result: left != 

right

O G

K

o

In
é

s

o

a
d

ria
n

o

W G

K

missing in test grid 

: this was required 

for 2.10,11,12,13

O T

M

O G

K

w

In
é

s

_my account is 

euromuse… so i chose 

cpr and it send it ok.

o

a
d

ria
n

o

G

K

O T

M

_error message was 

displayed

_received notification mail

O G

K

o

In
é

s

o

a
d

ria
n

o

G

K

O T

M
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o
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I only modified the url, 

the name remains 'test 

filter', so from now on i 

will assume 'test 

service' is 'test filter'

o

a
d

ria
n

o

G

K

O T

M

O G

K

w

In
é

s

_terms of use is not a 

writable

_email received at 

testuser email account 

ok

o

a
d

ria
n

o

didn't set G

K

O T

M

_was not able to enter 

anything in the terms of 

use text-box
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o

In
é

s

_expected results all ok 

but...

_possibility as owner of 

external service to send 

some feedback to the 

applicant? e.g. reason 

for not being accepted 

to the applicant?

_Here is an idea: when 

signing back with my 

account, I come from a 

very uninformative 

email, "so, I cannot 

suscribe...ok, but... 

why?", could I not have 

this being showed in the 

main page 

automatically, or a 

message, "your 

requested subscription 

to 'test filter' has been 

denied, please do not 

bother us again".

_additionally maybe not 

tecnically, but a logically 

a mistake... as a refused 

applicant, I can suscribe 

the 'test filter' again and 

start a never ending 

story.

o

a
d

ria
n

o

G

K

O T

M _mail received

O G

K

o

In
é

s

_just as info, last time 

the message landed in 

my inbox, this time in 

the spam…(test user 

email was a gmail 

address)

o

a
d

ria
n

o

G

K

O T

M
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_ok now I understand 

why the 'test filter' is 

still available…

o

a
d

ria
n

o

G

K

O T

M

O G

K

x

In
é

s

_date is a dropdown 

menu…?

_i cannot choose the 

test filter servcie… only 

receive none as options!

h
tt

p
:/

/w
w

w
.e

u
ro

m
u

se
.n

e
t/

th
o

rs
te

n
2

/

h
a

rm
o

se
a
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h

/s
ch

e
d

u
le

_
e

rr
o

r.
p

n
g o

a
d
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n
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G

K

T

M

O G

K

x

In
é

s

same as row 40 o
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M

_mail received

_number was decreased 

successfully
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_now it finally is!

_please keep in mind 

wording, "share" in 

menu navigation 

'exchange data', but 

"push" in the child page 

title

o
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_flawlessly i executed task 

R2.15 already

X G

K

BLOCKING : 

The file in the inbox is different. The file is the outbox is 

ok. Fil in the inbox is attached

NOT BLOCKING : 

File in inbox would be better if opened in another tab

2
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n
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_Failed on test: Error in 

data mapping from 

Harmonise Ontology to 

test: Cannot convert 

string "" to xs:decimal 

Please check the 

mapping file.

_mapping file from local 

system to hto (spk_hto) 

is correct and uploaded, 

but there is no mapping 

hto_spk…

o

a
d

ria
n

o

ok. Not obvious that one 

has to push the add 

button

O G

K

O T

M

_Event fields filter was not 

listed; after requesting 

persmission the external 

service was listed as 

described

_ operation was 

successfull

_ data looked as expected

O G

K

w
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s

_actually the permanent 

exhibition was listed, 

and the temporary 

exhibition was filtered 

out…

x

a
d

ria
n

o

two events are shown. 

Not possible to discard all 

the events from 

confirmation, you get the 

message "no item 

selected", but actually 

that what i wanted!
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M
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K

o
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o
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n

o
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K
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M
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Here again, short description of what service are & do 

could help. Even only a link to doc, faq…
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see comments on rows 

36,37,42
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No doc available _
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no documentation or 

link is not very visible.

w
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o

no documentation or link 

is not very visible.
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M

T
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_email received 
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_wow, whas this part of 

this release? 

o

a
d

ria
n

o

tested on social networks, 

only the title of the event 

looks published.

G

K

W T

M

_social networks were not 

tested

_email received

_inbox OK result however 

was not complete; e.g., 

address field was missing, 

city, province, etc.

O G

K

o
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_uhhh still very 

positively surprised!

o

a
d

ria
n

o

great! G

K

O T

M

_mail received

_testuser received an XML 

file including the date 

stored in the Excel file

W G

K

Providing resources for template, or a way to get  them 

right would be nice here (FAQ…)

w

In
é
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_as expected, I agree 

with Guillaume

w

a
d

ria
n

o

ok, would be nice to have 

an example of format. In 

which format it is ?

G

K

O T

M

_task results are as 

expected

_agree with adriano et al 

that more info on the 

correct format or how to 

get my data right would be 

very helpful

G

K

w

In
é

s

_add in the data file 

upload box, some 

information e.g. formats 

allowed: csv, xls, xml

_here it would be also 

helpful to offer the 

excel tamplate for 

downloading.

w

a
d

ria
n

o

sometime i do not know 

if i have to go to upload 

or share menu items, 

which is the difference ?

G

K

T

M
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Here will be a good place to provide information (link 

to FAQ for common errors, best practices…

w
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s

_short description and 

long description is 

something very 

euromusely… the 

minimal requierement 

for euromuse is a long 

description .

_suggestion, the short 

description box is to 

small (see pic 

long_short.png)

_categories, too much, 

think about grouping 

exhibition categories 

into art, history, science 

and technology, mixed 

and others, and then 

offer if one chooses 'art' 

the possibility to choose 

more detailed 

categories 

(contemporary, modern, 

art history, european 

art, non-european...) I 

will provide a 

suggestion to tree down 

categories from 5 main 

types if this idea is 

interesting, it is already 

an issue for euormuse 

and i want to simplify 

them anyway. This 

could improve A LOT 
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No doc available -

In
é

s
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T

M
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THIS ISNT TRUE : 

"In 'Configurations' -> 'Exchange Data Service' there is 

no value for 'Collection Id' for sending data from the 

'Event' subdomain."

=> I have "events" in this cell, this was uploaded earlier 

in tests. It means the document hasn't been 

overwritten

x

In
é

s

_I had from other row 

another collection Id, 

but I deleted this 

mapping and uploaded. 

and is still available here 

(collection id 20121114)

x

a
d

ria
n

o

not sure what happened. 

I see 

19907_#events_so.xslt 

(from local to hto) . It is 

the new one ? No 

reference to the actual 

name

X G

K

Same issue : THIS 

ISNT TRUE : 

"In 'Configurations' -

> 'Exchange Data 

Service' there is no 

value for 'Collection 

Id' for sending data 

from the 'Event' 

subdomain."

=> I have "events" 

in this cell, this was 

uploaded earlier in 

tests. It means the 

document hasn't 

been overwritten

to do the next 

tests, I had to 

delete the 

uploaded files for 

sending events, 

going to the service 

table, edit data 

sending (just 

validated so it was 

updated and 

whows no service.

then did the upload 

again without 

checking the box 

and it was as 

expected

X T

M

_file was uploaded 

successfully

_collection id was still 

listed
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Failure as expected. Message was not the one 
expected : 
"Input file is incompatible with the mapping file. 
Please check."

w

In
é

s

_Missing or not 

configured data 

mapping from test to 

Harmonise Ontology

x

a
d

ria
n

o

it worked succesfully ? W G

K

Ok when I deleted 
uploaded 
mapping file and 
edited the 
sending data line 
in the table to 
refresh it, then 
uploaded again 
with unchecked 
"events" box

W T

M

_had to manually 
remove events from the 
uploaded mapping (even 
after deleting and 
uploading the local to 
HTO mapping again) - 
maybe I forgot to 
uncheck events … 
_ after the modification 
it worked as expected
_ mail received
_ error message 
displayedW G

K

Ok, but it was present already in the 2 previous steps w

In
é

s

_expected result, but 

_the send data with 

collection id '20121114' 

was substitued

o

a
d

ria
n

o

G

K

O T

M

O G

K

o
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s

o
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K

o
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o

a
d
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n

o

G
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O T

M

_file sent and available in 

the file list at the bottom

_acco is present in the 

service configuration
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I got 10 results but not the same file as the example 

(same layout, i don't know if this is normal. See file 

attached for the result

2
0

1
2

1
1

1
3

_
G

K
_

a
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o
-q

u
e

ry
-1

0
-
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su

lt
s.

xm
l

w

In
é

s

looks like it , is not the 

same as 

'accomodation_results.x

ml'
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_worked as expected 

W G

K

As said before, more information on imported files 

would be nice, especially as regards overwritten ones 

(so i'd say upload date, and default checkboxes 

selected)

_
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é

s

w

a
d

ria
n

o

that's difficult to 

understand. Some hints 

on the page are necessary

G

K

T

M

- G

K

No doc w
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no documuentation or 

link not visible

x
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o

no link G
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T

M
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s

T

M

O G

K

o
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_received 7 results 

successfully

- G

K

already done, see  R4.5

In
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s

o

a
d

ria
n

o

G

K

- T

M

_dublicated?

- G

K

already done, see  R4.6

In
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s

o

a
d

ria
n

o

G

K

- T

M

_dublicated?
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_sq7 is not available, 

are there any 

prerequisite to 

performe this testcase 

other than uploading 

mapping for receiving 

accommodations?

o

a
d

ria
n

o

G

K

O T

M

W G

K

Don't have such xml editor (only simple ones)

How do i perform such import from simple search ?

x

In
é

s

_in the import page i 

cannot define myself or 

biella as reciver, biella 

only as data provider

-

a
d

ria
n

o

G

K

X T

M

_was not able to fulfill the 

test case. I did the 

following: 

_going to Exchange Data--

>Import Data did not 

provide me the fields 

described in the task 

description … 

G

K

w

In
é

s

_'metasearch' is not 

connected with 

exchange data or the 

'data repository'. There 

is no possibility to reuse 

the metasearch criteria 

in another subpage. E.g. 

I like the results I get on 

metasearch, a button 

allows me to store the 

retrieved data in 

metasearch in the 

querybox, or to export 

the query in xml format.

-

a
d

ria
n

o

G

K

T

M
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No doc w
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no documenation linked 

in this pages.
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n

o

G

K

T

M

G

K
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will need some more 

time to review_next 

week per mail feedback

G

K

T

M

In
é

s

T

M

X G

K

Scheduled share is not active

Receive queries is not active, querry mapping not 

configured

w

In
é

s

_share data ok

_scheduled tasks were 

done with other user 

account, there they are 

ok.

_typo: social media 

configuration alt text is 

"Social Media 

vonfiguration"

_did not do the 

metasearch rows

o

a
d

ria
n

o

O G

K

W T

M

_Import data/Scheduled 

import: events are also 

active
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The top bar is confusing, the name at the top redirects 

to a 404 page

The navigation tree present in each page is useless as 

the categories pages are empty. They should provide 

the list of subpages with links and description

w

In
é

s

_the icons are not that 

self explanatory, the alt 

text are essential. 

_menus and sub-menus 

are a bit confusing still, 

specially under 

exchange data, maybe 

by clickin in exchange 

data, a list of 

possibilities with a short 

explanation should be 

listed, instead of a blank 

page.
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No doc available -
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no doc -
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W G

K

Can be improved with illustrated explanations

For now it mostly misses link to documentation, and 

contact

Will probably look better with the demonstration 

preparation (web presence tasks), with infos, links to 

social networks...

w

In
é

s

_please change the top 

right options "sign in" 

and "sign up" are 

confusing, either "sign 

up" and "login", or 

"register" and "login" 

(picsignuplogin.png)

_Is it possible to hide 

the blue liferay bar, and 

show in the new design 

the user? 

_This would imply to 

add a log out (or sign 

out) button visible in 

the black bar

_Maybe also a profile 

edit button next to it, 

and have 2 alternatives 

to get here, through 

there or the menu 

under configuration 
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se

.n
e

t/
th

o
rs

te
n

2
/h

a
rm

o
se

a
rc

h
/s

ig
n

u
p

lo
g

in
.p

n
g

h
tt

p
:/

/e
u

ro
m

u
se

.n
e

t/
th

o
rs

te
n

2
/h

a
rm

o
se

a
rc

h
/u

se
rc

o
n

f.
p

n
g o

a
d

ria
n

o

si
g

n
u

p
lo

g
in

.p
n

g

u
se

rc
o

n
f.

p
n

g G

K

T

M
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Appendix B.5. Test cases for release 5 

Test cases for the 5th release were divided in 4 documents:  
1. Test Case Release 5 – Portal. For a better understanding of the scenario and topic of each test session, this 

documents contains several parts :  
a. Part 1 : Registration 

b. Part 2 : Import 
c. Part 3 : Publisher 

d. Part 4 : Metasearch 
e. Part 5 : Qualified Search 

f. Part 6 : Reference list 
g. Part 7 : Crawler 

h. Part 8 : Documentation 
2. Test Case Release 5 –Registry 

The results of all those excel documents were exported and included in this section. 

  



Id Action Description
Comment

 (and alternatives)

Expected 

Output

#
#

#
#

#
#

#

W
h

o

#
#

#
#

#
#

#

W
h

o

Actual Result

#
#

#
#

#
#

#

W
h

o

Actual Result

#
#

#
#

#
#

#

W
h

o

#
#

#
#

#
#

#

W
h

o

Actual Result

R
e

g
R

e
g

0
.1 Registratio

n

- go to

http://harmosearchdev.harmo

net.org/landing-search-

qualified-events

- click on 'Register' on the top 

right

- insert your own data (names 

and a valid email address)

- select a type of account (*) 

- select also the organization 

you belong to (if not present 

insert the organization's name)

- wait for the account 

activation email (**); 

activation is done by the 

administrator

* Select the type of account 

from where you want to start 

the tests. Each account type 

has its own excel sheet.

** For security reasons, the 

activation of an account is 

implemented to be not fully 

automatic . The administrator 

receives the notification as 

soon as a new user registeres 

to the portal. The he activates 

manually the account, and an 

automatic notification is sent 

to the new user.

You may contact the persons 

Claudio Prandoni or Marlis 

Valentini to speed up this step.

Two emails: 

the first 

confirms that 

the request 

for activation 

was received, 

the second  

confirms that 

the account 

has been 

activated.

O

P
ro

m
o

te
r

W

A
fid

iu
m

- harmosearch logo 

redirection

- logged, graphic issue 

on landing 

page(button & tabs)

- role field should be 

required

O

S
P

K a user anita martínez under the 

organisation euromuse was 

registered as a publisher

o

m
u

se
u

m
sm

e
d

ie
n

w

M
H had to type in several times, 

because captcha was partly 

difficult to read and i could type in 

a screen name that was not 

allowed.

I never received a success 

message, but suddenly i could not 

register because my screenname 

was taken. Chose a new one but 

then my email adress was taken 

already. checked my mails and 

had a confirmation - strange, 

cause on the gui i never 

succeeded.

once i had a browser (FF19.0) 

error message that the content of 

the site has invalid characters and 

it cannot be displayed.

R
e

g
R

e
g

1
.1 Edit 

Profile

Optional* :

- log in as testuser 

(testuser@test.user, password: 

testuser) 

- go on 'Configurations' -> 'Edit 

Profile'

- insert a valid email address 

where you want to receive the 

notifications (must be different 

from the email of the new user 

you created)

- click 'Save'

* 'testuser' belongs to the 

organization 'Test' which is 

involved in several test cases 

together with your user. It 

acts, when necessary, as data 

provider, as service provider 

and as data receiver for push 

operations.

This step is necessary only if 

you want to check the email 

notifications sent to this user 

for some of the tests

You can now 

log in as 

testuser with 

the new email 

as username

O

P
ro

m
o

te
r

W

A
fid

iu
m

how will it work when 

this is deactivated 

after tests ? Detailled 

suggestion in the 

"Metasearch" sheet

- Once logged, I still 

think it's confusing for 

all elements in the 

black top bar to 

redirect to the home. I 

think we should have 

them not clickable or 

have a parent page for 

each of those links 

saying "here's what 

you can do here (list & 

links)

W

S
P

K Functionality as expected, have 

only layout comments: 

attention, if we use log in, we 

should change 'sign out' for 'log 

out' in all cases.

the logout (now sign out) button is 

on the blue bar, I still think is 

better to loose the blue bar and 

integrate the 'log out' in the black 

bar and create a quick link near it 

that leads to the profile editing 

page.

while logged in, there is a heading 

in all landing pages and in the 

main pannel that says "Web 

content display"

o

m
u

se
u

m
sm

e
d

ie
n

x M

H

wanted to change to 

manfred.hackl@ec3networks.at - 

did not receive any notification

---

there is a menu item "manage" 

and another "configuration" --> 

both lead me to the edit profile, i 

wonder if both are required

User creates a new account

User edits his profile
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Id Action Description
Comment

 (and alternatives)

Expected 

Output

#
#

#
#

#
#

#

W
h

o

#
#

#
#

#
#

#

W
h

o

Actual Result

#
#

#
#

#
#

#

W
h

o

Actual Result

#
#

#
#

#
#

#

W
h

o

#
#

#
#

#
#

#

W
h

o

Actual Result

R
e

g
1

.2 Edit 

Profile

AT THE END OF YOUR 

TESTING: *

'- log in as testuser (username: 

your email, password: 

testuser) 

- go on 'Configurations' -> 'Edit 

Profile'

- insert 'testuser@test.user' as 

email address

- click 'Save'

* Necessary only if you

changed the email of the 

'testuser'

You can log in 

as testuser 

with 

'testuser@test

.user' as 

username

O

P
ro

m
o

te
r

O

A
fid

iu
m

 

o

S
P

K o o M

H

guess it worked - email was saved
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Id P
a

re
n

t

S
e

q
-

u
e

n
ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#
#

W
h

o

#
#

#
#

#
#

#
#

W
h

o Actual 

Result #
#

#
#

#
#

#
#

W
h

o Actual 

Result 5
/2

/2
0

1
3

W
h

o

Actual Result

I-
B

E
G

IN

Check 

your type 

of 

account

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

m
u

se
u

m
sm

e
d

ie
n

O

S
P

K

I1 User imports data

I1
.1

I1 I1
.1

, 
I1

.2
, 

I1
.3

, 
I1

.4

Import 

without 

permissio

ns to 

query a 

given 

organizati

on ('Test')

log in with your user

go on 'Exchange Data' -

>'Import Data'

Either an error message 

is shown: "No 

participants available to 

be queried" if no 

providers have given 

permission to query, or 

just 'Test' does not 

appear in the list of data 

providers that can be 

queried.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K

I1
.2

I1 I1
.1

, 
I1

.2
, 

I1
.3

, 
I1

.4

Import 

without 

permissio

ns to 

query

log in as testuser 

('testuser@test.user' or the 

email you set*, password: 

testuser) 

- go on 'Configurations' -> 

'Access Policies'

- add the permission 'All can 

QUERY to Test' (or your 

organization can QUERY to 

Test)

* Optional: change the 

email of the preloaded 

testuser

policy is added in the 

box below

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K

I1
.3

I1 I1
.1

, 
I1

.2
, 

I1
.3

, 

I1
.4

Import 

without 

permissio

ns to 

query

log in with your user

go on 'Exchange Data' -

>'Import Data'

'Test' is now available in 

the list of data providers

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K

Begin of tests for Import

Im
p

o
rt

Precondition to do the following tests is that your user account has the right 

role assigned. You must have just registered with the right role (*) or you must 

have done the last step (END1) in the previous test excel sheet you executed.

See : Registration
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Id P
a

re
n

t

S
e

q
-

u
e

n
ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#
#

W
h

o

#
#

#
#

#
#

#
#

W
h

o Actual 

Result #
#

#
#

#
#

#
#

W
h

o Actual 

Result 5
/2

/2
0

1
3

W
h

o

Actual Result

I1
.4

I1 I1
.1

, 
I1

.2
, 

I1
.3

, 
I1

.4

Import 

without 

permissio

ns to 

query

log in as testuser 

('testuser@test.user' or the 

email you set, password: 

testuser) 

- go on 'Configurations' -> 

'Access Policies'

- delete the permission 'All 

can QUERY to testuser'

policy is deleted from 

the box

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K

I1
.5

I1

Own data 

mapping 

is missing 

in import

from Harmonise ontology to 

local system must NOT be 

available for your 

organization (check in 

'Configurations' -> 'Mapping 

Store', and if necessary 

delete it)

log with your user

go on 'Exchange Data'-

>'Import Data' and perform 

an import from 'euromuse' 

selecting 'exhibition ancient 

world'

 

Screen message is 

shown: "Missing or not 

configured data 

mapping from 

Harmonise Ontology to 

<your-organization>"

In 'Operation Status' tab 

the entry of the previous 

import reports: 'Failed 

on euromuse: Missing 

data mapping from 

Harmonise Ontology to 

<your organization>'.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K
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Id P
a

re
n

t

S
e

q
-

u
e

n
ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#
#

W
h

o

#
#

#
#

#
#

#
#

W
h

o Actual 

Result #
#

#
#

#
#

#
#

W
h

o Actual 

Result 5
/2

/2
0

1
3

W
h

o

Actual Result

I1
.6

I1

Upload 

data 

mapping 

file from 

Harmonis

e 

ontology 

to local 

system 

(for the 

events 

domain)

Log in with your user

- go on 'Configurations'-

>'Mapping Store'

- select any identifier as 

'collectionId' (for instance 

'events')

- choose 'Upload mapping 

from Harmonise ontology to 

local system'

- select the mapping from 

Harmonise ontology to local 

system (choose the file 

available in the test folder as 

'HTO_Euromuse.xslt')

- select 'default for receiving 

events'

- click on 'Send' and check for 

the success message on top 

File is listed in the box at 

the end of the page.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K

I1
.7

I1

Import 

with 

invalid 

query

log in with your user

go on 'Exchange Data' -

>'Import Data'

perform an advanced search 

with an incorrect 

HarmoSearch query (you can 

write any text, or use for 

instance the test query 

'SQ0_invalid_import_query.x

ml')

Error message is shown: 

"User query not valid 

against HarmoSearch 

query language XSD".

The same message is 

shown in 'Operation 

status' and in the mail 

notification you'll 

receive.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K
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Id P
a

re
n

t

S
e

q
-

u
e

n
ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#
#

W
h

o

#
#

#
#

#
#

#
#

W
h

o Actual 

Result #
#

#
#

#
#

#
#

W
h

o Actual 

Result 5
/2

/2
0

1
3

W
h

o

Actual Result

I1
.8

I1 I1
.5

, 
I1

.7 Import 

Events 

successful

Prerequisite:  You have 

uploaded the mappings from 

Harmonise ontology to your 

system

- log in with your account

- go on 'Exchange Data'-

>'Import Data' 

- select 'euromuse' as data 

provider

- 'exhibition ancient world' as 

category

- click on 'Search'

Screen message and 

'Operation Status' report 

success of the import.

You also receive an 

email notification.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

w

X
M

L 
R

e
su

lt
 F

il
e

s 
sh

o
u

ld
 o

p
e

n
 i

n
 

o
w

n
 w

in
d

o
w

, 
if

 y
o

u
 d

o
w

n
lo

a
d

 

th
e

m
 w

it
h

 l
e

ft
 c

li
ck

.

o

S
P

K
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Id P
a

re
n

t

S
e

q
-

u
e

n
ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#
#

W
h

o

#
#

#
#

#
#

#
#

W
h

o Actual 

Result #
#

#
#

#
#

#
#

W
h

o Actual 

Result 5
/2

/2
0

1
3

W
h

o

Actual Result

I1
.9

I1 I1
.5

, 
I1

.8

Import 

Events 

with 

Advanced 

Search 

perform an import through 

Advanced Search using 

'SQ1_for_import.xml'

Operation Status'  and 

email confirm that the 

operation was 

successful.

In 'Data Repository'-

>'Querybox' the result 

file is available (check 

with the example file 

'import_results_Advanc

ed_Search.xml' in the 

test folder)

O

P
ro

m
o

te
r

W

A
fi

d
iu

m
 

I really 

think the 

XML file 

should 

open in 

another 

browser 

tab, as 

browser 

read XML 

file : 

clicking the 

download 

button just 

opens the 

XML in the 

same tab 

for now, 

making 

user leave 

harmosear

ch for a 

page of 

code

O o

S
P

K the exhibitions 

are not the 

same, because 

the xml file in 

the  repository 

is outdated, the 

query result 

gives updated 

result, so it is 

successful.

Agree with 

David, either 

open the file in 

a new tab, or 

activate the 

download 

dialog of the 

browser… it 

would be nice 

to see in the 

table how many 

results where 

retrieved in the 

file.
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Id P
a

re
n

t

S
e

q
-

u
e

n
ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#
#

W
h

o

#
#

#
#

#
#

#
#

W
h

o Actual 

Result #
#

#
#

#
#

#
#

W
h

o Actual 

Result 5
/2

/2
0

1
3

W
h

o

Actual Result

I1
.1

0

I1

For the 

accommo

dation 

domain:

Upload 

data 

mapping 

file from 

Harmonis

e 

ontology 

to local 

system 

Log in with your user

- go on 'Configurations'-

>'Mapping Store'

- select any identifier as 

'collectionId' (for instance 

'acco')

- choose 'Upload mapping 

from Harmonise ontology to 

local system'

- select the mapping from 

Harmonise ontology to local 

system (choose the file 

available in the test folder as 

'identity.xslt')

- select 'default for receiving 

accommodations'

- click on 'Send' and check for 

the success message on top 

File is listed in the box at 

the end of the page.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K

I1
.1

1

I1 I1
.9

, 
I1

.1
0

Import 

Accommo

dations 

successful

go on 'Exchange Data'-

>'Import Data' 

- select 'Accommodation' as 

subdomain

- 'b&b' as type

- 'biella' as data provider

- click on 'Search'

reports about the 

success of the 

operation. 

In 'Data Repository' -> 

'Querybox' the file with 

the accommodations 

from biella is available 

with 10 accommodation 

results (it looks like the 

file 

'accommodation_results

.xml' in the test folder).

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K other results 

but also 10 and 

same format
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Id P
a

re
n

t

S
e

q
-

u
e

n
ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#
#

W
h

o

#
#

#
#

#
#

#
#

W
h

o Actual 

Result #
#

#
#

#
#

#
#

W
h

o Actual 

Result 5
/2

/2
0

1
3

W
h

o

Actual Result

I1
.1

2

I1 I1
.7

, 
I1

.8
, 

I1
.9

, 

I1
.1

0
, 

I1
.1

1

Check 

results of 

import in 

'Querybo

x'

log in with your user

go on 'Data Repository' -

>'Querybox'

The files received from 

the user with a 

successful import 

operation are present 

(see the timestamp) and 

can be downloaded or 

deleted

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K

I2 User schedules regular automatic import operations

I2
.1

I2

Schedule 

import

log in with your user

go on 'Exchange Data'-

>'Scheduler' and select

   - IMPORT Data as 

Operation

   - euromuse as data 

provider

   - exhibition art history as 

category

   - schedule the operation 

within the next 10 minutes 

(**)

   - click 'Schedule task'

**  the server's system 

clock is CET (Central 

European Time)

After the time set in the 

scheduled options, the 

result file is available in 

'Querybox' and contains 

some results.

In 'Operation Status' the 

import operation is 

reported to be 

completed successfully 

on euromuse.

After some minutes you 

receive also a 

notification email.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K as my user is 

from eurmouse 

I perform the 

test in 

euromusemf

the file 

retrieved is 

empty see xml

see : 

www.euromuse

.net/thorsten2/

harmonise/sche

dule_euromuse

mf_3101.xml

I2
.2

I2

Remove 

scheduled 

tasks

Log in with your account

- go on 'Exchange Data' -> 

'Scheduler'

- delete all scheduled 

operations within 'Exchange 

Data' -> 'Scheduler' No tasks are listed in the 

box.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K

I3 User imports data through Web Services

S
ch

e
d

u
le

d
 I

m
p

o
rt

Im
p

o
rt

W
e

b
S

e
rv

ic
e

s
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Id P
a

re
n

t

S
e

q
-

u
e

n
ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#
#

W
h

o

#
#

#
#

#
#

#
#

W
h

o Actual 

Result #
#

#
#

#
#

#
#

W
h

o Actual 

Result 5
/2

/2
0

1
3

W
h

o

Actual Result

I3
.1

I3 I1
.6

, 
I3

.1

Import 

Events 

through 

Web 

Services

Prerequistite : you have 

configured the mapping for 

receiving events

perform an import with 

'simpleSearch' method using 

your organization's name as 

sender, 'euromuse' as 

receiver, 'Event' as 

subdomain, and void (not 

null!) search_criteria

To be tested using 

Oxygen or XMLSpy or 

similar. 

WSDL: 

http://harmosearchde

v.harmonet.org/WebA

ccessPortal-

portlet/DataExchange

Manager?wsdl

Documentation: 

'Annex_D_4_3_Web 

Service APIs 

Specifications_v0.3.do

cx' file available in SVN 

at 

/04_Query_Mapping/

metasearch engine 

Two strings are 

returned. The first says 

'Operation completed 

successfully on: 

euromuse.' and the 

second is a link to the 

imported file available 

on the Data Repository.

'Operation Status' also 

reports about the 

successful completion 

and links to the 

'Querybox', where the 

result file is available 

(check the timestamp).

O

P
ro

m
o

te
r

A
fi

d
iu

m
 

O w

S
P

K my user is 

euromuse 

user… so i can 

only import 

from 

euromusemf, 

but at no point I 

am offered the 

possibility to 

set sender and 

receiver… the 

only thing I can 

choose in 

simple search is 

a data 

provider…

the first 

returned 

message is: 

Operation 

I3
.2

I3 I1
.1

0
, 

I3
.2

Import 

Accommo

dations 

through 

Web 

Services

Prerequistite : you have 

configured the mapping for 

receiving accommodations

perform an import with 

'simpleSearch' method using 

your organization's name as 

sender, 'biella' as receiver, 

'Accommodation' as 

subdomain, 'guesthouse' as 

type and 'restaurant' as 

facility

Same documentation 

as import Events

returned. The first says 

'Operation completed 

successfully on: biella.' 

and the second is a link 

to the imported file 

available on the Data 

Repository.

'Operation Status' also 

reports about the 

successful completion 

and links to the 

'Querybox', where the 

result file is available 

(check the timestamp).

O

P
ro

m
o

te
r

A
fi

d
iu

m
 

O w

S
P

K same as row 

21… no 

possibility to 

set a receiver, 

only to choos 

biella as data 

provider. 

Message 

"Operation 

COMPLETED. 

You will receive 

an email 

notification. To 

check result…"

Im
p

o
rt

 W
e

b
 S

e
rv

ic
e

s
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re
n

t

S
e

q
-

u
e

n
ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#
#

W
h

o

#
#

#
#

#
#

#
#

W
h

o Actual 

Result #
#

#
#

#
#

#
#

W
h

o Actual 

Result 5
/2

/2
0

1
3

W
h

o

Actual Result

I3
.3

I3 I1
.6

, 
I3

.3

Advanced 

Search 

import 

through 

Web 

Service

perform an import with 

'advancedSearch' method 

using your organization's 

name as sender, 'Event' as 

subdomain, and 

'SQ1_for_import.xml' (from 

test folder) as xml_query

Same documentation 

as import Events

Two strings are 

returned. The first says 

'Operation completed 

successfully on: biella.' 

and the second is a link 

to the imported file 

available on the Data 

Repository.

'Operation Status' also 

reports about the 

successful completion 

and links to the 

'Querybox', where the 

result file is available 

O

P
ro

m
o

te
r

A
fi

d
iu

m
 

O o

S
P

K

I4 Use external servicesUser imports data including extenal services

I4
.1

I4 I1
.6

, 
I4

.1
, 

I4
.2

, 
I4

.3
, 

I4
.4

Us

e 

ext

er

nal 

ser

vic

es

Register 

new 

service 

that 

requires 

authoriza

tion

log in as testuser 

('testuser@test.user' or the 

email you set*, password: 

testuser) 

- go on 'External Services' -> 

'Manage Services'

- register a new service on 

the 'Add Workflow Service' 

panel, with fields:

- name: 'Permanent Events 

Filter'

- description: 'Takes only 

permanent events'

- check the box 

'Authorization required'

- access URL: 

http://harmosearchdev.harm

onet.org/ExternalService-

portlet/permEvents

* Optional: change the

email of the preloaded 

testuser

The new service is in the 

workflow services list on 

the left

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K
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a

re
n

t

S
e

q
-

u
e

n
ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#
#

W
h

o

#
#

#
#

#
#

#
#

W
h

o Actual 

Result #
#

#
#

#
#

#
#

W
h

o Actual 

Result 5
/2

/2
0

1
3

W
h

o

Actual Result

I4
.2

I4 I1
.6

, 
I4

.1
, 

I4
.2

, 
I4

.3
, 

I4
.4

Us

e 

ext

er

nal 

ser

vic

es

Subscribe 

to service 

that 

requires 

authoriza

tion

log in with your account

- go on 'External Services' -> 

'Subscribe to Service'

- click on 'subscribe' for the 

'Permanet Events Filter' 

service

(You are free to insert the 

limitations on use that you 

prefer, i.e. the number of 

times to use the service and 

the date interval)

Status of the service is 

'REQUESTED'.

An email is sent to the 

email address that you 

have set for 'testuser', 

saying that a user 

requested the 

subscrition to the 

service.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O w

S
P

K as a user 

suscribing an 

external service 

i do not think 

the 'customer' 

has any 

conditions to 

set, or terms of 

use… it is the 

testuser that 

has to set 

these… as my 

user i cannot 

write anything 

in the terms of 

use, which is in 

my opinion 

I4
.3

I4 I1
.6

, 
I4

.1
, 

I4
.2

, 
I4

.3
, 

I4
.4

Us

e 

ext

er

nal 

ser

vic

es

Accept 

subscripti

on

log in as testuser 

('testuser@test.user' or the 

email you set*, password: 

testuser) 

- go on 'External Services' -> 

'Manage Services'

- click on 'Modify' on the 

subscription request of your 

user (on the Workflow 

Requested Service Panel)

- assign permission to use the 

service only 3 times ('max 

number of times'=3), within a 

date interval that includes 

* Optional: change the 

email of the preloaded 

testuser

An email is sent to your 

account, saying that the 

request for  subscrition 

was accepted.

If you log in with your 

account, in 'Subscribe to 

Service' the service is in 

'Authorized' status, the 

terms of use are 

updated, and the service 

is now available in the 

dropdown list on the 

import and scheduler 

pages.

O

P
ro

m
o

te
r X

A
fi

d
iu

m
 

I could do 

it but Using 

Firefox 18 : 

the date 

picker 

doesn't 

work well 

("allow" 

button  

causing 

bug)

O w

S
P

K _on test user: 

basically as 

exepcted 

except the 

calender… it 

allowed neither 

to set today 

and today as 

range, nor any 

other time 

range…

_on my user 

everything as 

expected
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S
e

q
-

u
e

n
ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#
#

W
h

o

#
#

#
#

#
#

#
#

W
h

o Actual 

Result #
#

#
#

#
#

#
#

W
h

o Actual 

Result 5
/2

/2
0

1
3

W
h

o

Actual Result

I4
.4

I4 I1
.6

, 
I4

.1
, 

I4
.2

, 
I4

.3
, 

I4
.4

Us

e 

ext

er

nal 

ser

vic

es

Use 

external 

service in 

import

- log in with your account

- go on 'Exchange Data'-

>'Import Data' 

- select 'euromuse' as data 

provider

- 'Austria' as country

- 'exhibition archeology' as 

category

- include 'Permanet Events 

Filter' as external service 

(click on 'Add' button)

- click on 'Search'

Screen message and 

'Operation Status' report 

success of the import.

In 'Data Repository' -> 

'Querybox' the just 

received file contains 

only 3 events out of 9 

(which would be 

returned without 

including the external 

service); they all are 

permanent exhibitions.

In 'Subscribe to Service' 

the 'max number of 

times' is updated to 2.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K as my user is 

registered as 

euromuse user, 

and the 

euromusemf 

provider did not 

respond, i 

shortly assigned 

the spk editor 

user the role of 

import, with a 

mapping from 

hto to system 

identity.xslt and 

a suscription to 

the permanent 

exhibition 

service... and I 

got the 

expected result.
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S
e

q
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u
e

n
ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#
#

W
h

o

#
#

#
#

#
#

#
#

W
h

o Actual 

Result #
#

#
#

#
#

#
#

W
h

o Actual 

Result 5
/2

/2
0

1
3

W
h

o

Actual Result

I4
.5

I4 I1
.6

, 
I4

.1
, 

I4
.2

, 
I4

.3
, 

I4
.4

, 
I4

.5

External 

service 

permissio

n expired

- log in with your account

- go on 'Exchange Data'-

>'Import Data' 

- do any import operation 

you like, but including 

'Permanet Events Filter' as 

external service (click on 

'Add' button) 

- click on 'Search'

- repeat doing this kind of 

import 3 (or less) times - you 

should at the end have no 

possibility to include the 

external service

This operation 

consumes the number 

of times you (acting as 

testuser) have set in 

the access policy for 

using the external 

service

The 'Permanent Events 

Filter' is no more 

available in the drop 

down list of the import 

form.

In 'Subscribe to Service' 

the 'max number of 

times' is updated to 0.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O w

S
P

K what if the 

process fails for 

other reasons?

As testuser i 

allowed spk 

editor to search 

on euromuse 1 

time... then I 

tried as spk 

editor with the 

import roled 

assigned, but 

mistakenly 

without 

mapping file 

uploaded, to 

search events 

on euromuse. 

After searching 

the system 

warned there 

was no 

mapping file.. 

so i uploaded it, 

but then, my 1 

time had run 

out!! that was 
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re
n

t

S
e

q
-

u
e

n
ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#
#

W
h

o

#
#

#
#

#
#

#
#

W
h

o Actual 

Result #
#

#
#

#
#

#
#

W
h

o Actual 

Result 5
/2

/2
0

1
3

W
h

o

Actual Result

I4
.6

I4 I4
.1

, 
I4

.6

Us

e 

ext

er

nal 

ser

vic

es

Delete 

external 

service

log in as testuser 

('testuser@test.user' or the 

email you set, password: 

testuser) 

- go on 'External Services' -> 

'Manage Services'

- click 'Delete' on the 

'Permanet Events Filter' 

service

The service is no more 

listed in the workflow 

services panel.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K

I5 Home User takes overview of services

I5
.1

I5

Ho

me

Take 

oveview 

of 

configura

tion

logged in with your account

go on 'Home'

check the status of the 

services

The status of the 

available services should 

be shown (active or not, 

missing configurations 

and links to the 

respective configuration 

pages)

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O o

S
P

K

End of tests for Import
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n

t

S
e

q
-

u
e

n
ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#
#

W
h

o

#
#

#
#

#
#

#
#

W
h

o Actual 

Result #
#

#
#

#
#

#
#

W
h

o Actual 

Result 5
/2

/2
0

1
3

W
h

o

Actual Result

I-
E

N
D

1

Change 

your type 

of 

account

log in with your user

- go on 'Manage' -> 'Control 

Panel' on the top left

- select 'Roles' from the 

menu

- on 'Import' click  'Actions' 

and then  'Assign members'

- click on the 'Current' tab 

and uncheck your account, 

then click on 'Update 

Associations' on top of the 

list

- (*) click on 'View all' and 

assign yourself the role of 

your next tests:

- on the selected role click 

'Actions' -> 'Assign members'

- click on the 'Current' tab 

and check your account, then 

click on 'Update Associations' 

on top of the list **

- click on 'Back to 

HarmoSearch' on the top left

* necessary only if you 

have to test some 

other type of account 

(and corresponding 

excel sheet)

** you can check your 

new role, for instance, in 

the 'Control Panel' 

within 'My Account' 

(don't remove the extra 

roles 'User' and 'Super 

User'!) 

Once back to the portal, 

you'll see different 

entries in the operations 

menu

O

P
ro

m
o

te
r

A
fi

d
iu

m
 

O o

S
P

K

I-
E

N
D

2

END * Restore email of 'testuser'

* Only if your tests end 

with the current type 

of account
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and 

alternatives) Expected Output 2
8

/0
1

/1
3

W
h

o

2
9

/0
1

/1
3

W
h

o

Actual Result 3
0

/0
1

/1
3

W
h

o

Actual Result

P
u

b
-B

E
G

IN Check your 

type of 

account

Precondition to do the following tests is that 

your user account has the right role assigned. 

You must have just registered with the right 

role (*) or you must have done the last step 

(END1) in the previous test excel sheet you 

executed.

* Registration 

of new user 

account

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K

User pushes data to another participant

P
u

b
1

.1

P
u

b
1

P
u

b
1

.1
, 

P
u

b
1

.2
, 

P
u

b
1

.3 Push 

without 

permission

log in as testuser ('testuser@test.user' or the 

email you set*, password: testuser) 

- go on 'Configurations' -> 'Access Policies'

- delete the permission 'All can PUSH to Test'

* Optional: 

change the 

email of the 

preloaded 

testuser

Policy is removed from the box at the 

end of the page.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K

P
u

b
1

.2

P
u

b
1

P
u

b
1

.1
, 

P
u

b
1

.2
,

 P
u

b
1

.3 Push 

without 

permission

log in with your user

go on 'Exchange Data' ->'Share Data' and 

select 'Push Data'

Either an error message is shown: "No 

participants available to receive data" if 

no providers have given permission to 

push, otherwise 'Test' just isn't listed in 

the drop-down menu of the providers

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K only promoter is available 

to receive data

P
u

b
1

.3

P
u

b
1

P
u

b
1

.1
, 

P
u

b
1

.2
, 

P
u

b
1

.3 Push 

without 

permission

log in as testuser ('testuser@test.user' or the 

email you set, password: testuser) 

- go on 'Configurations' -> 'Access Policies'

- add the permission 'All can PUSH to Test'

Policy is added in the box at the end of 

the page.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K

P
u

b
1

.4

P
u

b
1 Push with 

missing 

data 

mapping 

file

Prerequisite : mapping file from local system 

to Harmonise ontology must not be available 

for your organization (check in 

'Configurations' -> 'Mapping Store', and if 

necessary delete it)

log in with your user, 

go on 'Exchange Data' ->'Share Data' and 

select 'Push Data'

select 'Test' as receiver and 

'euromuse_to_push.xml' * (available in the 

test folder) as data file 

click on 'Send'

* You can use 

smaller files 

like 

'euromuse_Wir

_essen_Reis.x

ml' or 

'euromuse_Arc

hitektur.xml' as 

an alternative

Operation status and email report about 

the failure in sending the data, saying 

that the data mapping is missing or not 

configured.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K

Begin of tests for Publisher

Pub1

P
u

sh
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re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and 

alternatives) Expected Output 2
8

/0
1

/1
3

W
h

o

2
9

/0
1

/1
3

W
h

o

Actual Result 3
0

/0
1

/1
3

W
h

o

Actual Result

P
u

b
1

.5

P
u

b
1

P
u

b
1

.5
, 

P
u

b
1

.7 Upload 

data 

mapping 

file from 

local 

system to 

Harmonise 

ontology

log in with your user

go on 'Configurations'->'Mapping Store'

insert 'events' as collection id

choose 'Upload mapping from local system to 

Harmonise ontology (for sending data)'

select the mapping from local system to 

Harmonise ontology (choose the file available 

in the test folder as 'Euromuse_HTO.xslt')

select 'default for sending events'

click on 'Send' and check for the success 

message on top of the page

File is listed in the box at the end of the 

page.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K it is the only mapping file 

uploaded, therefore the 

first

P
u

b
1

.6

P
u

b
1 Push data 

file not 

compliant 

with your 

mapping 

file

log in with your user

go on 'Exchange Data' ->'Share Data' and 

select 'Push Data'

select 'Test' as receiver and 

'harmonise_to_push_reduced.xml' (available 

in the test folder) as data file 

click on 'Send'

Error message is shown: "Input file is 

incompatible with the mapping file."

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K

P
u

b
1

.7

P
u

b
1

P
u

b
1

.5
, 

P
u

b
1

.7 Push 

successful 

to multiple 

receivers

log in with your user

go on 'Exchange Data' ->'Share Data' and 

select 'Push Data'

select 'Promoter' and 'Test' as receivers and 

'euromuse_to_push.xml' * (available in the 

test folder) as data file 

click on 'Send'

* You can use 

smaller files 

like 

'euromuse_Wir

_essen_Reis.x

ml' or 

'euromuse_Arc

hitektur.xml' as 

an alternative

Screen message is shown: "Operation 

stated. You will receive an email 

notification. To view the status and 

results go here.'

After some minutes you will receive an 

email saying '   Operation completed 

successfully on: Promoter, Test'.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K

P
u

b
1

.8

P
u

b
1 Push data 

and bypass 

mapping

logged in with your account

- go on 'Exchange Data' -> 'Share Data'

- select 'Push Data' as operation

- choose 'harmonise_to_push_reduced.xml' 

as data file (from the test folder)

- 'Test' as recipient

- 'Event' as subdomain

- check 'Exclude data mapping' checkbox

- click 'Send'

'Operation Status' reports the success of 

the operation.

It you tried the same steps without 

bypassing the mapping an error would 

be raised, because the file sent is not in 

the expected format (one of the 

previous tests)

Furthermore, if you log in as 'testuser', 

the file that is in the inbox is exactly the 

same as the one you sent. 

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K
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q
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A
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Name Description

Comment

 (and 

alternatives) Expected Output 2
8

/0
1

/1
3

W
h

o

2
9

/0
1

/1
3

W
h

o

Actual Result 3
0

/0
1

/1
3

W
h

o

Actual Result

P
u

b
1

.9

P
u

b
1 Push 

through 

form

logged in with your account

- go on 'Exchange Data' -> 'Upload Data'

- select 'Push Data' as operation

- insert the event fields

- select 'Test' as recipient

Screen message and 'Operation Status' 

report the success of the operation.

Testuser receives an email and a file is 

sent to its inbox.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

X

S
P

K I fill out "alt vertrautes" 
(see xml) this message 
error appears: 
"Failed on Test: Error in 
data mapping from 
HarmoNET to Harmonise 
Ontology: 
org.xml.sax.SAXParseEx
ception: The reference to 
entity "typeId" must end 
with the ';' delimiter. Line: 
5 Column: 403." The file 
is stored in the "outbox" 
of my user, seems a bad 
formed xml...
When I fill out "gone with 
the wind.xml" (see xml) 
operation succeeds
layout comments:
I would like to refer to my 
comments in the excel of 
release 4, I gave a lot of 
feedback about this input 
form, and asked about 
the possibility to 
complete these fields. I 
would add these issues 
in this release:
-If a user wants to enter 
an event other than an 
exhibition, but cultural: 
e.g. a concert taking 
place on 1st and 2nd of 
March, starting both days 
at 8 pm, he could not..

P
u

b
1

.1
0

P
u

b
1 Push 

through 

Excel file

logged in with your account

- go on 'Exchange Data' -> 'Share Data'

- select 'Push Data' as operation

- choose 'push_Excel_2003.xsl' as data file 

(from the test folder)

- 'Test' as recipient

- 'Event' as subdomain

- click 'Send'

Screen message and 'Operation Status' 

report the success of the operation.

Testuser receives an email and a file is 

sent to its inbox.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K
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Name Description

Comment

 (and 

alternatives) Expected Output 2
8

/0
1

/1
3

W
h

o

2
9

/0
1

/1
3

W
h

o

Actual Result 3
0

/0
1

/1
3

W
h

o

Actual Result

P
u

b
1

.1
1

P
u

b
1 Push 

through 

Excel file 

with wrong 

template

logged in with your account

- go on 'Exchange Data' -> 'Share Data'

- select 'Push Data' as operation

- choose 'wrong_template_Excel_2003.xsl' as 

data file (from the test folder)

- 'Test' as recipient

- 'Event' as subdomain

- click 'Send'

Error message: "Excel file may be 

corrupted. Please check if the right 

template was used."

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K

P
u

b
1

.1
2

P
u

b
1

P
u

b
1

.5
, 

P
u

b
1

.7
,

P
u

b
1

.1
3 Check 

sentbox

log in with your accout

- go on 'Data Repository' -> 'Sentbox'

The files you sent with a push operation 

are present (see also the timestamp).

O

P
ro

m
o

te

r O

A
fi

d
iu

m
 

O

S
P

K

P
u

b
1

.1
3

P
u

b
1

P
u

b
1

.4
,

P
u

b
1

.1
4 Check 

outbox

log in with your accout

- go on 'Data Repository' -> 'Outbox'

The files you sent with an unsuccessful 

push operation are present (see also the 

timestamp).

O

P
ro

m
o

te

r O

A
fi

d
iu

m
 

O

S
P

K

P
u

b
1

.1
4

P
u

b
1

P
u

b
1

.5
, 

P
u

b
1

.7
,

P
u

b
1

.1
2 Check 

inbox

log in as testuser ('testuser@test.user' or the 

email you set, password: testuser) 

- go on 'Data Repository' -> 'Inbox'

The files you sent with a push operation 

are present (see also the timestamp) 

and can be downloaded or deleted

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K

P
u

b
2

User pushes data through Web Service

P
u

b
2

.1

P
u

b
2 Push data 

file 

through 

Web 

Service to 

multiple 

receivers

perform a push through 'pushData' method, 

setting your organization's name as sender, 

'Promoter' and 'Test' as receivers, 'Event' as 

subdomain and using 

'euromuse_to_push.xml' (available in the test 

folder) as xml_file

To be tested 

using Oxygen or 

XMLSpy or 

similar. 

WSDL: 

http://harmose

archdev.harmo

net.org/WebAc

cessPortal-

portlet/DataExc

hangeManager

?wsdl

Documentation

: 

'Annex_D_4_3_

Web Service 

APIs 

Specifications_

v0.3.docx' file 

available in SVN 

at 

/04_Query_Ma

pping/metasear

The method returns a successful 

completion message: ' Operation 

completed successfully on: Promoter, 

Test".

'Operation Status'  and email report also 

successful completion. Your 'Sentbox' 

contains the file you sent.

Logged in as tesuser, in 'Data Repository'-

>'Inbox' the file that has been sent is 

available.

O

P
ro

m
o

te
r

A
fi

d
iu

m
 

W

S
P

K The file it is available, I 

guess test user has not a 

very complete mapping, the 

file recieved has only the 

same start and enddate in 

all events, other fields are 

empty.

P
u

sh
 W

e
b

 S
e

rv
ic

e
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alternatives) Expected Output 2
8

/0
1

/1
3

W
h

o

2
9

/0
1

/1
3

W
h

o

Actual Result 3
0

/0
1

/1
3

W
h

o

Actual Result

P
u

b
3

User publishes events on social networks

P
u

b
3

.0

P
u

b
3

P
u

b
3

.0
, 

P
u

b
3

.1 Clean up 

prior 

HarmoSear

ch app 

permission

s on 

Facebook

If you did the social network tests for past 

releases of HarmoSearch, you might need for 

Facebook to first clean up  the permissions 

that were set at that time inside of Facebook. 

Do the following:

- log in to Facebook

- go on 'Account Settings' (top right)

- go on 'Apps' and remove 'HarmoSearch' if 

you find it in the list

O

P
ro

m
o

te
r

A
fi

d
iu

m
 

O

S
P

K

P
u

b
3

.1

P
u

b
3

P
u

b
3

.0
, 

P
u

b
3

.1 Give 

permission 

to publish 

on your 

behalf

Login with your account

- go on Configurations -> Social Networks

- click on 'give permissions' for one of the 

social networks where you have an account

- follow the procedure proposed by your 

social network in order to complete the 

operation

The button for giving permission is 

replaced by the buttons for expanding 

the credentials token and for removing 

the just given permission.

On the Scheduler page, if you select 

'Publish' as operation, your social 

network target is now available in the 

dropdown list (e.g. as 'Twitter (User 

status)')

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

W

S
P

K on scheduler page I get a 

warning and I cannot 

choose an operation:

To schedule a PUSH or 

PUBLISH operation it is 

required to have a data 

provider profile associated

which is wrong, for I set my 

profile as publisher for 

euromuse, that is, a data 

provider…

P
u

b
3

.2

P
u

b
3

P
u

b
3

.1
, 

P
u

b
3

.2 Publish 

through 

form

logged in with your account

- go on 'Exchange Data' -> 'Upload Data'

- select 'Publish Data' as operation

- keep selected 'Filter manually before 

publishing' and insert the event fields

- select your social network as recipient

There is your event listed in 'Exchange 

Data' -> 'Confirm publishing'

You also receive an email.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K

P
u

b
3

.3

P
u

b
3

P
u

b
3

.1
, 

P
u

b
3

.3 Publish 

from excel 

file

logged in with your account

- go on 'Exchange Data' -> 'Share Data'

- select 'Publish Data' as operation

- keep selected 'Filter manually before 

publishing'

- choose 'push_Excel_2003.xsl' as data file 

(from the test folder)

- select any social network as recipient

The Excel events are listed in 'Exchange 

Data' -> 'Confirm publishing'

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K

P
u

b
li

sh
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 (and 

alternatives) Expected Output 2
8

/0
1

/1
3

W
h

o

2
9

/0
1

/1
3

W
h

o

Actual Result 3
0

/0
1

/1
3

W
h

o

Actual Result

P
u

b
3

.4

P
u

b
3

P
u

b
1

.5
, 

P
u

b
3

.1
, 

P
u

b
3

.4 Publish 

from xml 

file

Prerequisite:  you have uploaded and 

configured the mapping of events from your 

local system to HarmoSearch

- Log in with your account

- go on 'Exchange Data' -> 'Share Data'

- select 'Publish on social network' as 

operation

- uncheck 'Filter manually' checkbox

- select the file 'euromuse_Architektur.xml' as 

data file (available in the test folder)

- your social network's target (one or more) 

as recipient

- 'Event' as domain

- click on 'Send'

As alternative 

files you can 

use 

'euromuse_Wir

_essen_Reis.xm

l' or 

'euromuse_2_e

vents.xml'

In 'Operation Status' the publish 

operation is reported as completed.

An email is sent that informs on the 

success of the operation.

The event is visible on your social 

network page.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

W

S
P

K for results see picture… 

better than R4!

attention, I filled an event 

with no event url, but with 

a picture url,  the post 

understood that picture url, 

and did not show the 

picture, but used that as 

status url…

see : 

www.euromuse.net/wiki/u

ploads/02_publish_sm.jpg

The publisher is also a data provider, and can 

specify how its data is used on the portal (set 

up permissions, licenses, remote query 

service configuration, …)

P
u

b
4

.1

P
u

b
4

A
d

d
 r

o
le User 

assigns 

himself the 

role of data 

provider

log in with your user

- go on 'Manage' -> 'Control Panel' on the top 

left

- select 'Roles' from the menu

- on 'Data Provider' click on 'Actions' and then 

on 'Assign members'

- click on the 'Available' tab and check your 

account, then click on 'Update Associations' 

on top of the list

- click on 'Back to HarmoSearch' on the top 

left

The publisher 

must also be a 

data provider, 

and be able to 

specify how its 

data is used on 

the portal (set 

up permissions, 

licenses, 

remote query 

service 

configuration, 

…) in order to 

do some 

advanced 

operations, i.e. 

to schedule 

automatic 

push and 

publish 

operations

Once back to the portal, you'll see more 

entries in the menu (for instance 

'Configurations' ->'Access Policies'

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K this explains behavoir in 

row 23, ignore the 

comment… or set 

publishers as data providers 

as default?

P
u

b
5

User specifies the basic configuration for a data providerSet up data provider

ADVANCED PUBLISHER
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alternatives) Expected Output 2
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/0
1

/1
3

W
h
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2
9

/0
1

/1
3

W
h

o

Actual Result 3
0

/0
1

/1
3

W
h

o

Actual Result

P
u

b
5

.1

P
u

b
5

P
u

b
5

.1
, 

P
u

b
5

.2 Set up 

query 

service

Login with your user

go in 'Configurations'->'Query Service'

click on your organization's name

go on panel 'Create and attach a new Data 

Provider' and insert an id (e.g. <Your-

organization>_dataprovider (no whitespaces!)

click on 'Create' and insert the following 

parameters:

      any name for your provider

      the name of the collectionId that you used 

when uploading the data mapping (for 

instance 'events')

'http://www.euromuse.net/harmonise/query

/query.php' as service access endpoint (no 

whitespaces!)

      'karin' as username and password

      'HTTPAdapter' as Connector class

      select 'IMPORT'  and 'METASEARCH' as 

operation

      'Event' as Subdomain

      click on 'Save Changes'

click 'Edit Data Description' and select 'events'

click on 'Save Changes'

If you go back to the view 'Harmonise 

Participant Details' (back to list), the 

new data provider is attached to the 

your organization

O

P
ro

m
o

te
r

W

A
fi

d
iu

m
 

- I think the password 

shouldn't be in clear

-" Edit Data Description" 

is before save changes. 

Yet if we click it before 

saving, we loose any 

modification when going 

back. I think the button 

should be before the edit 

link, or that we should 

keep fields up to date, or 

a popup asking if we want 

to save link or discard 

before accessing the edit 

data screen

- the edit data description 

page isn't clear.. i don't 

know if i did something or 

if my selection had any 

impact or is validated

O

S
P

K The data provider profile is 

not clear to me… I assume 

as a publisher I am a data 

provider, for in order to 

publish all the events from 

the past rows, theoretically 

I provided the events.

The steps work if the order 

of things is followed,but to 

fill in a form should require 

a user's manual... 

P
u

b
5

.2

P
u

b
5

P
u

b
5

.1
, 

P
u

b
5

.2 Upload 

query 

mappings 

(for the 

events 

domain)

log with your user

- go on 'Configurations'->'Mapping Store'

- insert the collection id you already used for 

the events domain when uploading the data 

mappings (for instance 'events')

- choose 'Upload query mapping to translate 

HarmoSearch fields and enumerations'

- select the query fields and enumerations 

mapping file (choose the file available in the 

test folder as 

'HTO_Euromuse_query_enum.xslt')

- choose 'Upload query mapping to translate 

HarmoSearch query structure'

- select the query structure mapping file 

(choose the file available in the test folder as 

'HTO_Euromuse_query.xslt')

- click on 'Send' and check for the success 

message on top of the page

Files are listed in the box at the end of 

the page.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O
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 (and 

alternatives) Expected Output 2
8

/0
1

/1
3

W
h

o

2
9

/0
1

/1
3

W
h

o

Actual Result 3
0

/0
1

/1
3

W
h

o

Actual Result

P
u

b
6

User schedules pushing and publishing of events

P
u

b
6

.1

P
u

b
6

P
u

b
1

.5
, 

P
u

b
5

.1
, 

P
u

b
5

.2
, 

P
u

b
6

.1 Schedule a 

push 

correctly

Prerequisite : you have uploaded and 

configured the mapping of events from your 

local system to HarmoSearch, the two 

mappings for the query, and you have 

configured a query service for your 

organization

log in with your user

go on 'Exchange Data'->'Scheduler' and select

   PUSH Data as Operation

   Test as recipient

   exhibition ancient world as category

   schedule operation within the next 10 

minutes **

   click 'Schedule task'

In a scheduled 

push the user 

does not 

upload a file 

but he 

schedules a 

query to his 

associated 

data provider 

through which 

the system 

automatically 

exports the 

actual data to 

be sent from 

his system. 

Therefore, the 

user needs to 

register a 

query service 

and to upload 

a query 

mapping to use 

this 

functionality.

**  the server's 

system clock is 

CET (Central 

European 

In 'Operation Status' the push operation 

is reported to be completed successfully

After some minutes you receive also a 

notification email.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K

P
u

b
li

sh

Scheduled Operations
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alternatives) Expected Output 2
8

/0
1
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3

W
h
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2
9

/0
1

/1
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W
h
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Actual Result 3
0

/0
1

/1
3

W
h

o

Actual Result

P
u

b
6

.2

P
u

b
6

P
u

b
1

.5
, 

P
u

b
5

.1
, 

P
u

b
5

.2
, 

P
u

b
6

.2
, 

P
u

b
6

.3 Schedule 

publish 

with 

manual 

filter

Prerequisite : you have uploaded and 

configured the mapping of events from your 

local system to HarmoSearch, the two 

mappings for the query, and you have 

configured a query service for your 

organization

go on 'Exchange Data' -> 'Scheduler'

select 

- 'Publish on social network' as operation

- your social network's target (one or more) 

as recipient (*)

- keep 'Filter manually' selected

- subdomain 'Event', country 'France', city 

'Paris', category 'exhibition painting'

- schedule the operation within the next 10 

minutes (**)

** the server's 

system clock is 

CET (Central 

European 

Time)

In 'Operation Status' the publish 

operation is reported as suspended and 

awaiting confirmation.

An email is sent that invites the user to 

log in and confirm the publishing of the 

selected events.

Some events should be available for 

publishing on your social network (the 

same that are returned with a 

metasearch using the same search 

parameters).

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

W

S
P

K double results again (same 

as R4)

P
u

b
6

.3

P
u

b
6

P
u

b
1

.5
, 

P
u

b
5

.1
, 

P
u

b
5

.2
, 

P
u

b
6

.2
, 

P
u

b
6

.3 Confirm 

publishing 

go on 'Exchange Data' -> 'Confirm publishing'

select one or more of the events in the list

click on 'Publish selected items'

The message 'Selected items have been 

published' is shown.

The selected events are published on the 

users social network target.

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

W

S
P

K as expected

why are the others 

atuomatically discarded? 

P
u

b
6

.4

P
u

b
6

Remove 

scheduled 

tasks

Log in with your account

- go on 'Exchange Data' -> 'Scheduler'

- delete all scheduled operations within 

'Exchange Data' -> 'Scheduler'

No tasks are listed in the box. O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K

P
u

b
6

.5

P
u

b
5

.1
, 

P
u

b
6

.5 Remove 

your data 

provider 

login with your user

go in 'Configurations'->'Query Service'

click on the Data Provider attached to your 

organisation if it exists

click on 'Delete Provider' (DO NOT DELETE 

THE PARTICIPANT!)

Data provider removed O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

O

S
P

K

P
u

b
7

User takes overview of services

H
o

m
e
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1
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2
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/0
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h

o

Actual Result 3
0

/0
1

/1
3

W
h

o

Actual Result

P
u

b
7

.1

P
u

b
7 Take 

oveview of 

configurati

on

logged in with your account

go on 'Home'

check the status of the services

The status of the available services 

should be shown (active or not, missing 

configurations and links to the 

respective configuration pages)

O

P
ro

m
o

te
r O

A
fi

d
iu

m
 

W

S
P

K access policies: the lock is 

not well linked to the 

navigation, it should be a 

link to here: 

http://harmosearchdev.har

monet.org/accesspolicies

P
u

b
-E

N
D

1 Change 

your type 

of account

log in with your user

- go on 'Manage' -> 'Control Panel' on the top 

left

- select 'Roles' from the menu

- on 'Publisher' click  'Actions' and then  

'Assign members'

- click on the 'Current' tab and uncheck your 

account, then click on 'Update Associations' 

on top of the list

- do the same with 'Data Provider' role 

(remove it)

- (*) click on 'View all' and assign yourself the 

role of your next tests:

- on the selected role click 'Actions' -> 'Assign 

members'

- click on the 'Current' tab and check your 

account, then click on 'Update Associations' 

on top of the list **

- click on 'Back to HarmoSearch' on the top 

* necessary 

only if you have 

to test some 

other type of 

account (and 

corresponding 

excel sheet)

** you can check your new role, for 

instance, in the 'Control Panel' within 

'My Account' (don't remove the extra 

roles 'User' and 'Super User'!) 

Once back to the portal, you'll see 

different entries in the operations menu

O

P
ro

m
o

te
r

W

A
fi

d
iu

m
 

 - it's quite confusing to 

access this menu to 

change role, I would look 

for such link in the black 

navigation menu or in 

edit profile. Maybe a link 

to the role management 

page could be added to 

the profile edition page ?

'- In the user selection 

screen (to 

check/uncheck), it may be 

useful to add the 

company filter to the 

advanced search. This 

would allow for instance 

Afidium manager to 

assign all Afidium's 

account to a specific role

W

S
P

K i assign myself the import 

role… but i will continue 

another day...

P
u

b
-E

N
D

2 END * Restore email of 'testuser' * Only if your 

tests end with 

the current 

type of account

O

S
P

K test user was reseted, as i 

will continue testing other 

time…

H
o

m
e

End of tests for (Advanced) Publisher
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#
#

#
#

#

W
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o #
#

#
#

#
#

#

W
h
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Actual Result 1
/2

/2
0

1
3

W
h

o

Actual Result #
#

#
#

#
#

#

W
h

o

Actual Result

M
-B

E
G

IN Check your 

type of 

account

Precondition to do the 

following tests is that your 

user account has the right 

role assigned. You must have 

just registered with the right 

role (*) or you must have 

done the last step (END1) in 

the previous test excel sheet 

you executed.

* Registration of new 

user account

O

P
ro

m
o

te
r

O

A
fid

iu
m

O

m
u

se
u

m
sm

e
d

ie
n o

S
P

K

M
1 Metasearch A user performs metasearch 

by using the search fields of 

the user interface

M
.1

.1

M
1 Metasearch 

on 

unregistered 

category

go in 'Search Data' -> 

'Metasearch'

execute a simple search of 

events selecting 'agricolture' 

as category

No provider has 

registered providing 

events of this category

Error message: "No 

provider registered that 

matches search 

criteria.".

O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K

M
.1

.2

M
1 Insert invalid 

query

go in 'Search Data' -> 

'Metasearch'

click on 'Advanced Search' 

and insert an invalid 

HarmoSearch query (as an 

example you can use the test 

query 

'SQ0_invalid_metasearch_qu

ery.xml', or just any free text 

you like)

Error message is shown: 

"User query not valid 

against HarmoSearch 

query language XSD".

O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K

M
1

.3

M
1 Set up query 

service for 

metasearch

log in as testuser 

('testuser@test.user' or the 

email you set*, password: 

testuser) 

go in 'Configurations'-

>'Query Service'

- click on the attached data 

provider

- check the box 

'METASEARCH' for the 

operations

click on 'Save Changes'

* Optional: change the 

email of the preloaded 

testuser

'Test' is now available 

among the data 

providers of a 

metasearch

O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K

Begin of tests for Metasearch

M
e

ta
se

a
rc

h
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#

W
h

o #
#

#
#

#
#

#

W
h

o

Actual Result 1
/2

/2
0

1
3

W
h

o

Actual Result #
#

#
#

#
#

#

W
h

o

Actual Result

M
.1

.4

M
1

M
1

.3
, 

M
1

.4
, 

M
1

.5
, 

M
1

.6 Query 

mapping is 

missing in 

metasearch

log in as testuser 

('testuser@test.user' or the 

email you set*, password: 

testuser) 

go on 'Configurations'-

>'Mapping Store'

delete the query structure 

mapping file 

(nnnnn_#events_query_os.xs

lt) if it exists

File is removed from the 

box at the end of the 

page.

O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K

M
.1

.5

M
1

M
1

.3
, 

M
1

.4
, 

M
1

.5
, 

M
1

.6 Query 

mapping is 

missing in 

metasearch

log in with your account

go on 'Metasearch' and 

execute any simple search 

selecting 'Test' as data 

provider

Error message: "Missing 

mapping for the query 

structure from 

Harmonise Ontology to 

Test".

O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K

M
.1

.6

M
1

M
1

.3
, 

M
1

.4
, 

M
1

.5
, 

M
1

.6 Query 

mapping is 

missing in 

metasearch

log in as testuser 

('testuser@test.user' or the 

email you set*, password: 

testuser) 

go on 'Configurations'-

>'Mapping Store'

insert 'events' as collection id

choose 'Upload query 

mapping to translate 

HarmoSearch query 

structure'

select the file available in the 

test folder as 

'HTO_Euromuse_query.xslt'

click on 'Send' and check for 

the success message on top 

of the page

File is listed in the box at 

the end of the page.

O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K

M
.1

.7

M
1

M
1

.3
, 

M
1

.7
, 

M
1

.8
, 

M
1

.9 Data mapping 

is missing in 

metasearch

logged in as testuser

go on 'Configurations'-

>'Mapping Store'

delete the data mapping file 

from local system to HTO 

(nnnnn_#events_so.xslt) if it 

exists

File is removed from the 

box at the end of the 

page.

O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K
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a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#

W
h

o #
#

#
#

#
#

#

W
h

o

Actual Result 1
/2

/2
0

1
3

W
h

o

Actual Result #
#

#
#

#
#

#

W
h

o

Actual Result

M
.1

.8

M
1

M
1

.3
, 

M
1

.7
, 

M
1

.8
, 

M
1

.9 Data mapping 

is missing in 

metasearch

log in with your account

go in 'Search Data' -> 

'Metasearch' and execute 

any simple search selecting 

'Test' as data provider

Error message: "Missing 

data mapping from Test 

to Harmonise Ontology".

O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K

M
.1

.9

M
1

M
1

.3
, 

M
1

.7
, 

M
1

.8
, 

M
1

.9 Data mapping 

is missing in 

metasearch

log in as testuser 

('testuser@test.user' or the 

email you set*, password: 

testuser) 

go on 'Configurations'-

>'Mapping Store'

insert 'events' as collection id

choose 'Upload mapping 

from local system to 

Harmonise ontology'

select as mapping the file 

available in the test folder as 

'Euromuse_HTO.xslt'

select 'default for sending 

events'

- click on 'Send' and check 

for the success message on 

top of the page

File is listed in the box at 

the end of the page.

O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K

M
1

.1
0

M
1 Remove 'Test' 

from 

metasearch 

data 

providers

log in as testuser 

('testuser@test.user' or the 

email you set*, password: 

testuser) 

go in 'Configurations'-

>'Query Service'

- click on the attached data 

provider

- uncheck 'METASEARCH' 

from the operations

click on 'Save Changes'

Test' is no more 

available among the 

data providers of a 

metasearch

O

P
ro

m
o

te
r

O
A

fid
iu

m
O o

S
P

K
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#

W
h

o #
#

#
#

#
#

#

W
h

o

Actual Result 1
/2

/2
0

1
3

W
h

o

Actual Result #
#

#
#

#
#

#

W
h

o

Actual Result

M
1

.1
1

M
1 Metasearch 

successful

log in with your account

go in 'Search Data' -> 

'Metasearch' and execute a 

Simple Search inserting 

'exhibition ancient world' as 

category

You can try with any 

combination of search 

criteria. The result may 

also be void.

Some results are shown O

P
ro

m
o

te
r

O

A
fid

iu
m

O w

S
P

K 36 results are found in 

euromuse… 8 were 

shown in the first page 

of results, it was not 

possiblie to go to the 

next page, the link was 

not active. See : 

http://www.euromuse

.net/thorsten2/harmos

earch/turn_page.png

S
Q Advanced 

Metasearch

A user performs metasearch 

by posting directly 

HarmoSearch queries in the 

Advanced Search text area

S
Q

1 Search all 

from 

Euromuse

go in 'Search Data' -> 

'Metasearch' and execute an 

Advanced Search inserting 

the SQ1 query available in 

the test folder (the same for 

all following SQx tests)

This query searches for all 

possible information in all 

domains coming from 

Euromuse.

Output should contain 

title, shoth description, 

event location, event 

category, date range, url, 

vignette.

The metasearch process 

is asynchronous and the 

results can be visualised 

as soon as they become 

available.

In the result list it is 

possible to understand if 

the data comes from an 

external data source or 

from the local index.

O

P
ro

m
o

te
r

O

A
fid

iu
m

O w

S
P

K results load, over 100, 

turn pages works this 

time around.

results do not contain 

all information 

expected, two 

observations:

_exhibitions in UK, no 

title available, in the 

source intance uk 

exhibitions are filled 

only in the local 

language, which is 

english anyway. But 

the title are present

_exhibitions in Finland, 

missing Town and 

Country

compare: 

http://www.euromuse

.net/thorsten2/harmos

earch/query_uk_fin.xm

l

http://www.euromuse

.net/thorsten2/harmos

earch/query_uk_fin.pn

T
e

st
 S

e
a

rc
h

 Q
u

e
ry

 L
a

n
g

u
a

g
e
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a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#

W
h

o #
#

#
#

#
#

#

W
h

o

Actual Result 1
/2

/2
0

1
3

W
h

o

Actual Result #
#

#
#

#
#

#

W
h

o

Actual Result

S
Q

2 Search All 

events

Retun all possible events Output should be result 

list: see SQ1

Same as SQ1 O

P
ro

m
o

t

O

A
fid

iu
m

Vignette were not 

available

O o

S
P

K

S
Q

3 Search All 

events within 

time frame

Retun all possible events 

within [1.4.2013, 30.04.2013 

]

Output should be result 

list: see SQ1

Comment from CP - if 

you specify both start 

and end date you will get 

events whose time 

interval overlaps with the 

specified dates

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

O w

S
P

K the query seems to be 

formulated wrong: 

the startDate is related 

to the tag <to>??

the EndDate with the 

tag <from>??

S
Q

3
.1

S
Q

3 Search All 

events within 

time frame, 

alternative 1

Retun all possible events 

starting from 1.4.2013

Output should be result 

list: see SQ1

Alternative 1: give only 

Date 1

Comment from CP - if 

you specify only the start 

date you will get all 

events which ends after 

the specified date 

(independently from 

when they start)

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K sq3 alt 1

S
Q

3
.2

S
Q

3 Search All 

events within 

time frame, 

alternative 2

Retun all possible events 

until 30.04.2013

Output should be result 

list: see SQ1

Alternative 2: give only 

date 2

Comment from CP - if 

you specify only the end 

date you will get all 

events which starts 

before the specified date 

(independently from 

when they end) - 

THEREFORE ALSO PAST 

EVENTS ARE RETRIEVED

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K sq 3 alt 2
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a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#

W
h

o #
#

#
#

#
#

#

W
h

o

Actual Result 1
/2

/2
0

1
3

W
h

o

Actual Result #
#

#
#

#
#

#

W
h

o

Actual Result

S
Q

4 Search All 

events within 

locations

Retun all possible events in 

Berlin/Germany

Output should be result 

list: see SQ1

Comment: note that the 

results are not the same 

as if you insert the same 

parameters in Simple 

Search, because in that 

case a further, default 

search criteria is added, 

namely "from today on".

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K SQ 4

S
Q

4
.1

S
Q

4 Search All 

events within 

locations

Retun all possible events in 

Germany

Output should be result 

list: see SQ1

Alternative 1: In Germany 

(Country instead of given 

city)

Comment: note that the 

results are not the same 

as if you insert the same 

parameters in Simple 

Search, because in that 

case a further, default 

search criteria is added, 

namely "from today on".

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K sq4 alt 1

S
Q

4
.3

S
Q

4 Search All 

events within 

locations

Retun all possible events in 

Italy

Output should be result 

list: see SQ1

Alternative 3: in IT (ISO 

code for Italy)

Comment: note that the 

results are not the same 

as if you insert the same 

parameters in Simple 

Search, because in that 

case a further, default 

search criteria is added, 

namely "from today on".

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

O O

S
P

K sq4 alt…

S
Q

4
.4

S
Q

4 Search All 

events within 

locations

Retun all possible events in 

Biella or Berlin

Output should be result 

list: see SQ1

Alternative 4: in Biella or 

Berlin

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

O O

S
P

K sq4 alt…
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#

W
h

o #
#

#
#

#
#

#

W
h

o

Actual Result 1
/2

/2
0

1
3

W
h

o

Actual Result #
#

#
#

#
#

#

W
h

o

Actual Result

S
Q

4
.5

S
Q

4 Search All 

events within 

locations

Retun all possible events in 

Biella or Berlin within 

[1.4.2013,30.04.2013]

Output should be result 

list: see SQ1

Alternative 5: in Biella or 

Berlin within a certain 

period

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

O O

S
P

K sq4 alt…

S
Q

4
.6

S
Q

4 Search All 

events within 

locations

Retun all possible events in 

Biella within 

[1.4.2013,30.04.2013] or 

Berlin within 

[1.5.2013,31.05.2013]

Output should be result 

list: see SQ1

Alternative 6: in Biella 

within a certain period or 

Wien within another 

period

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

O O

S
P

K sq4 alt…

S
Q

5 Search All 

events for 

certain 

categories

Retun all possible events in 

Biella corresponding to 

cultural

Output should be result 

list: see SQ1

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K SQ 5

S
Q

5
.1

S
Q

5 Search All 

events for 

certain 

categories

Retun all possible events in 

Berlin  corresponding to 

modern art exhibitions or 

sculpture exhibitions

Output should be result 

list: see SQ1

Alternative 1: in Berlin  

corresponding to modern 

art exhibitions or 

sculpture exhibitions

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

O o

S
P

K

S
Q

5
.2

S
Q

5 Search All 

events for 

certain 

categories

Retun all possible events in 

Berlin or Biella 

corresponding to modern art 

exhibitions

Output should be result 

list: see SQ1

Alternative 2:  in Berlin or 

Biella or corresponding to 

modern art exhibitions

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

O w

S
P

K loads 51 events in 

berlin from euromuse, 

contacts 2 data 

providers, none are 

retrieved from biella or 

euromuemf

S
Q

5
.3

S
Q

5 Search All 

events for 

certain 

categories

Retun all possible events in 

Berlin or Biella 

corresponding to modern art 

exhibitions during that 

period

Output should be result 

list: see SQ1

Alternative 3:  in Berlin or 

Biella corresponding to 

modern art exhibitions 

during that period

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

O w

S
P

K loads 3 events in berlin 

mordern art in april 

from euromuse, none 

from biella modern 

art… contacted 

providers 2 (should be 

euromuse and 

euromusemf but 

maybe beilla and 

euromusemf are 

temporarily down?)
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#

W
h

o #
#

#
#

#
#

#

W
h

o

Actual Result 1
/2

/2
0

1
3

W
h

o

Actual Result #
#

#
#

#
#

#

W
h

o

Actual Result

S
Q

5
.4

S
Q

5 Search All 

events for 

certain 

categories

Retun all possible events in 

Biella corresponding to sport 

or cultural in that period and 

the events in Berlin 

corresponding to modern art 

exhibition or sculpture 

exhibition in the same period

Output should be result 

list: see SQ1

Alternative 4:  in Biella 

corresponding to sport or 

cultural in that period 

and in Berlin 

corresponding to modern 

art exhibition or 

sculpture exhibition in 

the same period

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

O x

S
P

K loads berlin mordern 

art in april and berlin 

sculpture in april, 

neither biella culture in 

april nor biella sport in 

april… (provider might 

be down for now?)

S
Q

5
.5

S
Q

5 Search All 

events for 

certain 

categories

Retun all possible events in 

Biella corresponding to 

cultural in that period and 

the events in Berlin 

corresponding to modern art 

exhibition in the same period

Output should be result 

list: see SQ1

Alternative 5:  in Biella 

corresponding to cultural 

in that period and in 

Berlin corresponding to 

modern art exhibition in 

the same period

Same as SQ1 O

P
ro

m
o

te
r

O

A
fid

iu
m

W Failed on euromuse: 
Impossible to 
connect to provider

x

S
P

K 3 results loaded from 

euromuse, none from 

biella (provider might 

be down for now?)

M
2 A user queries directly the 

semantic registry

M
2

.1

M
2 Find matching 

data 

providers

logged in with your account

go on 'Search Data' -> 

'Browse Data Providers'

select 'events in biella'

click 'Check Provider'

Alternative: select any of 

the proposed queries to 

the registry

The provider 'Biella' is 

returned

O

P
ro

m
o

te
r

o

A
fid

iu
m

O o

S
P

K ok, this confirms the 

warnings and bugs in 

rows 30 to 33, biella is 

not shown as provider 

of events in biella…

M
3 User takes overview of 

services

M
3

.1

M
3 Take oveview 

of 

configuration

logged in with your account

go on 'Home'

check the status of the 

services

The status of the 

available services should 

be shown (active or not, 

missing configurations 

and links to the 

respective configuration 

pages)

O

P
ro

m
o

te
r

w

A
fid

iu
m

I think Social & access 

policies misses links (as 

we have those for 

configuration)

O o

S
P

K

B
ro

w
se

 D
a

ta
 P

ro
v

id
e

rs
H

o
m

e

End of tests for Metasearch
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Id P
a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#

W
h

o #
#

#
#

#
#

#

W
h

o

Actual Result 1
/2

/2
0

1
3

W
h

o

Actual Result #
#

#
#

#
#

#

W
h

o

Actual Result

M
-E

N
D

1 Change your 

type of 

account

log in with your user

- go on 'Manage' -> 'Control 

Panel' on the top left

- select 'Roles' from the 

menu

- on 'Metasearch' click  

'Actions' and then  'Assign 

members'

- click on the 'Current' tab 

and uncheck your account, 

then click on 'Update 

Associations' on top of the 

list

- (*) click on 'View all' and 

assign yourself the role of 

your next tests:

- on the selected role click 

'Actions' -> 'Assign members'

- click on the 'Current' tab 

and check your account, 

then click on 'Update 

Associations' on top of the 

list **

- click on 'Back to 

HarmoSearch' on the top left

* necessary only if you 

have to test some other 

type of account (and 

corresponding excel 

sheet)

** you can check your 

new role, for instance, in 

the 'Control Panel' 

within 'My Account' 

(don't remove the extra 

roles 'User' and 'Super 

User'!) 

Once back to the portal, 

you'll see different 

entries in the operations 

menu

O

P
ro

m
o

te
r

W

A
fid

iu
m

user may need a 

button allowing to 

request a change in 

role in the profile 

edition (section 

"roles"). 

O o

S
P

K

M
-E

N
D

2 END * Restore email of 'testuser' * Only if your tests end 

with the current type of 

account

O o

S
P

K
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a

re
n

t

S
e

q
u

e
n

ce

A
ct

io
n

Name Description

Comment

 (and 

alternatives) Expected Output #
#

#
#

#
#

#

W
h

o #
#

#
#

#
#

#

W
h

o

#
#

#
#

#
#

#

W
h

o

Actual Result

Q
s-

B
E

G
IN Check your type 

of account

Precondition to do the following tests is that your user 

account has the right role assigned. You must have just 

registered with the right role (*) or you must have done 

the last step (END1) in the previous test excel sheet you 

executed.

* Registration 

of new user 

account

O

P
ro

m
o

te
r

O

A
fid

iu
m

 

o

S
P

K

Q
s
1 User searches events enhanced with extra information

Q
s1

.1

Q
s1 Search top 3 

ordered by 

overall score

go in 'Search Data' -> 'Qualified Search'

- select 3 as max number of results

- click on 'Search'

- when searching is completed, click on 'Show results'

The top 3 results are shown. The overall score of 

the events is in descending order.

O

P
ro

m
o

te
r

O

A
fid

iu
m

 

o

S
P

K

Q
s1

.2

Q
s1 Search top 10 

ordered by 

multiple 

occurrences

go in 'Search Data' -> 'Qualified Search'

- select 10 as max number of results

- select 'Order results by multiple occurrences'

- click on 'Search'

- when searching is completed, click on 'Show results'

The top 10 results are shown. The occurrences 

score of the events is in descending order.

Note that the completeness score may not be in 

descending order. Some events may miss the title 

or the image.

O

P
ro

m
o

te
r

O
A

fid
iu

m
 

w

S
P

K what does occurrence mean? 

That is found both in multiple 

proviers e.g. euromusemf and 

euromuse?

Q
s1

.3

Q
s1 Search top 10  

ordered by 

completeness of 

information

go in 'Search Data' -> 'Qualified Search'

- select 10 as max number of results

- select 'Order results by completeness of information'

- click on 'Search'

- when searching is completed, click on 'Show results'

You get all results that have completeness score 4 

(maximum); the occurrences score is random

O

P
ro

m
o

te
r

O

A
fid

iu
m

 

o

S
P

K

Q
s1

.4

Q
s1 Search top 10  

ordered by 

multiple 

occurrences and 

by completeness 

of information

go in 'Search Data' -> 'Qualified Search'

- select 10 as max number of results

- select both 'Order results by completeness of 

information' and 'by multiple occurrences'

- click on 'Search'

- when searching is completed, click on 'Show results'

You get all results that have the maximum sum of 

completeness score and occurrences score (but 

the single scores, e.g. the occurrences score may 

not be the maximum (check with 'order by 

occurrences score')

O

P
ro

m
o

te
r

O

A
fid

iu
m

 

w

S
P

K gives the impression of 

arbitrary... to search for 

completedness and get a 

result in the top 5 with max 

score for occurrence but 

ranking poorly in 

completedness. Aalto-majlko 

75 vuota from euromusemf, 

which is a record without 

english text and no image

Q
s1

.5

Q
s1 Search top 3 

results using also 

search criteria

go in 'Search Data' -> 'Qualified Search'

- select 3 as max number of results

- insert as dates: from 3 to 4 febrauary 2013

- restrict to Austria-Vienna

- restrict to 'exhibition paintings'

- click on 'Search'

- when searching is completed, click on 'Show results'

The top 3 results (ordered by default by overall 

score) comply with the search criteria inserted by 

the user

O

P
ro

m
o

te
r

O

A
fid

iu
m

 

x

S
P

K vienna with such criteria 

returns no result, it should 

retrieve at least one 

exhibition that matches 

criteria: 

http://www.euromuse.net/en

/exhibitions/exhibition/view-

e/die-nacht-im-

zwielicht/content/en/

Q
s
2 User searches events enhanced with licence information

Begin of tests for Qualified Search
Q

u
a

li
fi

e
d

 S
e

a
rc

h
V

ie
w

 l
ic

e
n

s
e

 i
n

fo
rm

a
ti

o
n
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Actual Result

Q
s2

.1

Q
s2

Q
s2

.1
, 

Q
s2

.2 Add license log in as testuser ('testuser@test.user' or the email you 

set*, password: testuser) 

- go on 'Configurations' -> 'Access Policies'

- select any CC license from the drop down list and save

* Optional: 

change the 

email of the 

preloaded 

testuser

The license is added in the box below. 

Note that: 

(1) adding a licence has effect only on the day 

after's searches, because the qualified search is 

done on a local daily cache of the providers. 

(2) Adding a license to 'Test' has evident effect on 

the query service set up in order not to be 

included in the caching process (enriching it 

locally with further information) in order not to 

replicate any of the available data providers. 

Thus, the effect of assigning the license cannot be 

verified directly with these test cases.

O

P
ro

m
o

te
r

O

A
fid

iu
m

 

o

S
P

K

Q
s2

.2

Q
s2

Q
s2

.1
, 

Q
s2

.2 Remove license log in as testuser ('testuser@test.user' or the email you 

set*, password: testuser) 

- go on 'Configurations' -> 'Access Policies'

- click on 'Delete' on the license in the box

license is removed from the box O

P
ro

m
o

te
r

O
A

fid
iu

m
 

o

S
P

K

Q
s2

.3

Q
s2 View results with 

license

log in with your account

go in 'Search Data' -> 'Qualified Search'

- do any search on 'euromuse' as data provider

- when searching is completed, click on 'Show results'

The results have a license information attached; 

euromuse attached it like the testuser did 

through the 'Access Policies' page.

The license information is updated when the local 

cache of the data providers is refreshed 

automatically, namely once a day.

O

P
ro

m
o

te
r

O

A
fid

iu
m

 

o

S
P

K

Q
s2

.4

Q
s2 View results with 

license

log in with your account

go in 'Search Data' -> 'Qualified Search'

- do any search on 'biella' as data provider

- when searching is completed, click on 'Show results'

The results have no license information attached O

P
ro

m
o

te
r

O

A
fid

iu
m

 

x

S
P

K No results!

Q
s
3 User takes overview of services

Q
s3

.1

Q
s3 Take oveview of 

configuration

logged in with your account

go on 'Home'

check the status of the services

The status of the available services should be 

shown (active or not, missing configurations and 

links to the respective configuration pages)

O

P
ro

m
o

te
r

O

A
fid

iu
m

 

o

S
P

K

End of tests for Qualified Search

V
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w
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e

n
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n
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n
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Actual Result

Q
s-

E
N

D
1 Change your 

type of account

log in with your user

- go on 'Manage' -> 'Control Panel' on the top left

- select 'Roles' from the menu

- on 'Qualified Search' click  'Actions' and then  'Assign 

members'

- click on the 'Current' tab and uncheck your account, 

then click on 'Update Associations' on top of the list

- (*) click on 'View all' and assign yourself the role of your 

next tests:

- on the selected role click 'Actions' -> 'Assign members'

- click on the 'Current' tab and check your account, then 

click on 'Update Associations' on top of the list **

- click on 'Back to HarmoSearch' on the top left

* necessary

only if you 

have to test 

some other 

type of 

account (and 

corresponding 

excel sheet)

** you can check your new role, for instance, in 

the 'Control Panel' within 'My Account' (don't 

remove the extra roles 'User' and 'Super User'!) 

Once back to the portal, you'll see different 

entries in the operations menu

O

P
ro

m
o

te
r

O

A
fid

iu
m

 

o

S
P

K

Q
s-

E
N

D
2 END * Restore email of 'testuser' * Only if your

tests end with 

the current 

type of 

account

O
P

ro
m

o
te

r
O

A
fid

iu
m

 

o

S
P

K
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1
3

W
h
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Actual Result #
#

#
#

#
#

#
#

W
h

o

User creates and uses a mapping of referenced lists

R
L1

.1

R
L1

R
L1

.1
 -

 R
L1

.1
1 Download 

Mapping Tool

Download the Mapping Tool (v4.0.3) from the portal in 

'Configurations' -> 'Mapping Store'. To do this you can log in 

with user 'tester@mapping.tool', password 'testuser'. 

 Choose the 32 or 64 bit version depending on your 

Windows OS.

Alternative (to shorten the download time):

Download the Mapping Tool from SVN at 

"07/Demonstration_Activities/MappingTool_<nn>bit"

It is important that your installation 

directory does not contain any 

spaces, otherwise the tool will not 

start

O

P
ro

m
o

te
r

O

A
fid

iu
m

o

S
P

K O

A
fid

iu
m

R
L1

.2

R
L1

R
L1

.1
 -

 R
L1

.1
1 Launch the 

Mapping Tool

Double click on the 'Flocke.exe' file For ease of use, the tool on SVN has 

already a preloaded project 

containing the data mapping. The 

test consists in creating the 

mapping of reference lists.

O

P
ro

m
o

te
r

O
A

fid
iu

m
o

S
P

K O

A
fid

iu
m

R
L-

e
xt

1 Open the 

editor for 

creating a 

mapping of 

data (between 

the concepts of 

two data 

schemas)

Within the Mapping Navigator View, open 'Mapping-

>museoliitto_mapping.harmonize' (double click or right-

click: 'Open With->Harmonize Model Editor')

For ease of use, the preloaded 

project contains already a source 

and a destination schema, and a 

preexisting mapping.The test 

consists in extending the mapping 

with one new link.

O

P
ro

m
o

te
r (7

/2
/2

0
1

3
)

o

S
P

K
 (1

9
/2

/2
0

1
3

)

o

A
fid

iu
m

R
L-

e
xt

2 Add a mapping 

for the concept 

Category

1. Select Step 3

2. Select 'category' in the Target Schema list. 

3. Find the 'categories' element in the Museoliitto source 

schema

4. Drag it onto the 'Link to Source' list in the Mapping(s) 

section, and select it (it is grey colored)

5. Select 'hto:SKOSCategory' listed in the Mapping Details 

section

6. Type 'http://www.tu.at/' (including the ') into the text 

field of the UniqueID parameter

7. Choose 'category_id' from the drop-down box of the value 

parameter

    a. Note, the 'category_id' is a sub element of categories 

and contains the actual value that has to be mapped. Thus, it 

must be specified as an input parameter for the 

hto:SKOSCategory mapping pattern.

8. Confirm your mapping by clicking the Confirm button. 

('categories' becomes green colored)

- save the project

This operation creates a new 

mapping link  that maps a concept 

from the Museoliitto source 

reference list to a concept of the 

Harmonise target reference list. 

Thus, it is necessary to create also 

the mappings between the single 

values of the two (source and 

target) reference lists.

O

P
ro

m
o

te
r (7

/2
/2

0
1

3
)

o

S
P

K
 (1

9
/2

/2
0

1
3

)

o

A
fid

iu
m

Referenced ListsRL1
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R
L-

e
xt

3 Recreate the 

output 

mapping file

1. Double-click the museoliitto_mapping.harmonize mapping 

file

2. Re-create the transformation output by clicking the 

'Create and run Transformation' yellow arrow button in the 

toolbar

3. Close the Feedback View

The Feedback View shows you the 

output of running the mapping on 

a test input file (preloaded in  the 

Input folder)

O

P
ro

m
o

te
r (7

/2
/2

0
1

3
)

x

S
P

K
 (1

9
/2

/2
0

1
3

)

In the feedback 

view (where I can 

see the reuslt of the 

transformation -

unfortunately only 

in xml, not in html-), 

the category is not 

matched: 

"<category>No 

matching concept 

found for: 

http://www.tu.at/T

anz</category>" 

(see screenshot)

see: 

http://euromuse.ne

t/thorsten2/harmos

earch/MT_categorie

o

A
fid

iu
m

R
L1

.3

R
L1

R
L1

.1
 -

 R
L1

.1
1 Open the 

editor for 

creating a 

mapping of 

values 

(between two 

skosified 

reference lists)

Within the Mapping Navigator View, open 'Mapping-

>valuemapping.values' (double click or right-click: 'Open 

With->Value Mapping')

For ease of use, the preloaded 

project contains already a source 

and a target reference list 

(represented as skos relations) and 

a sample mapping between the 

two (also expressed with skos 

terminology). 

Note that the source and target 

reference lists in this demo are 

loaded from the workspace on your 

file system (you can check with  

right-click: 'Open With->Text 

Editor') . But they could also be 

loaded from a public URL, clicking 

on the button above each value 

tree.

O

P
ro

m
o

te
r

O

A
fid

iu
m

o

S
P

K o

A
fid

iu
m

R
L1

.4

R
L1

R
L1

.1
 -

 R
L1

.1
1 View the 

existing 

mapping

In the central tab below the value tree (Concept A - maps To - 

Concept B) right-click and select 'Show All Relations'

The concept 

<http://www.tu.at/Bildhauerei> is 

mapped to the concept               

<http://www.harmonet.org/sculpt

ure> .

O

P
ro

m
o

te
r

O

A
fid

iu
m

o

S
P

K o

A
fid

iu
m

R
L1

.5

R
L1

R
L1

.1
 -

 R
L1

.1
1 Modify the 

existing 

mapping

In the values tab, select 'Tanz' on the left and 'dance' on the 

right

- right-click and select 'Create Relation'

- do the same for 'Malerei' and 'painting'

- save the project

If you do again 'Show All Relations' 

on the below tab, you will see all 

three concept mappings

O

P
ro

m
o

te
r

O

A
fid

iu
m

o

S
P

K o

A
fid
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m
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#
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#
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W
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R
L1

.6

R
L1

R
L1

.1
 -

 R
L1

.1
1 Make the 

values mapping 

available from 

a public 

queryable 

triple store

This step is done by the administrator, who uploads the file 

in the Fuseki server (which is the container of the semantic 

registry) of HarmoSearch.

You may ask Claudio Prandoni or Marlis Valentini to 

substitute the actual file on the server with yours, or just 

check that your file looks like 'valuemapping-output.values' 

in the test folder, and proceed with the test.

The mapping of values is 

represented as skos relations 

between two skosified reference 

lists. The triple store is needed in 

order to interpret such type of 

mapping specification.

Check that your file looks like 

'valuemapping-output.values' in 

the test folder

O

P
ro

m
o

te
r

O

A
fid

iu
m

o

S
P

K o

A
fid

iu
m

R
L1

.7

R
L1

R
L1

.1
 -

 R
L1

.1
1 Upload the 

support 

libraries

This step is already done: the libraries needed by the schema 

mapping (in 'Museoliitto/Pattern') are already uploaded as 

private libraries on the portal

Optional:

Logged in as tester@mapping.tool 

(passw: 'testuser') on the portal, 

you may check in 'Configurations'-

>'Mapping Store' that there are 4 

private libraries for the 

'testmappingtool' organization

O

P
ro

m
o

te
r

O

A
fid

iu
m

o

S
P

K o

A
fid

iu
m

R
L1

.8

R
L1

R
L1

.1
 -

 R
L1

.1
1 Update the 

mapping file to 

reference 

correctly the 

support 

libraries

Open the file 'Output/museoliitto_mapping2hto.xsl', and, if 

necessary (*), update the 2 <xsl:include> instructions with: 

<xsl:include href="../privateSupportLibs/htov2-1-

extension.xsl"/>

<xsl:include href="../privateSupportLibs/htov2-1.xsl"/>

* When a test transformation is 

run, the include paths are updated 

automatically to link to the libraries 

in your workspace

O

P
ro

m
o

te
r

O

A
fid

iu
m

w

S
P

K the output file 

museoliitto_mappin

g2hto.xsl" already 

had both lines

O

A
fid

iu
m

R
L1

.9

R
L1

R
L1

.1
 -

 R
L1

.1
1 Upload the 

schema 

mapping file on 

the portal 

(from your 

local system to 

HTO)

log in with user 'tester@mapping.tool', password 'testuser'

- go in 'Configurations' -> 'Mapping Store'

- insert 'events' as collection id

- choose 'Upload mapping from local system to Harmonise 

ontology (for sending data)'

- select the mapping from local system to Harmonise 

ontology (choose the file 

'Output/museoliitto_mapping2hto.xsl')

select 'default for sending events'

click on 'Send' and check for the success message on top of 

the page

The upload of mappings is also be 

available as Web Service invocation 

to the portal. However the current 

version of the Mapping Tool lacks 

still the GUI that allows this 

operation.

The uploaded mapping references 

on one hand the support libraries 

and the other hand the separated 

mapping of values, which is 

implemented as skos relations 

between two skosified reference 

lists. This implies that Fuseki is 

involved in interpreting the part of 

mapping between data values.

The mapping is listed in the box at 

the end of the page.
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r
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o
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P
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#
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#

#
#

#
#

W
h

o

R
L1

.1
0

R
L1

.1
 -

 R
L1

.1
1 Execute a push logged in as 'tester@mapping.tool', go in 'Exchange Data' -> 

'Share Data' and select 'Push Data'

select 'Test' as receiver and the 

file'Museoliitto/Input/museoliitto.xml' (available in the 

workspace of the MappingTool) as data file 

click on 'Send'

Screen message and Operation 

Status report the success of the 

operation. 

Log in as 'testuesr@test.user', 

password 'testuser' 

- go in 'Data Repository' -> 'Inbox'

- download the just received file 

and check that the occurrence of 

Tanz has been mapped into 

'http://www.harmonet.org/dance'

.

O

P
ro

m
o

te
r

A
fid

iu
m

o

S
P

K o

A
fid

iu
m

R
L1

.1
1

R
L1

.1
 -

 

Remove 

schema 

mapping

log in with user 'tester@mapping.tool', password 'testuser'

- go in 'Configurations' -> 'Mapping Store'

- delete the mapping from local system to HTO

The mapping is no more listed in 

the box at the end of the page.

O
P

ro
m

o
te

r

A
fid
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m

o
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P

K O

A
fid
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m
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Actual Result

C
1

.1 C
1 View the 

identifiers and 

current states of 

all crawl jobs

log in as testuser ('testuser@test.user', password: testuser) 

go in 'Configurations'->'Crawler'

On the top there appear two lists, showing the 

current crawl jobs for microformat pages (first 

list) and for ics data (second list), which 

correspond to the xml list

O

P
ro

m
o

te
r

A
fid

iu
m

C
2

.1 C
2 Add a new 

microformats 

crawl job

go to the crawler portlet and add a new crawl job: 

- job identifier: 'TestJob'

- max pages to fetch: 50

- max crawl depth: 1

- politeness delay: 1000

- User Agent: HarmoSearch WebCrawler

- solr host: http://harmosearchdev.harmonet.org:8983/solr

- only crawl text data

- seed urls: http://www.euromuse.net/index.php?id=654

- stay on same host

click on the create-Button 

The new crawl job appears in the list of crawl 

jobs on the top of the page.

O
P

ro
m

o
te

r
W

A
fid

iu
m

Worked, but I 

noticed there was 

already the same 

crawl job in the list 

(not deleted from a 

previous test ?

C
2

.2 C
2 Add a new 

calendar crawl 

job

go to the crawler portlet and add a new calendar crawl job: 

-  identifier: 'CalendarTestJob'

- solr host: http://harmosearchdev.harmonet.org:8983/solr

- calendar urls: 

http://www.schulferien.org/iCal/Ferien/icals/Ferien_Bayern_2013.ics

click on the create-Button 

The new crawl job appears in the list of 

calendar crawl jobs on the top of the page.

O

P
ro

m
o

te
r

W

A
fid

iu
m

Worked, but I 

noticed there was 

already the same 

crawl job in the list 

(not deleted from a 

previous test ?

C
3

.1 C
3 Clear up the local 

index of crawled 

data

Note: if you want to have evidence of a change in the results after having 

launched a crawling process, it is necessary to clear up the whole local 

index. Otherwise, there is evidence of a change only if the crawled sites 

have been updated since a crawling job was launched the last time. In 

that case, the number of results will be higher.

Optional (see Note above): Ask an administrator - Marlis Valentini -

(otherwise Claudio Prandoni) to reset the local index

If you do a metasearch on local indexed data, 

you get no results (if the local index was not 

cleaned up, then take note of the number of 

results you get):

- logged as 'testuser', go on 'Search Data' -> 

'Metasearch'

- execute a Simple Search selecting 

'euromusemf' as dataprovider

- you get 0 results (otherwise take note of the 

number)

O

P
ro

m
o

te
r

W

A
fid

iu
m

testing crawler (on 

the "portal" file), 

test C3.1, I had 88 

results (see previous 

step as some crawl 

jobs were already 

present)

Crawler: Viewing Crawl Jobs

Crawler: Adding a Crawl Job

Crawler: Launching Crawl Jobs
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Id P
a

re
n

t

Name Description

Comment

 (and alternatives) Expected Output #
#

#
#

#
#

#

W
h

o #
#

#
#

#
#

#

W
h

o

Actual Result

C
3

.2 C
3 Launch a single 

microformats 

crawl job

go to the crawler portlet

- select a microformats crawl job (your 'testJob') in the first list of crawl 

jobs

- click on "start job"

The chosen site is crawled and the found 

information is stored in solr (database with the 

local index).

if you run a Metasearch, selecting 

'euromusemf' as data provider, you get some 

results (if the local index was not cleaned up, 

you may just get more results than before 

running the crawl job, but only if the target site 

was recently updated). 

O

P
ro

m
o

te
r

O

A
fid

iu
m

C
3

.3 C
3 Launch a single 

ICS crawl job

go to the crawler portlet

- select an ics crawl job (your 'CalendarTestJob') in the second list of 

crawl jobs

- click on "start job"

The test site used here, which is 

hosting events in Calendar 

format (ICS), is not included 

among the data providers of 

HarmoSearch. Thus, the local 

index is updated including these 

events, but Metasearch does not 

return such results.

The chosen ICS (Calendar) site is crawled and 

the found information is added in solr (local 

index)

You can check directly in the local index if it 

contains the events. Go on: 

http://harmosearchdev.harmonet.org:8983/sol

r/admin/

 and insert as query string:  

dataProvider:http*schulferien*

You get several results.

O

P
ro

m
o

te
r

o

A
fid

iu
m

C
3

.4 C
3 Launch all the 

stored crawl jobs

go to the crawler portlet

- click on the "Start all Jobs" button

Again, the change in results 

becomes evident only if the 

administrator cleanes up the 

database with the local index.

All crawl jobs are launched. The new 

information is stored in solr

O

P
ro

m
o

te
r

o

A
fid

iu
m

C
4

.1 C
4 Delete a certain 

Microformat 

crawl job 

go to the crawler portlet 

- choose the 'testJob' crawl job from the list of Crawl Jobs

- click on the "delete job" link next to this job 

The crawl job is deleted from the list of crawl 

jobs. Additionally it is also deleted from the 

internal list of scheduled crawl jobs (if 'enable 

Scheduler' checkbox was set)

O

P
ro

m
o

te
r

O

A
fid

iu
m

C
4

.2 C
4 Delete a certain 

Calendar crawl 

job 

go to the crawler portlet 

- choose the 'CalendarTestJob' crawl job from the list of Calendar Crawl 

Jobs

- click on the "delete job" link next to this job 

The crawl job is deleted from the list of crawl 

jobs. Additionally it is also deleted from the 

internal list of scheduled crawl jobs (if 'enable 

Scheduler' checkbox was set)

O

P
ro

m
o

te
r

o

A
fid

iu
m

Crawler: Deleting a Crawl Job
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Id P
a

re
n

t

A
ct

io
n

Name Description

Comment

 (and alternatives) 5
/2

/2
0

1
3

W
h

o Actual Result 1
5

/2
/2

0
1

3

W
h

o

Actual Result 1
8

/2
/2

0
1

3

W
h

o

Actual Result

D
o

c1
D

o
c1

.1

D
o

c1 Registration page Content of the user 

registration page

User registration page allows 

creation of a new user. It 

contains fileds, menus, 

buttons.

O

A
fid

iu
m

w

S
P

K be consistent with register and log out, in 

the registration form (underneath) there 

is still the possibility to "sign in", should 

be "log in"

W

A
fi

d
iu

m I agree we should 

have the same 

wording (login / login 

…)

D
o

c1
.2

D
o

c1 Documentation of the 

user registration page

W

A
fid

iu
m

documentation is ok, but the 

support button isn't here until 

the user is logged. I doubt user 

may need help here but if so 

he couldn't access doc from 

this page (link missing)

w

S
P

K From the registration page you cannot 

access the help topic create-account. Just 

if the user is logged in.

There could be a basic help desk for non 

registered users (The harmosearch 

services, User roles, Harmosearch 

participants and from account 

management create an account). see 

http://harmosearchdev.harmonet.org/to

pic-create-account

W

A
fi

d
iu

m I agree we should be 

able to access some 

basic doc (account, 

roles, main features… 

before creating an 

account.

At least to 

understand the role 

selection.

D
o

c1
.3

D
o

c1 Content of user profile 

editing form

O

A
fid

iu
m

o

S
P

K o

A
fi

d
iu

m

D
o

c1
.4

D
o

c1 Documentation of the 

user profile editing form

W

A
fid

iu
m

Generally speaking, online doc 

is ok, clear and well illustrated. 

I noticed a few typose which 

were sent by mail to Claudio & 

marlis

w

S
P

K do you mean this? 

http://harmosearchdev.harmonet.org/he

lp-account-management

W

A
fi

d
iu

m Maybe this section 

could be more 

developped (explain 

which info can be 

changed for each of 

the links in the 

sidebar)

D
o

c2 O

D
o

c2
.1

D
o

c2 Content of the 

Metasearch page

O

A
fid

iu
m

w

S
P

K as combining simple and advance search, 

when landing in this page that the simple 

search is extended is good, but should be 

constrainted when clicking in advance 

search… it is either one of both, not both.

O

A
fi

d
iu

m Ok for me, it is true 

that an auto expand 

collapse would be 

nice, but I think 

would require a 

clearer style for 

collapsed titles (a + 

for instance)

D
o

c2
.2

D
o

c2 Content of the Simple 

Search

O

A
fid

iu
m

o

S
P

K o

A
fi

d
iu

m

D
o

c2
.3

D
o

c2 Content of the Advanced 

Search

O

A
fid

iu
m

w

S
P

K it is not resizeable, it could expand to be 

able to compfortably edit the query.

w

A
fi

d
iu

m Indeed, the picto is 

confusing (it means 

we can resize it)

A user performs metasearch by using the search fields 

of the user interface or by posting directly HarmoSearch 

User creates and manages his account

M
e

ta
se

a
rc

h
R

e
g

is
tr

a
ti

o
n

 a
n

d
 P

ro
fi

le

http://harmosearchdev.harmonet.org/help-account-

management

Configurations -> Edit Profile page has user information 

fields to change the user's accout details

http://harmosearchdev.harmonet.org/topic-edit-profile

Overall structure of the page. Simple, advanced and 

response block will be detailed in different area

Simple search area

Advanced search area
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Id P
a

re
n

t

A
ct

io
n

Name Description

Comment

 (and alternatives) 5
/2

/2
0

1
3

W
h

o Actual Result 1
5

/2
/2

0
1

3

W
h

o

Actual Result 1
8

/2
/2

0
1

3

W
h

o

Actual Result

D
o

c2
.4

D
o

c2 Content of the Result area O

A
fid

iu
m

w

S
P

K if the results are more than 8, they are 

paginated, sometimes  the link to next 

page and previous page were not active. 

Other times, the page would load with a 

long white space under the first page of 

resuts.

O

A
fi

d
iu

m

D
o

c2
.5

D
o

c2 Documentation of the 

Page

w

A
fid

iu
m

Also, some contextual help 

could be helpful when an error 

message appears ("see [the 

related doc topic]")

S
P

K W

A
fi

d
iu

m Same comment

D
o

c3
D

o
c3

.1

D
o

c3 Content of the page Overall structure of the 

page + single input fields, 

menus and buttons. 

The page contains search 

criteria to filter the results, 

sorting criteria to order by 

score, and a field to set the 

maximum number of events to 

show.

O

A
fid

iu
m

w

S
P

K as I commented during testing, I do not 

understand what is "multiple 

ocurrences". The criteria is not very well 

defined, I like the completedness of 

information, multilinguality should be 

also a criteria by which SPK would like to 

search data

O

A
fi

d
iu

m indeed, you could 

add details on 

"occurrence" in 

mouse over

D
o

c3
.2

D
o

c3 Content of the Result area Result list area A separate page shows the 

results with some added 

information on completeness 

of information (availability of 

title, image, documentation, 

etc), multiple occurrences 

between different providers, 

sponsored events, license 

information.

O

A
fid

iu
m

o
S

P
K o

A
fi

d
iu

m

D
o

c3
.3

D
o

c3 Documentation of the 

Page

O

A
fid

iu
m

S
P

K o

A
fi

d
iu

m

D
o

c4 O
A

fid
iu

m

B
ro

w
se

D
a

ta
 P

ro
v

id
e

r

A user gets only a restricted maximum number of 

search results sorted by different possible score criteria

Q
u

a
li

fi
e

d
 S

e
a

rc
h

Result list area

http://harmosearchdev.harmonet.org/topic-metasearch

http://harmosearchdev.harmonet.org/topic-qualified-

search

A user queries directly the semantic registry
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Id P
a

re
n

t

A
ct

io
n

Name Description

Comment

 (and alternatives) 5
/2

/2
0

1
3

W
h

o Actual Result 1
5

/2
/2

0
1

3

W
h

o

Actual Result 1
8

/2
/2

0
1

3

W
h

o

Actual Result

D
o

c4
.1

D
o

c4 Content of the page O

A
fid

iu
m

w

S
P

K how about change the order, select your 

type of query, button Check providers 

and leave the table out, or make it appear 

when the providers are listed.

It is strange that from here, it is not 

possible to contact data provider, or ask 

permission to retrieve data from data 

provider or something like this, at least a 

link to the suscribe a service

o

A
fi

d
iu

m

D
o

c4
.2

D
o

c4 Documentation of the 

Page

O

A
fid

iu
m

S
P

K o

A
fi

d
iu

m

D
o

c5
D

o
c5

.1

D
o

c5 Content of the page Overall structure of the 

page + single input fields, 

menus and buttons. 

The page allows to import by 

using the search fields of the 

user interface or by inserting a 

HarmoSearch query (more 

complex operations are 

possible)

External services can be 

included in the process.

O

A
fid

iu
m

o

S
P

K o

A
fi

d
iu

m

D
o

c5
.2

D
o

c5 Documentation of the 

Page

O

A
fid

iu
m

S
P

K o

A
fi

d
iu

m

D
o

c6
D

o
c6

.1

D
o

c6 Content of the page Overall structure of the 

page + single input fields, 

menus and buttons. 

The form allows both to send 

an event to HarmoSearch 

participants and to publish 

events on social networks

O

A
fid

iu
m

w

S
P

K se comments of last release o

A
fi

d
iu

m

D
o

c6
.2

D
o

c6 Documentation of the 

Page

O

A
fid

iu
m

S
P

K o

A
fi

d
iu

m

D
o

c7
D

o
c7

.1

D
o

c7 Content of the page Overall structure of the 

page + single input fields, 

menus and buttons. 

The page allows both to send 

events expressed as xml in 

some format (also bypassing 

the schema mapping) and to 

send events contained in an 

Excel file. The events may be 

sent to HarmoSearch 

participants or published on 

social networks

O

A
fid

iu
m

w

S
P

K i would still like it to be able to download 

the excel file that can be inserted if I do 

not have a mapping set up.

W

A
fi

d
iu

m indeed, such a file 

could be useful

B
ro

w
se

 D
a

ta
 P

ro
v

id
e

r
Im

p
o

rt
U

p
lo

a
d

 D
a

ta
S

h
a

re
 D

a
ta

Overall structure of the page + single input fields, menus 

and buttons. 

http://harmosearchdev.harmonet.org/topic-browse-data-

providers

http://harmosearchdev.harmonet.org/help-import-data

http://harmosearchdev.harmonet.org/topic-push-to-a-

harmosearch-participant

A user sends data from though a file (xml or excel)

A user uploads data through a form

A user imports data from multiple distributed providers
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Id P
a

re
n

t

A
ct

io
n

Name Description

Comment

 (and alternatives) 5
/2

/2
0

1
3

W
h

o Actual Result 1
5

/2
/2

0
1

3

W
h

o

Actual Result 1
8

/2
/2

0
1

3

W
h

o

Actual Result

D
o

c7
.2

D
o

c7 Documentation of the 

Page

O

A
fid

iu
m

S
P

K o

A
fi

d
iu

m

D
o

c8 O

A
fid

iu
m

D
o

c8
.1

D
o

c8 Content of the page Overall structure of the 

page + single input fields, 

menus and buttons. 

The page allows to schedule 

push, publish and import 

operations. 

Pushing and publishing takes 

the data from the sender, thus 

a query service must be set up.

O

A
fid

iu
m

w

S
P

K if i (SPK) want to schedule an import from 

a url where exhibitions from a member 

data provider (case of museoliitto and 

spk) are dumped (no password); it would 

be nice to be able to enter the url where 

the data is dumped in the field "data to 

send".

o

A
fi

d
iu

m

D
o

c8
.2

D
o

c8 Documentation of the 

Page

O

A
fid

iu
m

S
P

K o

A
fi

d
iu

m

D
o

c9 O

A
fid

iu
m

D
o

c9
.1

D
o

c9 Content of the page O

A
fid

iu
m

w
S

P
K I do not like that the service discards the 

not published events automatically after 

publishing one…. 

If they are not discarded, you could add a 

button beside "publish selected", with 

"delete selected"

w

A
fi

d
iu

m i agree (thought 

about multiple user 

managing a same 

organization). If we 

don't want the table 

to be filled too much 

over time, it could be 

an option to "lock" 

some of them, or 

management of the 

user that scheduled it 

(UserA publish some, 

other that were 

schedulded by him 

are not discarded, 

but only those)

D
o

c9
.2

D
o

c9 Documentation of the 

Page

O

A
fid

iu
m

S
P

K o

A
fi

d
iu

m

D
o

c1
0 O

A
fid

iu
m

O
p

e
ra

ti
o

n
 S

ta
tu

s
S

ch
e

d
u

le
r

C
o

n
fi

rm
 P

u
b

li
sh

in
g

A user schedules regular automatic operations

A user reviews events before publishing on social 

networks

A user checks the status of current and past operations

http://harmosearchdev.harmonet.org/topic-push-to-a-

harmosearch-participant

http://harmosearchdev.harmonet.org/topic-scheduled-

publish

Overall structure of the page + single input fields, menus 

and buttons. 

http://harmosearchdev.harmonet.org/topic-publish-on-

social-network
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Id P
a

re
n

t

A
ct

io
n

Name Description

Comment

 (and alternatives) 5
/2

/2
0

1
3

W
h

o Actual Result 1
5

/2
/2

0
1

3

W
h

o

Actual Result 1
8

/2
/2

0
1

3

W
h

o

Actual Result

D
co

1
0

.1

D
o

c1
0 Content of the page O

A
fid

iu
m

o

S
P

K o

A
fi

d
iu

m

D
co

1
0

.2

D
o

c1
0 Documentation of the 

Page

O

A
fid

iu
m

S
P

K o

A
fi

d
iu

m

D
o

c1
1 O

A
fid

iu
m

D
o

c1
1

.1

D
o

c1
1 Content of Inbox O

A
fid

iu
m

O

S
P

K o

A
fi

d
iu

m

D
o

c1
1

.2

D
o

c1
1 Content of Outbox O

A
fid

iu
m

O

S
P

K o

A
fi

d
iu

m

D
o

c1
1

.3

D
o

c1
1 Content of Sentbox O

A
fid

iu
m

O

S
P

K o

A
fi

d
iu

m

D
o

c1
1

.4

D
o

c1
1 Content of Querybox O

A
fid

iu
m

O

S
P

K o

A
fi

d
iu

m

D
o

c1
1

.5

D
o

c1
1 Documentation of the 

Page

O

A
fid

iu
m

S
P

K o

A
fi

d
iu

m

D
o

c1
2 O

A
fid

iu
m

D
o

c1
2

.1

D
o

c1
2 Content of the page O

A
fid

iu
m

O

S
P

K o

A
fi

d
iu

m

D
o

c1
2

.2

D
o

c1
2 Documentation of the 

Page

O

A
fid

iu
m

S
P

K o

A
fi

d
iu

m

D
o

c1
3 O

A
fid

iu
m

D
o

c1
3

.1

D
o

c1
3 Content of the page O

A
fid

iu
m

o

S
P

K o

A
fi

d
iu

m

D
o

c1
3

.2

D
o

c1
3 Documentation of the 

Page

O

A
fid

iu
m

S
P

K o

A
fi

d
iu

m

D
o

c1
4 O

A
fid

iu
m

O
p

e
ra

ti
o

n
 S

ta
tu

s
D

a
ta

 r
e

p
o

si
to

ry
A

cc
e

ss
 P

o
li

ci
e

s
M

a
p

p
in

g
 S

to
re

E
x

ch
a

n
g

e
 D

a
ta

 S
e

rv
ic

e

A user has access to the sent and received data

Overall structure of the page + single input fields, menus 

and buttons. 

http://harmosearchdev.harmonet.org/topic-import-

operation-status

Overall structure of the page

http://harmosearchdev.harmonet.org/topic-publish-

operation-status

A user can specify the permissions to access services 

and the licenses on the data

Overall structure of the page + single input fields, menus 

and buttons. 

http://harmosearchdev.harmonet.org/topic-access-

policies-and-licenses

A user uploads the mappings to translate data from and 

to his data schema

Overall structure of the page + single input fields, menus 

and buttons. 

http://harmosearchdev.harmonet.org/topic-provider-

configure-mappings

A user can specify which mapping version to use for 

each specific operation and personalize the location for 

receiving push and query results
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Id P
a

re
n

t

A
ct

io
n

Name Description

Comment

 (and alternatives) 5
/2

/2
0

1
3

W
h

o Actual Result 1
5

/2
/2

0
1

3

W
h

o

Actual Result 1
8

/2
/2

0
1

3

W
h

o

Actual Result

D
o

c1
4

.1

D
o

c1
4 Content of the page O

A
fid

iu
m

o

S
P

K o

A
fi

d
iu

m

D
o

c1
4

.2

D
o

c1
4 Documentation of the 

Page

O

A
fid

iu
m

S
P

K o

A
fi

d
iu

m

D
o

c1
5 O

A
fid

iu
m

D
o

c1
5

.1

D
o

c1
5 Content of the page O

A
fid

iu
m

w

S
P

K Facebook: I still think we should be able 

to choose to which facebook profile we 

send data (see comments from last 

release)

Twitter: we have a problem with 

complete urls… as you know the max 

space availalbe are 140 characters, so 

even if now the information displayed is 

satisfactory, the url remains inactive, 

output only the exhibition title in one 

language (english)? in the pic you can 

compare what the rss deliveres and what 

harmosearch delivers

see : 

http://SPK.net/thorsten2/harmosearch/t

weet_r5.jpg

o

A
fi

d
iu

m

D
o

c1
5

.2

D
o

c1
5 Documentation of the 

Page

O

A
fid

iu
m

S
P

K o

A
fi

d
iu

m

D
o

c1
6 O

A
fid

iu
m

D
o

c1
6

.1

D
o

c1
6 Content of the page O

A
fid

iu
m

w

S
P

K o

A
fi

d
iu

m

D
o

c1
6

.2

D
o

c1
6 Documentation of the 

Page

O
A

fid
iu

m

S
P

K o

A
fi

d
iu

m

D
o

c1
7

O

D
o

c1
7

.1

D
o

c1
7 Content of 'Subscribe to 

Service' page

O

A
fid

iu
m

o

S
P

K o

A
fi

d
iu

m

D
o

c1
7

.2

D
o

c1
7 Content of 'Service 

Policies' page

O

A
fid

iu
m

o

S
P

K o

A
fi

d
iu

m

M
a

n
a

g
e

 S
e

rv
ic

e
s

S
e

rv
ic

e
 P

o
li

ci
e

s
E

x
ch

a
n

g
e

 D
a

ta
 S

e
rv

ic
e

S
o

ci
a

l 
N

e
tw

o
rk

s

Overall structure of the page + single input fields, menus 

and buttons. 

http://harmosearchdev.harmonet.org/topic-configure-

mappings

A user can give permission to HarmoSearch to publish 

events on his behalf

Overall structure of the page + single input fields, menus 

and buttons. 

http://harmosearchdev.harmonet.org/topic-configure-

social-networks

A user can add his own services into the HarmoSearch 

workflow of operations

Overall structure of the page + single input fields, menus 

and buttons. 

http://harmosearchdev.harmonet.org/topic-add-external-

service

A user can subscribe to external services and can specify 

the access policies for his own services

Overall structure of the page + single input fields, menus 

and buttons. 
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Id P
a

re
n

t

A
ct

io
n

Name Description

Comment

 (and alternatives) 5
/2

/2
0

1
3

W
h

o Actual Result 1
5

/2
/2

0
1

3

W
h

o

Actual Result 1
8

/2
/2

0
1

3

W
h

o

Actual Result

D
o

c1
7

.3

D
o

c1
7 Documentation of the 

Page

O

A
fid

iu
m

S
P

K o

A
fi

d
iu

m

D
o

c1
8

O

D
o

c1
8

.1

D
o

c1
8 Content of home page 

(after login)

O

A
fid

iu
m

o

S
P

K o

A
fi

d
iu

m

D
o

c1
8

.2

D
o

c1
8 Content of home page 

(without login)

O

A
fid

iu
m

w

S
P

K From the registration page you cannot 

access the help topic create-account. Just 

if the user is logged in.

There could be a basic help desk for non 

registered users (The harmosearch 

services, User roles, Harmosearch 

participants and from account 

management create an account). see 

http://harmosearchdev.harmonet.org/to

pic-create-account

w

A
fi

d
iu

m see user registration 

comments

D
o

c1
8

.3

D
o

c1
8 Documentation of the 

Page

O o

D
o

c1
9

D
o

c1
9

.1

D
o

c1
9 Documentation of Web 

Services for Import of 

Events and 

Accommodations (Simple 

Search)

A
fid

iu
m

D
o

c1
9

.2

D
o

c1
9 Documentation of Web 

Services for Import of 

Events and 

Accommodations 

(Advanced Search)

A
fid

iu
m

D
o

c1
9

.3

D
o

c1
9 Documentation of Web 

Services for Push of Events 

and Accommodations 

A
fid

iu
m

H
o

m
e

W
e

b
 S

e
rv

ic
e

s

A user takes overview of the available services

See 'Annex_D_4_3_Web Service APIs 

Specifications_v0.3.docx' file available in SVN at 

/04_Query_Mapping/metasearch engine

See 'Annex_D_4_3_Web Service APIs 

Specifications_v0.3.docx' file available in SVN at 

/04_Query_Mapping/metasearch engine

See 'Annex_D_4_3_Web Service APIs 

Specifications_v0.3.docx' file available in SVN at 

/04_Query_Mapping/metasearch engine

A user takes overview of the available services

http://harmosearchdev.harmonet.org/topic-service-

access-policies

Home page contains overview of services (active or not, 

missing configurations, links to configuration pages) 

Home page has text and registration and login buttons

http://harmosearchdev.harmonet.org/topic-login
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Id Name Description Expected Output Notes / Explanation

#
#

#
#

#
#

# W
h

o

Actual 

Result

#
#

#
#

#
#

#

W
h

o Actual 

Result

Data Provider registers a new query service, browses the semantic registry, and verifies its behaviour within the metasearch process

Comment: the number of results described in the 

'Expected Output' column may change in time, because 

the metasearch is an online operation that queries 

external data providers

In order to understand better the tests, at the bottom of the 

sheet there is a description of what the semantic registry 

"knows" about the data providers 'biella', 'euromuse' and 

'euromusemf'

 (euromusemf is the local index that contains crawled 

Microformat metadata from the euromuse web site)

S
R

0 Clean up if 

necessary

log in as testuser ('testuser@test.user', password: 

testuser) 

- go on 'Configurations' -> 'Query Service'

- click on the Data Provider(s) attached to your 

organisation if it/they exists

click on 'Delete Provider' (DO NOT DELETE THE 

PARTICIPANT!)

The evaluation starts with 'Test' organization having no 

data provider attached

o

A
fid

iu
m

o

e
ctrl

S
R

1

Add query 

service for 

a new 

HarmoSear

ch data 

provider

go in 'Configurations'->'Query Service'

click on 'Test'

- go on panel 'Create and attach a new Data Provider' 

and insert an id (e.g. TestDataprovider (no whitespaces!)

- click on 'Create' and insert the following parameters:

    -  'Test Data Provider' as Provider Name

    -  'events' as collectionId

- 

'http://www.euromuse.net/harmonise/query/query.php' 

as service access endpoint (no whitespaces!)

     -  'karin' as username and password

     - 'HTTPAdapter' as Connector class

     -  select 'METASEARCH' as operation

      - 'Event' as Subdomain

     -  click on 'Save Changes'

- click 'Edit Data Description' and select 'events in Berlin'

- click on 'Save Changes'

If you go back to the view 'Harmonise 

Participant Details' (back to list), the 

new data provider is attached to your 

organization ('Test')

A new data provider is registered for 'Test' organization. The 

data provider is added by specifying where and how the 

online query service  is accessed. 

An important step is the 'Data Description', which is used by 

the semantic registry to filter the input queries of a 

metasearch process, selecting only the relevant providers to 

be involved.

Note also, that the query service registered here 

corresponds to the data provider of 'euromuse', which is 

already a HarmoSearch provider. Thus, the results coming 

from 'Test' will be the same as those from 'euromuse'.

w

A
fid

iu
m

confus

ing 

screen 

: edit 

descri

ption. 

We 

may 

not 

save 

before

o

e
ctrl

S
R

2 Browse 

Registry 

(events in 

Berlin)

go on 'Search Data' -> 'Browse Data Providers'

- select 'events in Berlin'

3 providers returned

''Test' is listed as relevant data 

provider by the semantic registry 

(together with 'euromuse' and 

'euromusemf')

Consistent with the 'Data Description' of the data provider, 

the semantic registry considers 'Test' as relevant in a query 

that looks for 'events in Berlin' 

o

A
fid

iu
m

o

e
ctrl

SemReg0
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S
R

3 Metasearc

h (events 

in Berlin)

go on 'Search Data' -> 'Metasearch'

- select 'Germany' and 'Berlin'

- click on 'Search'

Message says: Contacted providers 3

Total results: 215 (71 euromusemf, 72 

euromuse, 72 Test)

All 3 data providers that are considered relevant are 

involved in the metasearch.

o

A
fid

iu
m

o

e
ctrl

but very 

slow!, 

several 

minutes 

to get 

the 

results

S
R

4 Browse 

Registry 

(cultural 

events in 

Berlin)

go on 'Search Data' -> 'Browse Data Providers'

- select 'cultural events in Berlin' 1 provider returned

''Test' is the only relevant data 

provider listed by the semantic registry 

'events in Berlin' is more generic than 'cultural events in 

Berlin', thus 'Test' is considered relevant for the query

o

A
fid

iu
m

o

e
ctrl

S
R

5 Metasearc

h (cultural 

events in 

Berlin)

go on 'Search Data' -> 'Metasearch'

- select 'Germany' and 'Berlin'

- select 'cultural' as category

- click on 'Search'

Message says: Contacted providers 1

Total results: 72 from Test

 Note that the search results are all n Berlin, but the 

category seams not to match: it means that the query of 

HarmoSeach looking for cultural events has been 

mapped, for the 'Test' data provider, into a query that 

includes all categories, either because cultural was mapped 

into all categories, or because cultural was not mapped, and 

the query service on Test (which corresponds to euromuse) 

did not consider that value / category within its local search 

engine

o

A
fid

iu
m

o

e
ctrl

very 

slow!

S
R

6 Browse 

Registry 

(events in 

Biella)

go on 'Search Data' -> 'Browse Data Providers'

- select 'events in Biella'

3 providers returned

But 'Test' is NOT a relevant data 

provider listed by the semantic registry 

'events in Berlin' excludes 'events in Biella' thus 'Test' NOT is 

considered relevant for the query

o

A
fid

iu
m

o

e
ctrl

S
R

7 Metasearc

h (events 

in Biella)

go on 'Search Data' -> 'Metasearch'

- select 'Italy' and 'Biella'

- click on 'Search'

Message says: Contacted providers 3 

(biella, euromuse and euromusemf)

Total results: 10 total, all from Biella

 'euromuse' and 'euromusemf' are involved because in the 

registry's data description (see * below) they have events in 

Italy (thus, in Biella). This does not mean that they actually 

have instances of events in Biella.

o

A
fid

iu
m

o

e
ctrl

S
R

8 Browse 

Registry 

(modern 

art 

exhibitions

)

go on 'Search Data' -> 'Browse Data Providers'

- select 'modern art exhibitions'

3 providers returned

''Test' is listed as relevant data 

provider by the semantic registry 

(together with 'euromuse' and 

'euromusemf')

'events in Berlin' includes 'modern art exhibitions 

(everywhere)' thus 'Test' is considered relevant for the query

o

A
fid

iu
m

o

e
ctrl

S
R

9 Metasearc

h (modern 

art 

exhibitions

)

go on 'Search Data' -> 'Metasearch'

- select 'modern art exhibitions' as category

- click on 'Search'

Message says: Contacted providers 3 

(Test, euromuse and euromusemf)

Total results: 50 (25 from Test and 25 

from euromuse, 0 from euromusemf)

 'euromuse' and 'euromusemf' are involved because in the 

registry's data description (see * below) it states that they 

have modern art exhibitions. This does not mean that they 

necessarily have instances of such events (in fact, 

euromusemf has not).

o

A
fid

iu
m

o

e
ctrl
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S
R

1
0 Browse 

Registry 

(events in 

Italy)

go on 'Search Data' -> 'Browse Data Providers'

- select 'events in Italy'

3 providers returned

But 'Test' is NOT a relevant data 

provider listed by the semantic registry 

'events in Berlin' excludes 'events in Italy' thus 'Test' NOT is 

considered relevant for the query

o

A
fid

iu
m

o

e
ctrl

S
R

1
1 Metasearc

h (events 

in Italy)

go on 'Search Data' -> 'Metasearch'

- select 'Italy'

- click on 'Search'

Message says: Contacted providers 3 

(biella, euromuse and euromusemf)

Total results: 32 total (4 from 

euromusemf, 10 from biella, 18 from 

euromuse)

 'euromuse' and 'Test' are the same provider, thus 'Test' 

would have some events in Italy. But the registry excludes it 

from the metasearch, because its 'Data Description' says it 

hosts (only): 'events in Berlin (Germany)'.

o

A
fid

iu
m

o
e

ctrl

S
R

1
2

Modify 

(GENERALI

SE) 'Data 

Descriptio

n' of the 

Test data 

provider

go in 'Configurations'->'Query Service'

click on 'Test'

- click on the attached data provider ('Test Data 

Provider')

- at the bottom, click on 'Edit Data Description'

- select 'events'

- click on 'Save Changes'

Now the Data Description of the provider includes every 

search criteria, and 'Test' is involved in every metasearch of 

events

o

A
fid

iu
m

o

e
ctrl

S
R

1
3 (Repeated) 

Metasearc

h (events 

in Italy)

go on 'Search Data' -> 'Metasearch'

- select 'Italy'

- click on 'Search'

Message says: Contacted providers 4 

(Test, biella, euromuse and 

euromusemf)

Total results: 50 total (4 from 

euromusemf, 10 from biella, 18 from 

euromuse, 18 from Test)

This time 'Test' was not filtered by the semantic registry, like 

it was when the Data Description was: 'events in Berlin 

(Germany)'

o

A
fid

iu
m

o

e
ctrl

S
R

1
4 Clean up go in 'Configurations'->'Query Service'

click on 'Test'

- click on the attached data provider ('Test Data 

Provider')

- click on 'Delete Provider' (DO NOT DELETE THE 

PARTICIPANT!)

There is no attached provider any 

more, and in Metasearch 'Test' is no 

more listed in the drop down menu

o

A
fid

iu
m

o

e
ctrl
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FP7-SME-1   262289  
HARMOSEARCH     

Deliverable D7.1 

APPENDIX C. ACCEPTANCE NOTES 

This section gathers all acceptance notes validated by the partners for 
each release. 



FP7-SME-1    

Project no. 262289 

HARMOSEARCH 

Harmonised Semantic Meta-Search in 

Distributed Heterogeneous Databases 

Appendix C.1: HARMOSEARCH Release 1 Formal Acceptance Note  Page 1 of 6 

Acceptance Note for Release 1 

Definition of the key components for the Harmosearch 

platform 

STRICTLY CONFIDENTIAL 

Start date of project: 2010-12-01  Duration: 27 month 

Project funded by the European Commission within the Seventh Framework Programme 

Dissemination Level 

PU Public 

PP Restricted to other participants (including the Commission Services) 

RE Restricted to a group specified by the Consortium (including the Commission Services) 

CO Confidential, only for members of the Consortium (including the Commission Services) X 
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FP7-SME-1   262289      

HARMOSEARCH                

Acceptance Note for D7.1 

DELIVERY CONTENT 

1.1 SOFTWARE  

Release 1 does not correspond to a specific deliverable but to the first release of 

independent components of the Metasearch Core engine. 

Content of release 1 encompasses: 

• The definition of the Harmosearch Query Language ontology 

• The semantic registry component (implementation of query language for the 

registry) 

• The meta search core Engine implementation (login, user and accounts 

management, file upload and download) 

• The crawler prototype based on micro format semantic annotations 

At present, no integration is in place and a complete search is not possible. 

1.2 DOCUMENTATION 

NOT APPLICABLE 
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FP7-SME-1   262289      

HARMOSEARCH                

Acceptance Note for D7.1 

FORMAL ACCEPTANCE 

2.1 SME ACCEPTANCE 

This section contains the list and status for each partner 

NR CHECK YES / NO / Conditional 

1 X+O BUSINESS SOLUTIONS GMBH YES 

2 ECTRL SOLUTIONS SRL YES 

3 EC3 Networks GmbH YES 

4 Lehmann & Werder Museumsmedien YES 

5 AFIDIUM YES 

2.2  OTHER PARTNER COMMENTS 

NO COMMENT 

2.3  CONSORTIUM ACCEPTANCE 

The consortium thereby accepts this release and considers that it covers 

requirements. 
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FP7-SME-1   262289      

HARMOSEARCH                

Acceptance Note for D7.1 

CONDITIONS AND NON ACCEPTANCE NOTES 

NOT APPLICABLE 
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FP7-SME-1   262289      

HARMOSEARCH                

Acceptance Note for D7.1 

APPENDIX: TEST SUMMARY 

Attached to this document are the Excel files detailing the tests that were performed 

and justifying the level of acceptance for the delivery. 

Tests that did not pass corresponded to either new requirements and have been 

entered in the list of requirements or to configuration issues that will be solved and 

tested in the next release. That was not considered an issue since no operation is 

expected between this release and the next one. 

• Test Case Release 1 - Crawler.xslx 

• Test Case Release 1 - Portal.xslx 

• Test Case Release 1 - Query.xslx 

• Test Case Release 1 - Semantic Registry.xslx 
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Acceptance Note for Release 2 

Integration of the different components in order to 

have a metasearch running 

 

STRICTLY CONFIDENTIAL 

 

Start date of project: 2010-12-01                                             Duration: 27 month 

 

 

 

 

 

                    

Project funded by the European Commission within the Seventh Framework Programme 

Dissemination Level 

PU Public  

PP Restricted to other participants (including the Commission Services)  

RE Restricted to a group specified by the Consortium (including the Commission Services)  

CO Confidential, only for members of the Consortium (including the Commission Services) X 
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Acceptance Note for D7.1 
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DELIVERY CONTENT ................................................................................... 3 
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Appendix C.2: HARMOSEARCH Release 2 Formal Acceptance Note  Page 3 of 6 

FP7-SME-1   262289      

HARMOSEARCH                

Acceptance Note for D7.1 

DELIVERY CONTENT 

1.1 SOFTWARE  

Release 2 does not correspond to a specific deliverable but to the second release of 

the integrated Metasearch Core engine and of the first release of the mapping tool. 

Content of release 2 encompasses: 

• The meta search core Engine implementation (login, user and accounts 

management, file upload and download) with  

• The integrated semantic registry 

• The integrated crawler 

• The integrated query engine 

A complete search is now possible. 

The mapping tool is present in the release 

1.2 DOCUMENTATION 

NOT APPLICABLE 
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FP7-SME-1   262289      

HARMOSEARCH                

Acceptance Note for D7.1 

FORMAL ACCEPTANCE 

2.1 SME ACCEPTANCE 

This section contains the list and status for each partner 

NR CHECK YES / NO / Conditional 

1 X+O BUSINESS SOLUTIONS GMBH Conditional 

2 ECTRL SOLUTIONS SRL Conditional 

3 EC3 Networks GmbH Conditional 

4 Lehmann & Werder Museumsmedien Conditional 

5 AFIDIUM Conditional 

2.2  OTHER PARTNER COMMENTS 

NO COMMENT 

2.3  CONSORTIUM ACCEPTANCE 

The consortium thereby accepts the Metasearch Core Engine part of the release 

and considers that it covers requirements.  

However, the mapping tool has been accepted with conditions. 
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FP7-SME-1   262289      

HARMOSEARCH                

Acceptance Note for D7.1 

CONDITIONS AND NON ACCEPTANCE NOTES 

The mapping tool in its present state is not usable for non technical experts. This is 

not compliant with the initial expectations. To remedy this situation a number of 

actions have been agreed with the RTD partner (see document workplan15-11-

2011.doc) . 
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FP7-SME-1   262289      

HARMOSEARCH                

Acceptance Note for D7.1 

APPENDIX: TEST SUMMARY 

Attached to this document are the Excel files detailing the tests that were performed 

and justifying the level of acceptance for the delivery. 

Tests that did not pass corresponded to either new requirements and have been 

entered in the list of requirements or to configuration issues that will be solved and 

tested in the next release. That was not considered an issue since no operation is 

expected between this release and the next one. 

• Test Case Release 2 - MetaSearch.xslx 

• Test Case Release 2 - Mapping Tool.xslx 
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Acceptance Note for Release 3 

First Complete Harmosearch version on one domain, 

with minimal features  

 

STRICTLY CONFIDENTIAL 

 

Start date of project: 2010-12-01                                             Duration: 27 month 

 

 

 

 

 

                    

Project funded by the European Commission within the Seventh Framework Programme 

Dissemination Level 

PU Public  

PP Restricted to other participants (including the Commission Services)  

RE Restricted to a group specified by the Consortium (including the Commission Services)  

CO Confidential, only for members of the Consortium (including the Commission Services) X 
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FP7-SME-1   262289      

HARMOSEARCH                

Acceptance Note for D7.1 

DELIVERY CONTENT 

1.1 SOFTWARE  

Release 3 does not correspond to a specific deliverable but to the first release of the 

complete Harmosearch system with the mapping tool integrated. 

Content of release 3 encompasses for the events subdomain: 

• The integration of the mapping tool into the system: download install from 

portal/ Assisted mapping upload and mapping validation 

• The enhance mapping tool to map the queries as well 

• The integration of a basic user interface for registry definition  

• The complete metasearch interface and a functional API (web service)  

• The implementation of scheduling capacity including a user interface to 

parameter the scheduler 

In addition to the actual release additional work has been performed to define how 

to 

• Have reference list mapping methodology with one base reference list for 

mapping 

• Manage parameters on mapping (language, currency...) 

• Register a new provider from the portal (crawler and API) 

• Register and setup a new organisation (providers and consumers) 

The enhanced mapping tool is present in the release 

1.2 DOCUMENTATION 

NOT APPLICABLE 
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FP7-SME-1   262289      

HARMOSEARCH                

Acceptance Note for D7.1 

FORMAL ACCEPTANCE 

2.1 SME ACCEPTANCE 

This section contains the list and status for each partner 

NR CHECK YES / NO / Conditional 

1 X+O BUSINESS SOLUTIONS GMBH Conditional 

2 ECTRL SOLUTIONS SRL Conditional 

3 EC3 Networks GmbH Conditional 

4 Lehmann & Werder Museumsmedien Conditional 

5 AFIDIUM Conditional 

2.2  OTHER PARTNER COMMENTS 

NO COMMENT 

2.3  CONSORTIUM ACCEPTANCE 

The consortium thereby accepts this release and considers that it covers 

requirements on the portal. The mapping tool is accepted as a prototype, provided 

it is transformed in the next release to take into account the usability requirements   
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CONDITIONS AND NON ACCEPTANCE NOTES 

Mapping tool is accepted as a prototype, provided that the next versions take into 

account the usability expected by the SME partners. 
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APPENDIX: TEST SUMMARY 

Attached to this document are the Excel files detailing the tests that were performed 

and justifying the level of acceptance for the delivery. 

Tests that did not pass corresponded to either new requirements and have been 

entered in the list of requirements or to configuration issues that will be solved and 

tested in the next release. That was not considered an issue since no operation is 

expected between this release and the next one. 

• Test Case Release 3 - Portal.xslx 

• Test Case Release 3 - Mapping Tool.xslx 
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DELIVERY CONTENT 

1.1 SOFTWARE  

Release 4 does not correspond to a specific deliverable but to the second release of 

the integrated Metasearch Core engine and integrated mapping tool. 

Content of release 4 encompasses the events and accomodation subdomain: 

• The integration of Twitter and Facebook profiles to an account on the 

Harmosearch platform using applications in order to publish content (manual, 

automatic or scheduled publication) on  Facebook and Twitter (only for events 

from Biella and Euromuse) 

• Extend HS portal to query and display results for hotels (display category 

according to domain) 

• Have a complete commercial portal with an operational subdomain (event) 

and a user friendly mapping tool  

• Addition of plugging capacity for external services, user rights, license 

subscription and validation management as well as services filtering for users, 

and integration of those features to the graphic interface. 

• Improvement of the graphical interface of the portal 

• Addition of the possibility to have multiple mappings (event mapping, hotel 

mapping) 

• Simplification of data import with the use of an excel template for events.  

• Addition of a simple minimal input format for events for data publication. 

The enhanced mapping tool is present in the release. 

1.2 DOCUMENTATION 

NOT APPLICABLE 
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FORMAL ACCEPTANCE 

2.1 SME ACCEPTANCE 

This section contains the list and status for each partner 

NR CHECK YES / NO / Conditional 

1 X+O BUSINESS SOLUTIONS GMBH YES 

2 ECTRL SOLUTIONS SRL YES 

3 EC3 Networks GmbH YES 

4 Lehmann & Werder Museumsmedien YES 

5 AFIDIUM YES 

2.2 OTHER PARTNER COMMENTS 

NO COMMENT 

2.3 CONSORTIUM ACCEPTANCE 

The consortium thereby accepts this release and considers that it covers 

requirements. The consortium acknowledges the numerous improvements in the 

mapping tool such as the form view that allows more intuitive data mapping. 

However a complete mapping could still not be performed with this release 

because of a number of missing functionalities 
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CONDITIONS AND NON ACCEPTANCE NOTES 

NOT APPLICABLE 
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APPENDIX: TEST SUMMARY 

Attached to this document are the Excel files detailing the tests that were performed 

and justifying the level of acceptance for the delivery. 

Tests that did not pass corresponded to either new requirements and have been 

entered in the list of requirements or to configuration issues that will be solved and 

tested in the next release. That was not considered an issue since no operation is 

expected between this release and the next one. 

• Test Case Release 4 - Portal.xslx 

• Test Case Release 4 - Mapping Tool.xslx 
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DELIVERY CONTENT 

1.1 SOFTWARE  
Release 5 does not correspond to a specific deliverable but to the third release of the 
integrated Metasearch Core engine and integrated mapping tool. 

Content of release 5 encompasses for the events subdomain: 

• The release 5 contains a complete Harmosearch platform including all the 
features (pas and described below) as well as the latest graphical layout. 

• Finalisation of the user and consumer role management on the portal (the 
subscription form contains a “role” field which will define which features the 
user can access, according to the following scenarios) 

o Publish : Qualified search and publication setup (including on the 
user’s and Harmosearch’s profiles on implemented social networks). 

o Metasearch : qualified metasearch for B2C users on the event site. 

o Qualified content import : transaction, file or form based import of 
qualified rich content in the system available for any consumer such as 
Pixmeaway 

• Specific interface (the interface only contains the relevant features for each of 
the roles mentioned above, including mapping configuration, external 
services subscription or management, notification and status reports…). A 
landing page describes each of those roles for user to select a role that 
matches its needs. 

• Expansion of the event scenario to  

o Allow input from at least 2 sources 

o Have capacity to qualify and enrich data,  

o Publish in 2 or 3 distribution channels.  

o Have a cache to distribution ready and minimal scoring notions in 
place.  

• Enhancement of data (addition of keywords, qualification, rating, completion 
indicator, and data scoring. 
The data scoring is based on :  

o Trustworthiness of the data source containing the data, 

o Number of sources where the data is available,  

o Completeness of the information (i.e. how many fields are filled in 
taking into consideration the most important ones... title, description, 
location, dates, links, thumbnail) 

• Integration of the help section structure on the platform (acess and 
navigation, main topics and articles definition) 

• Improvement of the registry management interface to easily store and 
browse data 
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• Integration of the crawler allowing to setup of a procedure which periodically 
updates indexes according to the providers configured in the semantic 
registry.  

• Addition of a feature allowing the import of ics calendars (file upload) 

• Expansion of the crawler for easier configuration 

• Improvement of the metasearch with sorting and filtering input capacities (on 
cached data) 

• Elaboration of a process to build a unique identifier reference 

As regard the mapping tool: the focused for events. The objective is still for the user 
to be able to make a mapping on its own  

The enhanced mapping tool is also present in the release : 

• Integration of reference lists and their mapping (categories, countries... but 
location names such as museums) 

• Integration of the management of an organization’s mapping of reference list 
in the mapping tool, and use in the reconciliation engine (for expert users) 

• Integration of output mapping in the metasearch 

• Overall Improvements of the mapping tool (dialog driven, step driven, user 
support while mapping, easy management parameters without complex path, 
differentiation of elements with attributes to map to different items, 
multilingualism support, and pre-configured mapping).  

1.2 DOCUMENTATION 
NOT APPLICABLE 
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FORMAL ACCEPTANCE 

2.1 SME ACCEPTANCE 
This section contains the list and status for each partner 

NR CHECK YES / NO / Conditional 

1 X+O BUSINESS SOLUTIONS GMBH Conditional 

2 ECTRL SOLUTIONS SRL Conditional 

3 EC3 Networks GmbH Conditional 

4 Lehmann & Werder Museumsmedien Conditional 

5 AFIDIUM Conditional 

2.2  OTHER PARTNER COMMENTS 
NO COMMENT 

2.3  CONSORTIUM ACCEPTANCE 
The consortium thereby accepts this release and considers that it covers 
requirements, except for the mapping tool that has only been accepted with 
conditions. 
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CONDITIONS AND NON ACCEPTANCE NOTES 

The consortium considers that the mapping tool is able to perform simple mapping 
but does not fully comply with the initial expectations in the sense that users are 
supported in easily performing mappings. 

Furthermore, a number of new mappings performed during the tests were not valid 
until technical expertise was involved. 
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APPENDIX: TEST SUMMARY 

Attached to this document are the Excel files detailing the tests that were performed 
and justifying the level of acceptance for the delivery. 

Tests passed well, some minor suggestions for additional improvements were 
provided. Those suggestions will be studied for potential improvements of the 
platform later on. 

• Test Case Release 5 - Portal.xslx (includes thesheet “Crawler” dedicated to 
tests on crawl jobs management, and the sheet “Reference list” dedicated to 
tests on how the portal handles the transformation o the reference lists made 
through the mapping tool). 

More details on the last release of the mapping tool and test steps can be found in 
the deliverable D6.3 Evaluation Report and Validation of Results of the Mapping Tool. 

xxx add testing steps in the mapping tool 
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